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Those of you who read our tests, and 
our Bazaar reviews, over the years, will 
have noticed that we have this param-
eter called value for money. This param-
eter tells us whether or not a certain  
product is worth your hard earned 
money, or not.

However, we don’t just sit around 
and critique other people’s products — 
every day we also analyse our own prod-
uct — Digit. Over the past eight years 
or so, we’ve consistently innovated and 
changed, based on feedback, boquets 
and brickbats that we receive from 
readers, our peers and colleagues. 

All of you have seen the recent 
changes that have been trickling into 
the magazine, the site and the DVDs. 
We’ve opened the f loodgates for this 
issue though, by presenting you with 
an all new design, and all new article 
sections. There’s exclusive software and 
video content on the DVD, and that’s 
going to increase steadily.

Digit, as a brand, is headed towards 
fulfilling all the needs that our rather 
large family has been demanding. Some 
people prefer the use of the word 
“community” to family, but like many 
other Digit readers, I’ve always felt very 
personally involved with this magazine, 
ever since I started reading Digit back 
in June 2001. You’ll understand the 
family ties better if you log on to the  
Thinkdigit.com forum, and watch as we 
bicker like feuding relatives at times.

Anyway, back to my point — the 
current global economic situation 
has ensured that the term “value for 
money” is burned into all our brains. 
Apart from helping you make informed 
decisions, keeping you ahead of the 
pack, and generally making sure you 
get the most out of every rupee you 
spend, we also want to ensure that 
Digit is truly value for money.

In the pages that follow, we’ve actu-
ally provided you with as much as 40 per 
cent more useful information per page. 
On an average, we used to have between 
750 and 800 words per page; this has 
now been increased to between 1,000 and 
1,200. This enables us to give you more 
information than before, and we’ve also 
been increasing the number of article 
pages over the past few months.

As I mentioned earlier, we’re not 
just adding value to the magazine, but 
online, and to the DVD as well, and 
we’re currently looking at some new 
ways in which we can serve you better; 
but more on that some other time...

We’ve added all new sections, based 
on feedback from you — Sci-Tech, Tech@
work and Toolbox specifically, seemed to 
be the popular demand.

We’re going to ensure that we cover 
open source more, in order to support 
that worthy movement. Budding devel-
opers will also get a few ideas from 
some of our workshops and articles.

In general, Digit will not only help 
you buy smarter, but now also help you 
learn quicker, adapt to changing trends 
in an instant, keep you ahead of the 
curve, and help you enjoy technology 
more than ever before.

I would also like to point out that 
this is work in progress, and by no 
means a finished product — to be 
honest it never will be, ever. We’re still 
open to suggestions, as always, and will 
continue to evolve, based on the feed-
back that we receive from you. Together 
we’ll build the best technology maga-
zine there is, period. 

To follow popular code naming 
conventions, you could consider this 
to be Digit 2.5 beta, and all of you are 
going to play a vital role in developing 
version 3.0. So please, keep those valu-
able emails coming in, and let us know 
what you think of this new direction 
that we’re headed in.

editor@thinkdigit.com

“...you could 
consider this to 
be Digit 2.5 beta, 
and all of you are 
going to play a 
vital role in
developing 
version 3.0.”

Digit 3.0

Editorial
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For any queries regarding the CD or DVD, email help@thinkdigit.com with “CD/DVD” as the subject.
If the subject is not mentioned, your mail might not reach the right person.
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■ AmoK Exif Sorter 2.5.1
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■ Aros Fractals
■ Ashampoo Burning Studio 6
■ Avidemux 2.4.3
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■ BurnAware 2.2.3
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■ jetAudio Basic
■ Kiddo
■ M3Unow 1.4.4
■ Media Jukebox 1.2
■ MWSnap
■ Now3D
■ Photo Wizard 1.2
■ Photoscape

Pictomio

Pictomio is an image browser and 
manager that can help you organize 
and catalog your image collections, 
using a modern interface with 3D 
rendering and plenty of eye candy. 
■ Pixia
■ Quick Media Converter 3.6.5
■ StickyView

STOIK Imagic Free Browser
STOIK Imagic Free Browser enables 
you to import, organize, enhance and 
share your digital photos. In addition 
to a thumbnail image browsing, the 
program includes a complete set of 
enhancement tools to adjust white 
balance, exposure, contrast, color 
curve.
■  Picasa for Windows
■  QuickCam 1.0
■  Real Alternative 1.9.0
■ Soundbase 2008.12.18
■ Stoik Video Converter
■ taksi 0.7.5.7 beta
■ TVersity Media Server
■ Virtual VCR 2.6.9
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■  Amazing Portal Generator 1.05
■  CQPhone 2.4

■  Filseclab Personal Firewall 3.0
■  GetGo Download Manager 4.0.1.95
■  Gizmo5 4.0
■ HydraIRC 0.3
■ PC Tools Firewall Plus 5
■ Phex 3.2
■ RocketOn 1.0.20
■ System Protect 1.0.0.83
■ ThreatFire 4.0
■ Tidy Favorites SE 3.75

Torrent Swapper

Torrent Swapper is an open sourced 
sociable peer to peer file-sharing client 
based on the Bittorrent protocol that 
is ideal for high-speed distribution 
of large files that has a basic 
understanding of human friendships, 
of user tastes in content, and of I
■ TRACE! 2.0
■ Trillian 3.1
■ TrilogyEC 1.3.0
■ VDownloader 0.77
■ WebRipper 1.32

SYSTEM
■ Autorun 1.0.0
■ DiskMemTray 1.1
■ EasyCleaner
■ HDAT2

HDDLife
HDDlife reads S.M.A.R.T. data from all 
of your hard drives and allows you to 
see clearly the health and resources of 
your disks.
■ JDiskReport
■ Lupas Rename
■ Mekuri
■ Pathbuddy 2.0
■ Quick Startup
■ Registry Jumper
■ Startup Control Panel
■ StatBar 2.406
■ Stock Startup
■ VisualCron
■ XP SysPad

ESSENTIALS
■.net Framework 2.0
■.net Framework 3.5
■ Avast Home Edition 4.8
■ Comodo Internet Security Pro 
■ 3.5.55810.432
■ Foxit Reader 3.0
■ Free Download Manager 2.5 build      
    758
■ Irfan View 4.20
■ Java(TM) 2 Runtime
■ K-Lite Mega Codec Pack FULL 4.2.5
■ Opera 9.6
■ Silverlight
■ Spybot Search and Destroy 1.6.0
■ VLC Player 0.9.4
■ WinRAR 3.80
■ µTorrent 1.8.1

Tools

Entertainment
GAMES
Urban Terror

Urban Terror™ is a free multiplayer 
first person shooter, that (thanks to 
ioquake3) does not require Quake III 
Arena. It is available for Windows, 
Linux and Macintosh.
■ Blindsight
■  Hellcarrier
■  Horrum
■  OpenQuartz
■  Orbiter
■  Racer
■  Speed Delight
■  Train Dispatcher 2
■  VoidRunner

HD TRAILERS
Planet 51
An alien planet, stuck in the culture 
of the 1950s, finds its paranoia kick-
started into high gear when a NASA 
astronaut arrives without warning 
and turns their world upside down.
■ All About Steve
■ Chocolate
■ Crank: High Voltage
■ Imagine That
■ Killshot
■ Push
■ State of Play
■ The Great Buck Howard

MUSIC
Butterfly Tea - 
The HEAVEN BUTTERFLIEz
Classical Symphony music 
synthesized by the French artist 
Butterfly Tea

ESSENTIALS

Audacity

A free, open source software for 
recording and editing sounds in 
Linux, Mac OS X , and other operating 
systems. 

■  7zip
■ amarok
■ Mplayer Codec Pack
■ Pidgin
■ Vuze
■ Wine

DISTROS

Granular 1.0
A free, open source software for 
recording and editing sounds in 
Linux, Mac OS X , and other operating 
systems. 
■ Sabayon 4.0

Linux

First look at IE8
We have a look at the 

latest version    32
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CREATE
3D Canvas v7.1.1.2

3D Canvas is a real-time, 3D-
modeling and -animation tool 
that incorporates a drag-and-drop 
approach. Complex models can 
be constructed from simple 3D 
primitives or created using 3D 
Canvas´s object-building tools. 
■  Aqsis Renderer 1.4.2 
■  Art of Illusion 2.7
■ AutoQ3D Community 1.38 
■  Bricks´n´Tiles - 1.5.3
■  CoCreate OneSpace Modeling 

Personal Edition v1.0  
■  DeleD 3D Editor Lite 1.53 
■ Drive Icon Changer 1.0 
■  Google SketchUp 7.0 
■ Greenfish Icon Editor 
   Pro 1.72
■  IcoFX 1.6.4  
■  Icon2Text 3.0 
■ K-3D 0.7.10.0 Dev 
■ Kerkythea 1.3.04 
■  OpenFX 1.5  
■  Pixelformer 0.9.6.3 RC3  
■ Sqirlz Water Reflections 2.5  
■  Autodesk 3D Studio Max 2009

PRODUCTIVITY
Abykus 1.02 
Abykus is an object-oriented 
spreadsheet for Windows that adds a 
new dimension to the classic ´what-
if´ analysis by allowing complex data 
types such as matrixes, coordinates, 
polygons, etc. to be stored in 
individual cells. 
■ 4ASoft Agenda 9.01 
■ Business Desktop Suite 
■ Business Manager 2007 1.1 
■ CoWord 1.0 
■ Evolution for Windows 2.22.2-4 
■ Forte CRM Solo 1.0 
■ IDEA! Free Edition 2.1.5.67
■ Logsourcev0.1.2
■ ManageEngine ServiceDesk Plus
■ Morefunc 5.05
■ Noah v1.02
■ PortableApps Suite 1.1 
■ Process Modeler v0.51a 
■ SSuite Office - The Fifth Element   
   1.22 
■ Smartworks-pe v2.0  
■ VORG Express 1.7  
■ Vevo! eSales 
■ sqlDESKTOP v3.00
■ eScan

HTPC
XBMC Media Center
XBMC is an award winning media 
center application for Linux, Mac OS 
X, Windows and XBox. The ultimate 
hub for all your media, XBMC is easy 

Tools
to use, looks slick, and has a large 
helpful community. Try it now!
■ Allegro Media Server
■ Beyond TV 4
■ Got All Media

■ J.River Media Center
■ SageTV Media Center V6
■ Twonky Media Manager
■  GBPVR
■  Icecast 2.3.2
■ Jinzora
■ Jinzora
■ MediaPortal 1.0
■ MeediOS
■ MythTV 0.21
■ Orb 2.0
■ Freevo
■ TVersity 1.0

FAST TRACK
Fast Track video 
■ Fast Track
■ Pokat Reader

PHOTOGRAPHY SOFTWARE
Jalbum 

Jalbum consists of free album 
software, free hosting and a creative 
community. With Jalbum it’s easy to 
create your own photo album site. Just 
the way you want it.
■ 4ASoft Agenda 9.01
■ 36-Image Converter 4.5.3.72
■ AndreaMosaic 3.30
■ Arclab Thumb Studio 1.5
■ DigiBookShelf 2005 v11.1
■ Digital Image Tool 1.2 
■ Digital Photo Recovery 3
■  FlipAlbum Standard 7.0.3
■ Free Picture Resize Starter 4.5.12
■ FxFoto
■ Gimp
■ HP Photosmart Essential 3.5
■ Image Analyzer 1.29
■ Jalbum
■ Kodak Easyshare 7.1
■ Life Photo Maker 1.2
■ Memeo Share 1.0.1367
■ PC Image Editor 3.70
■ Paint.NET 3.36
■ Phantasmagoria 1
■ Photo On Web

GAMES
Nuclear Bike 1.0 

Ride your sports bike through a rocky 
terrain and reach the flag! Complete 
levels as fast as possible to achieve 
maximum score points. Maximize 
your score by collecting bonuses 
and performing stunts, such as a 
360 degree flip or a wheelie! Feel 
breath-taking game play and amazing 
physics.
■  Digital Paint: Paintball 2.0 Build 23 
■ Penumbra 1.1 
■ The Crypt 1.2 
■ Burnout Paradise PC
■ Fear 2 
 
3D Adventure Studio
A system to create 3D adventure 

games without any programming 
knowledge.
■ 001 Action/ RPG maker
■ Gamemaker lite
■ Platform Studio
■ Reality Factory
■ WME

3d Rad 6.31 

3D Rad is a collection of intelligent 
objects you can combine in virtual 
space to create interactive 3d 
worlds. What you get depends on 
the nature of the objects you add 
and the relationships you establish 
between them.
■ FPS Creator
■ Game Editor 
■ InterAx
■ PlayBASIC
■ Silent Walk FPS Creator

GAME TRAILERS
The Sims 3
Get ready to return to your virtual 
life.
■ Dragon Age: Origins
■ Prototype
■ Riddick: Dark Athena
■ Tom Clancy’s H.A.W.X.

Digit videos
■ Unboxing the X360
■ Testing Mp3 Players
■ Blackberry Unboxing
■ HDD Disection

Videos

Gaming

Fast Track

■ Photo Story 3
■ PhotoFiltre 6.2.7
■ PhotoMeister 2.6 
■ PhotoPerfect Express 1.0
■ Photobie 5.2
■ Photobyte
■ Photozig Albums Express 1.0.302
■ Picasa 3
■ Poladroid 0.9.5r5 Beta 
■ Reallusion FaceFilter Xpress 1.0 
■ Restoration
■ Snapact Photo Manager 1.1
■ StudioLine Photo Basic
■ VSO Image Resizer
■ ViewNX
■ VisiPics 1.3
■ VueScan 8.5.02
■ WPanorama

Streaming Media
Using VLC, Orb 2.0 and 

other software.   76

Killer Rigs
The perfect machine to 

suit your needs  100

Make a game
A step-by-step DIY using 

two creators   110
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sions tested   46

Suggestion Box
I’m a regular reader of your magazine. 
I’ve been reading it for the past two 
years. Initially, I found the contents dif-
ficult to understand. However, as time 
passed by I found interest in it. Now, 
it has become part of my life. You have 
proved that you are the No. 1 magazine 
today. I like Tech Q and A, Tips and 
Tricks and also your CD and DVD. I sug-
gest you include an article on creation of 
web sites. How we can develop a web site 
and put it on the server? What is the cost 
involved? Last, but not the least, you are 
doing a good job. Keep it up!   
   Bhupesh

Haldwani, Nainital

We are overwhelmed by the letters of appre-
ciation from readers such as you. We appre-
ciate your continuous support, and hope you 
enjoy Digit in its brand new look. Do write in 
and let us know what you think you about it. 
We often carry content on web site creation. 
In fact, the February issue had an article 
on Mr. Site Takeaway, which covers all the 
points you have mentioned. If you want 
an easy process, Google’s Page Creator or 
Yahoo!’s Geocities should be of help to you. 

Team Digit

It has been a delight for me to keep in 
touch with the latest news in computers 
with the people who are best in business 
— Digit. I personally like the Fast Track 
that accompanies the magazine. 
1. Of late, I feel there has been a 

negligence towards the concept of 
Macintosh OS and its applications. 
There just isn’t any info about Mac 
apps, etc. May I suggest you to publish 
more on Mac apps and run a special 
“Fast Track” for Mac users such as 
Apple Script, Tweaks, etc.

2. The wonderful interface you provide 
in the DVDs doesn’t seem to work in 
Mac. Can't you fix it? An HTML view 
could do it. Looking forward for the 
next edition. 

Karthik Konduri

It is encouraging to know that you enjoy 
reading Fast Track. We will consider writing 
a Fast Track meant for Macintosh users.  

Team Digit

I am a regular reader of Digit and this is 
my second letter to you . You are really 
doing a great job. The February edition 
was simply superb. I was waiting for a 
gaming issue. Regarding the article on 
the game developers in India, you have 
put very brief information. You haven’t 
given much information regarding game 
development as a career. If it’s not so 
popular in India, please provide infor-
mation on options abroad. One more 
thing you should provide is what to do 
from the beginning to have a career in 
game developing.

You are simply the best technology 
magazine. Keep up the good work. My 
best wishes are with you.

Rakesh Ranjan
Bihar

There are many institutions in India that 
teach gaming as a part of the curriculum. 
There are many aspects of gaming, in the 
industry, people in a game development 
team are involved in highly specific tasks. 
AAG (Academy of Animation and Gaming) 
is located at Noida (www.aag.co.in) and is 
one such school in India. They offer courses 
in game programming, art and design. 
Meanwhile, get your hands dirty with the 
bunch of game creation tools included in 
this month’s DVD. 

Team Digit

I would like to express my gratitude 
because till I started reading your 
magazine in 2003, I didn’t know what 
a computer was. Now I’m the computer 
guy in my locality. I’m in the tenth 
grade and I just love all the sections in 
the magazine and DVDs. You would be 
pleased to know that even my brother 
who had an aversion towards computers 
has started using it. I have also started 
spreading word in my locality for people 
to start learning computers. They too, 

look forward to Digit. I have a request for 
you guys. Can you add a section on the 
History of Computing? 

Rohit Shivnani
Uttar Pradesh

Letters such as yours is reason for us to stay 
committed to our goal in leading you on the 
path of personal technology. Having readers 
grow in their knowledge and skill is in our 
interest and we continuously strive towards 
giving you the best quality content. We 
periodically cover subjects all through their 
origins in the technology space.

Team Digit

HD Fanboys
This is the first time I am writing to 
you. As we are entering the HD era, I'm 
very happy that Digit started to provide 
HD trailers. I want you to start an HD 
section in the magazine and DVD. 
Provide us more information on HD and 
put more HD content on the DVD.

Bhupinder Sidhu

I’m really fascinated by the HD trailers 
that you give along with the DVD packs. 
I would like to request for a full HD 
movie. Any movie will do. It would be 
good if it’s an English thriller movie. 

Farham

Thank you for writing in. We are happy to 
present you with this issue, containing sev-
eral HD trailers of the latest movies on the 
DVD. We have already provided an HD movie, 
called Elephant’s Dream. However, this is not 
the full run of the movie. Check out the num-
ber of HDTV screens reviewed this month. 
Also, enjoy reading articles on HTPC and 3D 
TV and setting up a Home A/V system. 

Team Digit

Response to February’s editorial
Wow! What a cool prank! I’m really 
happy to know that only a few Digit 
readers fell for that! This proves that 
Digit readers are intelligent people. I’m 
a programmer and I’m already aware of 
such things. It was really shocking to 
know that most people use such weak 
passwords! Well, they were very funny 
too! About your magazine, it was one 
of the best issues I’ve read. I really like 
your gaming centred issues. The reviews 
were excellent, especially, the review of 
Street Fighter 4.  Why have you guys only 
tested budget cellphones? As for your 
feature ‘What’s hot in 2009’, I’m really 
waiting for F.E.A.R 2 and Diablo 3 — one 
of my all time favourites. If possible, 
provide a demo of F.E.A.R 2 on your DVD. 

February 2009 Issue

Inbox
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Mazewar
was the fi rst MMOG to hit the 
virtual world. Believe it or not, this 
was way back in 1974.

Wi-Max
was originally known as WMAN 
(wireless Metropolitan Area 
Network) 

Ghajini the Game 
Ghajini the game re-

viewed, fl ip to  122

Your hands-on with Windows 7 
was very interesting as well. Finally, 
Microsoft got it right. One important 
suggestion — make your magazine 
thicker as I finish it in a week and then 
wait for your next edition eagerly. Your 
coverage of Chandrayaan-1 and inter-
view with the ISRO representative was 
very interesting as well. Now we Indians 
are one of those four nations. I’ve got 
a question. What does ‘MMORPG’ and 
‘RPG’ genres of games stands for and 
what do they actually mean? Your expla-
nation will be well appreciated. When I 
compare you guys with other technology 
magazines available, they are nothing 
other than copycats of your magazine. 
The stuff you provide in a month is 
given in their following month's issue. 
Even then, they stand nowhere near 
your standards. And one thing, I’m look-
ing forward to make a career in game 
development after reading your this 
month’s issue. You have simply shaped 
my career! You guys really deserve those 
150 bucks! Keep up the hopes and great 
work!

Kshitij Rawat, 
Dehradun

Regarding the email address for retrieving 
passwords, we had no intention of deceiv-
ing readers. We merely changed the email 
address in an authentic spam mail, so that the 
spammer would not receive a bunch of emails 
from our readers. It was most definitely not a 
prank, but a little social experiment. 

We received numerous emails and letters 
from our readers saying that the lower end 
of the market was ignored by the magazine. 
For this reason, we decided to test budget 
cell phones. We have included the demo of 
F.E.A.R. 2 in this month’s DVD. 

MMORPG stands for “Massive Multiplayer 
Online RPG” and RPG stands for “Role 
Playing Game”. In a role playing game, a 
person’s character is developed through 
game play, focussing on the choices of the 
player. This includes everything from how 
the character looks to the skills they devel-
op. An MMORPG is where a number of gam-
ers play in a virtual world, evolving their 
characters over time. World of Warcraft 
(WoW) is an example of such a game. 

Team Digit

Great Expectations
Another Excellent Issue! “Gaming 
Special” I just love it. But one thing to 
upset is “Shame on you”. This shows 
how people are ignorant and fall prey 
to these things. Digit should include 
a column on ‘security issue’ in each 
edition. Your editor would have done a 
Ph.D on ‘Password of email accounts’. 
Piracy is another headache to us. Please 
give some tips for recognising original 
software and stopping piracy.

Thanks for article on 3G and WiMAX. 
Agent 001 has given me an excellent 
choice for gaming keyboards. There 
should also be suggestions on small 
things such as pen drives or headphones 
and also UPS. Once again, thanks to Digit 
for such an excellent edition.

Mayur Gaikwad

Thanks for the praise. Our intention of the 
email password article was to highlight our 
vulnerability in security issues, in these days 
where passwords are hacked. We normally 
do cover USB drives, headphones and other 
peripheral devices. If these are not tested, 
then they are in the Bazaar section. We are 
seriously considering your suggestion of 
covering UPS, and will look into it. 

Team Digit

I wanted to know whether I will get my 
subscription copy near the same date in 
the future or not.

I congratulate Digit for faster 
service, as I now receive my magazine 
on the 1st of the month and  sometimes 
even on the 30th of the previous month.
Now that’s what I expect from India’s 
best tech magazine. There’s no doubt 
that with increase in prices you are 
giving more DVD content.

However, please (and thats a big 
please) concentrate on more magazine 
content too.

Earlier, Digit used to be quite thick. 
I loved “Beat that”, “Take a crack” and 
other contents which don’t show up 
nowadays. Also, please enlarge the 
“Inbox” section by a page or two as many 
mails don’t get all the points answered 
properly or even answered at all.

January’s Digit was awesome and 
now I’m more alert than ever while 
using the Internet. February’s edition 
was also great, but please avoid provid-
ing pictures as given on page 31, 32, 33 
of the Fast track.

How about giving out a “Fast track 
to Digit”. I’m sure every reader would 
want to know those behind the making 
efforts. Because of you guys, now I’ve 
turned to open source and left piracy. 
Digit is far better than any other tech 
magazine and it rocks!

Anirudh Khanna

The magazine appears to be thinner simply 
because the number of advertisements 
have reduced. The number of pages with 
the actual content has, in fact, increased. 
However, your point is well taken and every-
one loves a big fat magazine. We will ensure 
that you get high quality images in our 
prints. Great to know that we played a part 
in spreading the open source movement a 
little more!

Team Digit

This is my first mail to you. I started 
reading Digit from my school days when 
I was in class 8. My brother had bought 
the September issue of Digit. We also 
had a brand new PC at that time. So 
from that day onwards, I have read Digit 
till today. Your team is simply marvel-
lous. Your articles are very informative, 
detailed and very seminar type. Your 
product reviews, games reviews, Q&A, 
tips and tricks section are truly amaz-
ing. Today, many friends ask me about 
which laptops, cellphone, USB drives, 
graphic cards that they should buy, as 
if I’m their technology navigator as you 
are mine. 

And now for the February issue, your 
Fast track on Linux was a lifesaver for 
me. Many of my friends have installed 
Linux and don’t know anything about 
it. Your issue  was a life saver. Thank you 
for this wonderful gift. Apart from this, 
WiMAX vs 3G article was also very inter-
esting. We do have Wi-Fi in our hostel 
which serves our daily internet needs.

Last, but not the least I’m a racing 
genre lover and play many gaming 
titles such as NFS, Flatout, and many 
more. I would like to ask you a ques-
tion. I have a Dell d630 laptop. I want 
to play high graphic games on my 
laptop such as Undercover and Mirror’s 
Edge. Can I add a graphics card to my 
laptop? If so, which one should I add? 
My range is from Rs. 5,000-10,000. 
Please let me know.

Sunny Patil
Bhubaneshwar

Thank you for writing with your opinion 
on our magazine. It is always encourag-
ing to read letters such as yours. We hope 
you also enjoy reading our game reviews 
too. Continue reading Digit and lead others 
around you with your bit of knowledge. Also 
pass on word to read Digit. Responding to 
your query on graphics card for laptops, it's 
not possible to fit in an external graphics 
card on your laptop. Doing this isn't as easy 
as it is in the case of desktop PCs. Making 
changes to the hardware on a laptop is not 
advisable. While there are some gaming lap-
tops available in the market, we recommend 
considering a desktop solution instead. This 
way, it is easier for you to upgrade your sys-
tem with time, as the requirements to play 
the latest games keep increasing. 

  
Team Digit 

Letter of the month
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I
t would be unfair to say that signs of 
recession are surfacing around us now, 
because they have been there for quite 
some time. The signs have appeared in 

our techie world too. If you’re entirely oblivi-
ous, then it’s about time you crawled out 
from that rock you’ve been hiding under. 
Some industries are just about scratched, 
while others are reeling under the weight 
of the slowdown — yet everyone is affected. 
Take the case of the mobile phone industry, 
which is expected to weather the economic 
downturn better than the technology indus-
try in general. 

Nokia, the world’s largest phone 
manufacturer, announced recently 
that it expects mobile phone sales to 
be down by at least 10 per cent this 
year. Therefore, the decision by Nokia 
to reduce mobile phone production 
due to falling demand doesn’t come 
as a surprise. Nokia’s net profit in the 
last three months of ‘08 was down 69 
per cent compared to the previous year. 
The whole economic domino effect 
has decreased the disposable income 
available with consumers to spend on 
gadgets and technology. In the wake of 
their pessimistic outlook, Nokia plans 
to reduce production at its Finland 
unit. However, in order to cut costs, 
they’re adopting a rather curious strat-
egy. Nokia said the factory’s 2,500 staff 
would all be temporarily laid-off for 
a short period of time on a rotational 
basis, with 20 to 30 per cent of the staff 
unemployed at any given point in time.

The World Mobile Congress, too, 
reflected the sullen mood of the econ-
omy. Although manufacturers did show 
off some dazzling devices, there was 

certainly a decrease in terms of volume 
of products. Attendance too was lower, 
pegged at 49,000, down from 55,000 last 
year. However, a paradox is emerging 
in the form of smartphones. Purchases 
of such handsets (with multimedia 
functions, web browsers, and high-end 
cameras) have doubled over the past year 
according to TNS Research. In fact, Palm 
is banking on its big come-back with the 
Pre. The thinly veiled opportunity devel-
oping here thanks to smart phones, is 
revenue from service usage and applica-
tion downloads. App stores are certainly 
on the rise with almost all players in 
this space launching or expanding their 
Apps stores. Incidentally, the Apple 
App store has 13 applications that help 
you save money during the recession. 
Wonder if there is an app that tells 
you not to buy the iPhone in the first 

place? For India mobile games down-
loads should be an area that has some 
potential. Speaking of gaming there is 
a lot of trouble within game studios. 
Companies seem to want smaller teams 
now. In other words — layoff all around. 
Electronic Arts announced recently that 
they were reducing their workforce by 
11 per cent, which translates into 1,100 
people. It is closing twelve facilities and 
narrowing its product portfolio too.

Another one to bite the dust is 
CeBIT, the annual IT trade show. Slated 
to take place at Hannover Germany in 
March, CeBIT 2009, has lost over 25 per 
cent of its exhibitors compared to CeBIT 
2008. This year only 4,300 companies 
will be part of the expo as compared 
to 5,845 last year. CeBIT’s sister ‘coun-
try’ this year is California and hence 
the presence of Governor ‘Terminator’ 
Schwarzenegger at the trade show. 
However, it looks like the star’s presence 
is not lure enough for IT companies.

The world’s largest PC manufac-
turer, HP, is facing its share of economy 
voes. It’s profit for the recent quarter 
dropped by 13 per cent, with much of 

the damage coming from sales for the 
printer and ink division that contributes 
more than 40 per cent of HP’s operat-
ing profit. Employees were in for a rude 
shock following this, when they found a 
long memo from CEO Mark Hurd wait-
ing on their desktops explaining why he 
was imposing wide-ranging pay cuts in 
an effort to prevent further job losses. 
Well, at least pay cuts are better than 
being axed right? A bit of silver lining 
is that their services division however 
showed some promise.

There are ways of looking at the 
current scenario. The CEO of Intuit, an 
American tax software company, doesn’t 
look at it as a short term downturn, but 
more like a ‘new normal’. On the other 
hand, there are others who are looking 
at the economic slowdown as an oppor-

tunity. One industry on an upward trend 
in the midst of the slump and probably a 
result of it, is the online dating industry. 

Dating web sites usually get a 
spike in users during the buildup to 
Valentine’s day, but this year it seems 
it was higher compared to the last. A 
similar kind of surge is seen before 
Christmas and Thanksgiving. Experts 
attribute it to the pressure on singles to 
show up with someone to keep face in 
front of friends and family. Its almost 
like apart from their being embarrassed 
about their tight purse strings they 
don’t want to be further humiliated by 
being single! Well lets hope the times 
change for the better lest we see more of 
these market absurdities.

Internet growth in India

I
sn’t it shocking that India, Asia’s 
third-largest economy, has less 
than five per cent internet penetra-
tion? India in its current role as 

the flagbearer of the off-shoring busi-
ness, cannot afford this at all. A recent 
research indicates that although India 
is one of the fastest-growing mobile 
telephone markets in the world, it is 
in danger of being left behind by other 
emerging markets, unless it takes 
urgent steps to enhance its access to 
the internet. 

The Indian Council for Research on 
International Economic Relations said 
that India’s “very low” penetration of 
internet would be a drag on the coun-
try’s global competitiveness. The coun-
try would stand no chance against the 
likes of China, Korea and Indonesia. In 
fact, according to media reports in 2007, 
the government had proposed “free 
high-speed broadband internet connec-
tions” by 2009. 

The plan was to be implemented 
via state-owned operators BSNL and 
MTNL. The intention was to boost overall 
economic activity in the industry. We 
wonder where the plan stands today. 
While urban India is on the verge of 
embracing 3G, states such as Bihar and 
Assam have virtually no internet access. 
And speaking of 3G, the much awaited 
3G spectrum auction, originally sched-
uled for later this month, is said to face 
further delays. 

The Indian mobile market stands at 
350 million now with around 10 million 
new users added every month. Imagine 
the possibilities and information access 
when even a fraction of these devices 
can use 3G. If India is to remain at 
par with the world in terms of mobile 
connectivity, we wonder how these 
delays in implementing new technology 
will fare in the long run. 

Creeper
The fi rst computer vi-
rus  infected ARPANET 
in 1970

Recession: Doom or opportunity?



DIGIT MARCH 2009 11

ENTERFrom the labs
Reinventing the 

internet 75

Military struck by virus

T
hat very familiar doomsday 
scenario of planes falling out of 
the sky would nearly have been a 
reality thanks to the “Conficker” 

virus. Recently, French fighter aircrafts 
were unable to download their flight 
plans after databases were infected 
by the virus. Microsoft had warned 
that Conficker, transmitted through 
Windows, was attacking computer 
systems in October last year. However, it 
seems that the French military ignored 
the warning and failed to install the 
necessary patches. They managed to 
contain the infection by shutting down 
their entire communication system and 
resorting traditional forms of communi-
cation such as telephone, fax and snail-
mail! The attack on the system, however, 
is not believed to be specific or with 
malicious intent.

Conficker surfaced sometime 
in October ’08 and has been quite 
a pain for Microsoft. Also known as 
“Downandup“ and “Kido“, it is one of 
the worst computer threats in years, 
infecting more than 10 million systems 
worldwide. Microsoft has even put up a 
bounty of $250,000 (Rs. 12.35 million) on 
the Conficker’s authors head! However, 
this is not the first time such a strategy 
has been used. In 2005, Microsoft paid 
the same amount to two people for iden-
tifying the man behind the Sasser worm. 
As it turned out, it was a teenager by the 
name of Sven Jaschan. Even if this tactic 
has proved effective in the past, specula-
tion suggests that Microsoft won’t get 
far this time as it’s believed the creator 
of Downandup is from a part of the 
world that is soft on Cybercrime such as 
Russia, Ukraine, or Romania. Therefore, 
even if he were identified, conviction 
would be difficult. What Microsoft 
probably didn’t think about is that the 
designer of the code himself might jump 
at the bounty. This might spark off a 
ridiculous trend where malicious code 
writers start looking at the Bounty as 
prize money!

“Change” to open source 

I
n an open letter to the Obama 
administration, a group of soft-
ware vendors is encouraging the 
US Government to switch over to 

open source. The letter tries to impress 
upon the new president, the benefits of 
open source by likening open source to 
Obama’s campaign philosophy of hope, 
change, and openness. 

It’s curious to note that these 
vendors are actually commercial vendors 
and specifically plugging TriSano — an 
open source, citizen-focused surveil-
lance and outbreak management system 
for infectious disease, environmental 
hazards, and bio-terrorism attacks. 
These proponents of open source are not 
like your regular Linux fan boys. They’re 
entrepreneurs who appreciate the cost 
efficacy of collaborative development. 
However, it turns out that the US admin-
istration has been using open source 
for quite some time now, especially the 
Department of Defense. Linux and other 
open source technologies have been used 
by the DoD in a wide range of deploy-
ment areas, including the Army Future 
Combat Systems program and the Land 
Warrior program. 

The obvious advantages that the 
administration hopes to gain is in terms 
of lesser risk of vendor lock-in and lower 
IT infrastructure costs. The same advan-
tages can be leveraged into servicing 
other areas such as schools and other 
public utilities. 

Intel v/s NVIDIA

T
here seems to be some sort of 
a legal battle brewing between 
chip manufacturing rivals Intel 
and NVIDIA. Why are they rivals 

you might ask. Well if we are to go by 
NVIDIA’s take on the chip manufactur-
ing business, then CPU manufacturing 
is a decaying business and the GPU 
(graphics processing unit) is the new 
heart and soul of the the PC. In fact, 
NVIDIA believes that this whole law 
suit by Intel is nothing but a last ditch 
effort by processor manufacturer to 
protect precisely this decaying CPU 
business. The ruckus is being raised 
because Intel recently sued NVIDIA 
claiming that the existing licence agree-
ment between them does not allow 
NVIDIA to design chipsets for CPUs with 
integrated memory controllers such 
as the Nehalem. NVIDIA, on the other 
hand, is confident that it does. So like 
all disputes in the western world, this 
one, too, is being settled by a court. 
Mind you, both the companies have had 
agreements in place for a long time that 
allow NVIDIA to make chip-sets for the 
processor making giant. Emphasising 
that NVIDIA will not back down, the 
CEO Jen-Hsun Huang was quoted saying, 
“this case is about the future and 
NVIDIA’s ability to continue to innovate 
and make a difference in the industry by 
creating its own products, not just those 

that Intel allows it to create”. With sales 
of desktop processors down by 18 per 
cent in the last quarter, and those of 
graphics cards down by almost 35 per 
cent, this sort of in-fighting isn’t going 
to help either of the companies. 

Meanwhile, the companies are fight-
ing battles elswhere too. Intel is trying 
to launch products by defining newer 
product categories such as netbooks 
and the latest one MID. MIDs are mobile 
internet devices; basically, portable 
gadgets that can replicate the PC expe-
rience. Intel is trying to perfect a new 
platform technology called Moorestown 
for MIDs that will negate the power 
draining nature of processors. Similarly, 
NVIDIA is banking on the Tegra 600 and 
Ion chips to win in this segment.
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AP schools get low cost 
educational PCs 

A
ndhra Pradesh has been known 
to be a progressive state when 
it comes to implementing latest 
technology for state welfare. As part 

of its latest endeavour, the state govt has 
deployed a massive computerisation project 
for government schools in just four months. 

However, the real feather in the cap is 
the innovation in technology that has made 
this possible. The project employs a shared-
computing model using NComputing’s 
desktop virtualisation technology. The 
premise behind the technology is that 
today’s PCs are so powerful that the vast 
majority of users only use a small fraction 
of the computer’s capacity. Especially, while 
using it to run simple tasks. In the set up, 
there are several sets of keyboards, mice 
and monitors connected to an NComputing 
device that later connects to a shared PC. 

Reports suggest that each one of the 
students connected, gets full PC experience. 
Devices are supposed to be easy to install. 
Moreover, it uses only 1 W of power! The 
project is currently used to teach students 
computer skills, office productivity tools 
such as spreadsheets and word processing, 
and subjects such as mathematics. 

The systems run on the Microsoft 
Windows Server operating system and 
uses the Microsoft Office Suite. The project 
succeeded in facilitating computer access to 
1.8 million students across the state, many 
of whom have probably never even touched 
a computer. The project is also a success 
story for the government’s new public-
private partnership model, where successful 
partnerships have been formed to achieve 
transparency, accountability and efficiency.

Microsoft's HR blues

L
ately, we’ve seen some contradic-
tory news coming from Microsoft. 
Especially in the way they’re 
managing their workforce in these 

tough times. On one hand, it’s facing 
flack for thinning down their workforce, 
and on the other more attacks exhorting 
it to prioritise American workers over 
foreign guest workers as the software 
giant downsizes. In the wake of one such a 
letter by a senator to Microsoft, questions 
are being asked about the legality of axing 
H-1B workers. 

Microsoft plans to lay off around 5,000 
workers, many of whom are H-1B holders. 
And it appears that it has an affinity for H-
1B holders. We’re pretty sure any announce-
ment on this front must be sending shivers 
down the spines of thousands of H-1B hold-
ing Indians waiting on the edge of their 
seats — their fate hanging in the balance. 
However, some commentators on the 
subject are claiming that H-1B visas rarely 
go to exceptional talent and often are used 
by body shops that provide contract labour to 
other companies. 

Another curious incident involves 
Microsoft asking a refund from the laid-
off workers! The software giant, recently 
laid off 1,400 employees, and has sent 
letters to some of them saying that their 
severance payouts were a bit too “gener-
ous” and that the employees should pay 
the money back to Microsoft. Well, the 
letter at least apologises for any inconve-
nience caused. Talk about a PR blunder in 
the making. What could not be found out, 
however, was the exact amount that was 
over paid to the employees. Well it must’ve 
been quite a significant error really for 
them to send out such a letter. 
To save face with the American public at 
large, the company is also starting a job 
training effort aimed at giving technical 
skills to as many as 2 million Americans 
over the next three years. The program is 
being called Elevate America and will help 
people with creating a resume. Elevate 
America? More like alleviate Microsoft.

Outsourcing wonders of 
the tech world

W
hen you think of outsourcing 
what comes to your mind? 
Probably India and then 
China. But more specifically 

Chennai, Shanghai and Mumbai right? 
Well you can forget about them because 
the outsourcing hubs of tomorrow will 
be something like Zagreb and Penang, 
says a report by KPMG. The first is a city 
in Malaysia, while the other is in Croatia 
and several other unheard of places might 
become the next offshoring mammoths 
of the world according to the new report 
which list down 31 such places. 

The report indicates that traditional 
centres are faced with overburdened tele-
communications infrastructure and have 
overstretched labour markets so should be 
overlooked henceforth. Instead, the report 
urges companies to look at alternatives it 
suggests such as cities in the Asia-Pacific 
region that offer lower costs, younger 
populations, and government incentives 
such as easy work permits. While those 
in Europe, Middle East, and Africa have 
robust telecommunications and power 
infrastructures and niche specialisation 
in fields such as data management. While 
cities in the Americas can leverage their 
large pools of labour, a more mature 
service offering, proximity to major client 
bases, and multiple language skills. 

What is curious yet appropriate is 
that size is not a deciding factor for these 
emerging cities to be on the list. Cities such 
as Buenos Aires is home to around 1.3 crore 
people, while Gdansk in Poland has just 
8,00,000 people. The report emphasises on 
the proportion of computer graduates, the 
number of research and development insti-
tutions, the rate of migration to the cities, 
and common languages with their target 
markets. Also, Jaipur and Nagpur featured 
on the list of 31. 

Google tests electricity 
tracker

T
he news couldn’t have come at 
a better time. Cost conscious as 
we all are, we’ve always fretted 
about things such as our electric-

ity bills. With the recession eating away 
everyone’s purses and homeowners trying 
to cut corners in all possible ways, this 
new service currently being tested by 
Google, consumers can monitor their 
home energy usage almost in real time. 
Environmental concerns are also driv-
ing much of the research in this field. It 
seems there is great demand for products 
such as this one that track energy usage. 

About 40 million trackers are in use 
worldwide. Google says it believes another 
100 million will be sold in the next few 
years. Google obviously wants to cash in 
on this opportunity, and is actively testing 
its own software prototype PowerMeter. 
These days, you can manage almost 
anything online, be it your bank account 
or stock trades. Soon with PowerMeter, 
you’ll be able to manage your power 
consumption the same way. Simply plug 
your appliance into the device, specify 
your electricity cost and it will calculate 
your bill. 

Google PowerMeter will receive infor-
mation from smart meters and energy 
management devices and this information 
will be provided to anyone who signs up 
access to their home electricity consump-
tion on the iGoogle homepage. Imagine 
the cost saving that can be brought about 
by the widespread use of this device. 
Studies show that such kind of informa-
tion when made available toconsumers, 
they’ll invariably be able to save 5 to 15 
percent on their electricity bills. Google 
says that for every six households that 
save 10% on electricity, carbon emissions 
are reduced to the extent of taking one 
conventional car off the road.

Atlantis not yet found
Those who have heard of users of 
Google Earth unearthing Atlantis, 
Google says its just an artefact of 
their scanning. 
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Connections

Siddharth Parwatay

Y
ou might have noticed 
by now that we’re great 
cribbers. With most of the 
products that we review, 

almost always, we can find either 
this element missing, or that 
other feature which could’ve 
been better. So we thought of 
coming up with our list of peeves. 
Better still, a wish list of what we 
would ideally want in a product. 
So here’s a look at things we 
wish cell phones had, and maybe 
things even the industry at large 
should wake up and incorporate 
to make our lives easier. One 
thing is wishful thinking, but 
what is the reality? What are the 
latest developments taking place 
in the world towards perfection?  
We’ll tell you about them too.

Universal charging 
At some point in your life there 
would definitely have come a moment 
when you found yourself running around 
your office in sheer desperation look-
ing for a Nokia thin-pin charger, or a 
Sony Ericsson W series charger. Isn’t it 
frustrating? Your phone is about to die 
out, there’s electricity around, but you 
can’t tap into any of it! For long, people 
have been cribbing and crying about the 
thousand-odd types of  charging pins out 
there, courtesy cell phone manufacturers 
trying to be unique perhaps. Why can’t 
they just come together and make just 
one universal charging plug? It turns 
out they are. At the recent World Mobile 
Congress in Barcelona, the GSMA and 17 
leading mobile operators and manufactur-
ers announced that they are committed to 
implementing a cross-industry standard 
for a universal charger for new mobile 
phones. Apart from consumer experience 
improvement, the reasons are also energy 
saving and waste reduction. Hopefully, if 
all goes as per plan, you can expect the 
new charging solution based on Micro-
USB to be the standard by 2012.

More battery. If not, then at least 
alternative charging methods. 
GPRS, Bluetooth, Video, Music — all big 
time battery eaters. Some people resort 
to carrying spare batteries. Some carry 
car chargers. Could there be a better way? 
Well some time back we heard of motion-
based chargers that utilise the human 
body’s natural movements to create 
charge. So basically run around or go for a 

walk to charge your phone. Such a device 
would create power by using motion-
produced electromagnetic fields 
that are harvested, converted 
to electrical energy and 
stored. But research-
ers are scouting for still 
other ways. Companies like 
ZTE and Samsung showed off 
their earth friendly solar powered 
phones at WMC 09. While the ZTE 
is a rather plain looking ‘making 
calls’ type of phone, Samsung’s Blue 
Earth is a full touch Eco friendly 
wonder. Imagine you’re running out 
of battery. When this technology is 
perfected an hour or two in the sun 
and you should be good to go. But 
what about the fact that most people 
quite like to keep their phones in their 
pockets? Perhaps accessory makers could 
make hay while the sun shines by coming 
up with some strap-on devices! You could 
then perhaps even charge your phone 
while you’re on your way to work.

 
More apps, more freedom, maybe 
fewer operating systems 
Compatibility is a prickly issues when it 
comes to phones and the stuff you can 
run on them. Who has the patience these 
days really to look at which platform 
supports which application? Applications 
are very important. We would really like 
to see a free office suit on phones that 
allows more editing options. Restrictive 
operating systems inhibit innovation 

and reaching the full potential 
of functionality of devices. 
Whatever operating system it 
may be, should allow indepen-
dent developers to develop soft-
ware applications. Otherwise 
you have people such as Apple 
who want to criminalise 
Jailbreaking, which allows users 
to circumvent the digital rights 
management (DRM) technology 
on the iPhone, to be able to 
install third-party applications 
not authorised by the company. 
Firefox incidentally is support-
ing the iPhone jail breakers.

Bigger Dispalys 
Now that we have so much more 
to watch on our cell phones 
why do it on a itsy bitsy screen? 
When the iPhone came out it its 
large display, it made even the 
most hardened critics take notice 
and go “hmm that’s nice”. Now 
its about time someone came 
up with a bigger screen. Toshiba 

unveiled the TG01 which 
has a 4.1-inch 800x600 

display, and a 1-

GHz CPU from Qualcomm. 
But we’re greedier still. Bigger the better 
is always the way to go to get the most 
out of your portable media. 

Better Cameras
Agreed phones have come a long way 
since the time of VGA cameras that 
produced grainy images that barely 
passed off as photographs. Still, when 
do you think they’ll come close to truly 
replacing stand alone cameras? Lately 
many phones do have 5 MP and such. 
But that’s not enough. The WMC saw 
a few phones like the Nokia N86 and 
Samsung Memoir which show that they’re 
at least getting there, but a long way to 
go. Zooming is one area that requires 
improvement. Most cell phone cameras 

Digit’s Mobile Phone Wish List 

3G already outdated
4G launch in the US expected by 
Verizon in 2010. 

Mobile Watch
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have digital zoom instead of optical zoom. 
An actual moving lens could help make 
the leap. Another great divide that cell 
phones need to cross is sensor size. For 
greater picture density sensor size in 
phones must be increased. 

Better looking phones  
There are the standard chocolate bar 
phones, sliding phones, and flip phones 
but we really could do with some radical 
designs. Something interesting we laid 
eyes on recently was the GD900; LG’s 
transparent phone. Its got a glass-like 
polished silver body and a translucent 
keypad. A light illuminates around its 

keypad to make the buttons visible. It’ll 
definitely come in handy if you’re Hollow 
Man or the Invisible woman from fantas-
tic four!

Accessories compatibility (3.5-mm 
audio jacks and memory cards)  
Compatibility is one of the most impor-
tant factors when it comes to cell phones 
and its associated accessories. For instance 
one should be able to plug in any pair 
of headphones or earphones into any 
phone. If each manufacturer has its own 
proprietary standard, so much of listening 
equipment is rendered useless. One of the 
possible reasons why cell phone manu-

facturers even have their own distinct 
standards could be additional revenue. 
For example if your bundled LG or Sony 
Ericsson earphones get ruined, you have 
no other option than to go in for replace-
ments from that manufacturer. Also most 
discerning audio fanatics will agree that 
earphones that come along with most 
phones are not up to the mark in terms of 
audio quality. Naturally you would want 
to use your high quality headphones, but 
often the jack on your cell phone will not 
be a 3.5-mm standard jack. For phones to 
truly replace portable MP3 players they 
must allow listeners to be able to choose 
which headphone they want to plug into 
their device. Another issue is with expand-
able memory. When changing phones it 
should be as simple as transferring the 
memory card from one phone to the 
other. This doesn’t always happen because 
of so many proprietary formats such as 
M2, SD/MMC, Memory Stick, xD-Picture 
Card etc.

Other wishes 
When you buy a rather pricey device, 
it is not unfair to expect the phone to 
be easy to handle and of a better build 
quality. Better ergonomics would surely 
help; like scalloped or bevelled keys, 
angled screens etc. Plus the slider quality 
in most sliding phones leaves a lot to be 
desired. Since we’re in the era of touch 
screens, thats an area that could use some 
R&D, especially by companies other than 
Apple. Funcionality could be improved 
with small measures like having more 
useful displays in standby mode — giving 
you more at a glance without having to 
open the phone or unlock or slide. We 
would also like some more ease with 
inter-transferability of personal data such 
as contacts, notes and calender entries 
between brands.

So we hope our little wish list finds 
its way into the R&D lab of some handset 
manufacture. And if at all some genie 
manufacturer decides to make our wish 
his command, we get first dibbs on the 
dream device!

Local search 
What do you normally do when you are 
looking for a service or product in the non 
virtual world? A few years ago you would 
thumb through a dusty old yellow pages 
directory. Then we got pretty comfort-
able with services such as Just Dial. 
Now, it looks like the search giant of the 
virtual world Google, intends to enter the 
local search fray in a big way. Recently, 
Mumbai and Bangalore got a taste of 
Google’s phone search. Initially launched 
in Hyderabad and Delhi about a year ago, 

Yet another MS OS 
Microsoft launched their latest 
mobile OS — Windows Mobile 6.5 
on the 17th of February. 

More cut calls?
The number of mobile phones 
used in India is over 36,22,00,000. 

Who owns the web?
Havoc reigns in web 2.0. 

Read about it   18
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this service enables users to search for 
local businesses or movie show-times by 
calling a toll free number. The results 
are then sent to you via SMS. We decided 
to give it a shot. We called up 1-800-41-
999-999 and the automated IVR menu 
asked us to state business and location. 
Surprisingly it did recognise in the second 
try and sent us a single listing of Healthy 
Meal Tiffin Service in Ghatkopar (no 
where near our office which is in Vashi). 
Still not bad, though we would’ve liked a 
few more results. Google claims to trans-
fer the call to an operator after two failed 
attempts at recognition. We decided to 
put this to test too, so for business name 
we said “Ding Dong”. Obviously after 
two attempts at recognising ‘ding dong’ 
as a business name, the operator came 
on. When asked him for listings of Tiffin 
Services and he seemed not at all inclined 
to narrow down the location. When 
prompted from our end he was willing to 
send area specific listings. Otherwise he 
was going send the first three listings for 
the keywords ‘Tiffin Service’. How typi-
cally Google! (sponsored results anyone?) 
Also the three SMSs that we received 
were pretty garbled. Incidentally the 
same service is available via SMS. Simply 
send your search query to 9-77-33-00000 
and wait for the listings to be sent to you 
almost instantaneously.

Google 
Latitude
Google seems to be giving a major 
push to their mobile invasion lately. Its 
comforting enough to know that Google 
already knows more about us than we 
do ourselves. Be it our searches, mails, 
likes dislikes, and here’s yet another case 
Google trying to pervade another aspect 
of our lives. This time it seems Google 
wants to pin point our location! Okay 
perhaps this is a very paranoid way of 
looking at the recent launch of Google’s 
Latitude. The new service from Google is 
supposed to be a feature added to Google 
Maps for mobile that allows you pinpoint 
your friends location on a map. Your first 
reaction might be “oh that’s nice, who 
can I stalk or spy on?” But remember, even 
your location can be triangulated! Now 
are you thinking “that’s kinda creepy”? 
Well Google’s take on the service goes 
something like this — “Once you’ve opted 
in to Latitude, you can see the approxi-
mate location of your friends and loved 
ones who have decided to share their loca-
tion with you. So now you can do things 
like see if your spouse is stuck in traffic 
on the way home from work, notice that a 
buddy is in town for the weekend, or take 
comfort in knowing that a loved one’s 
flight landed safely, despite bad weather.”

Jokes and paranoia aside, 
it may indeed have some uses. 
You may really want to share 
your location with people 
you’re really close to. You 
could use it to show off too. 
Yes, apart from automatically 
detecting your location you 
can manually set your loca-
tion with the desktop version 
of the service via the Latitude 
iGoogle gadget. So you can 
even set your location to Paris 
if you wish. Perhaps concerned 
parents could use it to keep 
tabs on delinquent teenagers? 
Also to dispel a bit of paranoia, 
all this ‘sharing’ business is 
entirely as per your choice. You 
can choose who to share your 
location with and vice-versa. 
You can also decide what level 
of specific location you want to 
go into ie. your best available 
location or your city-level loca-
tion. Latitude currently is avail-
able on Blackberry, Windows 
Mobile, and most Symbian S60 
and Java-enabled (J2ME) mobile 
phones and the app can be 
downloaded from www.google.
com/latitude. 

Mobile Watch

More mobile apps
Nokia announces the launch of virtual 
OVI mobile app store as competition to 
the i-Tunes store. 



Web Watch

DIGIT MARCH 200918

C
O

N
N

EC
T

IO
N

S

Web Watch

Register on the ThinkDigit forum. We 
respect your privacy. 

W
ith the massive outbreak of 
web sites that work on user 
generated content, issues 
regarding ownership of such 

content have started to shake things up. 
Who controls all this information in a 
world of search engines, social network-
ing, and a culture of online sharing? As 
web sites of the so called web 2.0 revolu-
tion, such as Facebook, MySpace and 
YouTube are struggling to come up with 
a sustainable revenue model, it’s natural 
for them to cast a net and grapple for 
every last bit of your information. Perhaps 
it’ll be of some use or value some day, 
is what they probably reason. A recent 
example of this was when Facebook 
decided to make changes to their Terms 
of Service document which granted them 
rights to all your content, forever — even 
after you’ve left the service. Why do 
they want this content? All these traces 
you leave behind, help Facebook and 
others build a valuable database of your 
likes and dislikes. This treasure trove of 
information has got to be worth a lot to 
marketers.

A huge uproar was raised about the 
issue by consumer rights groups and 
strangely enough, communities within 

Facebook itself sprung up to protest the 
subject. Facebook quickly turned tail 
and issued statements saying it’ll come 
up with a reworked document. It’s defi-
nitely not a solution, but at least it’s a 
temporary salve. The larger question here 
still needs to be answered. Who owns 
all this stuff? Comprehensive privacy 
laws must be put in place to define such 
things. Also, if these companies don’t do 
something about their image, they can 
easily fall prey to something known as 
the big company syndrome. According to 
this syndrome that is currently afflicting 
Google, people begin to get suspicious of 
companies that have grown very large. 
In the case of Facebook, it’s important to 
point out the actual words of the “Terms 

of service” document stated that content 
was still subject to your privacy settings. 
Therefore, it was not like you could one 
day end up seeing your mugshot on the 
side of a bus, as one blogger commented.

Facebook’s view of the matter is that 
they just want to keep your content after 
you’ve left to keep the social fabric of the 
web site going. They liken it to emailing, 
where a copy of your email is found both 
with the sender in the sent items and one 
in the inbox of the receiver. Ostensibly, 
they just want to retain the copy they 
have. Therefore, does sharing imply part-
ing with rights? These are difficult ques-
tions to answer. And those that signifi-
cantly value their privacy tilt towards 
absolute control over their own content.
What can we learn from this? Well, the 
first thing you need to do is stop think-
ing of these web sites as your personal 
diary. Consider them as publishing tools 
instead of your own little digital domain. 
Update your privacy settings to the maxi-
mum possible level. An added benefit of 
this is that you’ll probably stop getting 
those friend requests from random people 
which make you go “hmm... do i know 
this person?”. Be proactive — maybe 
you can take an active part in formula-
tion of policies. Facebook for instance 
has now started a community where it 
welcomes users thoughts on the privacy 
issue. Incidentally the protest group on 
facebook called “People Against the New 
Terms of Service” had 1,13,383 members 
while going to print while the “Facebook 
Bill of Rights and Responsibilities” group 
had 73,272 members. Also you could take 
the trouble to read the privacy agree-
ments of these web sites instead of so 
willingly clicking on agree all the time. 
At least read the parts most relevant to 
you. If sifting through tons of legalese is 
not your thing look for blogs that explain 
stuff in simple English. Amanda French, 
a blogger, and authority on the subject 
offers comparisons between the terms 
of service of MySpace, Flickr, Picasa, 
YouTube, LinkedIn, and Twitter. Definitely 
worth a read. Last but not the least, one 
should remember that whatever you put 
out there on the internet will most likely 
remain much after you’re gone, even 
if the service providers honestly delete 
them from their databases. The internet’s 
memory unlike public memory is not 
short lived. 

Who owns your    
online content?

900%
The increase in the 
usage of Twitter in the 
year 2008. 
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Agent 001

A 
few years ago, WAP (wireless 
application protocol) was consid-
ered a luxury, and a lot of us had 
the “My service provider’s cooler 

than yours,” arguments, based solely on 
the cost of internet access. I was, at one 
point, paying Rs 499 per month to get 
internet access on my phone. 
When it comes to electronics and tech-
nology, the meek mobile phone has 
inherited the Earth. With a rather large 
percentage of people owning one, it’s 
obvious to everyone that networking the 
world is easiest achieved through mobile 
devices. Unfortunately, things aren’t as 
simple as hooking everyone up with a 
mobile internet connection.

We have the goal – connect the 
world; get them on the net. We have the 
technology: GPRS, EDGE, 3G, Wi-Fi, etc. 
However, as is usually the case, software 
plays spoilsport.

Just browsing
No two phone manufacturers seem to 
agree on any one browser. Although it 
may not seem like a problem, it actu-
ally wouldn’t hurt for someone to have 
a Microsoft-like strangle-hold on mobile 
browsers – the way IE is on the desktop. 
Before you gawk in disbelief at that 
statement, finish reading the article and 
perhaps it will begin to make sense.

Basically, there is a need for stan-
dards, as the lack of them is confusing 
everyone – you, me, developers, mobile 
manufacturers, ISPs; effectively chucking 
a rather large spanner in the works.

Order to chaos
Thankfully, the W3C (World Wide Web 
Consortium, founded by Tim Berners-Lee) 
is trying to set some standards here, and 
ensure that we all have similar experi-
ences when browsing the mobile web, no 
matter what handsets we use.

Wouldn’t it be nice to be able to 
browse the mobile web the same way 
we do on our desktops? Barring a few 
sites that are “optimised” for Internet 
Explorer, the “desktop web”, is basically 
standardised. When it comes to mobile 
browsers, however, the reality is quite the 
opposite.

Apart from the W3C, the Web 
Standards project is also involved in 
creating tests that browsers (especially 
mobile browsers) need to pass before they 
can claim to conform to standards. More 
information in the box “Acid3 test”.

Staying connected
Browsers that will let you get your daily dose of the net, on your mobile...

Developer Corner

Language of the year
Python was voted the Language of 
the year in 2008 by linuxquestions.org 
— for the second year in a row. 

Mobile Browsers
Let’s take a look at what’s on offer for 
those of you who can’t wait to get online 
from your mobiles.

Android
Google’s open source initiative brought 
us the Android mobile OS, and although 
there aren’t too many devices that run it 
just yet, you can count on Google’s past 
success in everything they do to ensure 
that  this will change soon. Android’s 
browser has got some rave reviews from 
early adopters. It uses the WebKit render-
ing engine, which is basically an API that 
Apple derived from the KHTML software 
library that is used in KDE’s Konqueror 
browser. The browser is fast, renders well, 
and with WebKit promising to be one of 
the few to pass the Acid3 test soon, there 
are certainly not going to be too many 
formatting errors. The android browser 
scores 72/100 in the Acid3 test.

The Web Standards Project has a battery of tests to verify how a browser follows the 
accepted web standards, and how a browser displays them. Standards are important 

for the web, and the WSP is doing its bit to try and get all major browsers to conform to set 
guidelines. Even those of you who use a desktop to surf the net will have come across some 
site or the other that just breaks when you view it — with text that refuses to stay in its box, 
images that refuse to resize right, or menus that seem to act all crazy. Sometimes it’s the 
site’s coder who have screwed up, but sometimes, it’s your browser that’s coughed and died, 
because it just doesn’t support a certain web standard. If everyone followed standards, you 
could just use your favourite browser, visit any site, and never have to see terribly broken 
layouts or renders. The Acid3 test is supposed to tell you whether your browser is following 
the coding rules, or not. Anyone can run the Acid3 test by visiting http://acid3.acidtests.org. 
More information on the various Acid tests are available at www.webstandards.org.
Scoring (desktop browsers):
IE7: 12/100
IE8: 21/100
Firefox 3.03: 71/100
Opera 9.63: 85/100
Google Chrome / Safari 3.2: 75/100

Interestingly, newer versions of both WebKit and Presto (that’s Safari/Chrome and Opera 
to regular folk) pass the Acid3 test with flying colours, and although IE8 has improved on 
IE7s scores, it’s still pathetically placed. Now if someone could only get Microsoft’s IE team 
to start caring, we’d hope to see some improvements in that score.

 Acid3 test

“The Mobile Web Initiative’s goal 
is to make browsing the Web from 
mobile devices a reality. W3C and 
mobile industry leaders are working 
together to improve Web content 
production and access for mobile 
users and the greater Web.”

Tim Berners-Lee
Internet Inventor / W3C Director
www.w3.org
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Feature

Nokia Symbian 60
Nokia’s S60-based phones use a browser 
that’s also based on WebKit, like Android 
and Safari, but somehow it doesn’t do as 
well as its cousins. It scores 47/100 in the 
Acid3 test, and generally does not feel as 
fast and smooth (rendering) as its cous-
ins. The one good feature it does add, 
which its cousins need to seriously think 
about, is Flash Lite support. There’s still a 
lot of tweaking needed, and Flash-lite on 
our test phone (a Nokia E51) was buggy 
and slow because it ate a lot of resources 
– but at least it worked. There are some 
decent Flash Lite applications available, 
just make sure you don’t use any of the 
screensavers – they just eat into your 
battery life. 

Safari
Mobile users will have used this if they 
coughed up the dough for an iPhone, or 
an iPod Touch, and they will be perhaps 
the most content of all us mobile net 
junkies. Safari is the best mobile browser 
yet — it is fast, renders impeccably, scrolls 
and zooms beautifully, and since it’s 
found on Apple devices, the multi-touch 
really makes it simple for anyone to use. 
It’s still got a long way to go though 
— it needs to add Flash support, fails 
the Acid3 test (74/100), and when pages 
break, they break terribly. Remember, 
WebKit claims to pass the Acid3 test with 
Safari 4.  

Opera Mobile
This is Opera’s Windows mobile and 
Symbian browser, which is bundled in 
some devices, and available for down-
load for all others. Opera have their 
own closed-source browser engine called 
Presto, and as you can see from the desk-
top version’s results, the Acid3 results, 
although not perfect, seem to suggest 
that Presto certainly follows more web 
standards than the rest. Opera Mobile 
9.5 beta scores 73/100 in Acid3, and the 
tests it fails are less likely to affect page 
layouts. A look at the screenshots should 
tell you what you need to know.

Flash Lite
Flash Lite is Adobe’s way of bring Flash 
content to the mobile phone specifically, and 
mobile devices in general. The Lite part of its 
name should immediately tell you that this is 
not a full blown Flash player, like the version 
for desktop browsers or Adobe’s Shockwave 
player, but it does have some interesting uses. 
You should check if your device is Flash Lite 
capable, and if it is, make sure to visit Adobe’s 
Marketplace at http://www.adobe.com/cfusion/
exchange/. Just search for Flash Lite, and you 
should find hundreds of apps that may inter-
est you.

Internet Explorer
IE on Windows Mobile is a barely able to 
render anything properly. If you thought 
Acid3 tests scores for its desktop version were 
bad, you have no clue how bad, bad can be. 
With so many sites breaking, it doesn’t make 
sense to even bother here. It’s obvious that 
IE has a long way to go before it’s suitable for 
smaller screens. For now, we’d rather urge 
Windows Mobile users to download Opera 

Mobile, which may not run as well as it does 
on Symbian, but at least you’ll be able to surf 
the net! 

Opera Mini
The best part about Opera Mini is that 
it can be installed on almost any mobile 
device – whether the iPhone, any Symbian 
device or even the run of the mill, everyday 
(Java-enabled) mobile phone. Opera mini is 
specialised for small-screen browsing, and 
renders really well. Opera Mini scores 80/100 
in the Acid3 test, which is commendable.

Mini uses Opera servers to compress, 
reformat and optimise data for your small 
screen, which results in faster page transfers, 
and little or no processing power required 
on your end. Unlike Opera Mobile, where 
your mobile does all the processing and page 
rendering, Mini lets a server farm somewhere 
in cyber space worry about all that, and just 
displays content on your screen. It’s also a 
good application for those on a pay-per-use 
data plan, because, for all practical purposes, 
Mini zips (as in compression, and speed) the 
net for you, saving you precious bandwidth 

and time. I for one am thankful for it, because 
I barely get 2 or 3 KBps over my pathetic 
GPRS connection, but can still do everything I 
need to online, from anywhere, using Mini.

Now what?
As usual, there needs to be some logical 
conclusion to the whole thing, right? Wrong. 
We still have a long way to go before the 
“mobile web” is as accessible as the “desktop 
web”. Recent news reports have suggested that 
the number of mobile users globally (and espe-
cially in India), are increasing exponentially. 
Much before we have one laptop per child we 
might end up having one mobile per child, and 
this is something that all mobile service provid-
ers are well aware of. The mobile is the new 
PC, and everyone and their uncles are hopping 
on to the mobile space to try something.

While this is great news for those of us 
who love the convenience of mobile connec-
tivity, all we can do is hope that groups like 
the W3C and the WSP succeed in encouraging 
the use of standards, or else it might not be 
as much of a runaway success story as the 
desktop web is.

Still, with some mobile devices starting 
to match the processing power of a 6 year 
old PC, perhaps we’re all going to be thrown 
into another race for performance, and will 
again skilfully adapt Moore’s Law for the 
mobile space to justify constant upgrades 
and doubling of features on mobiles. Perhaps 
we’re wasting time worrying about which 
browser to use, because in the near future we 
might be bickering over which OS to use and 
which antivirus software is best... whatever 
the outcome, we’ll still be here to help point 
the way. 

  Mobile Browsers

Firefox for mobiles
Codenamed "Fennec", it's under 
development. An alpha release is now 
available to download.
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Feature: IE8
A fi rst look at the latest 

release of IE.   32

 Bissols sub-30 mm.
 wonder.

Every luxury brand has tried to stay up to the times 
through outrageously expensive pen drives. Bissols 
sub-30 mm wonder is the smallest luxury pen drive 

in existence. The casing is engineered in a process 
reminiscent of swiss watches. The pen drive has 4 

GB of memory. The pen drive does not even have the 
customary rare metal body studded with rare gems, 

its made of plain old brass. Available for a very 
reasonable $260 (Rs. 12,726).

iThe Safari edition 
iM8 
Leica is a German company well known for making 
simple, highly effective cameras with outdated looks. 
The M8 and M8.2 were wonders, 10.3 MP digital 
cameras in a casing that would not look out of place 
back in the 50s. The Safari edition M8 is something 
really special. Only 500 of these rangefinder cameras 
will ever be made, and everything from the carrybag 
to the strap is designed around the dusty theme. 
There is a limited electronic menu, with most of the 
options available through good old chunky buttons 
and knobs on the casing itself. One of these will set 
you back by $10,000 (Rs. 488,731). 

 Pioneer X-Z9.
From the elite Hi-Fi stable of Pioneer, the X-Z9 

sound system is one of those high-end systems    
that does not leave the end user to do all the hard 

work. The system lets you plug in a USB drive, 
your MP3 player, supports your iPod and streams 

from your PC. You can connect your computer 
using a good old network cable. It can also 

interface directly with internet radio and satellite 
radio. In all probability, you will need a better set 
of ears to appreciate the X-Z9 to the fullest. Costs 

$ 1,800 (Rs 87,867)
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 Summit X speakers.
The Summit X speakers are floor standing speakers from 
MartinLogan. The speakers contain controls for changing the 
output according to the acoustics of the room, low distortion 
aluminum woofers that are laser engineered, and the trademark 
XStat Transducers borrowed from their flagship CLX series. The 
speakers are available in six wooden finishes (Wenge, Natural 
Cherry, Dark Cherry, Bird’s Eye Maple, Bubinga and Black Ash), 
and have soft lights that illuminate the base from below. Get a 
good portion of the $25,000 (Rs. 1,221,750) CLX technology for a 
mere $14,000 (Rs. 684,180). 

 Sony Ericsson X2.
The Walkman lives on — the first touch-controlled 
Walkman phones to hit the market will be the Sony 
Ericsson X-series phones, all of which hopes to give 
competition to the mighty iPhone. The pick of the 
lot is the X2, a powerful multimedia oriented piece. 
The menu directly leads you to YouTube. All major 
formats are supported, you can download DRM-free 
music from iTunes and BBC iPlayer, all in a 432x240 
OLED display. The battery lasts for 12 hours only 
though, with 16 GB and 32 GB models available. No 
word on the pricing yet. 

Vertu Constellation
Pure made from steel, leather & 
ceramics to sell for $8,500 (only 
2500 pieces available)

Tomorrow's Tech
Be ready to fi ght, Skynet's 

time is near  38
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Kumar Jhuremalani

I
magine walking back home after a hard day’s work and 
being honoured with a red carpet welcome. Add to this, 
some colourful butterflies and a shower of flower petals 
— no gibberish. The day is not too far when 3D technology 

will move out of being only available at the cinema halls but 
also will be available for everybody at their houses.

The story behind 3D TV
In the 50s, Disney, Paramount and Universal Studios had all 
created 3D films for everybody to enjoy and that was considered 
the birth of 3D technology. This vision was also meant to be the 
way of the future for watching videos, but soon got killed due to 
strain on the eyes and headaches which were caused by watch-
ing a 3D movie which usually, was like a fun filled evening for 

the family. Since that time, the idea has existed to provide 3D 
TV to homes everywhere. Of course, this also has to be done 
without those geeky paper glasses with the red and blue lenses 
otherwise we will send them back to the drawing board in 
protest.

Well that was the past, as many companies have developed 
prototypes that do not need those so called ‘3D glasses’. Moving 
forward a few technology cycles, and this concept of 3D TV 
without the glasses has risen from the ashes. The past few 
years have shown us progress in this field with more and more 
companies moving towards creating 3D TVs. 

A few years ago, 
Philips introduced 
their prototype 3D TV 
which gave people a 
view of objects actually 
being next to them. In 
reality, however, was 
just being displayed by 
a 42-inch LCD screen. 
The 3D technology is 
actually used with LCD 
TVs and not a sepa-
rate new type of TV. 
They used the concept 
of sending images, 
slightly differing 
from one another, separately to the right and left eye – which 
mimicks our stereoscopic vision. 

Philips is calling this technology WOWvx and is going 
to have a range of screens with the same title. The WOWvx 
technology places minute lenses over each of the millions of 
red, green and blue sub pixels that make up a LCD or plasma 
display. Basically, there is a processor present in the TV that 
generates nine slightly different views which correspond to the 
different viewing angles. This is why, if you view the TV from 
any angle, you will get a different image in each eye. Providing 
these many views is the actual key for the success of 3-D TVs.

Currently the best use for 3D TVs lies in playing video 
games on them. Technically games are created with the 
generation of three-dimensional objects internally which are 
then flattened to two-dimensional representation due to the 
limitations of standard available monitors. Video games are 
a great ready-made source for 3D content, but what about 
those of you who don’t like to play games, and want other 
source of entertainment? The reason why currently movies 
cannot really be shown in 3D is due to the cost. This cost that 
we are talking about is not really the cost of creating the 3D 
TVs, as they cost almost the same as the cost to create a regu-
lar LCD or plasma TV, but instead it is the cost of creating a 
movie to be watched in 3D that is affecting it. There is also 
research going on to convert ordinary 2D videos into 3D, but 
it has still not reached an acceptable viewing stage and more 
work needs to be done for it. 

3D TV 
Is it really here?

The future of television is here

You no longer need to wear 3D glasses

The stereoscopic principle

Psycho Circus
by KISS was the fi rst 3D 
music video made in 
1998.
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Sony, one of the 
major manufacturers 
of LCDs and Plasma TVs 
has also hopped on the 
wagon for 3D TVs and 
displayed their prototype 
model at CES 2009. Sony 
had a different take on 
the technology they used, 
as their 3D TV involved 
glasses for viewing. But 
don’t be scared as they 
are not those horrid 
paper glasses, but are 
much better and are 
being created by REAL D. 
Not much information 
was revealed about their 
launch plans and the 
future of how they are 
looking at 3D TVs. 

In 2008, Panasonic 
revealed to the world the largest plasma TV which was a whop-
ping 150 inches. But this time, at CES 2009 they decided not 
to compete in size; instead, they focused on showcasing their 
advancement in 3D technology. They showed off their 103-inch 
full HD 3D TV. According to Panasonic, “3D FHD [Full HD] system 
comprises a 103-inch Plasma HDTV and a Blu-ray Disc player that 
plays back Blu-ray Discs onto which 3D video (consisting of left- 
and right-sided 1080p Full HD images) are recorded. This current 
plasma will definitely not fit every home but Panasonic has defi-
nitely shown that they want to dominate the 3D TV market". So 
this is one brand to definitely watch out for if you want to move 
to 3D TV. 

3D has such a large scope when it comes to entertainment. 
Movies in 3D are already a tried-and-tested method and is loved 
by all. But having to strain your eyes for it on a regular basis is a 
price nobody is willing to pay. The fun-filled cartoon characters 
popping out of your screen, the terrifying horror that scares you 
in 2D, and now will really freak you out thanks to 3D TVs, are 
all going to be a part and parcel of your daily life soon.

It has a wide variety of applications other than just play-
ing games and watching movies. There must be quite a few 
sports lovers who really want to watch a particular event such 
as a cricket match, but cannot do so because these matches are 

played all around the world. Also, sometimes getting entry to 
these matches is tough not only because of the foot fall but also 
due to the cost. Broadcasting these matches live through 3D TVs 
would be one of the best things that could ever happen in this 
case. This kind of entertainment would require you to just sit 
at home, but these matches could also be broadcast in cinema 
halls. It would be just spectacular to watch your favourite sports 
icon right infront of your face, it would feel like you are actually 
a part of the game itself.

Other than entertainment what other purpose is there for a 
3D TV one may wonder, but infact there are many. One of them 
includes a gamer’s dream coming true as Westinghouse is work-
ing on a passively 3D LCD television. Imagine playing a game 
that you are finally part of, whereby looking to your left you 
will actually see objects and enemies right in front of your face, 
instead of just typically on the screen itself. They have accom-
plished this by aiming pixels in different directions with varying 
overlapping points, which creates the illusion of depth to the 
viewer. A drawback to this technology is that due to the pixel 
being spread in different directions, the television isn’t capable 
of switching from 2D to 3D. How many gamers will actually be 
spending their money on this particular display is a question 
that only time will answer.

Education will benefit to new extents with the introduction 
of 3D TVs. Education has already moved on to the PC where 
students even at school levels are referring to video tutorials 
and other media forms related to their subjects. Having 3D TVs 
will boost understanding to greater heights, not to mention it 
would be more fun all together. For example, while studying 
geography, instead of just looking at a country on the map, with 
3D TV you can zoom to show pin point locations right in front 
of your eyes. 

The field of medicine will really benefit from 3D TVs and 
this idea is being made a possibility by several large companies.
Some companies such as Alioscopy are currently focussing 
towards medicine and are not moving along the stereotypical 
path of targetting home users. Viewing the internal organs in 
the human body in 3D will give a boost to doctor's perform-
ing surgeries. Their diagnosis can be made more easily and it 
reduces the chances of causing an error. There will be a whole 
new understanding and approach to medical procedures with 
the introduction of 3D TVs. Biotechnologists and biomedical 
researches also profit from this and can display detailed struc-
tures of DNA and proteins that they have mapped, in return 
giving them a better understanding of genetics and our very 
own evolution.

A scene from Aliens vs Monsters

The ball will be in your hand Advance protein structures will be more visible

The fi rst 3D movie made by a 
major hollywood studio was 

Man in the Dark 
released on April 8, 1953
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People get easily distracted by shiny objects being displayed 
on a regular television and if it is a product, it will be wanted by 
all. This is a common advertising strategy that is used by compa-
nies to lure people into purchasing their products without 
actually getting to see them first hand. Traditional television is 
limiting the viewers from actually finding out the full features 
of a product. Utilising 3D TVs as a mode to sell products will 
give potential buyers a better look at the product and will not be 
dissapointed with what they purchase. Those tele scammers will 
finally be dealt with.

When 3D TVs go mainstream, which won’t be very long, 
even professionals like Architects and  Interior Designers will 
benefit from it. Creating and presenting their projects can be 
done with much more ease. Plans for building and homes can 
be laid out and conveyed to the clients simply through a 3D TV.

Using your LCD or plasma TV, that is wall mounted, to 
display beutiful pictures of art work is now a common thing 
seen in households that have these TVs. Now think about those 
images actually popping out of that screen, letting people view 
it in a whole new way. Luxury at home will soon know a new 
meaning with 3D Art. Sculptors and artisans normally create 
intricate designs before actually executing them, but sometimes 
things don’t turn out as originally planned as what they view 
is on a 2D plane. But with 3D playing a roll here as well, things 
will always go as planned.

3D technology has inspired many other similar fields. There 
are researches that are working towards creating a chip in 
cameras that can actually capture an image and convert it into 
a three-dimensional one with actual depth and distance. As this 
technology is new it does have it’s own kinks that need to be 
sorted out. But this has also helped to reduce noise and other 
distortion in images. This 3D technology would make a welcome 
addition to the cameras of the future. As battery capacities 
expand and processors become more powerful, cameras will be 
able to sport these chips with ease. Although the price would 
probably be higher than a traditional sensor, being able to take 
3D photos would certainly be worth it, at least for some.

3D is just the start of things and is already looking very 
promising. The next thing that this will evolve into is holo-
graphic imaging. The day will come when communicating 
between people will feel that you are actually talking to the 
person right next to you. Even your watch or mobile phones (if 
they will still exist) will be able to transmit this type of video 
and with a voice interface you can actually see the person you 
are speaking with right next to you even though he or she might 
be in another part of the world. Holograms are also useful is 
so most of the mentioned 3D TV applications. For example, in 
the field of education, many students opt for higher education 
through distance learning programs, which works out to be 
tough due to physical isolation, but will soon be able to sit in a 
holographic classroom along with the other students. 

What the future holds for us all is still not certain, but what 
is certain is that we are moving in the right direction and have 
definitely had a good start. How long it will take to reach the 
destination is upto all of us, whether to appreciate and accept 
the technology put forth is all our choice. We have already made 
our choice and can’t wait to see this technology turn into a 
complete reality, what about you? 

kumar.j@thinkdigit.com
Images will actually be transformed into reality 

  Other manufacturers making 3D TVs
Philips, Panasonic, LG, Mitsubishi, Sharp, NEC, Hitachi and Sony are 
in the race for taking over the 3D TV market.
LG
LG is just the next brand in the growing line of consumer 
companies that are caving to be one of the elite few in the 
3D run. LG has accepted that 3D TV is the next big thing and 
is also pushing forward their research to enter this market. 
Regrettably, that’s about all the details that LG is willing to 
shed light on. We hope LG doesn’t make us wear those horrid 
looking glasses though.
Hitachi
Hitachi has gone ahead and has done something which the 
others still haven’t reached. What we are talking about is not 
only 3D TV, but also controlling such a TV with hand gestures. 
Hitachi was another brand that was showcasing its 3D TV tech-
nology advancement at CES 2009. This high-end TV panel of 
theirs, works with a Canesta 3D sensor that allows TV viewers 
to interact with the controls of the TV through hand gestures. 
This TV is not just a prototype, but will be available soon. Soon 
you will be able to change the channels, even if you can’t find 
your remote control. 
Sharp
Sharp has started off without waiting for television and movie 
producers to shift to equipment that produce 3D content. Instead, 
it is researching ways to convert 2D content such as videos into 

3D. This would not only create new openings for content by 
converting old and current films and TV shows, but depending 
on the efficacy of the technology, could even eliminate the need 
for studios to invest in any new filming equipment at all. Sharp 
has used technology similar to Philips'. However, unlike Philips, it 
involves only a pair of images that will be recognised separately 
in each eye. However, in order for this to work, the viewer must 
be sitting still in one postition. 
NEC
NEC has been working on a prototype to bring 3D TV to your 
mobile phone. We really don’t know what NEC wants to accom-
plish by doing so, as the screen size is said to be only 3.1 inch as 
3D images never jump out beyond the frame of the screen you 
are looking at. This means you need to be holding the device 
really close to your face to have the full effect of 3D on your 
mobile phone. NEC wants to show how its hardware can decode 
and display 3D images in real time on a compact device.
Mitsubishi
Mitsubishi has its own concepts and theories on 3D TV and 
doesn’t want to be left behind. It has managed to demonstrate 
a scalable system for real-time acquisition, transmission and 
stereoscopic display of dynamic scenes, which actually means 
3D TV. However, we think it still really needs a lot of work 
done as the video that is available for preview doesn't match 
up to the others. 

Betting on 3D?
3D broadcast was expected 
to hit the markets by the 
year 2000, then 2006. The 
current bets are on 2010. 



DIGIT MARCH 200932

D
IG

IT
A

L 
LI

FE

Feature

Ahmed Shaikh

N
o one is going to accuse Microsoft of being innovative 
with its Internet Explorer (IE) product. For all the prog-
ress that the company made in wrestling the browser 
crown from Netscape, so long ago, the software giant 

could until recently be described as sleeping at the wheel with 
IE. In the face of competition from Mozilla Firefox, Opera, 
Safari, and Chrome – Internet Explorer seems stuck in the stone-
age, rubbing rocks while there's a space race in its backyard.

So what rouses a sleeping giant from its slumber? Is it losing 
21 per cent of market share to an open-source alternative? Is 
it being considered outdated by web developers? Or is it being 
perceived as a security threat in an increasingly web-aware world?

Whatever the cause, the giant is awakening and version 8 is 
Internet Explorer finally getting with the times. 

Let’s take a quick tour of some features offered in this release. 

Interface changes
The first noticeable change is that IE8 offers an address bar simi-
lar to that of Opera and Mozilla Firefox 3.x. Dubbed the Smart 
Address Bar; it matches what you type with URLs in your brows-
ing history, along with searching content in your favourites.  
Another visible change is the page that’s presented when you 
open a new tab: this page asks “What do you want to do next?” 

and offers you sets of frequent tasks – such as opening recently 
closed tabs, browsing in private, or using a new feature called 
Accelerators. IE8 also offers a better zoom feature – one that 
(finally!) scales both the text and the image on a page. An inter-
esting addition to version 8 is a feature called Caret Browsing. 
This is triggered when you press F7 and allows you to browse 
a web page sans mouse – the arrow keys allow you to browse a 
page like you would a text document. It’s not nearly as useful 
as Opera’s spatial navigation (using the SHIFT, S and W keys) 
but it is useful when you wish to highlight, copy-paste, or use 
Accelerators while reading text-heavy web sites, such as blogs.

Accelerators
When you select text in IE8, a small icon is triggered. This 
icon, when clicked, reveals the various “Accelerators” that 
the browser offers. An Accelerator might offer to bring you 
an encyclopaedic entry on the selected text, or if the text is 
the name of a place, it could show you mapping information, 
or let you blog the selection, and so on. It is a convenient 
way to perform everyday tasks without the need to shuffle 
between web sites. As of now, most of the Accelerators point 
to Microsoft services – Encarta for the encyclopaedia, Live 
Spaces for blogging, Live Maps for mapping, and so on. 
However, IE8 allows you to use third-party accelerators which 
can be downloaded much like extensions for Firefox.

Playing 

catch up
Our first look at Internet Explorer 8 RC1 reveals a browser that’s 
merely catching up to its competition; not blazing past

An Accelerator that integrates mapping information 
with a keyword

MS Encarta integration offers information on Mumbai, also 
through an Accelerator

Web sites that run under 
Compatibility View. Oh, the irony

Clicking the icon runs the website in Compatibility ViewThe Smart Address Bar offers suggestions from your browsing history, 
favourites, and feeds

Vista SP2
Windows Vista SP2 to be released 
within the next two months. Not to be 
confused with the 
pre-august release of Windows 7. 
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Web slices
Simply put, a Web Slice is essentially an RSS feed for a web site. 
The thought being that you would rather quickly glance at infor-
mation some web sites put out, instead of visiting that site every 
time you need an update. Weather report, stock updates, and 
auction alerts make for some of the Web Slices available. Once 
again, you can add third-party Slices to IE8: a web site which has 
a Web Slice to offer will cause an icon to pop-up under IE8 (simi-
lar to the RSS feed discovery icon that shows up in all modern 
browsers) – clicking this icon will add the Web Slice to IE8. 

Search enhancements
IE8 offers a couple of features to make internet searches 
friendlier. When you type a keyword in the browser’s search 
field, it offers real-time search suggestions. Moreover, you 
can add multiple engines to the browser (notably, not a 
new feature) and triggering a search through any of these 
added engines is just a matter of clicking on the correct 
icon. Apart from suggestions, IE8 also offers a so-called 
Visual Search. Visual Search, as the name suggests, offers a 

visual result to a query – for example, typing in ‘new delhi 
weather’ will offer a peek at the current weather conditions 
in the capital. Visual Search results are through third-party 
tie-ups: currently Wikipedia, Amazon, Yahoo!, and some 
weather services offer Visual Search results but one can 
expect future additions to this list.

Note that you can press [Shift] + [Enter] to launch the first result, and 
that you can remove a result if you don't think it's relevant

Delete, disable, or enable Search Providers Changing search providers is a simpler process Add more providers for Visual Search

Managing Add-ons and Search Providers. Note that you can also change 
the order in which the search engines are listed

A Web Slice keeps 
you updated 
without the need 
to visit a web 
site. This
particular Slice 
lists the top 
stories on Digg

If a Web Slice is available, a green icon appears in the upper right corner

Visual search 
using the
Amazon engine

IE Search also goes through 
your History. Note the different 
Search providers at the bottom

Visual Search shows you instant 
previews of your search results

Browser Releases
Mozilla Firefox 3.1 beta 2 public 
preview available for download. 
Opera 10 beta likely to be avail-
able by April. 
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InPrivate and other features
InPrivate is akin to Chrome’s Incognito mode. Start InPrivate 
browsing and IE8 will not retain your browsing history and 
cookies. IE8 offers InPrivate Browsing and InPrivate Filtering 
– either of which can be enabled independent of the other. 
InPrivate Browsing ensures that cookies, history and temporary 
internet files are not retained by the browser; toolbars and 
extensions are also automatically disabled while in this mode. 
InPrivate Filtering allows you to block online tracking behaviour 
of some web sites – basically behaviour that helps sites create 
and maintain an online profile of your online behaviour.

IE8 also introduces 
a neat idea to tabbed 
browsing. Tabs that 
originate from the 
same parent page 
are colour-coded to 
indicate grouping. If 
you close a tab from 
a group, another tab 
from that group is 
displayed. You can also 
re-order tabs, while a 
right-click allows you 
to remove a tab from a 
group, close an entire 
group, close other tabs 
but the current one, 
ungroup tabs, and to 
even duplicate a tab.

Another enhancement is the browser’s Find on Page feature. 
Much like how Google Chrome handles it, pressing [Ctrl] + [F] 
reveals a small toolbar that shows you the number of matches 
for a particular keyword, along with letting you cycle through 
all instances of matched words. It’s a much neater interface 
than IE’s traditional pop-up style Find-on-Page box.

Crash recovery and security
If a tab crashes in IE8, it is automatically restored and reloaded. 
Moreover, information that you might have typed in the crashed 
tab – a mail or a form, perhaps – is also restored. IE8 isolates 

tabs, much like Chrome does, so that a crashed tab does not take 
the entire browser along with it. 

IE8 also offers a phishing filter in the form of SmartScreen 
Filter. This is basically a black-list of known phishing sites; IE8 
offers alerts when one accidentally stumbles upon such known 
offenders. ClickJacking, or prevention thereof, is another exploit 
that IE8 addresses. ClickJacking is essentially a malicious script 
that masquerades as something useful – a known URL, for exam-
ple. Such scripts are typically embedded within well-hidden 
frames. IE8 allows a web site’s programmer to add a tag to the 
header of the site. When tagged, IE8 notifies a user that the 
site’s content is not meant to be inside of a frame and that the 
user might very well be the victim of ClickJacking.

Enhanced compatibility
IE8 supports CSS 2.1, offers better 
AJAX and Javascript performance, 
and renders the Acid2 browser test 
correctly (it fails Acid3). It also ships 
with a more standards-compliant 
layout engine.

That concludes our tour of Internet 
Explorer 8, Release Candidate 1. If you 
are a user of either Firefox or Opera, 
you will find that Internet Explorer 8 
offers little that is new and innovative. 
Almost everything that it brings to the 
table has been done before by its peers. 
It isn’t the web browser re-imagined, 
but a leaner, faster, more compatible, 
more stable, more secure, and friendlier 

Internet Explorer. IE8 isn’t Microsoft leaping and bounding ahead of 
the competition; it’s merely a dinosaur catching up. 

ahmed.shaikh@thinkdigit.com

Click on a New Tab button and IE8 offers common tasks including open-
ing closed tabs and working on a closed browsing session

Reopen closed tabs from a New Tab window

InPrivate Browsing prevents IE8 from storing 
cookies, history, and other data about your 
browsing session

Compatibility View allows older websites to run on IE8. In this instance 
the How to BUY section does not work under native IE8

Click on the Compatibility Mode icon though...

...making the How to BUY area clickable

Manage Compatibility from 
the Tools menu

Bugs
Don't expect a smooth run when 
you start surfi ng on IE8. It does 
not render more than 2000 top 
sites because the sites are not 
ready for it yet. 
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RobotFan’s
Countdown Blog
I’m waiting for S-Day, and so are you. Join me in this year-long run-up!

How Stuff  Works
Find out more about 

search engines           41

About Me

Well, I’m a fan of robots, 
LOL! I’ve not studied them 
or anything, I just like what 
they mean for society (vaca-
tions!!).

View my complete profile

Sites I Visit
RoboTimes.com
RoboBiz.com
iRobot.com

SEPTEMBER 21, 2051
#F388673 Deletion Flag

Date: 20540921.1000.00
CauseCode: #112974AF Routine History Purge
Priority: 4

Posted by Admin at 10.00 AM 0 Comments

MAY 5, 2048
(no subject)

Postng frm cell. Bad conn. Thngs gng crazy. Shld hv listend to Zeno.

Posted by RobotFan at 2.01 AM   1 Comment

FEBRUARY 12, 2048
NEWS: Robot soldiers successfully overrun terrorist outfit

Ah, these terrorists. Will they never learn?

From RoboTimes.com:
“In a landmark victory for local law enforcement, the New York Police Department successfully 
captured or killed all the members of a terrorist outfit that has claimed responsibility for the 
recent bombing of the World Robotics Council. This marks the first successful use of the military’s 
Tactical Armed Robot Team (TART) in city law-enforcement. Situated near the scene, Lt. Caden 
Frost supervised the TART robots, and successfully took down the terrorists without a single police 
officer entering the line of fire. 

When questioned, the terrorists remain silent, save for one cryptic statement: ‘You should have 
listened to Zeno.’

The TART project has also been in the news recently, when a researcher supposedly leaked docu-
ments suggesting that the team was working on a robot team that didn’t need human supervision. 
A subsequent press release refused to confirm the possibility, but did note that the project’s aim 
was to guard humans against even the possibility of danger.”

I wasn’t able to find a picture of the TART robots, but v4der found me this image from a classic 
video game:

It seems to be an artist’s impression of a TART robot, but I can’t be sure. Any ideas?

Posted by RobotFan at 8.03 AM   23 Comments

OCTOBER 11, 2047
Skin of my teeth

You won’t believe what I’ve been through today. I go out for lunch, and walk right into a crowd of 
people, on their way to a demonstration outside the new iRobot office. 
Honestly, I don’t know what people have against iRobot. They’ve given us so many of the robots we 
take for granted today - from the classic Roombas and Scoobas to even the Bartenders. And after 
their deal with Taser (the one where the companies tied up to stick stun guns on military robots), 
they became important allies to the military, too.  

Nimish Chandiramani
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From The Labs
Rebuilding the internet for 

the future          44

Robot mega-tanks 
DARPA (Defense Advanced Re-
search Projects Agency) wants 
to build AI-enabled super tanks!

Smart Buildings
The Japanese have started 
building houses that are com-
pletely managed by robots

Anyway, I’m getting pushed around in this crowd, because I’m trying to get to the café, and not to 
the protest. Finally, just as I manage to free myself, I see iRobot’s security systems kick in - all the 
protesters within 20 feet of the entrance got zapped by tasers. Serves the buggers right.

And to think, I was so close to being zapped myself!

Posted by RobotFan at 5.11 PM   17 Comments

AUGUST 12, 2047
Wakamura performance: awesome!

After watching Wakamura in action, I’m wondering if it’s his talent I’m impressed with, or that 
he’s come so far. 

Wakamura started out with a small part in a 20-minute Japanese play called Hataraku Watashi 
(I, Worker), back in 2008. Even then, his every circuit oozed talent. Of course, back then his part 
was practically pre-programmed, but his performance received rave reviews, and his abilities have 
only become better since then. In 2013, he got his first lead role - a small adaptation of Asimov’s 
The Caves of Steel. By 2022, he was getting nominated for awards, and in 2024, he won his first 
Emmy. 

Thankfully, nobody’s made any more robot actors - that would just dilute Wakamura’s appeal. Not 
to mention that we don’t need robots replacing us in the cinema as well. 

Posted by RobotFan at 11.19 AM   16 Comments

AUGUST 11, 2047
Wakamura performance today

In about two hours, I’ll be in the audience at the Ballmer Memorial Theatre, watching Mitsubishi’s 
award-winning Wakamura perform in the Lord of the Rings. I’ve been a big fan of Wakamura for 
the past ten years, so you can imagine (or can’t, actually) how exciting this is. 

I must now go iron my tuxedo. Stay tuned for the performance report, and I suppose I owe you a 
history lesson, too. 

Posted by RobotFan at 4.54 PM   4 Comments
July 1, 2047
I bought a dog!

…a BigDog, to be precise. I’ve been saving up for this day for almost four years now. Well, not 
exactly. I’ve had the money all this while, but the military has only just decided to let Boston 
Dynamics manufacture BigDogs for RobotFans like lil ol’ me. 

Here’s a picture:
He’s a little less than three feet tall, weighs about 75 kilos, can go wherever I go, and can keep 
his balance even if I kick him in the side! But the best part is that he can carry close to 140 kilos 
in those cool military bags (included in the price), which means that I can start camping without 
worrying about backpacks now!

He’s also fully electric - not like the military’s hybrid versions, so he isn’t as powerful or dangerous 
(thankfully) as the military ‘Dogs. 

I haven’t decided what to name him. Suggestions?

Update: I’m a big fan of retro characters, and clearly so are you - meet Gromit!

Posted by RobotFan at 3.44 PM   22 Comments

MAY 3, 2047
First self-repair sighting!

It’s an exciting day! Like many of you, I’ve been itching to see the new ckBot 4.0 in action - but it’s 
hard to see a self-repairing robot in action when it rarely breaks itself, lol. 
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Tomorrow's Tech

It happened while I was downstairs, taking out the garbage (why don’t they have robots for that 
yet?). Some crazy motorist lost control of his car and rammed right into a class-3 service ckBot. It’s 
weird, seeing a robot disintegrate like that. I mean, I knew it was a ckBot, but still…

But, of course, there’s the thrill of watching all the parts crawl towards each other and re-assemble 
themselves into the robot again. It’s like hitting a rewind button. 

So. As promised, I must tell you some of the history of this incredible bot:
Like so many robots, ckBot debuted at a science fair - Wired’s NextFest 2008, to be precise. It started 
out as a bipedal (and I use this term loosely) robot, made up of several parts that were magneti-
cally attached to each other. Each part had wheels that enabled them to move around when disas-
sembled, so if broken apart, they could move towards each other till the magnets took over and 
ckBot was whole again.

In the years since then, creator Mark Yim has perfected the ckBot, and even made different models 
for different purposes. The Class-3 bots you see cleaning the streets are the most basic models - no 
frills, and can’t take much more than a car crash. The coolest ones are the Class-1 bots - used only 
by the military on special (read über-dangerous) missions. They can survive mini-nuclear attacks 
at close range, and if the individual parts are too far from each other to communicate, they can 
each act as a weapon.  

Obviously, it’s not likely I’ll see the Class-1s do their thing. I’m pretty sure I don’t want to be in the 
vicinity when something attacks them. 

Posted by RobotFan at 10.22 AM 8 Comments

APRIL 22, 2047
NEWS: RoboKind Goes Under

From RoboBiz.com:
“In an announcement this morning, a spokesperson for RoboKind (formerly Hanson Robotics) 
declared that the company will be closing its doors early next month. This news doesn’t come as 
a shock - just last month, the company announced that it was ending the Zeno project for lack of 
support from robot developers...”

I’m not surprised either. I’ve been skeptical about this Zeno nonsense from the day it was 
announced back in 2008. I got this tidbit from the WayBack Machine:

“Zeno is coming! He is the smartest and coolest robot yet! He has everything he needs to become 
your friend; he sees, hears, talks and remembers who you are.”

What use could something like this be? David Hanson (the creator) kept talking about Zeno paving 
the way for “robot ethics”, but I could never figure it out. Zeno was just another toy with a fancy 
tagline, I think.

Also, look at him - he’s a horror movie waiting to happen:

Posted by RobotFan at 10.22 AM 14 Comments

APRIL 12, 2047
Hello, World!

...and welcome to my new robot blog! As you know, scientists estimate that it’s roughly one year to 
Singularity Day (or S-Day, as I shall call it from now on) - the day when the technology we create 
develops the ability to improve itself. 

This means that we won’t have to waste our time thinking about new products, or developing new 
technologies - we’ll have our robot friends to do that! Which means more vacations for me!  So, in 
honour of our soon-to-be-independent friends, I’ve created this blog. Over the year, I’ll be talking 
about the stories behind all the robots that are now part of our lives. 
Enjoy!

Posted by RobotFan at 12.07 PM 2 Comments 
readersletters@thinkdigit.com

Robot rights 
California Polytechnic  
wants bots to have 
similar rights as men

War begins
Boeing begins the 
war by shooting 
down a UAV bot 

About Me

Well, I’m a fan of robots, 
LOL! I’ve not studied them 
or anything, I just like what 
they mean for society (vaca-
tions!!).

View my complete profile

Sites I Visit
RoboTimes.com
RoboBiz.com
iRobot.com
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Aditya Madanapalle

B
efore the advent of search engines, the web was a strange 
place. Back then, content was growing at a startling pace, 
with no means to filter information or direct people 
to content they were unaware of. Users typically used 

forums, IRC or email to find links. Any service that could make 
sense of the range of information, make it coherent, and allow 
users to find the content they wished for, was poised to grow 
spectacularly. 

What was necessary, was a front door to the internet, 
a structure that allowed users to “surf”. Within a decade 
of their introduction, search engines changed the entire 
face of the web. Before search engines, the web was mostly 
used for academic purposes and communication – primar-
ily through electronic mail. Search engines allowed users to 
create content, market products, establish e-commerce and 
offer a wide variety of services. The technologies behind search 
engines have evolved with time, and are constantly mutating. 
The innovations, takeovers and competition among search 
engines were intense in the beginning of this century because 
the winner might replace Microsoft as the chief technology 
service provider. No guesses for who won, but the struggle is 
still on. There are a whole range of technologies driving a new 
generation and breed of search engines. 

The internet is a connection of different servers and comput-
ers. There is a range of cable types that make these connections. 
These servers may belong to individuals, or be owned by a 
company. Stored on these servers are a number of documents 
written in a markup language (HTML and variants) that are 
interpreted by browsers. These documents invariably have hyper-
links (text that leads viewers to another page when clicked). This 
network of hyperlinks forms the world wide web, known simply 
as the web. While the internet is the hardware, the web is the 
information stored on this hardware. Search engines keep track 
of developments and changes on the web, and allow users to 
track down documents they want to access. This is a never ending 
process because the web is constantly changing with every pass-
ing moment.

The history of internet search
HotBot and AltaVista were among the early search engines. Both 
Yahoo! and MSN have had popular email and messenger services, 
both augmented by search. Yahoo! had the additional benefit of 
having a larger database of web sites stored in a directory struc-
ture. AskJeeves was also a very popular web service that was one 
of the first search engines to allow users to look for information 
as if they were talking to an actual person. AltaVista was one of 
the first search engines to have a wide audience, and growth in 
popularity because of the number of pages it had indexed. HotBot 
and Yahoo! dethroned AltaVista. While this race had been going 
on since 1996, Google entered the scene only in 1998 with a small 
index and minimalist interface and vision. 

There is a whole range of highly specialised search engines 
developed in recent times, but essentially, the status quo has 
been maintained since 2000, with the top three search engines 
being Google, Yahoo! and MSN, in that order. Another important 
player is Inktomi that only provided back-end search technolo-
gies, and were used by both Yahoo! and MSN. Inktomi never had 
its own web portal for providing search services to users. They 
allowed their indexes and search technologies to be used by other 
search service providers. Before Google, Inktomi-based search 
providers were the most used, and displaced HotBot and AltaVista 
as the leading search service provider. It also had a large data-
base of business and listed ads from these businesses next to the 
search results. Inktomi pioneered the pay-per-click model, which 
was later perfected by Google with its AdSense. Yahoo! switched 
to Google’s databases and back to Inktomi within the five years 
of the millenium. MSN started using its own search technologies 
since 2004. Inktomi was acquired by Yahoo! in 2002.

With the web growing, search engines started increasing 
their services. Google was the market leader in innovation, 
buying out promising startups or stressing on developing fresh 
services in its own labs. AskJeeves.com was the first to make money 
by asking pages to pay for being indexed. Multimedia content 
provisions were made by early search engines such as Inktomi, 
but never really took off on a large scale. Search engines now 
make money by displaying advertisements related to a search 
query. In most engines, these ads occupy a separate space, but 
this distinction is not always clear. Multimedia search including 
video and images is offered by leading search providers. Locations, 
maps and people are other common search services offered by 
search engines, but are now feasible only in a few countries.

Spiders crawling the web
One of the fundamental tasks of a search engine is to find out that 
documents exist on the web at all. This was initially done by look-
ing at known file servers, but the process is much more compli-
cated now. Search engines use programs or scripts that automati-
cally search the web, following hyperlinks. These programs or 
scripts are known as robots (colloquially called bots) or spiders. 
Spiders go to a particular web page, save it on their servers and 
follow all the links on that page. Going over the web is called 
“crawling”, which is a continuous process. There are a number of 
approaches that these spiders can make when crawling the web. 
A wide crawl will focus on  as many different URLs as possible, 
from as many different domains as possible. A depth crawl first 
goes deep into a single site. Practically, it is essentially a compro-
mise between these approaches. There are also random crawls, 
which do not give any preference to a single approach. Spiders 
continuously track the creation of new content, and hence have 
a never-ending job. Search engine crawlers, typically, have a huge 
queue of URLS waiting to be crawled. Spiders will never be able 
to crawl the entire web, and no search engine has crawled more 
than 20 per cent of the web. The number of pages crawled by a 
spider is no measure of the quality of the search engine. Google 

We dig deep into Web Search Engines, revealing their functions and methods. 

It's not all about 
Feeling Lucky

How Stuff Works

Archie and friends
Archie, an FTP tool that indexed fi les 
on servers is considered the fi rst 
search engine. Jughead  and Veronica 
were early gopher search engines.  
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How Stuff Works

had a very small cache 
when it started out, but 
still gained popularity 
because of the relevance 
of its results. Google uses 
a spider called Googlebot. 
Due to the different 
approaches a spider 
can make, some search 
engines use multiple 
spiders. Yahoo! uses 
Slurp or Yahooseeker. 
MSN uses Msnbot, 
Msrbot, Msiecrawler 
and Lanshanbot.

A spider often visits 
the same page several 
times over. This is essen-
tial to keep the search 
engine up-to-date with 
the web site. A news web 
site or a web log tends to 

change rapidly, and so spiders have to keep crawling them over 
and over again. Static pages are not crawled as frequently. Most 
sites on the internet strive hard to be dynamic, and offer new 
content for every visit, which drains a considerable share of the 
spider’s time from new web pages. It takes some time, and a lot 
of effort on the part of the web designer to get the page to be 
crawled, which is why many search engines take payments for a 
site to be crawled, and updated frequently. 

Site owners have a love-hate relationship with spiders. While 
getting their page crawled is important to them for hits, a number 
of spiders can easily drain resources from a small web site with 
limited bandwidth. The speed at which spiders can make demands 
on web sites can take them down and deny the web site’s service 
to legitimate visits. Spiders also use a multi-threaded approach to 
cache the web pages. This is akin to a download manager making 
a number of requests to the same site in parallel. Many website 
owners prefer to disallow some spiders from crawling their 
content. Therefore, a robot.txt file is used by webmasters to deny 
some or all spiders access to the page. This is also used so that a web 
master has the liberty to withhold his data from being crawled. A 
robot.txt file can be used to allow only some crawlers to search, 
and disallow other crawlers from searching. A robot.txt file can 
also be used to protect private content on the web. However, this 
approach is not always safe, as a number of aggressive crawlers 
may ignore the robot.txt file and crawl the web page anyway. 

The flooded server farms
Search engines require a large amount of storage space. An index 
of all the web pages crawled by the spider of the search engine is 
stored. Initially, this index was stored on a single server. Google 
innovated a technique of storing data in an array of machines, 
which allowed faster access. This was a cheaper option for Google 
when it started up in a garage. This technique was soon picked up 
by other search engines.

The index is constantly updated, and there needs to be 
several technologies that allow data retrieval from the index. 
The most common method for this is hashing. Hashing allows 
data retrieval from incredibly large databases such as those used 
by search engines. Hashing is the process of creating a relatively 
small numerical value from a text string. This is used to make 
retrieval from the index much faster and easier. 

For a simplistic explanation of how hashing works, consider 
a user looking for a particular Linux distribution. In the database 
of the search engine, there will be a number of distributions 
such as Fedora, Mandriva, Sabayon, OpenSUSE and so on. If a 
user searches for “Fedora”, the index will have to match the 
alphanumeric values of all the distributions, of different lengths. 
A much shorter approach would be the numbers 1, 2, 3, 4 and so 
on assigned to each of the distributions. When a search is made, 
the search engine will just match the numerical values of shorter 

length, instead of the much longer alphanumeric values. This is 
just an illustration, and hashing often relies on pretty lengthy 
(often 32-bit) alphanumeric strings, but the speed of the search is 
increased in very large databases.

When a spider crawls a page, it reads the page in many 
ways, and interprets and stores a number of aspects of the page 
for later use. The spider looks at all the words in the page, their 
proximity to each other, their presence in bold or in headers, 
the title of the page and stores the entire page in a cache. If it 
encounters a non-HTML document such as a PDF, a spreadsheet 
or a Word file, it stores the same content in XHTML format. 
A copy of the web page is made on the servers of the crawler, 
called a cache. This cache is the state of the web page when it 
was crawled, and is useful when the page has been updated, 
and has lost the content that was relevant to the search. The 
qualitative information about the page is stored in the servers 
of the search engine, often after compression. This data is used 
later to display the search results.

There are three kinds of servers that every major search 
engine employs. The first kind is the spidering server, that 
indexes the web. Servers across the globe store parts of the 
index called “shrads”. The index functions as an essential 
whole, but is physically located in different geographical areas. 
The second kind — document servers, store the cache of the 
crawled pages. The third kind of servers directs the traffic, 
resolve search queries, implement search algorithms and inter-
face with the user. Typically, an x86 architecture is used, with 
a Linux-based OS. A typical search engine may have servers 
in as many as twenty different locations around the world.

What are you really looking for anyway?
Languages are very complex, and context plays an important 
role in communication. Words such as “executive”, “silver” 
or “orange” have different meanings and can be interpreted 
differently. This is a common problem encountered by users, 
who frequently get search results that are in stark contrast to 
their expectations. Content creators may have used different 
words, so a user may have to try different variations of the 
same search. Those who search for “car” will miss out an entire 
section of pages that use the word “automobile” instead. Some 
search engines such as Google resolve this problem by using 
the tilde character (~) before the search string to search for 
similar terms. 

Apart from the highly interpretive nature of search, there are 
a number of factors in a page that can affect the relevancy of the 
content. Therefore, search engines use a number of approaches to 
resolve the relevancy in each search, and assign a level of signifi-
cance to each page according to the search. 

This process is very complex, and implements a number 
of algorithms. 
Basically,  a 
certain page is 
given a number 
of points to begin 
with (often called 
cash). The page 
gets these points 
purely for its 
existence. These 
points are then 
distributed to all 
the links in the 
page. A page that 
has a high number 
of incoming links, 
automatically has 
a lot of points. In 
a breadth crawl, 
when a spider 
goes to as many 
different sites as 
possible, the most What goes on when you hit the "Search" button

How a spider crawls the web

7 grams of CO2
Your carbon footprint every time 
you conduct a search on Google. 
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popular pages get crawled early because many pages link to them. 
Google predominantly calculates relevancy by the number of incom-
ing links to that page, which is called PageRank. This is a safe way 
of calculating relevancy, as it disallows the content creator from 
manipulating his/her page to boost relevancy. However, this has often 
been abused by a lot of people “bombing” a site by linking to it, to 
boost its PageRank (called googlebombing). Other search engines use 
a proprietary mixture of considerations. These considerations include 
the number of times a searched word has appeared in a document, 
whether or not it appears in bold text, how many times it appears 
in the links, in sub-headings and in the title. Other considerations 
include the neighbouring pages, the frequency of site updates and 
even whether or not the owner has paid the search engine. An impor-
tant consideration is the geographic origin of the content and the 
location of the user originating the search query. 

Typically, pages created in the same country as the searcher get a 
higher relevance. An Indian looking for “news” would likely have no inter-
est in the news web sites of Belarus. Relevancy is also calculated using 
meta-tags in the page. Meta-tags exist specifically for search engines, 
where the content creator includes keywords in the document, explain-
ing what the document is about. Keyword spamming is where a creator 
uses a lot of keywords to get hits, most of which have no relevance to 
the content of the page. Search engines automatically match meta-tags 
with the content of the page, and accordingly judge the relevancy. Some 
search engines such as Google and Yahoo! penalise keyword spammers by 
reducing their relevancy. 

Many web site creators try hard to optimise their sites in such a way 
that they become more relevant for search returns. This includes artifi-
cially boosting the number of incoming links, using the right keywords in 
the meta-tags, formatting the page properly, and a number of other meth-
ods. Many of these are transparent, but a lot are clandestine. Optimising a 
particular web site for search engines is a very lucrative business. A third 
party may work on a site between the creator and the search engine. Due 
to the aggressive nature of search engine optimisation, all search engines 
continuously change the methods for relevance ranking, and keep the 
exact methods used, a secret.

Deep magic
As the web moves away from the domain of personal computers into 
portable devices such as PMPs and mobile phones, search engines will 
also spread out to these technologies. Geo-tagging will take on more of 
a hold, which means you can search while on the move. Products and 
services in the real world will be more easily integrated with the virtual 
alternatives. 

Google cannot afford to move away from its minimalistic design. Search, 
however, does not end at Google. There are a whole bunch of interesting 
search engines waiting to be found. Swicki (www.eurekster.com) let’s you build 
your own search engine. Chacha (www.chacha.com) answers questions the way 
good-old Jeeves used to, and even replies to SMS. Gnod (www.gnod.net) has tools 
for searching movies, music or books similar to what you already like. Results 
are displayed in a spatial map of similarity. Clusty (http://clusty.com/) breaks 
down results in clusters, which let you refine your searches. 

In recent years, there has been 
a new breed of search engines that 
have made their presence felt. These 
are meta-search engines that do not 
have indexes or databases of their 
own, but work of the indexes and 
databases of other search engines. 
When a search query is entered in 
the search forms of these search 
engines, the search engine will 
retrieve the results from the data-
bases of Google, Yahoo!, Ask and 
others. Mamma (www.mamma.com) 
or Dogpile (www.dogpile.com) are two 
very popular examples of meta-
search engines. 

aditya.madanapalle@thinkdigit.com

A meta-search engine at work

SCI-TECH
Secret Google Server
Google has an ultra clandestine 
data center in Dellas, Oregon but 
searches (online and offl  ine) don't 
give any useful results. 
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Nimish Chandiramani

I
t’s a boring Sunday, and you’ve decided to while away the 
time in a wonderfully unproductive game of Tetris. At some 
point, you’re accidentally (or purposefully) going to plug 
an empty space, temporarily throwing away your chances 

at scoring a line. “It’s all right,” you think, “I’ll just finish these 
lines on top first, and then I can get to that later”. But inevita-
bly, you end up plugging another vital space, and then another. 
Pretty soon, the bricks have mounted high enough for you to 
start worrying. Today, the internet is that game of Tetris, and the 
bricks are stacked uncomfortably high. 

Game over?
This might sound familiar: “The internet is running out of IP 
addresses!”. Even in the early days of the internet, scientists 
were beginning to realise that this system was getting too 
popular too fast — they predicted that the world would run 
out of IP addresses by 1994. Of course, that didn’t happen. The 
internet had plenty of addresses to spare in 1994, and contin-
ues to chug along happily even today. This is just another hole 
we’re going to come back to later. Meanwhile, we’re finishing 
the other rows — like security.

Hang on
The internet isn’t secure. While you’re hitting the Report Spam 
button on your email account, someone’s watching an adware 
program spew out its horrifying results, and some other poor 
soul can’t tell that his PC is part of a botnet, helping send you 
the spam you’re reporting. Firewalls are nice, but the fact that 
you’re still receiving spam and fighting off phishing attacks 
speaks for itself. And the root of all these problems (predict-
ably enough) is stupidity.

The dumb network
In networking-speak, a dumb network is essentially a bunch of 
terminals and wires. It doesn’t care about the information 
travelling on it — just that it’s taking the information where it 
needs to go. The terminals themselves — the computers — are 
pretty smart, so the onus was on them to interpret the data 
and present it to users. 

There is much to love about the dumb network — mostly, 
it’s economical. A dumb network is ridiculously easy (and 
hence cheap), to deploy — a router here, a cable there, and 
one more happy customer gets connected to the web. It’s 
also extensible — because a dumb network is like a clean 
slate, you can add more functionality to it as you go along: 
perfect for a network that grew as fast as the internet did. 
And finally, by putting the onus of processing data on the 
terminals, you’re creating a network that lets data travel 
quickly, without obstructions. 

The internet is a packet-switched dumb network, which means 
that the information you send along the pipes is broken up into 
packets, sent along different paths to the destination, and then 
re-assembled at the other end. This is all very well for data; send 
voice over a line like that, however, and you get gibberish at the 

other end — if anything. It took ten years for VoIP to work around 
this mess; but even now, it’s too unreliable to replace the good 
old wired phone line.

Still, VoIP gets the job done. Ish. The real problem with the 
dumb network is that it isn’t secure. 

The trusting network
The internet was designed by a bunch of scientists, for the 
scientific community. It was a good-natured network that 
had faith in its users, and wouldn’t believe that people 
would actually send malicious data to each other. Then it 
got misused — malicious people used it to spread malicious 
code, and the internet suffered a bad reputation. Now, of 
course, it’s become somewhat smarter. By installing fire-
walls and packet sniffers (software that checks packets for 
malicious data) on servers, routers and your PCs, the inter-
net has made it much harder for evil code to get to you, 
unless you’re conned into letting it in yourself. 

But there still remains one part of the net that’s still good-
natured and trusting at its core — DNS. It was originally designed 
to be the digital equivalent of the friendly guy at the concierge’s 
desk. You would ask it for a web address, and it would helpfully 
tell you where to go. Then came cache poisoning, by which hackers 
could fool DNS servers into believing they’re sending you to the 
fun part of town, but you really end up in a dark alley with your 
head bashed in. And somewhere underneath all the security 
protocols, this flaw still exists.

It’s time to re-do the internet, and turn it into a smart, 
secure network.

What we need
The new internet needs to be faster and more reliable — IP tele-
phony shouldn’t suffer the way it always has, and must eventu-
ally become the alternative to the classic telephone line that it’s 
supposed to be. 

And yes, it would also be nice if the new internet could let 
our devices have their own unique IP addresses, instead of an 
internal address that a router or server assigns to it. We’d also 
like the internet to be “ready” for when we want to use our 
mobile phones as our primary computing devices. 

However, before researchers are to give us the internet we 
desire, they need a sandbox to test their designs — a guinea-
pig network. 

The playground
In 2005, the National Science Foundation (NSF) in the US 
asked researchers to come up with a new plan for the internet. 
To help them test their designs, the NSF started the Global 
Environment for Networking Innovation (GENI), which would 
be the guinea-pig internet for them to use. Several support-
ing projects have spawned since, each with their own view of 
what the internet should be. 

It isn’t hard to guess which side of the fence Stanford’s Clean 
Slate Design project is on. The group is creating a set of technolo-
gies that they hope will form the backbone of the new internet 
— from a framework for a mobile internet, to an infrastructure for 

The internet is broken. And to fix it, researchers want to start all over again

From the labs

No, it was not CERN
ARPAnet was the fi rst internet 
that was used by US military to 
exchange information via Network 
Control Protocol
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virtual worlds such as Second Life. Scientists 
will be able to use these basic frameworks to 
design their own visions of the internet, and 
then test those designs using GENI. 

On the other hand, there’s the 
PlanetLab project, which aims to create 
overlay technologies, which will sit on top of 
the world’s existing internet infrastructure, 
and by becoming more popular, will squish 
out the old technology. Something like this 
has already been in existence, in the form 
of the university-only Internet2. The under-
lying philosophy is that there are several 
parts of the internet that get the job done 
just fine, so why throw all that away?

So what does a more realistic inter-
net look like?

Middle ground
While we wait for the competing projects to 
come up with a brand new internet we can 
use and love, there are two upcoming tech-
nologies that we should see pretty soon. You 
already know about the first — IPv6. The 
other is called f low routing.

Right now, packets on the internet 
travel like they always have — taking differ-
ent paths to their destination, where they 
are reconstructed. In a flow-based network, 
packets that need to travel together — voice, 
audio and video, for example — will travel 
together. The new flow routers will work 
like regular routers, except when they see 
packets that say that they’re part of a f low. 
For these packets, the routers will choose 
paths that allow the packets to reach their 
destination in order. 

Of course, a flow router won’t be able 
to do its work without packets that have 
information flows. And this is where IPv6 
comes in. IPv6 packets have traffic class 
fields, which will tell routers how to priori-
tise them. As a bonus, these packets will 
also carry authentication and security head-
ers, which will let routers and PCs find out 
whether the packets are coming from the 
right server. 

Finally, IPv6 opens up a whole new 
world of IP addresses, which means that 
every device — from PC to phone to hear-
ing aid — can have its own unique address, 
and not have to hide behind access points 
ever again. This means it’s theoretically 
possible to have an IP address that never 
changes. So, if you’re using a service 
that authenticates you based on your IP 
address, you don’t have to worry about 
losing your authorisation by moving to a 
new network.

However, even though IPv6 was stan-
dardised in 1998, only 0.236 per cent of all 
internet users are using IPv6, according to 
a Google report published in October 2008 
(read the PDF at http://tinyurl.com/6c634k). 
It may be disappointing news now, but it 
does offer a simple solution to our IPv6 
adoption problem. The people on IPv6 may 
not necessarily be using it intentionally 
— their ISPs began to support IPv6, so they 
gave customers IPv6-capable routers. And 
since the newest generations of Windows, 

Mac OS X and Linux are all set to prefer 
IPv6 if it’s available, more people went 
online with the new protocol without 
even realising it. Which means that it isn’t 
the people who need to be convinced, it’s 
the ISPs.

So after all this talk, it may well be 
that the future of the internet is simple 
— slightly smarter, with a new protocol and 
updated routers. 

Which may be a good thing, because we 
may not want a smart internet after all...

The stupidity of smartness
We point nasty fingers at dumb networks, 
but the truth is that even smart networks 
aren’t beyond reproach. When you load 
routers with software that authenticates 
and analyses and directs and decides, 
you’re actually getting in the way of data 
moving swiftly. But there’s a possibility 
that’s even worse. We complain about the 
internet today, because it’s an old design 
that hasn’t been improved because it got 
too large — but twenty years in the future, 
people will say the same thing about 
a smart network. Take the telephone 
network, for instance — it’s the original 
smart network, fully aware of the signals 
that travel along it — it has now solidified 
into a behemoth that’s too expensive to 
upgrade, and too complicated to easily 
add new functionality. 

Tom Evslin, who helped build the origi-
nal MSN, and AT&T’s first internet service, 
thinks that any effort to make the internet 
smarter “will cost incalculably more in loss 
of future flexibility and scalability.” He 
argues that the dumbness of the internet is 
what enables it to support new and wonder-
ful applications, and should thus stay that 
way. He isn’t the only one to think this way, 
either. Vinton Cerf, Google’s Chief internet 
Evangelist, and father of the internet, says that 
it’s the terminals that need to get smarter, 
not the network.

And then, there are the “political” 
implications. A fully redesigned internet 
may well turn out to be what the New 
York Times calls a “gated community where 
users would give up their anonymity and 
certain freedoms in return for safety.” Scary 
thought, yes? 

And when you think about it, a lot of 
news about internet outages seems over-
blown. In October, a worm called Conficker 
infected 15 million Windows PCs, prompt-
ing renewed fears of a “digital Pearl 
Harbour”, which will supposedly bring the 
internet to a standstill. But if Conficker 
was the harbinger of doom, why didn’t 
you stop surfing? Did you even notice that 
the internet “was under attack”? Truth is, 
Conficker didn’t bring down the internet, 
it exploited a vulnerability in an OS. A 
Windows OS. If there’s any terminal that 
needs to get smarter about security, it’s the 
Windows terminal. 

Bottom line: whatever the internet ends 
up being, we shouldn’t accept a design that 
emerged from panic. 

readersletters@thinkdigit.com

SCI-TECHIn 2020, expect web 4.0
The numbers next to the web like web 
2.0 and 3.0 roughly correspond to the 
decade of the existence of the internet. 
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Flat panels are hot, and everyone who doesn’t have one is not. 
Choose yours from one of these...now!

Desktop PC test
The latest desktops run  

our gauntlet  54

Michael Browne

F
or the last year or so most elec-
tronics malls have been overflowing 
with displays of flat panel televi-
sions and everybody flocks to these 

exhibits. If you happen on any showrooms 
that stock these large-screen displays you 
will see several admiring onlookers drool-
ing over the exhibits. The reason for this 
is simple and steeped in human psyche 
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— one of our most important senses is the 
one of sight. A good example of technology 
having capitalised on this fact are cinema 
theatres in general. If a person were given 
the choice between watching a blockbuster 
release on his television at home or at a 
cinema hall he would go with the latter 
nine times out of ten, assuming he isn’t 
a total introvert. This is because a cinema 
theatre gives any movie a living, breath-
ing feel with a huge screen, and great 
surround speakers. The thrill of watching 
anything on a large display just cannot be 
replicated on a smaller television.

However, many of us do not get time 
to go to the movies. Work, social commit-
ments and commuting distances are all 
hindrances. Perhaps this is the reason why 

flat screen displays have become so popu-
lar. With manufacturers offering advertise-
ment slogans like “bring the movies home” 
or “your world of entertainment starts 
here” it’s not rocket science to figure out 
why so many people are throwing out their 
old 21-inch and 29-inch CRT televisions 
and buying one of the new breed of televi-
sions; also known as flat panels, flat screen 
displays, or large screen TVs — these terms 
are used synonymously by most vendors. 
The fact is these displays are nothing new 
in the way of technology. Rather they are 
based on either of two technologies that 
have been around for awhile — LCD (Liquid 
Crystal Display) and Plasma Display.

If you’ve been a keen spotter of new 
technological breakthroughs and keep a 
close watch on market prices, you will note 
that the price of LCD monitors have fallen 
drastically. There was a time five years 
back when 22-inch monitors were unheard 
of and when these displays appeared 
they were priced at near the Rs. 35,000 
mark. Today one can buy a 22-inch LCD 
monitor for less than Rs. 12,000 and the 
prices of larger displays have percolated 
into the lower rungs of the market. The 
reasons for this are binary — technological 
advances leading to sharp declines in costs 
of production and of course mass adop-
tion, which itself is often a function of the 
former. Just as the prices of LCD monitors 
have fallen, the falling costs and techno-
logical breakthroughs made it possible 
and feasible for manufacturers to explore 
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37-inches, it’s a tie. If you want something 
in the region of 37-inches or less — it’s LCD 
all the way. Of course people have their 
favourites and there are those who claim 
that the phosphor gas inside a plasma 
display loses its working efficiency after 
around 20,000 hours and therefore plasma 
displays have shorter life spans. This is not 
really true and the life span of the latest 
plasma displays is around 30,000 hours 
which is the same as some LCD displays 
and at worst around 15,000 hours worse 
than most LCDs. Plasmas also have an 
issue with burn-in whereby due to uneven 
wear on the phosphors if a static image 
is left to be displayed on the screen for a 
long time, this image ends up leaving a 
ghost image on the display behind. This 
is called burn-in; as the image appears to 
be burned into the screen. While we have 
verified that this is indeed an issue if left 
unchecked; most plasmas these days come 
with inbuilt screen savers that do not allow 
a static image to remain on-screen for very 
long. However, burn-in is a minus point 
for plasma displays. Contrary to belief 
LCD displays can never suffer from burn-
in because they work on the principle of 
blocking light unlike a plasma display that 
actually produces light. This is why an 
LCD is referred to as a transmissive display. 
A plasma display in contrast works on the 
principle of emission and plasmas are 
emissive displays. Quite simply LCDs do not 
produce light themselves but simply allow 
through or block light that is produced 
by a CCFL tube or (the more recent) LED 
source. In The simple benefit of a plasma 
display over an LCD is the fact that you 
can buy a much larger screen for a cheaper 
price. Some also claim that plasma displays 
offers deeper blacks than most LCDs and 
also offer wider viewing angles. While we 
agree on the latter somewhat, the former 
is definitely up for debate.

Sony KDL-70X3500: Goliath
The KDL-70X3500 is a long name for a 
huge 70-inch display. We were expecting 

Baazar
The newest tech to hit 

the streets  68

Media Streaming
Yes, you can do it on your 

local network  76

Home Cinema
All the gyaan you need 

on A/V Systems.  78

the possibilities of making larger displays 
with wider market appeal (read affordable 
prices). After all people use computers for 
a multitude of reasons and not all uses 
necessitate a larger display.

At the very outset both LCD and 
plasma display technologies are very differ-
ent from one another and were aimed at 
totally different markets. While the techni-
cal aspects of their working are beyond the 
purview of this test plasma displays were 
never really aimed at home users. Rather 
they were aimed at corporate users who 
would use such displays for presentations, 
displays in malls and other areas where 
a mass viewing audience is expected. For 
this reason plasma displays have always 
been manufactured in larger screen sizes. 
In fact it’s only recently that plasma 
displays became available in screen sizes 
of 42-inches; mainly to serve the needs 
of the lower rungs of the market. Prior 
to this, plasma displays have always had 
huge screen sizes; to the tune of 65-inches 
and upwards. It’s not uncommon to see 
plasma displays cross the 100-inch mark, 
obviously their price scales accordingly. 
LCD, on the other hand is a technology 
that was pushed towards the consumer 
markets first. While plasmas started at the 
higher screen sizes and moved downwards, 
LCDs did the reverse and started from the 
smaller screen sizes. The most common 
LCD displays are the 26-inch and 32-inch 
categories. Due to this peculiarity, the 
larger screen LCDs are disproportionately 
expensive when compared to the smaller 
size displays. For example, a 32-inch LCD TV 
may cost Rs 45,000 while a 42-inch display 
may cost as much as Rs 80,000 meaning 
that you pay some 43 percent more for just 
10-inches more of display size. Obviously a 
plasma display with a larger 
screen would be costlier 
than a smaller one, but 
this difference is not as 
much as in the case of LCDs. 
Therefore, when buying a 
plasma TV, remember that 
the larger the screen, 
the higher the price, 
but you pay propor-
tionately less for more 
on-screen real estate.

The debate over 
which technology is 
better is an eternal 
one and personally we 
have no favourites. If 
you want something 
in the region of 50-
inches or larger we 
recommend looking 
at a plasma display as 
they offer more value 
for money, while for 
anything under 50-
inches but bigger than 

a plasma display when we heard we were 
getting a 70-inch unit from Sony, but it 
turned out to be an LCD. To say its bulky 
would be an understatement, obviously 
due to its massive size. The wide bezel 
doesn’t help things and makes the unit 
appear even larger, especially since the 
rather wide speaker grilles are built into 
the sides. Additionally the outer portion 
of the bezel has a transparent fibre strip 
running along the entire outer dimen-
sion of the display. Sony really wanted 
this display to appear as large as it 
possibly could; this is not exactly a plus 
if space is a premium. The stand is quite 
small considering the bulk of the display; 
surprisingly it is very stable and the 
display does not tilt even a bit. The KDL-
70X3500 is rich with connectivity options 
although it misses out on DVI or Display 
Port connects. The connectors are located 
on the rear and to the left; which means 
they are accessible even if the display is 
slap bang against a wall.

Once we calibrated this display we 
noticed that the Spyder 3 Elite had really 
toned down on the red component. Pre 
calibration this display was plagued with 
a very highly saturated red and any part 
of any scene with this colour appeared too 
rich to the eye. Post calibration the red 
component was more neutral but it still 
tended to be high. Display Mate showed 
that this display has a decent contrast 
ratio. Watching movies was a good expe-
rience mainly because despite its size, 
there was hardly any pixellation notice-
able which was surprising for such a large 
display; since the pixel pitch is normally 
higher on larger displays. Although the 
display supports 1080p natively, even 720p 
and DVD-resolution movies looked good.

Sony advertises this one as the larg-
est LCD display available and frankly 70-
inch LCDs are an elite bunch. Exclusivity 
doesn’t come cheap though and this one 
is priced at (brace yourself) Rs 20,00,000; 
in case you messed up on the count of 
zeroes its price is twenty lakhs, which is a 
sizable chunk of dough. Unless you own a 
yacht and your very own private island we 
don’t reckon you indulge this sinful, sinful 
extravagance. In any case if its size that 
matters, you could probably buy a 100+ 
inch plasma display for less. It did win our 
Best Performance award, but the trophy 
was shared since two displays came very 
close to each other.

Philips 52PFL9703/98: Large 
and lovely
Barely had our sore backs recovered from 
lugging the massive 70-inch Sony around 
and we had to handle this beast. The 
52PFL9703/98 is a 52-inch LCD display from 
Philips and once we unpackaged it we 
spent a couple of minutes looking it over, 
running covetous hands all over it. It’s Sony KDL-70X3500

M A R C H  2 0 0 9
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arguably one of the best looking displays 
in this comparison test and one of the best 
looking displays we’ve seen. The surface 
of the front bezel is a transparent fibre 
material and the bottom is piano black 
which gives it a very classy looking smooth 
finish that appears translucent. In fact 
at first glance we thought the fibre itself 
was black coloured. The stand is lovely 
looking and made of solid, half-inch thick 
glass, which adds a lot to the weight of the 
display. There is a small fibre bezel running 
right around the display and this makes it 
appear bulkier. The unit we received had a 
“made in Belgium” badge on the rear — a 
difference from most of the other displays, 
which were made either in Japan, Korea or 
India. Sadly upon powering on the display 
we noticed it had one dead pixel that was 
stuck on the colour green — although this 
is definitely a one-off glitch we were disap-

pointed mainly because of our very high 
expectations.

In the 16 shade-intensity and 256-
colour ramp tests this display showed very 
good variations in colour and it was one of 
the two displays that provided such good 
results. Text quality was mediocre but the 
reverse text test was decent.

When watching movies there was a 
peculiar issue with dark areas of the screen 
which appeared reddish, and not black, or 
dark-grey as it should be. Other than this 
everything was fine and 1080p content 
looked crisp and clear, with good colours 
and contrast. Obviously the screen size 
makes for a very enjoyable home-theatre 
experience, the only sore point of course 

being the issue mentioned above. Priced 
at Rs 2,24,990 the Philips 52PFL9703/98 is 
not cheap, but as far as 52-inch LCDs go, 
it is not astronomically priced either. At 
the price there are alternatives available 
so we recommend you not getting bitten 
by this bug.

Sony KLV-52W400A: Dial 
W for wide
This display is catchy with a slim 
side and top bezel livered in 
smooth black fibre that is set with 
a multitude of tiny, shiny particles 
that give it a shiny satin-like look. 
The speakers are on the bottom 
and to the sides and these appear 
to curve inwards giving the display 
a slightly sleek, futuristic look. The 
speakers are finished in steel-grey. 
Above the speakers is a chrome 
strip that is a contrast to the steel-

grey of the speaker grilles and the piano 
finished black of the screen bezel. In the 
middle of the bottom bezel, the word Sony 
is backlit in white. This may look garish 
to some; but we feel its not overdone, and 
we give Sony credit for knowing the fine 
line between classy and loud. This display 
was the only one that came with what 
Sony calls a DM Port or Digital Media Port. 
Basically this allows connecting of PMPs 
and such to the display unit. The device 
can charge through this port while music 
can be played through the display units 
speakers and artist information can be 
displayed on-screen. Obviously its some-
thing that will have its share of compat-
ibility issues but it’s a novel feature that 
warrants mention.

While calibrating this display the 
Spyder made things look very dark on-
screen. In fact repeated attempts at cali-
brating met with the same fate and eventu-
ally we did a little manual brightening up. 

The beauty of the Spyder 3 Elite and the 
display profile it creates is the fact that one 
can adjust brightness and contrast after 
RGB calibration has been done and this 
does not affect the colours at all. Obviously 
there is a limit within which manual 
tuning can be done without upsetting 
the colours, but it’s a useful feature and a 
serious plus for the Spyder that came most 
handy with this display.

What was immediately noticeable 
was the quality of text, which was good 
with everything looking sharp. The blues 
on this display are a little deficient in 
comparison to the reds and the greens 
and Display Mate attested to this fact with 
slightly deficient blue gamut. In typical 
Sony style the reds are a little aggres-
sive and post calibration we noted that 
the Spyder had turned down the reds 
significantly. However, it was impossible 
to negate the slight bias this display had 
to the colour red and this makes it pres-
ence felt with rendering bright red objects 
on-screen. These appear slightly over-rich 
and saturated. Although to be honest the 
issue with the other Sony display where 
the dark areas appeared reddish was not 
repeated here. Overall movie quality was 
good, with very decent contrast and an 
enjoyable experience. The price of this 

Test

Sony KLV-52W400A

We did not divide these displays into any categories based on screen size since we were 
more interested in which of them made the most sense for their price.  We hooked up 

these displays to a test PC using our standard HDMI connect. The PC configuration consisted of 
an AMD Athlon X2 6000+, 2 GB of RAM, an ASUS GeForce 8200 motherboard and an XFX 9800 
GT graphics card. We used a hardware display calibrator, the Spyder 3 Elite (http://spyder.
datacolor.com/product-mc-s3elite.php) to calibrate each display and measure colour and 
gamma levels. This colorimeter uses a seven-detector engine and an embedded ambient light 
sensor along with a large light aperture to calibrate accurately and is the choice of imaging 
professionals the world over. Throughout the test we ensured even external lighting to reduce 
variations in both calibration and testing results. Once each display was calibrated with the 
Spyder, we began our tests. A warm-up time of 30 minutes was given to each display prior to 
testing to minimise the effect of this variable.

In terms of features we noted down the connectivity options of these displays. Connects 
are of vital importance since any display could be used in a variety of situations and absence 
of a particular connect limits usage scenarios. Sometimes multiple connects of the same type 
are also required and we gave marks not only for presence of connects but also the quantity 
of connects. For example a display with four HDMI ports got double the rating than a display 
with two ports. We also rated the ergonomics of usage and button placement and the remote 
unit. The intuitiveness of the menu system was also graded as was the stability of the stand 
and it pivot functionality.

In terms of performance we used the Spyder 3 Elite to give us an accurate measure of 
the actual contrast ratio — the one that manufacturers do not want to tell you. It comes 
as no surprise when the difference in rated figures and actual specifications is as much as 
500 per cent! We also used DisplayMate Video Edition which gave us the chance to study 
the colour reproduction and contrast output of the test candidates. Finally we ran every 
sort of movie on these displays ranging from Blu-Ray, to 1080p content to DVDs to judge 
colour and contrast practically. Finally we did a couple of text and presentation tests to 
check for text clarity and font rendition.

  How we tested

Philips 52PFL9703/98

The Sony Bravia Z450A
is the world’s fi rst LCD TV with
Motionfl ow 200 Hz technology
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Nevertheless it’s a very clean looking 
display and has a very rugged industrial-
grade look to it. The rear is metal, unlike 
plastic that is favoured by most other 
vendors. The outer portion of the front 
bezel is finished in brushed aluminum 
while the inner portion is finished with 
a mock glass sort of finish. The speakers 
are very cleverly integrated into the front 
bezel and you won’t feel that they have 
been added later — great design here. The 
middle portion of the bottom of the bezel 
consists of a flap that is flush fitting with 
the rest of the bezel and opens to reveal 
an HDMI port, a 3.5mm jack, composite 

port and the menu and volume buttons. 
We welcome the inclusion of a front HDMI 
port because of the convenience offered. 

Even more welcome is a headphone jack 
on the front panel. The panel being a 
plasma display is hard glass and gloss-
finished. There is some sort of surface 
treatment that has been done because 
despite the fact that the panel is glossy 
there is minimal reflection. Hitachi has 
also done well with the stand; it’s not 
large, but is ultra stable and the pivot 
action is very smooth. 

Being an older display when we 
connected it to our test PC using D-Sub 
connectivity the maximum resolution 
we could get was 1280 x 1024 pixels. 
While there was no serious issue with 
any of the Display Mate tests we were not 

fully satisfied with this displays perfor-
mance in all of the tests. The colours are 
not bad, but could have better while the 
same can be said for the contrast ratio 
and moiré tests.

With movies the P50-X01AU is good 
with 1080p content, but it does not scale 
well with lower resolution stuff. Text reso-
lution is decent but should have been 
better before we recommend you using 
this as a monitor. DVD movies also have 
issues, presumably because they are not of 
the panels’ native resolution. This, it seems 
is the major issue with this display — it 
doesn’t do very well with non-native resolu-
tion content. For Rs 1,35,000 the P50-X01AU 
is expensive for a plasma display and not 
recommended by us for any usage pattern.

in a glossy black fibre that has embedded 
red highlights that give certain parts of 
the bezel an almost red-wine like colour. 
The rear is plastic too, but finished well 
and nothing looks cheap. This display has 
retractable speakers that can be set to 
retract when it’s powered off or they can 
be left extruded permanently. The motor 
assembly for the speakers is very silent 
and we played around with this gimmicky 
addition for a few minutes. And it turns 
out this isn’t another useless add-on; the 
larger speakers are pretty powerful too, 
although to be honest they are nowhere 
close to even a cursory speaker system. 
Even the remote unit looks attractive 
with a matte-finish; it works flaw-
lessly too. Unfortunately the stand is 
not very stable and we could actually 
tilt the display 10 degrees forward 
and backward with the stand affixed; 
LG needs to work on the stand before 
we deem this acceptable — for now its 
definitely not.

In terms of performance the 42-
LG80FR is a scorcher. It did well across 
the board with Display Mate with 
good rendition of colours and a good 
contrast ratio. Throughout our movie 
tests we had no colour aberrations 

or any sort of problems. 
It does excellently well 
with 1080p content 

and even displays lower 
resolution stuff well. Text 
rendition is clear, crisp and 
with great detail making 

reading even long documents a pleasure. 
If you want to use your display as a moni-
tor or even to read the odd e-book this 
display should be at the top of your prior-
ity list. It’s a superb all rounder and at a 
price of Rs 83,000 its reasonably afford-
able. This display was our (joint) Digit 
Best Performance winner and comes highly 
recommended for anyone shopping for a 
42-inch LCD display.

Hitachi P50-X01AU: Industrial 
grade beauty
The P50-X01AU is one of the older models 
in test. In fact its date of manufacture 
indicates it was made it 2007, which 
means it was probably lying around in 
some warehouse for a good many months. 

display is Rs 2,59,900 which is frankly a 
little more than what we would expect 
to pay but its also comparable to Philips’ 
offering which brings us to one conclu-
sion — 52-inch LCD displays are overpriced 
as of now and we suggest you wait a bit if 
you want something in this size category.

Samsung LA- 40A650: 
Expensive real estate
The LA-40A650 is a 40-inch LCD display 
and looks neat. The entire back is plastic 
and matte black. The front bezel is piano-
finished in black and is translucent. This 
bezel has red implants all through it and 
this gives it a reddish tinge in certain 

areas and since the amount of red varies 
so does the colour tone. Weirdly there are 
no buttons on the body of the display but 
the remote unit looks very neat and has a 
good range; buttons also work well and we 
didn’t have the sporadic issues with keys 
not working when being pressed that 
plagued some of the other remote units. 
This unit has all the important connects 
and even the cable port had RCA ports for 
outputting to auxiliary speakers.

Post calibration we ran into issues 
under Display Mate first; this display 
totally missed out on the three highest 
intensities and all three bands looked 
identical. This problem also cropped up 
during the movie tests. We found places 
where there were smudges of red instead 
of smooth transitions in the colours 
intensity that are expected. Although 
this isn’t serious enough of an issue to 
ruin the experience of watching movies we 
found it a little annoying. Other than that 
this display gave good performance with 
contrast and colouring throughout the 
movie tests and works with lower resolu-
tion content quite well. Text rendition is 
sharp and this display will satisfy even if 
it’s being used as a substitute monitor.

Priced at Rs 1,07,000 the LA-40A650 is 
expensive — especially when you consider 
that other 42-inch displays are available at 
much lower prices. We can’t recommend 
paying more for less, so don’t bust your 
wallet here.

LG 42-LG80FR: Beautiful 
stranger
This was perhaps one of the most attractive 
looking displays we received. Its finished 

TRIED & TESTED
You can also fi nd LCD monitor tests 
online at www.thinkdigit.com

Samsung LA- 40A650

Hitachi P50-X01AU

LG 42-LG80FR

1920x1080
The resolution of the World's 
largest OLED display, from 
Samsung. 
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Hitachi UT42-MX700A: Ultra slim 
This displays main claim to designer fame 
is the fact that it is only 1.5-inches thick. 
We measured this advertised feature and 
it is accurate. Although the display is 
not lighter than others in the same 
size category the drastically slimmer 
design mean that it is often less than 
50 per cent of the thickness of other 
42-inch displays. The bezel is also very 
slim and a translucent, glossy-black. 
The silver stand is also pretty compact 
and these two colours interact to 
create a starkly attractive look.

The colours on this display are 
realistic without being oversatu-
rated and unrealistically vibrant. The 
contrast is a little deficient. This is 
noticeable in certain scenes involving 
a lot of intensity-variation in the same 
colour, for example clouds with vary-
ing intensities of white, or the sky. In 
such images slight banding is noticeable. 
There is also noticeable artifacting that 
happens with certain non-native resolution 
videos. In fact this display did very poorly 
in the grey-scale check that is a good indi-
cation of the contrast ratio of a display. 
Even the Spyder showed this displays true 
contrast ratio to be in the region of 400:1 — 
this is not good enough. One saving grace 
was the fact that it did very well with text 
and fonts appear very clear and crisp. At
Rs 1,35,00 the UT42-MX700A does not pres-
ent a strong enough case for itself to 
warrant a recommendation from us. 

Panasonic Viera TH-42PV80D: 
Viera - the new synonym for value
Panasonic’s TH-42PV80D is a 42-inch plasma 
display. It has a very neat look with no real 
standout attributes but everything looks put 
together well and with care. The front is 
finished in a smooth glossy black and the 
bezel isn’t too wide — it’s a suave looking 
display that will subtly attract attention. And 
it’s built very well too. We were surprised 
to find a n SD memory card slot integrated 
into the front bezel and recessed under a 
cleverly designed, flush fitting tray that opens 
outwards. This means you can now access 
images taken with your camera by simply 
the card into the SD/MMC slot and view your 
images at a resolution of 1080p! There is also 

a USB connect on the side of the display. 
The front panel also features an HDMI 
port and one composite connect.

This is a great display with a superb 
contrast and great colours. Once cali-
brated, we could not see any issues 
with colour or contrast 95 percent of 
the time. In fact our 1080p clips have 
not looked this good too often and 
there is absolutely no deficiency in the 
contrast that is noticeable by the naked 
eye. Colours are rich and vibrant but 
not unrealistically so and everything 
on-screen has a very life-like look to 
the colours. It’s a superb display for 
movies and gaming of any 

sort. A pity that its text rendition 
using HDMI connectivity is not 
as good and text looks a little 
blurry around the edges and all 
fonts are rendered as well as 

we’d like. Hooking up this display via D-
Sub reduced the issue with text to a great 
degree but doing this means going without 
the wonder of 1080p or 1080i — since 1920 
x 1080 de-interlaced/progressive scanned is 
not supported via D-Sub connectivity.

The price of the Viera TH-42PV80D is the 
killer — Rs 64,900 for a 42-inch display is good 
by anyone’s standards and superb for a really 
quality display. In fact so impressed were 
the lot of us, that we awarded it our Digit 
Editor’s Choice. If you’re looking for excel-
lent value for money and want something in 
the region of 42-inches for movie watching 
or gaming — this is the one to get.

LG 42PG61UR-80R: Smooth 
Operator
LGs 42-inch plasma offering looks radi-
cally different from their 42-inch LCD 
we tested. For one the screen and bezel 
are one integrated unit and without the 
display turned on its difficult to tell the 
bezel apart from the actual screen because 
when the display is off the colour of the 
bezel and screen match. However, when 
the display is turned on we noticed the 
bezel was a little thicker than we would 
like and this makes the unit unnecessar-
ily bulky. The remote unit is identical 
to the one bundled with the other LG 

display we tested. Upon turning on 
the display imagine our shock when 
we realised that its native resolution 
is 1024 x 768 progressive scanned 
pixels. 1080p is a selectable resolution 
but it messes up text quite a lot to the 

point that you wouldn’t want to use 
this resolution. This clearly indicates 
that this display is aimed at corpo-
rate users who will not be interested 
in HD-resolutions that are typically 
meant for the movie watchers.

Upon calibration the whites had 
a yellowish tinge to them and we 
repeated the calibration process. 
Everything went off without a glitch 
the second time round although text 
had a noticeably stretched look to it; 
presumably because this is a wide-
screen display that does not run at a 
widescreen resolution. Even Display 
Mate had its share of complaints 
with the 42PG61UR-80R — there was 
an issue with the rendition of red 

and green in the colour tests and moiré 
was noticeable. Even movies were not 
as impressive as they could be mainly 
because of the resolution of the display. 
There are also the ugly black bands on the 
top and bottom of the screen when work-
ing with HD-content because of the aspect 
ratio mismatch. Priced at Rs 62,000 this 
would have been the ideal display for the 
value oriented user looking at a 42-inch 
display but not with its rather low level 
of performance. As it stands we’d recom-
mend the LG 42-LG80FR over this one 
— the fact that this one is a whopping Rs 
21,000 cheaper not withstanding.

Sharp Aquos LC-37A65M: 
True beauty is superficial
     The 37-inch Aquos is a real beauty. 
It is built around a glossy LCD panel 
that has adequate surface treatment 
to avoid unnecessary reflections. The 
speakers are beautifully made and 
occupy an entire strip at the bottom. 
Finished in steel-grey these are 
placed angled inwards,      so as to give 
them a slightly recessed look. The 
entire bezel is black and the finish 
is smooth and glossy. Separating the 
black bezel and the bottom mounted 
steel-grey speakers is a curved strip 
of fibre that is finished in high-

Panasonic Viera TH-42PV80D

LG 42PG61UR-80R

The Samsung LA22A480 
is a 22-inch LCD TV 
that comes with an FM tuner and 
sells for Rs. 20,900

Hitachi UT42-MX700A
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gloss chrome that runs through the entire 
bottom bezel. This is what really sets off 
the entire appearance. If we awarded 
beauty the LC-37A65M would be our 
unanimous choice. The control buttons 
are on the top of the display — great 
points for ergonomics here.

Sadly upon testing we found that 
this beauty was only skin deep. There 
is an issue with red and this colour 
appears oversaturated and at times there 
are chromatic aberrations visible which 
centre around the red component. While 
watching movie clips even certain dark 
areas of the display had a reddish tinge. 
Text quality is good and text is crisp but 
for us the issue with the oversaturated 
reds was a little hard to swallow. The fact 
that this display has issues with other 
colours in Display Mate means that we 
cannot really recommend it unless it were 
dirt cheap. Which at a price of Rs 67,990 its 
quite frankly not and therefore loses out 
on our approval.

Onida Xaria Thunder 32-inch: 
Simply too mediocre
The Xaria Thunder is a very ordinary look-
ing display. The outer bezel is glossy black 
while the inner bezel is a matte-finished, 
dark purple colour. The wide bezel is a 
bit of an annoyance and quite frankly we 
don’t see the need on such small displays. 
The stand is also very mediocre and this 
display tilts forward even when its prop-
erly setup. Quality of fixtures of the stand 
and even the retaining screws is also 
mediocre. Since the outer bezel is 
slightly tapered it causes reflections 
on-screen which bespeaks volumes 
about design quality.

The HDMI connects on the rear 
jut out sideways and are very close to 
the back of the display; in fact we had 
trouble getting our slightly thicker 
reference HDMI cable. The slightly 
thicker plug would interfere with 
the body and we could not connect 
HDMI; and were thus forced to use 
D-Sub connectivity. VGA connectiv-
ity allows a plethora of resolutions 
and only 1080p and 1080i are not 
supported via D-Sub. Obviously since 
this display had a resolution of 1366 x 768 

pixels we did not expect 1080p to work. 
The 32-inch Xaria Thunder has a lot of 
issues with the colour blue and any scene 
involving displaying of skies or water has 
a lot of artifacting and banding. Even 
greens are not displayed accurately, espe-
cially the higher intensity shades. Finally 
reds also have a slightly compressed look 
to them and colour tonality is way off 
— even after calibrating. With issues 
with colour it was obvious that this 
display is not ideally suited to movies and 
such, although to be honest most viewers 
will not be as discerning. One redeem-
ing quality was this displays superla-
tive performance with any sort of text 
— fonts are renditioned beautifully and 

everything looks crisp and sans artifact-
ing. Priced at Rs 39,990 the Xaria Thunder 
is not really something that any serious 

movie buff should consider. Its good as 
a monitor however and its price makes it 
an attractive grab for someone looking at 
something that offers good value.

Videocon VDL-32-FBT: 32-inches 
of pain
This was the second display that Videocon 
sent us. The first one was another 32-
inch model but after switching it on we 
discovered serious display anomalies that 
to us either meant that the display was 
not really worth testing or something was 
damaged internally. This display isn’t really 
great to look at, but has a neat piano black 

Sharp Aquos LC-37A65M

finish that we couldn’t fault. The remote 
unit is quite good however and we liked 
the translucent buttons. In fact the remote 
works really well and there is no button 
lag as nearly all the other displays had. 
Upon testing we found that this display 
suffered from a deficient contrast ratio 
— it failed miserably in the grey-scale test 
and we could not even see the first 12 
grade squares; which means if you not be 
able to make out darker colours from each 
other or from a black background — this 
is not acceptable for the movie-watching 
audience. The text tests were equally poor 
and at times the words were not even read-
able. At Rs. 37,990 even the pricing on this 
display is not attractive. Performance is 
not even mention-worthy. There are much 
better options available for the same price.

Panasonic TX32-LX80C: Less 
painful, on your eyes and pocket
Panasonic’s 32-inch offering is an LCD 
display and quite frankly looks quite a 
bit like the 42-inch plasma display they 
sent us, only its smaller (obviously). Up 
front we didn’t really like the remote unit 
because while it was feature rich buttons 
need to be pressed two or three times 
before the highlighted action occurs. 
There are no buttons on the display itself 
so you have to use the remote unit. Setting 
up this display was a task we did twice. 
The first time we used the ambient light 
sensor on the Spyder 3 Elite and got a very 
dim looking image and the whites looked 
a little warm. The second time round 

we got a better picture but there was 
some moiré noticeable even when only 
the desktop was being displayed. Display 
Mate confirmed this and the greens were 
not as tonally accurate as we would like. 
1080p content is viewable on this display 
but to be honest it is better watched on a 
display that can do the resolution of 1920 
x 1080 pixels natively. That way any sort 
of scaling is not needed, and from the test 
it was evident that this display does not 
scale well with non-native resolutions. 
Text quality was much better than the 
Videocon display but nowhere near the 
Onida. At Rs 37,900 the TX32-LX80C is 
the cheapest display in test but it doesn’t 
perform up to its price. As it stands we 
recommend giving it a wide berth. Q

michael.browne@thinkdigit.com

Panasonic TX32-LX80C

Videocon VDL-32-FBT

Onida Xaria Thunder 32-inch

1964
was the year the fi rst monochrome 
plasma video display was
co-invented at the University of
Illinois at Urbana-Champaign

Now is the time to buy 
The prices of LCD TVs have dropped 
by a factor of 35% to 40% over the 
year 2008. 
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Brand Panasonic Videocon Onida LG Panasonic             Sharp
Model No TX32-LX80C VDL-32-FBT Xaria Thunder 42PG61UR-80R TH-42PV80D        LC-37A65M

Price (Rs) 37,900 37,990 39,990 62,000 64,900 67,990
Plus (+) Affordable Neat looking Affordable, good 

performance
Very neat looker Good for movies, 

decent value
Clear, sharp text display

Minus (-) Very Mediocre
quality

Very poor
performance

Looks ugly Mediocre performer Text quality
not good

Mediocre performance 
everywhere else

Grand Totals (Out of 100) 59.80 50.00 68.18 64.39 70.58 64.33
Features (Out of 38) 23.47 22.47 25.14 27.93 25.74 26.89
Performance (Out of 62) 36.33 27.53 43.04 36.46 44.84 37.45
Features

Screen Size (Diagonal) 32-inches 32-inches 32-inches 42-inches 42-inches 37-inches
Weight 17 kgs 13.8 kgs 14.5 kgs 31 kgs 28 kgs 17.5 kgs
Panel Type LCD LCD LCD Plasma Plasma LCD
Native Resolution # 1366 x 768 pixels 1366 x 768 pixels 1366 x 768 pixels 1024 x 768 pixels 1080p 1080p

Connectivity
HDMI (Y/N) / Number of Ports � / 2 � / 2 � / 2 � / 3 � / 2 � / 3
Component (Y/N) / Number of 
Connects

� / 1 � / 1 � / 2 � / 2 � / 2 � / 2

Composite (Y/N) / Number of 
Connects

� / 3 � / 4 � / 3 � / 3 � / 4 � / 2

S-Video (Y/N) / Number of Connects � / 1 � / 1 � / 1 � / 1 � / 1 � / 1
USB (Y/N) / Number of Ports � / NA � / NA � / NA � / 1 � / NA � / NA
Display Port (Y/N) / Number of 
Ports

� / NA � / NA � / NA � / NA � / NA � / NA

D-Sub Port (Y/N) / Number of Ports � / 1 � / 1 � / 1 � / 1 � / 1 � / 1
DVI Port (Y/N) � � � � � �

Digital Audio Out (Y / N) � � � � � �

Usability And Ergonomics
Placement of controls on the 
display (So 10)

0 3.5 8 0 6.75 8.5

Menu Intuitiveness (So 10) 8 5.75 8 7.75 7.25 8.25
Options Available (So 10) 6.75 4.75 7 7.5 7.5 8.25
Remote Control Unit (So 10) 6.5 5.5 8.5 8.25 7 8
Wall Mounting (Y / N) � � � � � �

Stability of Stand (So 10) 7.5 6.75 5.5 8.5 8.75 8
Swivel Base (Y / N) � � � � � �

Performance
Inbuilt Speakers (So 10) 3.75 4 3 3 4.75 4.5

Spyder 3 Elite
Contrast Ratio 602:1 577:1 366:1 1686:1 1278:1 892:1
Gamma (Target / Calibrated) 2.20 / 2.27 2.20 / 2.21 2.20 / 2.23 2.20 / 2.46 2.20 / 2.15 2.20 / 2.27

Display Mate Tests (So 10)
Colour Accuracy 6 6.5 7 6.5 7.25 6
Intensity Ramp (16 intensity) 4.5 3.5 7.5 7.5 7.5 4.75
Grey Scale Check 6 3 7 7 7.25 4.5
Moire 4 3.75 7.75 6 8 7.5
Reverse Text 6 6 6.5 6.5 7.25 7.75

HD Movie and Video Tests (So 10)
1080p Clip 7 4.25 7.25 5.5 8.25 6.5
720p Clip 6.5 4.25 7.25 6 7.75 6
Blu-Ray Movie 7 5.25 7.25 5.5 8.25 6.75
DVD Movie 6 5.5 6.75 6.5 6.75 5.75

Text/Presentation Sharpness Test 
(So 10)

6 3 8.25 5.5 4.5 7.75

# 1080p = 1920 x 1080 pixels (progressive 

scanned)

  
LCD TVs
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Buying decisions
Needs and Desires We recommend Price (Rs)
A basic 32-inch LCD TV, price is a constraint Onida Xaria Thunder 32-inch 39,990
A display that displays text beautifully and is not more than 32-inches in size Onida Xaria Thunder 32-inch 39,990
A good 42-inch display for gaming, it should not be too costly Panasonic TH-42PV80D 64,900
The best performing 42-inch display, price no bar LG 42-LG80FR 83,000
The largest screen my money can buy, I own a Rolls too — so don’t talk to me 
about price

Sony KDL-70X3500 20,00,000

The largest display that is cost effective, I want screen size, but it should be 
value for money too

Hitachi P50-X01AU 1,35,000
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LG Samsung Hitachi Hitachi Philips Sony Sony
42-LG80FR LA- 40A650 UT42-MX700A P50-X01AU 52PFL9703/98 KLV-52W400A KDL-70X3500

83,000 1,07,000 1,35,000 1.35.000 2.24.990 2.59.900 20.00.000
Superb all round 
performer

Good looks and perfor-
mance

Decent performance Well built, good looks Looks classy, superb 
build quality

Great performer, built 
well

Well built, large screen

Slightly expensive Very Expensive Very Expensive Mediocre performer We expected more 
performance

Expensive Astronomically
expensive

70.68 70.96 56.37 64.66 73.16 73.26 76.61
24.64 29.82 15.54 25.23 29.14 28.26 30.81
46.04 41.14 40.83 39.43 44.02 45.00 45.80

42-inches 40-inches 42-inches 50-inches 52-inches 52-inches 70-inches
22.05 kgs 18.6 kgs 20.9 kgs 45.5 kgs 39.5 kgs 38 kgs 94 kgs
LCD LCD LCD Plasma LCD LCD LCD
1080p 1080p 1080p 1080p 1080p 1080p 1080p

� / 2 � / 3 � / 1 � / 2 � / 4 � / 3 � / 3
� / 2 � / 2 � / NA � / 2 � / 2 � / 2 � / 2

� / 3 � / 2 � / NA � / 2 � / 2 � / 3 � / 1

� / 1 � / 1 � / NA � / NA � / 1 � / 1 � / 1
� / 1 �  / 1 � / NA � / NA � / NA � / NA � / 1
� / NA � / NA � / NA � / NA � / NA � / 1 � / NA

� / 1 � / 1 � / 1 � / 1 � / 1 � / 1 � / 1
� � � � � � �

� � (Optical) � / NA � (Optical) � (Optical) � / NA �  (Optical)

3.5 0 4 6.75 7.5 8.25 4

6.5 7.5 6 7 7 8.75 8
5 7.5 7 7.5 7.5 8 8
7 8.5 4 3.75 7 8 8.25
� � � � � � �

3.5 7.75 7 9 8.75 8.25 8.75
� � � � � � �

6.5 4.5 4.5 4.5 6.25 5 5.5

599:1 1362:1 400:1 756:1 833:1 1102:1 956:1
2.20 / 2.26 2.20 / 2.16 2.20 / 2.20 2.20 / 2.25 2.20 / 2.17 2.20 / 1.97 2.20 / 2.23

7.75 5.5 7.5 6.25 7.25 7 7
8.25 4.5 8.25 6.75 8.25 7.5 7.25
7.25 8.75 3.25 6.5 8 7.25 7.5
8 7.5 7.5 6.5 8 8 8
5.75 7.75 5.5 6.25 8 7.5 7.75

8.5 7 7 7 7.25 8 8.25
7.5 7.25 6.25 6.75 7 7.5 7.75
8 7.25 7.25 6.75 7 7.75 8
6.5 6.75 6.75 6.5 6.75 6.75 6.75
8.75 7.75 8 6.25 8 8.25 8.5
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 Contact Sheet        LCD - Plasma

Brands Contact Phone Number Web site
Hitachi Hitachi India Ltd +91-11-4551 5500 www.hitachiconsumer.com
LG LG Electronics India Pvt. Ltd. +91-120-256 0900 www.lgindia.com
Onida MIRC Electronics Ltd   +91-22-6697 5777 www.onida.com
Panasonic Panasonic India Pvt Ltd. +91-22-4033 1600 www.panasonic.co.in
Philips Philips Electronics India Ltd 1-860-180-1111 www.philips.com
Samsung Samsung India Pvt. Ltd. +91-11-4151 1234 www.samsung.com/in
Sharp Sharp India  Limited +91-22-2682 7501 / 2 / 3 www.sharpindialimited.com
Sony Sony India 1-800-11-11-88 (Toll Free) www.sony.co.in
Videocon Videocon Industries Ltd +91-97118 08983 www.videoconworld.com
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Disciplined Desktops?
Rossi Fernandes

E
verybody needs a PC and everybody 
needs to upgrade to a new one 
every now and then. Most people 
would and should run down to 

their local computer shopping area and 
pick up some stuff, go home and assemble 
it. But then that isn’t everybody’s piece of 
cake. So automatically, the next best solu-
tion is to have somebody build a PC for 
you. That brings along additional worries 
of warranty and whether your computer 
will get fixed in time or not. Will you have 
to run after your computer-walla every 
few days asking him whether the replace-
ment part has returned? The only solution 
sensible left then is to go in for a desktop 
PC from one of the well known PC manu-
facturers and there have been many over 
the past decade or so. 

We were looking at desktop PCs. We’ve 
received a few desktops from the manu-

T
R

IE
D

 &
 T

ES
T

ED

facturers we contact with a few specific 
models. These were going to be non-gaming 
desktops for those who want PCs for their 
SoHos and maybe some everyday home 
use.

Acer Aspire IE3222
The Acer Aspire IE3222 look suggests that 
it is a desktop geared for use at home. The 
Acer Aspire IE3222’s cabinet is nowhere as 
compact as the other Acer – the NX4440 
but is somewhat stylish. The front end has 
a raised section that houses four USB ports 
and the two audio connectors. A nice big 
flat power button is located at one corner.  

The Interiors are extremely spacious 
and the few cables present are neatly tied 
up at the bottom of the case. A rear fan 
takes care of the cooling and ventilation. 
It isn’t very noisy overall. It’s a little weird 
to see a LPT port and a serial port on a PC 
today. Build quality of the cabinet is good 
and it has the sliding lock feature for all 
the drives. 

An ECS i945 motherboard and an Intel 
Core 2 Duo E2220 power this system. This 

combination along with 2GB of memory is 
good enough for basic office applications 
and browsing. We received a 16:9 aspect 
ratio 19-inch LCD screen for this PC like 
the other Acer desktops. The resolution 
isn’t so great for vertical scrolling but nice 
for videos. The screen design is good and is 
an above-average performer. The keyboard 
and mouse combination are as expected 
– cheap but perfect for the job it’s meant 
for. 

The performance through all the tests 
weren’t spectacular but it’s a very evenly 
matched system. It makes a good system to 
upgrade from. For example, adding a cheap 
graphics card under Rs. 5,000 makes it a 
very good entry-level gaming system.

The IE3222 isn’t such a great performer 
and is priced at Rs. 28,999. It is just a 
bit cheaper than the much more stylish 
and well designed NX4440 which we like. 
Although this system comes with a giga-
byte more of memory, the NX4440 has a 
superior graphics solution. Even if you 
don’t require the compact case that the 
NX4440 comes in, it is the more sensible 
buy.
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India's Rs. 500 comp 
The $10 computer is a USB drive 
that can connect to the internet. 
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The keyboard is neatly designed as 
well. The keys are as they are with most 
other desktop PCs but this has a few inter-
esting things like the volume knob on the 
right top of the keyboard. The mouse too is 
sleak but is too light and sort-of flimsy. 

With the kind of hardware there is 
on this Acer and the form factor used, it 
makes a decent HTPC solution you can 
connect to a large TV using its HDMI 
connectivity. Performance in the bench-

marks was also satisfactory 
despite the lack of 2 GB of 
RAM. For example, Doom 3 
and Far Cry fared well. At 
800 x 600 with medium 
quality, it was able to 
run Doom 3 at 35.7 
frames per second. 3D 
Mark and the graphics 
component of PC Mark 
too showed good perfor-
mance. 

The verdict is straight 
forward once you get to 
the price. The NX4440 is 
priced at just Rs. 29,299 

which makes very good 
value for money if you want a system as a 
HTPC or even otherwise.

Acer Entra E961
The Acer Entra E961 is another basic desk-
top powered by one of the entry-level low 
power processors from AMD – the Athlon 
LE-1620. In appearance, it’s even simpler 
looking than the Aspire IE3222. The front 
panels feel cheap and plastic but the frame 
itself is sturdy and designed well. It’s an 
everyday basic-computing case with no 

Acer Aspire NX4440
The Acer Aspire NX4440 is one of the few 
neatest pieces of hardware we receivethe 
neatest pieces of hardware you cao provi-
sion for an additional fan at the front of 
the case..d. Although the ultra-widescreen 
LCD with the 16:10 aspect ratio was the 
common component sent to us for all the 
Acer desktops, the keyboard, mouse and 

obviously the main case were different. 
This is one of the really compact systems 
we’ve seen and it looks really pretty.

The front has a really glossy finish and 
houses the audio, USB connectors along 
sidethe memory card reader that reads 
pretty much every format. There’s even a 
tiny Firewire port in the front. The Acer 
Aspire branding along the side adds to the 
style element of this system. The top has 
a flap which when pressed powers on the 
system. The build of the system is pretty 
good as well. 

With the case open, things get even 
more interesting. A large cooler sits in the 
center of the GeForce 8200 board used for 
the AMD Athlon X2 5000+ processor. The 
hardware used is a pretty good combina-
tion for all kind of work. It’s a shame that 
only a gigabyte of memory was used in the 
system sent to us. Opt for 2GB of memory 
if you can. The configuration is just about 
right for playing back HD 1080p content 
on it too. A full sized DVD writer and a 
standard 3.5-inch 320 GB desktop drive is 
used in it.

The case has been designed well. Most 
of the cables have a synthetic sheathing 
around them and are routed through the 
gaps along the sides of the case. A PCIe 
x1 and a full sized PCIe x16 slot are also 
present in case you want to upgrade your 
graphics solution but the space for a large 
card may not be present in this particu-
lar cabinet. The power supply used is a 
narrower and long one which is present 
in most cabinets of this kind. There are 
support frames built for the power supply 
resting on the optical drive. Everything is 
sturdy and there is no wobbling, shaking 
or sounds from vibrations in this case. 

specialties. The case only has two slots for 
two 5.25-inch and two 3.5-inch drives. 

The case is tidy though. A simple cool-
ing solution, a cleanly setup interior and 
a rear fan ensures effective cooling. The 
cabinet is dense and can accommodate 
large graphics cards if necessary. There 
is also provision for an additional fan at 
the front of the case. There is only 1 GB of 
memory on the system so running Vista on 
it automatically is a big no-no. There are 
four slots in all for memory expansion so 
upgrading is possible. The nForce 430 is an 
old solution and it’s the one used in the 
case of the Entra E961.

With this configuration, the Entra E961 
doesn’t do a lot to fight against the other 
desktops for performance rankings but the 
onboard graphics solution does show its 
power in the game benchmarks. In Farcry, 
it scored a fairly impressive 71.37 frames 
per second. The old nForce chipset is still 
pretty decent for some basic gaming. 

At Rs. 23,099, it’s average value for 
money system. It’s an underpowered 
system but is OK if you plan on using it 
with a couple of known applications for a 
very long period of time without any plans 
of upgrading the system. 

Dell OptiPlex 960 
Dell’s are generally known for their qual-
ity and performance but also for being a 
bit on the higher side of the price bracket 
with their products. The OptiPlex is one 
of the elite business desktops. Business 
desktops are meant strictly for office use, 
so they should be fast for desktop use and 
preferably be small to occupy the least bit 
of space. The Dell brings a bit of excitement 

Product testing was done in the same manner as it with desktops in the past and somewhat 
like laptops. All the products were tested with the operating systems they came with. In 

almost every case, the vendor installed Windows Vista. There were one or two that came with 
Windows XP. Many of the desktops had proprietary software installed and some even with 
antivirus. All of this software which would affect performance was removed and only then 
were the tests run.

The staple diet of any test to do with desktops and laptops includes the PCMark and 
3DMark suites which give a good indication of the core system performance. We used PCMark 
2005 and 3D Mark 2005 as the benchmarks. This was done keeping in mind the kinds of 
desktops we were testing. We were most interested in the CPU score from the 3D Mark 
2005 test. There were also test focusing on real world applications that users would use. 
Cinebench would be used to measure performance at rendering which was mostly was highly 
dependent on the processor and on the system memory. Similarly, the WinRAR benchmark 
would measure the performance. SiSoft would give us a drive index value for the hard drive 
performance but we also did a simple file copy test to gauge the hard drive performance in a 
real world situation.

As always, weights for the tests were distributed evenly among the benchmarks. The focus 
was on performance on the desktop and also on the graphics performance. A lot of points 
were distributed to the features component. For example, the size of the display, resolution 
and hard drive space and memory played an important part in the test. Importance was given 
to the upgradability offered by the system. This was mostly to do with the number of free 
slots for memory and the ability to add an extra graphics card in the future. Number of SATA 
ports, USB and Firewire formed the other numbers which would add up the features part of 
the ratings. Of course, performance numbers would come from what we thought of the quality 
of the case, how well the screen and speakers performed. Weights were allotted also to the 
ergonomics of the keyboard and mouse.

  How We Tested

Acer Aspire NX4440

Two new iMacs
Apple has rolled out two new 
iMac models with intel core 2 
duo processors. 
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to this otherwise boring and plain-boring 
category of desktops. 

The desktop we received was the 
OptiPlex 960. At first glimpse itself, it 
looks like it means business even though 
it was one of the smallest in this test. The 
case is covered with tiny holes which give 
it its distinctive look and it also helps with 
some ventilation. The DVD drive, the audio 
connectors and the USB connectors form 
the rest of the face of the OptiPlex. Dell 
didn’t send us a display with the desktop 
but they did a keyboard and a mouse 
which were as expected similar to what 
we’ve seen on some other desktops before. 
The mouse is shaped well and the keyboard 
comes with a detachable palm-rest. 

Opening the case is simple. The rear of 
the case has a slider which unlocks the side 
panel. Unlike other desktops, the mother-
board is mounted on the left panel and the 
right panel unlocks. At first, everything 
looks inaccessible and crowded. The view 
inside is blocked by a large flat surface. 
One then notices the clips surrounding 
the various pieces. The main panel is a 
door which reveals the two 2.5-inch 160GB 
mounted on it. The drives are arranged in a 
RAID setup. The optical drive used too is a 
slim DVD writer to try and save space. This 
drive can also be released using a similar 
clip mechanism. Under the DVD drive 
lies the cooling for the processor. A fan 
sucks in air from the front of the case to 
the heatsink behind it and then is chan-
neled out from the back. 

The surprises don’t end there. The 
processor on this tiny desktop for the office 
has an Intel Core 2 Quad Q9550 running 
at 2.8 GHz. There’s also 8 gigabytes of 
memory in a 4 x 2 GB configuration lined 
up on the board. This hardware ensures 
that the competition is demolished. The 
performance is ridiculous. In processor-
intensive benchmarks such as Cinebench, 
it’s around two times faster than its near-
est competitor. The RAID hard drives also 
churn up mindboggling numbers. A 1 GB 
file only takes 16 seconds to copy. Even 
though the GMA 950 isn’t a great graphics 
solution on a PC of this kind of power, it 
still manages to get results with the help of 
the powerful processor. Office goers using 
this PC will be able to easily play rounds of 
Far Cry with an average frame rate of 60 
frames per second.

Although all this power is there when 
you need it, it’s not sure what kind of 
office work demands such hardware. The 
kind of hardware here is not even seen on 
many gaming rigs. Still, there’s a price one 
pays for this kind of power. The OptiPlex 
960 is priced at Rs 58,000 in the market 
without the LCD screen. It is expen-
sive but if you want to be seen with a 

really good desktop at work, then this is 
the one for you.

HCL EZEEBEE MAX XP 
P999
The HCL EZEEBEE MAX XP P999 is a very 
entry-level PC for the masses that makes 
use of the latest Atom processors. From 
the outside, it looks like any other desktop 
PC. When you open up the big cabinet, you 
discover a tiny board on it. It is an Intel 
i945G motherboard with an Intel Atom 
N230 processor running at 1.6GHz. It’s 
almost the same thing used in netbooks. It 
only comes with 1 GB of memory.

The insides are spacious but the 
cables aren’t tied up very tidily. The case 
is simple, looks decent and is built well. 
The cooling fan for the processor is tiny 
but good for the low-power Atom processor 
but the setup is still pretty noisy due to 

the full size 
power supply 
fan. A scoop 
is mounted 
on the side 
panel to let 
the tiny CPU 
f a n 

pull in cool air from the outsides. There 
is no room for expansion on this tiny i945 
board and it means that you can only put 
in an additional memory stick and a PCI 
card. 

The entire system seems like a waste 
of space. A tinier cabinet would have done 
wonders and would be much more attrac-
tive for many users. The keyboard supplied 
with the HCL is standard, comes with 
multimedia keys and keys for Internet 
functions. The layout is a little crowded 
near the center panel between the numeri-
cal pad and the character keys. 

In comparison to other desktops we 
tested, the EZEEBEE MAX XP P999 is bad. 
It’s not exactly cheap at Rs. 19,999. If 
cheaper and maybe a bit smaller in size, 
people who want only browsing capabil-

ities or a system for downloading 
would find it most excellent!

HCL EZEEBEE UP 
Z811 C2D
The HCL UP Z811 is the more 
impressive of the two HCL desk-
tops we received. Unlike the MAX 
XP P999 is built in a chassis that 
can be placed horizontally or verti-
cally. It is thinner than most other 
desktops we’ve seen this test but 
not as small as the Dell OptiPlex 
960 and the Acer Aspire NX4440. 

It has a very nice design and 

look. A single optical drive and the USB 
panel with audio connectors and finally 
a card reader take up three-thirds of the 
front panel. The last bit of area has the 
classy power buttons and LED indicators. 
All the panels have a press-and-release lock 
to them. 

The entire case is built well. The top of 
the case has an opening right about on top 
of the processor fan from Coolermaster. 
The case runs pretty warm. At the heart of 
this system lies a pretty powerful 2.8GHz 
Intel Core 2 Duo E7400 and an Intel G31 
based motherboard. 

The performance of the system is good 
at the WinRAR compression and Cinebench 
rendering tests. One of the most impressive 
components is the 320 GB hard drive which 
showed transfer rates of 83 MB/s in the 
SiSoft Sandra benchmarks and also the 
realworld file transfer tests. The perfor-

mance of the system in gaming 
benchmarks was pretty bad. 

The chassis of this system 
is pretty good and is definitely 
a bit more spacious than the 
other compact desktop cases. 
The 19-inch LCD that came with 
the HCL desktops is average and 
have speakers are mounted at 
the bottom of the screen. The 
screen along with the desktop 
makes it look like a very tradi-
tional and simple desktop PC. At 

Rs. 27,999, it’s in the same price 
bracket as the Acer Aspire NX4440 but 
doesn’t offer as good a graphics solution.

HP Pavilion A6740
HP’s Pavillion range has been around for 
ages now and the a6700 series is the latest 
they have for offer. The range is usually 
targeted at home users and also at basic 
office use. We received the A6740 and it 
came in a very fancy avatar. It has the regu-
lar mid-tower form factor but is the classi-
est looking one in this comparison test. The 
tower has a small glowing power button at 
the top of the case. Below that is the media 
card reader which supports all commonly 
used card formats.

The insides of the Pavilion are secured 
and there are metal strips in place to stop 
users from making changes. The mother-
board is mounted on the other side and 
thus the processor ends up at the base of 
the case. The hard drive is mounted verti-
cally and all the cables are tied to reduce 
the mess inside. There is space for expan-
sion on the board for a graphic card and 
also an empty memory slot.

We received an equally stylish 19-inch 
HP display as well. The display has a nice 
glossy bezel but the most special thing 
about is its interface which is extremely 
detailed yet very simple to use. It’s some-
thing very few LCDs today have. The 
keyboard is great and has multimedia 
buttons lined up along the sides of the 
keyboard. The mouse feels light and is 
lower than some other mice.

One of the irritating things is the Dell OptiPlex 960 

HCL EZEEBEE MAX XP P999

Intels Rs. 5000 comp 
Intel has launched a Rs. 5000 desk-
top for the Indian market with it's 
Atom processor. 
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PC that allows you to run office applica-
tions and maybe a few Internet utilities 
now and then. The LG D6047-E0381 is one 
such system and comes with a 17-inch 
screen with a 4:3 aspect ratio display. It’s 
more compact than the other LG PC we 
tested during the test but this feels even 
more office oriented. This is because of 
the few missing components. You get no 
memory card reader in this PC and the 
chassis is smaller too. The system runs 
pretty cool and isn’t too noisy either. There 
is a small blower fan placed under the case 
that blows air out from underneath.

The optical drive is present on the side. 
The interiors are pretty crowded but it’s 
still well ventilated. It gets a little warm 
after a while. The performance of the 
system isn’t so great either. 

The price for this PC is Rs. 27,808 which 
is a lot compared to some of the other rigs. 
The Acer NX4440 for example comes with 
a larger screen, has much better perfor-
mance and costs just Rs. 29,299. If you are 
on a tight budget, then go for the LG other-
wise the Acer seems like a better deal.

Zenith Premium PC Q6600
The Zenith Premium PC Q6600 might 
appear as the simpleton of the pack but 
is one of the heavily loaded desktops. It is 
powered by an Intel Core 2 Quad Q6600 
process which might seem a bit dated 
but it is still a pretty powerful quad-core 
processor. To add to this, there is 8 GB of 

memory that comes with the system. 
Zenith has only put a GeForce 7300SE 
on this system which isn’t a lot for a 
system of this kind. 

The layout inside is neat, the case is 
spacious but the only issue is the noisy 
case. The power supply fan in our case 
was creating a constant low hum. The 
keyboard is simple without any special 
ergonomic designs and the mouse too is 
standard. The Zenith Premium PC was the 
only one to come with a 22-inch screen. 

The performance was where the Zenith 
stood out the most. The quad core proces-
sor is great for rendering and the amount 
of memory did too. Cinebench scores were 
the second best of all the desktops behind 
the Dell OptiPlex. It also did well in the 
game benchmarks where it topped in the 
Far Cry benchmark with 115 frames per 
second.

A dedicated graphics card would have 
done much more to the score and would 
be the component required to create a 
balanced setup for this configuration. At 
Rs. 42,500, it’s not very expensive and 
makes a good system to upgrade from. A 
GeForce 7300SE simply doesn’t cut it and 
replacing it with a faster graphics card 
would do wonders. It could then be used 
as a gaming desktop or even as a decent 
system for 3D modelers or any computer-
graphics artist for that matter.

Conclusion
Of the PCs we tested, we’ve seen everything 
from simple low-power desktops to high-

in between the function keys and the 
numerical pad. There isn’t any space left 
over to keep your palm on while typing. 
Some of the biggest annoyances are from 
the moving of the Insert key to the base 
of the keyboard and the backward slash 
key to the left bottom of the keyboard. The 
optical mouse is as tiny as a portable laptop 
mouse, is too light and shaped very oddly. 

This PC came preinstalled with 
Windows XP. We ran benchmarks on it but 
it didn’t product any spectacular score. 
The hard drive performance was the only 
respectable number of all the other scores. 
The performance is only so because of the 
configuration used. A 2.2 GHz Intel Core 
2 Duo E4500 is used alongside an i945GC 
chipset which isn’t particularly great for 
its graphics performance. The price for this 
PC is Rs. 24,900.

LG U8047-E0463 
LG isn’t known to be a PC brand. It is well 
known for its DVD drives and displays the 
most. LG’s desktops are sold to offices but 
they aren’t known to make enthusiast-level 
gaming rigs. We received two systems from 
LG. Both the LG PCs had similar configura-
tions. The larger oddly named the U8047-
E0463 comes with a larger 19-inch screen. 
There isn’t a lot that makes this PC stand 
out.

The configuration is 

pretty similar to the other LG. The Intel 
Core 2 Duo E7200 with two gigabytes of 
memory can handle most applications 
easily. Gaming might not be the thing 
to do with the underpowered Intel G31 
chipset’s graphics solution. 

In benchmarks, the U8047-E0463 
performs very close to the D6047-E0381 
across all the benchmarks except the 
memory bandwidth and file transfer tests. 
The game benchmarks show small changes 
as well. The effects of the lack of memory 
are even more visible as memory is allo-
cated by the system for the graphics accel-
erator. The pricing of this model is similar 
to the HP Pavilion A6740. The HP is Rs. 1300 
more than the LG but also comes with a 
slightly processor which makes it a little 
faster as well.

LG D6047-E0381 
For most offices, the need is of a basic every 

amount of HP software that comes along 
with the PC. It seems excessive and 
although it might be useful for a few, it’s 
the cause of most of the PC’s slowdown. 
With the software removed, we proceeded 
to the tests. The Pavilion we received came 
set up with a 2.66 GHz Intel Core 2 Duo 
E2200, 2 GB of DDR2 RAM all running on a 
slightly older nForce 630i platform. 

The setup performs well throughout 
the tests. The superiority of the nForce 
chipsets once again boost the game bench-
mark scores. The Pavilion A6740 is able to 
run Far Cry at around 84 frames per second 
at a resolution of 640 x 480 at minimum 
details. Doom 3 scored 22.6 frames per 
second at 800 x 600 with medium qual-
ity. The fast dual-core processor also gets 
a good score in the Cinebench rendering 
test. 

The HP Pavilion A6740 sells for Rs. 
38,700 which for the performance it 
provides isn’t too shabby a price tag. Those 
who want a desktop PC for home use 
should consider this. It’s more than suffi-
cient performance for desktop applications 
and it can also be used for some basic 
gaming.

Intex Platinum PM 45431
We received one of Intex’s desktops targeted 
at the entry-level home user called the 
Intex Platinum PM 45431. The desktop 
comes with a 19-inch display, a standard 
keyboard and mouse and a USB-powered 
set of speakers that sit flat on the table. 

The case is a standard mid-sized 
tower. Externally, the case looks good in 
features and appearance as well. There is 
space for two optical drives. The case has a 
cover over the drive bay which folds open 
when the drive is ejected. The memory 
card reader is left open and has no cover 
so dust will get in. The cabinet panels are 
all really thin and very flexible. 

The cabinet will get a bit noisy 
over time from the vibrations from the 
throttling fans and drives as the side 
panels are really thin and flex when 
you move them around or put any pres-
sure on them. The cables aren’t tied up as 
neatly as with some of the other PCs and 
the cables were left hanging over the CPU 
fan region. A scoop hangs over from the 
side panel on top of the processor fan. Like 
some other manufacturers, there is some 
glue stuck to the drive screws. This glue 
has been splattered on shabbily. The power 
supply cables too feel flimsy and thin. This 
is another PC to come with a LPT port and 
a serial port. 

The display is simple but looks pretty 
good. It is an average performer. The only 
real complaint is the center button which 
is used to interface with the menus and 
also acts as the primary power button. It 
feels weak and is most likely to break or 
stop work if you use it a lot.

The keyboard and mouse are the other 
two main issues. The keyboard is an inch or 
so smaller than some of the other desktop 
PCs which might seem unnecessary. This 
has been done by getting rid of the spaces 

LG U8047-E0463 

Desktops from LG
LG is getting into the Desktop 
PC market with a manufacturing 
plant at Noida. 
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Brand Acer Acer Acer Dell                 HCL
Model Aspire IE-3222P Aspire NX4440 Entra E961 OptiPlex 960    Ezeebee MAX XP P999

Price (Rupees) 28,999 29,299 23,099 58,000 19,999
Grand Total (Out of 100) 48.63 55.43 42.43 69.02 26.29
Features (Out of 40) 22.92 21.04 19.52 21.48 15.12
Performance (Out of 60) 25.71 34.39 22.91 47.54 11.17
Processor Model No / Speed Intel Dual Core E2220 / 

2.4GHz
AMD Athlon 64 X2 5000+ 
/ 2.6GHz

AMD Athlon LE-1620 / 
2.4GHz

Intel Core 2 Quad Q9550 
/ 2.83GHz

Intel Atom N230 / 1.6GHz

RAM (MB) / Type / Speed (MHz) 2048 / DDR2 / 667 1024  / DDR2 / 667 1024 / DDR2 / 667 8192 / DDR2 / 667 1024 / DDR2 / 533
Chipset Intel i945G NVIDIA GeForce 8200 nForce 430 NA Intel i945G
Graphics Chipset Intel 82945G NVIDIA GeForce 8200 nForce 6100 Intel GMA 950 Intel 82945G
Audio Solution Realtek ALC883 Realtek ALC888 Realtek ALC888 NA Realtek ALC662
HDD Size unformatted (GB) 320 320 160 160 GB x2 (RAID) 160
Screen (Inches) / Aspect Ratio / 
Resolution (Native)

19 / 16:9 / 1366 x 768 19 / 16:9 / 1366 x 768 19 / 16:9 / 1366 x 768 NA 19 / 16:10 / 1440x900

Upgradeability
Memory (no of slots) 2 2 4 4 1
HDD (No of SATA Ports) 4 2 4 3 2
No of additional ODD Bays 2 1 2 1 (Slim drive) 2
PCI Express x16 Slot (Y/N) / No of PCI 
Slots / Others

 / 2 / (1 PCI-E x1)  / 1  / 1 / (2 PCI-E x1)  / 1 / (2 PCI-E x1)  / 1

Specifications & General Features
No of Ports (USB (Front+rear) / 
FireWire)

8 / 0 10 / 1 6 / 0 8 / 1 (E-SATA) 6 / 0

Audio (Coaxial / SPDIF / N)  /  /  /  /  / 
Video Connectivity (VGA / DVI / TV-
Out)

 /  /  /  /  (HDMI)  /  /  /  /  / 
(1 DisplayPort)

 /  / 

Memory Card Reader (Y/N) / Types 
of Cards

 / All

Performance
Synthetic Scores
PC Mark 2005 (Overall Marks) 4375 4538 3038 7143 1631
CPU 5782 5160 3365 9036 1498
Memory 4468 3888 3956 5800 2416
Graphics 1197 1663 1162 3342 739
HDD 6002 6525 5601 5835 4880
SiSoft Sandra 2008
CPU Arithmetic (Dhrystone) / 
(Whetstone)

22025 / 15239 17032 / 15683 8707 / 7292 52248 / 41643 4045 / 3326

CPU Multimedia (Integer) / (Floating) 132375 / 72038 49139 / 54041 22103 / 25038 311503 / 170604 29431 / 19905
HDD (Drive Index) 68 / 7 67 / 6 58 / 19 61 / 16 55 / 15
Memory Bandwidth (Integer) / 
(Floating)

3884 / 3884 4730 / 4769 4639 / 4588 6142 / 6142 2761 / 2399

3D Mark 2005 Score 648 1537 817 1809 246
3D Mark 2005 CPU Score 5484 8766 6613 10598 1632
Real World Tests
Cinebench Rendering 4193 4028 2039 11137 842
WinRAR File Compression (kB/s) 635 864 568 1505 357
1 GB File Transfer test (seconds) 35 39 53 16 142
Doom (fps) (800x600, medium detail) 11 35.7 18 18.1 5.2
Farcry (fps) (640x480, minimum 
detail)

28.22 102.82 71.37 60.6 6.98

  
Desktop PCs

M A R C H  2 0 0 9 M A R C H  2 0 0 9

end business desktops. The most striking 
desktop of them all was the Dell OptiPlex 
960 which also wins the Best Overall 
Performer. Even with the limited space, 
Dell has got out an overpowered office PC 
that is practical. Price? Rs 58,000 – it seems 
like a mighty lot for a desktop PC with no 
screen but that really is as much perfor-
mance as you can get within that space. For 
those who price of the PC is no issue, then 
the Dell works fine.

For those who don’t see the need 
for something as powerful instead some-
thing that gets you features and decent 
performance at a reasonable price, there 
is the Acer Aspire NX4440 which becomes 
our Best Buy winner. At Rs. 29,299, it’s 
priced at around half the price as the 
Dell. It manages to score reasonable scores 
throughout the synthetic tests. In the real 

world tests of games, it pushes away from 
the other PCs. It also happens to be one of 
the PCs that has HDMI connectivity and 
can play back HD content good enough 
to be viewed on a large TV. If looked at in 
that way, it makes a good HTPC solution. 
Adding a gigabyte of memory will only 
make things even better.

Asus Eee Box 
The smallest and most eco-
friendly desktop in the world 
runs on an Atom and has 
Xandros installed by default. 
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HCL HP Intex LG LG Zenith
Ezeebee UP Z811 C2D Pavilion A6740 Platinum PM 45431 D6047-E0381 U8047-E0463 Premium PC Q6600

27,999 38,700 24,900 27,808 37,400 42,500
50.56 55.73 42.11 46.09 51.43 67.23
21.36 22.56 20.84 18.96 22.8 26.4
29.20 33.17 21.27 27.13 28.63 40.83
Intel Core 2 Duo E7400 
/ 2.8GHz

Intel Core 2 Duo E7300 / 
2.66GHz

Intel Core 2 Duo E4500 
/ 2.2GHz

Intel Core 2 Duo E7200 / 
2.53GHz

Intel Core 2 Duo E7200 / 
2.53GHz

Intel Core 2 Quad Q6600 / 2.4GHz

2048 / DDR2 / 667 2048 / DDR2 / 800 1024 / DDR2 / 667 1024 / DDR2 / 667 2048 / DDR2 / 667 8192 / DDR2 / 667
Intel G31 nForce 630i Intel i945GC Intel G31 Intel G31 Intel Q35
Intel GMA 3100 nForce 7100 Intel GMA 950 Intel GMA 3100 Intel GMA 3100 GeForce 7300SE / 256 MB
Realtek ALC883 Realtek ALC888 Realtek ALC888 Realtek ALC888 Realtek ALC888 Realtek ALC883
320 320 250 250 320 500
19 / 16:10 / 1440x900 19 / 16:10 / 1440x900 19 / 16:10 / 1440x900 17 / 4:3 / 1280 x 1024 19 / 16:10 / 1440x900 22 / 16:10 / 1680x1050

2 2 2 2 2 4
2 4 4 4 4 6
1 2 2 2 2 2

 / 2  / 1 (2 PCI-E x1)  / 2 (1 PCI-E x1)   / 2 / (1 PCI-E x1)   / 2 / (1 PCI-E x1)   / 2 / (1 PCI-E x1)

6 / 0 4 / 1 6 / 0 6 / 0 6 / 0 6 / 1

 /  /  /  /  /  / 
 /  /  /  /  /  /  /  /  /  /  /  / 

 / All  / All  / All

4470 5577 3654 4769 4791 5815
6217 6441 4131 6340 6378 7673
5357 5200 3958 4675 4997 4918
1370 1934 1163 1468 1559 1863
6506 5372 6335 5783 6044 5208

17233 / 13724 24778 / 19608 20160 / 14084 23319 / 18595 23337 / 18514 43691 / 30980

102864 / 56246 147156 / 80389 112725 / 55319 139637 / 76282 139747 / 73323 2648715 / 144069
83 / 8 84 / 16 72 / 16 74 / 6 91 / 8 54 / 14
5289 / 5252 4885 / 4923 3512 / 3541 4214 / 4242 5060 / 5047 4855 / 4872

795 1105 472 599 751 1184
6672 9438 4083 5270 6682 14225

5675 5512 3362 5188 5204 8589
734 737 550 909 680 1254
36 38 48 54.2 37 42
18.1 22.6 10.2 11.8 13.7 31.8
26.06 84.53 21.65 28.52 29.9 115.18

Contact Phone E-mail Web site
Acer India Pvt. Ltd. 080-40708747 ganaraj.kamath@acer.co.in www.acer.co.in
Dell India 18004254026 dell_enquiries@dell.com www.dell.co.in
HCL Infosystems Ltd 9818989875  product.lab@hcl.in www.hclstore.in
Hewlett Packard 0124-2566111 - www.hp.com/in
Intex Technologies (India) Ltd 1800116789 info@intextechnologies.com www.intextechnologies.com
LG Electronics India Pvt. Ltd. 0120-2560900 AjaySurjan@lgindia.com www.lgindia.com
Zenith Computers Limited 1800222004  info@zenith-india.com www.zenithpc.com

 Contact Sheet        Desktop PC Comparison Test
Of the mid-towers, the HP Pavilion 

A6740 is one to go for if you want a big 
sized home PC that you would want to 
upgrade in the future. If you can shell 
out a little more money, then the Zenith 
Premium PC with its quad-core processor 
should be considered. There is the space 
required to add a better graphics. With 
a few changes to that system, it can be a 
decent choice once you feel the gaming 
performance isn’t upto the mark. 

rossi.fernandes@thinkdigit.com

Made in India 
HCL has released a range of 
desktops designed by the 
students of NID (National 
Institute of Design.)
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Nokia Music Store
Nokia to launch its own music 
store in India to compete against 
iTunes Store by Apple 

Groove on the go
Need something compact for music and little else? 

Your search ends here

Michael Browne

T
he little MP3 player of yesteryear 
has become a converged device 
today that we refer to as a PMP 
or portable multimedia player. 

PMPs represent a conglomerate of features 
– some used often and others seldom 
touched. The simple principle behind 
developing the PMP was the need for 
an all-in-one device that converged the 
most widely used feature sets. At its most 
basic, a PMP is an MP3 player. Well, to be 
precise, a music player, since most PMPs 
play several audio formats in addition to 
MP3. But there are other features that 
people would want from such a device. 
One reason for this is that nobody wants to 
carry around multiple devices for specific, 
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individual tasks. Therefore, players with 
larger screens for watching movies are 
more or less out. While such players often 
end up being jacks-of-all-trades, there are 
some that manage to master a few.

Some people need something basic 
that just plays music. For others, compact-
ness is a more important criterion for a 
PMP than its feature set. In fact, some 
people don’t even require a screen. On 
board a dusty bus, or a crowded local, all 
they need is something that plays music 
with decent quality or maybe a device that 
allows them to tune in to their favourite 
FM radio station. For others, it’s the all-
important price that motivates them to 
choose a basic PMP rather than something 
with fancy features. If you fit into any of 
the above target audiences, then this test 

was designed with you in mind and tasked 
with providing you a fit solution.

Many people want good audio quality 
and are afraid to look at lower-end PMPs for 
fear that a reduction in the feature set (and 
hence price tag) also brings about a reduc-
tion in quality. If this test taught us one 
thing, it was that the above assumption is 
totally false. Sure, the analogy of paying 
for what you get, does hold good. However, 
there is no hard-and-fast rule that a PMP 
with a large screen and a price tag of Rs. 
8,000 would outperform a really compact 
PMP without a screen that costs Rs. 3,000. 
Another preconception that many people 
have is that a bigger brand equals a better 
product. While this rule of thumb may 
hold good 80 per cent of the time since 
bigger companies do have more resources 



TRIED & TESTED
www.thinkdigit.com/1234 for the full 
testing story
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Saehan’s MPMan
was the world’s fi rst mass-
produced hardware MP3 player.  

little less proportionately and get a video-
based PMP that brings more of a feature 
set to the party.

This is also one of the most important 
categories in terms of consumers because 
90 per cent of shoppers looking for a PMP 
will be looking to spend no more than 
this amount. Features become a premium, 
as does storage space when constrained 
by a budget of not more than Rs 5,000. 
Everybody wants more inbuilt memory, 
but not everybody will actually be using 
the extra space. For example, many people 
buy a PMP with 4 GB of memory and then 
promptly use it for storing some 50-odd 
favourite tracks and move on to using the 
FM radio component the most. That way, 
approximately 3.5 GB of extra space is 
wasted. Other people choose to purchase 
a PMP with a screen, when they only use 
the player for audio playback and a screen 
is not required. Obviously, purchasing is a 
decision best left to the one parting with 
the funds, but all we’re saying is to buy 
what you need and do not splurge need-
lessly.

Features
The tiniest player in this category is Apple’s 
iPod Shuffle. It’s very well built with an all 
aluminium outer body that is available in a 
number of tasteful colours. Some may find 
electric pink and sea blue gaudy, but we 

available for research and development, 
this does not hold true all the time. You can 
also get multiple products with immensely 
variable feature sets for the same price, 
which further adds to the confusion. For 
example, a compact PMP from a large 
brand without any sort of display might 
be available at the same price point as 
a product from a smaller, lesser-known 
manufacturer that can play videos and has 
a two-inch display for the same. Now where 
do you invest your money? Hopefully, by 
the time you’re done reading this test, you 
won’t be confused.

PMPs up to Rs. 5,000: a 
diverse bunch
When we look at this category, the first 
thing that comes to mind is diversity. Some 
of these players had very tiny, single-colour 
displays, while others had much larger 
displays capable of being used as video 
PMPs albeit without the joy that comes 
from watching movies on a larger screen 
like the screen on the Cowon Q5W; which 
at five inches is one of the largest screens 
ever to grace a PMP. One of the PMPs in 
this category had no display at all. That’s 
diversity for you. The divide seemed to 
be the brand name. Bigger brands (typi-
cally) charge more for their products and 
as such most of the PMPs from larger 
brands had fewer features for the price. 
While talking about basic music capable 
PMPs, even a screen can be considered 
a “feature”, because it’s not necessarily 
required for audio playback. Therefore, the 
binary choice available here seems to be 
between paying extra for a more reputed 
brand and making do with a very cursory 
display unit (or no display at all) or pay a 

Creative Zen Stone Plus

like it. These colours are very understand-
able for a product mainly aimed at college 
kids and those looking for something really 
funky looking. To save on space the Shuffle 
doesn’t even have a display. What it does 
have are very clear and easy-to-use controls. 
The four buttons for volume up / down and 
next / previous track are shaped to form a 
circle with the large play / pause button in 
the centre of it. The layout of these buttons 

Philips GoGear SA2825

We divided our test candidates into two categories on the basis of their all-important 
price. The first category consisted of PMPs priced up to Rs. 5,000. The second category 

consisted of PMPs priced above Rs. 5,000. Since we were only interested in the players’ capa-
bilities at audio playback, we discounted the presence of any sort of screen. Screen quality 
along with any other display-related parameters were only logged and not taken into account 
when computing results for a winner. We took special note of memory upgradeability, pres-
ence of customisable equalisers and integrated FM radio.

Our reference system’s source was an iPod Touch 16 GB with files encoded in the Apple 
lossless audio codec (ALAC) format. We used a Little Dot Micro Tube hybrid headphone ampli-
fier along with Grado’s SR 225 and Audio Technica’s ATH A900 headphones. The A900 is known 
for its vast sound stage, slightly laid back presentation and its thundering bass along with a 
slightly revealing top-end. The Grado SR 225, on the other hand, has a very forward sound 
that places you right up to the music, something like a front row seat. It is also endowed with 
good bass, an excellent and very open mid-range and a treble that is both very revealing and 
extends well into the upper echelons of the audible sonic spectrum. Together with the head 
amp, these headphones give a very unbiased, audiophile-grade look at the performance of 
these PMPs. We also used bundled earphones with these players and their performance was 
rated against the performance of PMPs with respect to our reference headphones.

For our performance testing, we used MP3 files encoded at very high quality settings, at a 
bit-rate of 320 KBps keeping the bit-rate constant. These files were a mix of tracks from differ-
ent genres, each of them testing different aspects of the audible sonic spectrum. Metallica’s 
~Unforgiven 2~ is a good track to test a PMP’s performance in complex passages. It is also a 
guitar-and-drum heavy track that also tests the mid-range while emphasising drum and bass. 
Additionally, male vocals are tested. Dire Straits’ ~Private Investigation~ tests mainly the 
mid-range with particular emphasis on lead and rhythm guitar. It tests for tonal accuracy of 
guitar notes and the very texture of the notes themselves. Pink Floyd’s ~Money~ is one track 
that tests instruments and sound staging in addition to sound panning. The Corrs’ rendition 
of R.E.M’s ~Everybody Hurts~ is a beautiful test of female vocals as Andrea Corr is one of the 
better female vocalists around. ~Knockin on Heaven’s Door~ by Eric Clapton does more test-
ing of male vocals and guitar rendition. It has a lot of delicate finger plucks and some very 
articulate notes and we have checked for any sort of sound aberration.

  How We Tested
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Test
Sounds bad, smells great 
to put MP3 Player along with portable 
speakers in their perfume bottles.

is perfect and are very large and intuitive. 
Suiting its ultra-compact status, the Shuffle 
comes with a belt clip that has a good 
spring that grips well.

Creative’s Zen Stone Plus is the next of 
the really tiny players. It’s about the same 
footprint as the Shuffle, but a little thicker 
and marginally longer. Creative goes one 
step further and provides the Zen Stone 
Plus with a single-colour OLED display. 
This is a boon for those storing extra music 
as you can tell what exactly is playing, or 
which track is next without actually having 
to listen in. This PMP is very solidly built 
and has a loudspeaker as well. Creative 
has got the controls right and although 
they aren’t as good, in terms of feedback, 
as Apple’s controls, they are very well laid 
out and very intuitive to use. The ergonom-
ics are top class. Unlike the Shuffle, the 
Zen Stone Plus uses an all-plastic body, but 
finished in matte texture tones. The qual-
ity of plastics used seems very good and 
in testament to this, the Zen Stone Plus 
survived (unscathed) a rather nasty drop 
that occurred during a photo shoot session, 
where it fell while running from a height 
of eight feet.

Philips’ GoGear SA2825 was one of the 
more novel designs that we’ve seen. The 
body is finished in burnished chrome that 
looks like a metallic, mirror finish, similar 
to the finish LG uses on some of its cell 
phones. It’s got a small OLED display, which 
is covered by a transparent plastic shell. 
Initially, this shell seemed to fit the player 
rather loosely and we were wondering if 
it was removable. We figured out that the 
shell was a large clickable button with four 
functions, similar to 4-way joypad keys on 
cell phones. The screen is reasonably clear, 
more so than the display on the Zen Stone 
Plus, and the square-shaped player with 
slightly rounded edges looks really neat. 

The other two players in this category 

are from Mitashi. The cheaper of the two is 
the KNM-2GB that has a really neat looking 
red-backlit, touch-sensitive array of buttons 
on the front. It’s got a decent LCD display 
that measures two inches diagonally. The 
player itself is built pretty well and looks 
decent with an entire black body. The 
front is a smooth piano finish, while the 
rear makes do with a slightly more rugged 
looking matte finish. Using this player can 
be a pain because the indicated controls 
for the buttons are not very intuitive and 
we found that we could not perform some 
very common tasks without referring 
to the manual. For example, the middle 
button will play a highlighted song, but 
will not pause the track. The pause button 
is located towards the side of the device. 
Furthermore, if you’ve played a track, and 
then navigate to the track listing, and then 
press the “Pause” button, you are asked 
whether you want to delete the song from 
the track list, instead of pausing the the 
song that’s playing like you’d expect. Such 
goof-ups are unforgivable, but should be 
rectifiable via firmware upgrades, which 
we hope will happen very soon. 

The other PMP from Mitashi is the 

Term Description

Tonal Balance Degree to which one aspect (read frequency range) of the sonic spectrum 
is emphasised above the rest

Brightness A sound that emphasises on the higher frequencies i.e. lower treble or 
higher mid-range or more

Congested Smeared, confusing and flat sounding, total absence of soundstage

Crisp Extended high frequencies, especially cymbals

Detailed Reproduction of sound where it is easy to hear minute details and 
nuances

Mid-Range Audio frequency between 250 Hz and 6000 Hz

Punchy Good dynamics with strong impact. Typically, used to signify good bass

Soundstage The area between the left and right channel (or two speakers) that 
appears to the listener to be occupied by sonic images, similar to a stage 
concert where different sounds come from different instruments that are 
placed in different locations. 

Test

MWI-4GA, which boasts of a 2.4-inch LCD 
display  – the largest display from among 
the PMPs in our test. It’s a little thick for 
our tastes, but not enough to call it bulky. 
The entire body is chromed and this is 
relieved only by the black-coloured eyelet 
provided on the top, presumably to strap it 
to your belt or wrist. There’s a loudspeaker 
vent on the rear. Its buttons are positioned 
to the right side which is inconvenient. Not 
only is feedback absent, but the buttons 
are so recessed into the player that they are 
actually hard to press — we found ourselves 
using our nails solely for the purpose of 
skipping a track, or pausing playback or 
other common tasks. After a while, your 
nails begin to hurt from the pressure of 
using the keys – unforgivable design goof-
ups! While still on design flaws, how about 
the absence of a 3.5-mm stereo jack? The 
MWI-4GA uses a rare 2.5-mm jack that 
we’re used to seeing in budget CDMA hand-
sets and this, perhaps, is a more unforgiv-
able blunder than the previous one.

Performance
When it comes to performance, none 
of the other three PMPs can really hold 
a candle to Apple’s tiny Shuffle or 
Creative’s Zen Stone Plus. This does prove 
our theory that a bigger, costlier player 
with a display unit does not necessar-
ily equal unbeatable sonic performance. 
Both these PMPs leave the others far 
behind in terms of overall music quality 
and the difference is so noticeable that 
one did not need the much acclaimed 
“golden ears” to spot the differences. 
Both these players do well with the highs, 
but we noticed a bit of extra treble that 
could be termed as both brightness when 

Apple iPod Shuffle

Mitashi KNM 2GB
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ibly slim. It’s got a sleek contoured design 
and the sides are completely rounded. 

In fact, the entire player is gently 
curved and even the screen is not flat but 
mildly concave. It has a crystal clear display, 
with very crisp text and video display capa-
bilities, despite being all of two inches. The 
click wheel is typically Apple and works 
flawlessly with very even tracking. Menus 
are well laid out and the new Nano has an 
inbuilt accelerometer (gyroscope) meaning 
the display changes orientation according 
to the viewing angle. 

The Sony NWZ-E436F is a very solid 
looking PMP as thin as the Nano. Its in-
hand feel is even sturdier than the Nano, 
probably because it’s smaller but also 
because it feels somehow denser in the 
hand. The finish is brushed aluminium 
and Sony has used some bright colours. 
The display of this unit is its highlight – it’s 
amazingly clear and although measuring 
only two inches, text is very readable. Both 
these display units are said to use white-
LED LCDs and the world of difference this 
makes to the colours and the contrast leads 
us to conclude that every manufacturer 
should dump the old CCFL LCD displays 
and jump on to the white-LED bandwagon. 

Although the Sony NWZ-E436F’s 
buttons are very small, they are ultra-
usable and laid out really well. Even the 
tiny volume up / down buttons retain 
100 per cent of their usability despite 
being half the size of those on the Mitashi 
MWI-4GA. If you have larger fingers, you’ll 
have no ergonomic issues. Kudos to Sony’s 
development teams for designing these 
devices so intelligently.

The other two players were from 
SanDisk. Fuze, from SanDisk, is square in 

know exactly what they want. Obviously, 
there is no upper end to this category, save 
the one stipulation we had that each player 
had to be below a certain pre-defined size 
and weight limit. Therefore, larger, feature-
rich and performance-heavy PMPs such 
as the iPod Touch and the iPod Classic, 
not to mention Cowon’s excellent D2 and 
Q5W, were prevented from spoiling the 
minnows’ party here. 

We’ll be testing larger PMPs, including 
video-based PMPs and the high-capacity, 
bulky hard drive-based offerings later this 
year, but we wanted to see if one could 
spend upwards of Rs. 5,000 and still get 
something that was relatively compact. We 
also wanted to see if there existed a large 
divide in terms of audio performance of 
PMPs across both categories.

It’s difficult to define what someone 
buying a PMP for more than Rs. 5,000 
expects for their money. To some, it may 
mean a large screen. To others, it may 
represent something that is sturdily built 
and does not compromise on audio quality 
one little bit. Obviously, style also matters 
and one expects a better grade finish, 
colour options, more memory and maybe 
some more functions such as an alarm, 
calendar, e-book reader and so on. 

Someone shopping for a serious PMP 
would also look at storage size and the 
presence of expandable memory options. 
With the price of MMC/SD cards falling to 
throw-away values due to dirt-cheap flash 
memory prices, even 16 GB SD cards are 
now readily available and more affordable.

Features
If anything, all four test candidates in this 
category were similar to each other when 
compared to the cheaper PMPs. Apple’s 
iPod Nano was the longest in terms of 
dimensions, but in its defence it is incred-

TRIED & TESTED
www.thinkdigit.com/1234 for the full 
testing story

Sony NWZ-E436F

the music was playing and sibilance with 
some female vocals, particularly on the 
higher notes. The mid-range is sweet 
– clear, precise and with barely a hint of 
being recessed. The bass is punchy and 
extends pretty low. 

Overall, the mid-range is where most 
of the action takes place and both these 
PMPs should be considered for classical 
and country music buffs where the mid-
range and lower highs are really well 
rendered. While channel separation is 
good on both these PMPs, it’s the Creative 
Zen Stone that gets the nod over the 
Shuffle for panning sounds. Therefore 
this player has a much more accurate and 
wider sound stage. However, for the sheer 
enjoyment or reproduction of most types 
of music, the iPod Shuffle is better than 
the Creative Zen Stone Plus.

Although it does not handle complex 
passages well and things get a little 
muddled at the top, the Philips GoGear 
SA2825 also did reasonably well. The 
bass is not as punchy as the leaders 
of the pack, neither is the mid-range 
well presented. Both the Mitashi players 
were not really bad. In particular, the 
MWI-4GA sounds good on its bundled 
earphones. The only disappointment 
was the absence of a 3.5-mm jack. The 
only issues we found on both these PMPs 
in terms of audio quality was that the 
bass, while boomy, was not focussed and 
rather slightly f labby. The mid-range 
was also recessed while the treble has a 
little extra sparkle that comes from an 
unfocussed top-end.

PMPs above Rs. 5,000: 
Sight with sound
When somebody spends upwards of
Rs. 5,000 on a PMP, chances are they either 
have a good bit of cash to spend, or really 

Mitashi MWI-4GA

Gone in a Flash
Apple is hoarding almost all the 
fl ash memory being produced to 
meet expected demands 
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MP3 Players

PMPs up to Rs 5,000
Brand Philips Creative Apple Mitashi                      Mitashi
Model No GoGear SA2825 Zen Stone Plus Ipod Shuffle KNM-2GB                     MWI-4GA

Price (Rs) 2,999 3,499 3,700 4,290 4,990
Plus (+) Really Compact Compact, great sound Ultra compact, great 

sound
Touch controls Large Screen, good music 

quality
Minus (-) Clicks not intuitive Slightly thick None in particular Quality of earphones Tacky buttons
Grand Totals (Out of 100) 58.69 64.26 40.75 65.75 60.97
Features (Out of 50) 29.50 29.90 6.00 38.00 38.00
Performance (Out of 50) 29.19 34.36 34.75 27.75 22.97
Features

Capacity 2 GB 2 GB 2 GB 2 GB 4 GB
Display Type OLED OLED NA LCD LCD
No of colours displayed onscreen Monochrome 1 (Blue) NA 262000 262000
Size of Display 1.8-inches 1-inch NA 2.4-inches 2.4-inches
Type of Battery Lithium Ion Lithium Ion Lithium Ion Lithium Ion Lithium Ion
Weight of Device (gms) 29 grams 30 grams 15.5 grams 60 grams 70 grams
Firmware Upgradeable (Y/N)
Memory Upgradeable (Y/N)
Type of upgradeable memory NA NA NA microSD SD / MMC
FM Radio Tuner (Y/N)
Voice Recording (Y/N)
Audio Formats supported MP3, WAV, WMA MP3, WMA AAC, AAC+, MP3, WAV MP3, WMA MP3, WMA
Photo Viewing (Y/N) NA
Supported Image Formats NA JPEG JPEG
Video Playback (Y/N) NA
Video Formats supported NA AVI AVI, MPEG-4
Screen Brightness adjust (Y/N) NA
Screen Orientation Sensor (Y/N) NA
Built-in Speakers (Y/N)
No of Preset Modes 7 5 0 6 7
Customisable Equaliser (Y/N) NA
Point A to B Track Repeat (Y/N)
Custom Playlist saving (Y/N)  (via PC connect)  (via PC connect)  (via PC connect)  (via PC connect)
Folder Creation (Y/N)  (via PC connect)  (via PC connect)  (via PC connect)  (via PC connect)
Audio File Transfer (Sync/Copy) Copy Copy Sync only Copy Copy
Use as Portable Drive (Y/N)
Colour Options Silver Black, Blue, Pink, Silver Silver, Pink, Blue, Red, 

Green
Black Chrome

Miscellaneous Features
Built-in Calendar
Built-in Contacts
Built-in Stopwatch
Built-in Alarm
Bundled Software NA NA NA NA NA
Bundled Accessories Neck strap, data cable, 

charger
data cable Neck strap, data cable, 

charger
Charger, USB cable Strap, data cable

Additional Features (If any) NA NA NA E-book reader E-book reader
Performance

Music Performance (Out of 10)
Metallica — Unforgiven 2 6 7 7.25 6.5 6.5
Dire Straits — Private Investigation 7 8 8 7 7
Pink Floyd — Money 6.5 7.5 7.25 6.5 6.75
The Corrs — Everybody Hurts 7 8.25 7.75 7.25 7
Eric Clapton — Knockin on
Heavens Door

7 7 7.75 7 6.5

Bundled Earphone Quality (On 10) 5.75 6 5.75 4 5.75
Transfer Rate (MBps) 0.96 2.94 3.89 1.36 0.92
Battery Life (Actual Tested hrs and min) 9.29 14.31 14.15 8.46 9.23

Test

Android gains ground
The next generation of Archos 
PMPs will work on 
Google’s Android platform
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PMPs above Rs 5,000
Sony SanDisk SanDisk Apple

NWZ-E436F Sansa Fuze Sansa Fuze iPod Nano 4G

6,490 6,890 8,999 9,700
Well Built, good sound Great Features, well built Features, Great sound Good screen, Great sound

Quality of bundled earphones None in Particular No feedback on clickwheel Sibilant highs
60.79 76.41 76.75 56.94
28.90 38.90 38.90 20.10
31.89 37.51 37.85 36.84

4 GB 4 GB 8 GB 8 GB
LCD LCD LCD LCD
262000 262000 262000 262000
2-inches 1.9-inches 1.9-inches 2-inches
Lithium Ion Lithium Ion Lithium Ion Lithium Ion
50 grams 60 grams 60 grams 36.8 grams

NA microSD microSD NA

MP3, WMA, AAC-LC1, Linear PCM MP3, OGG, FLAC, WMA, WAV, Audible MP3, OGG, FLAC, WMA, WAV, Audible AAC, AAC+, MP3, WAV

JPEG JPEG JPEG JPEG

AVC, WMV, MPEG-4 MPEG-4, AVI MPEG-4, AVI H264, AVI, MP4, .MOV

5 10 10 22
 (2 custom settings)

 (via PC connect)  (via PC connect)  (via PC connect)  (via PC connect)
 (via PC connect)  (via PC connect)  (via PC connect)  (via PC connect)

Copy Copy Copy Sync only

Black, Red, Pink, Blue Red, Black, Pink, Navy Grey 9 colours (Silver, Grey, Purple, Green, Blue, 
Yellow, Orange, Red, Pink

NA NA NA NA
Data Cable, dock Strap, Data Cable Strap, Data Cable Data Cable

NA NA NA Contacts, Notes

6.25 7.75 7.75 7.5
7 8 8 8
6 8 8 7.75
7 8 8 7.5
6.75 7.5 7.5 8.25

6.5 6.25 6.25 5.75
3.11 3.94 4.11 3.45
13.2 20.18 21.2 21.51

TRIED & TESTED
You can fi nd more pictures of these 
PMPs at www.thinkdigit.com/March09/

Ogg left behind
Cowon is one of the few major 
MP3 players to support the free 
ogg format. 
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SanDisk Sansa Fuze 4 GB SanDisk Sansa Fuze 8 GB Apple iPod Nano

shape, but not as long as the iPod Nano. 
In fact, it resembles a squat looking device 
from the previous generation called the 
Nano 3G (the current generation being 
the Nano 4G). These players have mat 
rubberised finishes on the rear, while the 
front is finished with a smooth gloss. Both 
the front and the rear share common 
colours and makes the players look plain. 
The only attractive colour option is the 
grey that looks really chic, but this colour 
is available for the 8-GB version only. 

Fuze also uses the clickwheel-type 
design that Apple made famous. However, 
its clickwheel actually moves as you spin 
your finger, unlike the iPod that senses 
finger movements and jogs through the 
menu system while remaining stationary. 
The clickwheel on the Fuze is too sensitive 
in our collective opinion and it takes little 
for it to skip to the next function. 

In fact, navigating to the desired 
option can be tricky if you do not watch it 
carefully. A little more pressure will cause 
it to skip a couple of options and move on 
ahead. The Fuze is fully loaded with an FM 
Radio, video capabilities, besides reading e-
books and an in-built microphone to record 
audio. These players come with microSD 
expansion slots, so the ability to upgrade 
storage capacity is always present.

Performance
Both the SanDisk Sansa Fuze players are 
excellent performers. Initially, when we 
found the Apple players offering some-
what harsh and sibilant highs with the 
SR 225 headphones, we figured that it 
was because of their ruthlessly revealing 
nature. However, the highs are extended 

on the Fuze, but not harshly, nor is there 
any sibilance. Some may like this, some 
may want that extra bit of treble sparkle, 
but it’s a lot easier on one’s ears.

On the iPod Nano, the drum cymbals 
clinch our suspicion that this PMP has 
a slightly over emphasised top-end. 
However, the Nano’s mid-range perfor-
mance with vocals and guitar is impec-
cable. Fuze can be referred to as a more 
neutral option over the Nano. Bass repro-
duction on both these PMPs is similar. 
The Sony NWZ-E436F was in fact the 
only player that was not able to drive 
the Grados well enough. Guitar plucks 
seemed a little unfocussed and seemed 
to lack a proper rounded, musical feel to 
them. Although it gets the sound staging 
quite well, it loses out on picking up the 
finer sounds. It did perform well with 
its bundled earphones, but we didn’t 
find it as good. The major battle here 
was between Apple and SanDisk. SanDisk 
wins, although only by a very slight 
margin. We’re pretty surprised to see 
the sibilance rear its ugly head once too 
often for the Apple Nano, because this 
was not the case with the iPod Touch that 
was part of our reference system.

Guts and Glory:
Who won and why
The Best Performer award is a tie and 
goes to the duo from SanDisk. Both the 
Fuze 4 GB and its twin the Fuze 8 GB are 
simply the best all-round performers in 
this test. They beat the Apple iPod Nano 
4G by the slimmest of margins, but as 
the proverb goes – a miss is as good as a 

mile. The Best Value winner in our sub-
Rs. 5,000 category is the Creative Zen 
Stone Plus. At just Rs. 3,499, this player 
is superb value for money. It offers very 
good performance and the addition of 
a tiny screen is a plus for those manag-
ing multiple playlists. It’s also compact 
enough to fit almost any pocket incon-
spicuously. For those of you looking at 
really good performance, but not neces-
sarily 8 GB of storage space, we suggest 
the SanDisk Sansa Fuze 4 GB. This player 
is priced at Rs. 6,890, and frankly offers 
a load of features for the price. The fact 
that it jointly won the Best Performance 
award, too, and offers superlative battery 
life, is an added bonus.

If you’re looking for something with-
out a screen and ultra compact, then our 
hearty recommendations are with the 
Apple iPod Shuffle. For such a tiny player, 
it’s got superb sound quality. It is the best 
sounding PMP in the sub-Rs. 5,000 price 
bracket and lost out from getting our 
Best Buy recommendation only because 
it misses out on certain features. If you 
want something really cheap that has a 
large screen, but not necessarily the best 
screen, Mitashi’s MWI-4GA should satisfy. 
For the record, the Apple iPod Nano 4G 
has the best quality display from among 
all the participants (in this test) and is 
also one of the most attractive looking 
with several truly lively colour options. 
The brand value does not come cheap and 
we figure that for Rs. 9,700, this player is 
grossly overpriced. 

michael.browne@thinkdigit.com

Sales on the Apple iTunes store 

crossed 2 Billion songs in the 
second week of February. 
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N97
Nokia to launch N97 — the fi rst 
touch screen N-series phone in 
the fi rst half of 2009

NVIDIA’s latest card GTX 295 is a dual-
GPU monster based on the GTX-200 
GPU. Zotac has used NVIDIA’s refer-

ence design. 
This card is much heavier in compari-

son to the GTX 280 and the GTX 285 for 
that matter. Most of the air is pushed out 
using a large array of fins. 

This card does heat up as 
it has a lot running under its 
hood, surprisingly though it 
is not as noisy as expected. 

The reason why this card 
is the best is due to its perfor-
mance — what a performer it 
turned out to be. After testing 
this card with 3D Mark Vantage, we 
found it to be faster than the GTX 
285. However, this was expected as it 
has two GPUs instead of one. 

Since this is currently the best card 
available, until ATI has a trump card 
up its sleeve, it comes at a 
very high price. So if 
you have the 

m o n e y 
and you want 

the fastest 
graphics card in the 

world, then this is the one 
you need to get for yourself. 

Specifications:
 480 processor cores, 576 MHz engine clock, 
1242 MHz core clock, 1998 MHz memory clock, 
Dual 400 MHz RamDAC, 1792 MB GDDR3

 Ratings (on 10)
 Features: 8

 Performance: 8
 Build quality: 8
 Value for money: 7
 Overall: 8

Contact: ZOTAC International (MCO) Ltd. 
Phone: +91-11-4666 5666
Email: sales@zotac.com
Web site: www.zotac.com
Price: Rs. 35,555

Blackberry’s first touchscreen phone 
is christened the Storm. It has all 
the features you’d expect, coupled 

with all those that you’d expect to find in 
a BlackBerry.

The phone is sleek and smart, with 
a piano black finish and metallic lining 
around the body, while the battery 
cover has more of a matte finish to it. 
The volume buttons are on the right, 
between the 3.5-mm jack and the 
camera button. The charging port is 
also located on the right. 

The four buttons below the screen are 
ergonomically placed, and you will not 
find yourself accidently clicking the wrong 
one. The screen is 3.25 inches, and there 
seems to be a gap at the top. 

The touch keypad on 
this device is all worked 
on by tactile feedback. 
You can stick with the 
traditional keypad or 
turn the phone to type on 
a full QWERTY keypad. 
The phone is decently 
sturdy but when you tilt 
it slightly, you get to see 
how sensitive the accel-
erometer really is, which 
is another drawback of 
this phone.There are 
many rumours that the 
BlackBerry Storm is an 
iPhone killer — but it’s 
not. The main drawback 
of this phone is its perfor-
mance. The OS is slow, 
the phone lags when 
even trying to browse 

through the media gallery. 
Priced at Rs. 27,990, it’s an 
average phone that needs a 
lot of improvement. 

Specifications:
Dimensions: 112.5 x 62.2 x 13.95 
mm (L x W x H), Memory: 1 GB 
on-board memory, 128 MB flash 
memory, 3.5-mm stereo headset 
capable, Video format support: 
H.263, MPEG4 Part 2 Simple 
Profile, H.264, WMV, Audio for-
mat support: MP3, AAC, AAC+, 
eAAC+, WMA, WMA ProPlus

Ratings (on 10) 
Features: 7
Performance: 6
Build quality: 6.5
Value for money: 6.5
Overall: 6.5
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BlackBerry Storm
When will this Storm pass 

Zotac GTX 295
The champ is here

Razer’s Salmosa is an entry-level 
gaming mouse meant for good 
performance, yet being a practical 

mouse for everyday use. It’s not expensive 
by gaming standards either.

The mouse is slightly raised as to give 
you a better palm grip. The Salmosa is a 
three-button mouse without side buttons. 

However, we miss the side buttons or 
at least an on-the-fly button to change your 
sensitivity while playing. In fact, to change 
your settings you need to flip the mouse 
over, which means you actually have to stop 
gaming. If you really want to experience a 
Razer mouse, then the Salmosa is for you. 
If you’re the type of person who likes to try 

out all kinds of gaming mice, then this is 
another one to try. The Salmosa has a MRP 
of Rs. 1,999.

Specifications:
1800 dpi infrared sensor, 1000 Hz 
Ultra-polling / 1 ms response time, 
Approximate size: 115 x 63 x 37 mm (L x 
W x H) 

Ratings (on 10)
Features: 6.5
Performance: 7
Build quality: 6.5
Value for money: 6
Overall: 6.5

Contact: Netplace Technologies Pvt. Ltd
Phone: +91-22-4221 3901 / +91-22-4221 3951
Email: enquiry@netplacetechnologies.com
Web site: www.razerzone.com
Price: Rs. 1,999

Razer Salmosa
Gaming for beginners
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Palm Pre
The Palm Pre is rumoured to 
release on March 15th after it’s 
debut at CES 2009

Gigabyte’s GA-EP45-UD3P is based 
on the Intel P45 chipset, and is 
based on UD3. The PCBs used have 

improved heat conduction capabilities. 
This board also has two PCIex16 slots 

with CrossFireX capabilities. It also provides 
three PCIe x1 and two PCI slots.  

During our tests, including Maxon 
Cinebench R10 and SiSoft Sandra, it 
matched other P45 chipset-boards. 

The GA-EP45-UD3P board is great 
and has many features including the 
detailed BIOS designed for overclockers. 
The board is pretty decent in perfor-
mance, great on features but it’s a bit 
expensive at Rs 14,590. 

Specifications:
Intel P45 Express Chipset, Intel P45 
Northbridge, Intel ICH10R Southbridge, 4 
DDR2 SDRAM 240pin DIMM Sockets Supports 
DDR2-533/667/800 MHz, Supports up to 8 GB 
Total Memory (4x 2 GB)

 Ratings (on 10)
 Features: 8
 Performance: 7.5
 Build quality: 8
 Value for money: 6.5
 Overall: 7.5

Contact: GIGABYTE
Phone: +91-22-4063 3222

Email: viveks@gigabyte.in
Web site: www.gigabyte.in
Price: Rs. 14,590 

Gigabyte GA-EP45-UD3P
A new blue board

ASUS’ P5KPL-AM/PS is a mini — ATX 
board based on the G31 chipset. 

This board comes with only two 
memory slots, but can hold up to 4 GB of 
DDR2 RAM. It has two PCI slots, one PCIe 
X1 slot and even a single PCIe X16 slot. This 
motherboard also comes with the integrated 
Intel Graphics Media Accelerator — GMA 
3100. It has the Realtek ALC662 to support six 
channel High Definition audio. 

This board is not a high performer, 
nor is one of the best when it comes 
to overclocking and integrated graphics. 
However, the Southbridge tends to heat up 
quite a bit. This motherboard is not meant 
for gaming. If you want better perform-

ing integrated graphics motherboard, then 
you should opt for the GeForce 9300.

Specifications:
Supports Intel 45 nm multi-core processors, 
Northbridge: Intel G31, Southbridge: ICH7, 
FSB 1600(O.C.)/1333/1066/800 MHz, DDR2 

1066(O.C.)/800/667 MHz, 5000hrs VRM Solid 
Capacitors

Ratings (on 10)
Features: 6
Performance: 6
Build quality: 6
Value for money: 8
Overall: 6.5
 
Contact: ASUS Technology Pvt. Ltd.
Phone: +91-22-6766 8800 / 1800-2090365
Email: media_india@asus.com
Web site: www.asus.in
Price: Rs. 3,000

ASUS P5KPL-AM/PS 
For all your basic needs

Samsung X360
Sleek and stylish

T he X360 is sleek and stylish and  can 
get you drooling. It’s really thin 
and light and even lighter when 

you take out the six-cell battery. An 
interesting feature on the 
battery is an indicator that 
approximately indicates the 
amount of power left in the 
battery – all with just the 
push of a button. On the 
right side of this notebook, 
there are two USB ports, one 
SD/XD/MS expansion slot, a 
VGA port and even an HDMI 
port. The left side has the third 
USB port, a LAN port and ports 
for a headphone and a microphone. 
The keyboard has spacing between 
the keys which gives a good solid feel 
while typing. It’s somewhat similar to the 
Sony’s laptops and Apple’s Macbooks.  The 
Function key gives access to additional 

features such as an easy speed up mode 
that boosts the performance from 1.2 GHz 
to 1.6 GHz. 

We ran some real world 1-GB 
file transfers and were able to 
transfer the file in under half 
a minute.

When it comes to battery 
life, this impresses. It lasted an 
entire 3 hrs and 39 mins with 
full brightness and volume 
under our stress test. So, look-

ing at the facts, the only 
thing that does impress 

us is the battery life 
and the weight. 
Although the 

design is also pretty good, 
this laptop is aimed only for those people 

who like to sit in coffee shops and show off 
their sleek laptops. As some would put it – 
beauty without brains. The price of the X360 

is Rs 1,15,014 which is high but one must 
remember the SSD component to this PC. In 
terms of performance, it doesn’t match the 
other notebooks in this price range.

Specifications
Processor: Intel Core 2 Duo U9300 @ 1.2 GHz, 
Main Chipset: Intel GS45 + ICH9MS. HDD: 128 
GB(SSD), 1.3MP Integrated web Camera.

Ratings (on 10)
Features: 7
Performance: 6.5
Build quality: 7.5
Value for money: 5.5
Overall: 6.5

Contact: Samsung India Electronics Pvt. Ltd. 
Phone: +91-11-4151 1234
Email: r.venkata@samsung.com
Web site: www.samsung.com/in
Price: Rs. 1,15,014
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Idou
Sony Ericsson’s Idou is the
company’s fi rst 12 MP camera 
slated to launch in Q2 of 2009

The Sharp AR-M201 is capable of copy-
ing, printing, scanning and optional 
facsimile services and blends well 

into an office environment. It has a simple 
button interface with easy switching 
between functions. 

You can copy without even connecting 
it to a PC. Also, the paper tray itself has 
well defined lines for paper sizes and can 
be easily adjusted for different paper sizes. 

However, the AR-M201 is not great 
performer. It takes about 22 seconds to 
print out a word document in both stan-
dard as well as economy mode which 
is just too slow according to us. Also, 
in the economy mode, the text shows 
rough edges. Scan quality wasn’t impres-

sive either. Copying also takes time and 
doesn’t give you an exact match of the 
original document.

The Sharp MFP has some good features 
such as two-sided copy and even an option 
to rotate the image on the back. Also, 
there’s an Auto shut-off mode and even 
Toner saver mode. Optional features are 
available as add-ons for network capabili-
ties and fax.

Specifications:
Dimensions: 518 x 445 x 298 mm (L x B x 
H), Paper Capacity: 300 sheets, Scanner 
Resolution: 600 x 1200 dpi

Ratings (on 10)
Features: 6.5
Performance: 7
Build quality: 7
Value for money: 6.5
Overall: 7

Contact: Sharp Business Systems India 
Limited
Phone: +91-11-4666 5555
Email: info@sharp-oa.com
Web site: www.sbsil.com
Price: Rs. 28,500 + taxes (8000 prints free)

Sharp AR-M201
A basic MFP

T he satellites provided in this system 
are good and go well with the look 
of the main speaker. The volume 

controls are located on the back of the 
sub-woofer with dials for volume and 
bass. There are no other controls for 
treble, neither does it have any wired or 
wireless remote.

The bass on the Atom was very loose 
and flabby. Although, the highs are decent, 
these speakers lack in the mids. These 
speakers are not meant for large rooms.

The price tag for these speakers is
Rs. 1,900 which is pretty low for a 2.1 speaker 
set. The only attractive feature is the rotat-
ing satellites that can be wall mounted. We 

would rather suggest you save up and opt for 
something better instead.

Specifications:
Total RMS Power: 25 W, Frequency: 40 Hz — 20 
kHz, Signal to noise ratio: >80 dB, Satellite 
dimensions: 95 x 80 x 175 mm (W x D x H), 
Sub-woofer: 170 x 170 x 250 mm (W x D x H)

Ratings (on 10)
Features: 5.5
Performance: 6
Build quality: 6.5
Value for money: 6.5
Overall: 6

Contact: H T Impex
Phone: +91-22-6610 2080
Email: sales@zenthemaster.com
Web site: www.zenthemaster.com
Price: Rs. 1,900

Divoom Atom 357
Not that small

Aten’s CS661 is not an ordinary KVM 
switch. 

This KVM switch looks more like 
a USB hub than anything else. The USB 
port present on the switch can be used to 
plug in a USB peripheral device such as a 
printer. 

The CS661 has a plug-and-play device. 
In the File Transfer menu, the local PC is 
displayed on the left, while the remote PC 
is on the right of the window and files can 
be transferred between them by a simple 
drag and drop method, which makes it 
very user friendly.  

The Aten Laptop USB KVM Switch 
is a great solution for transferring files 
between two computers and also is very 
easy to use. No software needed to use and 
also an extra USB port to share a peripheral 
between the two computers is a bonus. But, 

at times this device reacts slowly on the 
remote computer when carrying out ordi-
nary tasks of the computer, other than file 
transfers, which might cause some frustra-
tion to the user at times. Even so this is 
ideal for quick transfers and also is easy to 
carry around as it is compact and comes 
with it’s own little carry bag. 

Specifications: 
Dimensions: 92 x 31 x 14 mm (L x W x H), 
LEDs: 2 (blue), USB hub: 1x USB 2.0 port, Local 
port: 0.9 m USB TypeA Male, Remote port: 1.8 
m USB TypeA Male 

Ratings (on 10)
Features: 8
Performance: 7
Build quality: 7
Value for money:6
Overall: 7

Contact: Cubix Micro System
 Phone: +91-20-2425 1594
 email: sales@cubixindia.com
 web site: www.cubixindia.com
 Price: Rs. 4,900 

Aten Laptop USB KVM Switch 
File transfers made easy
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Renamed
Nanopoint Technology Inc, the 
manufacturers of power supply 
units have changed the company 
name to Abertek Company Limited

Hitachi Deskstar 7K1000.B
1000 GB with this Hitachi

Hard drives with a couple of gigabytes 
of space are now a thing of the past. 
A typical desktop today comes 

with 250 to 320 GB but capacities 
have again started shooting 
upwards. One of the desk-
top drives with a terabyte 
of space is the internal 
hard disk from Hitachi — 
the Deskstar 7K1000.B. 

Performance-wise this 
drive is pretty good. In HD Tach 
3, we got some nice read and write 
results with a decent random access time. 
Also, the CPU utilisation was at 2 per cent, 
normal in most hard drives these days. 
SiSoft Sandra gave us lower results in 
comparison to HD Tach and also a much 
higher random access time. We can’t be 
certain which of these tests are lying to 

us, but what we can do is check out the 
performance it has with real world 

file transfer tests, which of course 
was also done here with 4 GB 

sequential and assorted 
data. The tests show 

us that this 
hard drive 
can actu-
ally read 
s t a n d 
alone files 

the best.
With the 

actual bytes to 
GB conversion, this 1-

T B drive actually holds a total of 
9 31. 51 GB which is expected when it 
comes to hard drives. However, considering 
that it is priced at Rs. 9,100, we really don’t 

think you should buy it, especially when 
cheaper 1.5-TB drives are already available.

 Specifications:
Dimensions: 147 x 101.6 x 26.1 mm (L x B x H), 
Interface: SATA 3.0 GBps, Cache: 16 MB

Ratings (on 10)
Features: 7
Performance: 7
Build quality: 8
Value for money: 5.5
Overall: 6.5

Contact: Cyberstar Infocom Pvt Ltd Phone: 
+91-9972580114
email: lalit.sudrik@cyberstarindia.com
Web site: www.hitachigst.com / www.cyber-
starindia.com
Price: Rs. 9,100 + taxes

The Mercury 1990TWA is another 19-
inch LCD screen, but at a cheap price. 
19-inch screens have become a stan-

dard for every desktop PC built. In general, 
the design gives the screen a simple, yet 
elegant look. The stand is pretty small and 
it isn’t the most stable screen around. 

The screen has a matte finish and 
supports the typical resolution of 1440 x 
900. With the screen properly setup and 
calibrated, it looks pretty good. Colours 
aren’t very saturated but contrast ratios 
are pretty decent. Banding is visible in 
high quality videos because of the TN 
panel in use. It is most visible in scenes 
with the gradient of the sky. DisplayMate 
tests performed well but there was a fine 
high-pitched sound that could be heard in 

some patterns. There were no issues with 
the display though. 

The screen has inbuilt speakers but 
they aren’t loud enough for movies. They 
get the job done for light music listening 
for users sitting next to the screen. Quality 
isn’t special either. Still, at Rs 6,700 it’s a 
steal for a 19-inch display. Quality-wise, it 
isn’t too far away from of the expensive 
brands and if you’re on a tight budget and 
considering a CRT monitor instead, this 19-
inch screen might change your mind. 

Specifications: 
19-inch widescreen, Maximum resolution sup-
ported: 1440x900 at 60Hz, built-in speakers; 
Dimensions: 439 x 365 x 190 mm 

Ratings (on10) 
Features: 8 
Performance: 7 
Build Quality: 7 
Value for money: 7 
Overall: 7 

Contact: Kobian Pte Ltd 
Phone: 9810085042 
E-mail: shivani_mangal@kobian.com 
Web site: www.mercury-pc.com 
Price: Rs. 6,700 

Mercury 1990TWA 
Displaying great value-for-money

Maya 2009 
Mighty Modeler

Autodesk’s Maya 2009 has been 
released and we’ve had a chance 
to touch on some of its countless 

features. Here’s what we think of it. 
Maya has been better known for its 

particles effects and inbuilt simulation 
systems. The cloth, fluid and particles 
features have been upgraded a bit. Copying 
of properties from a rig to another rigged 
model is made simpler as well. There have 
been even more additions to the package 
in that aspect and it’s things like this that 
make up the new software. 

Maya 2009 continues to be expen-
sive investment but it’s a complete suite 
meant for professional studios. All of these 

features are necessary in such 
places but for smaller studios, 
it’s a very expensive software to 
consider and it’s for them that 
it’s not very good value for money. 
There are cheaper suites and for 
beginners, there’s always the 
Maya Learning Edition or other 
free 3D modelling applications. 

Requirements: 
32-bit Maya requires a 32-bit Windows plat-
form, Internet Explorer 6 or higher or other 
browsers, Pentium 4 or higher, AMD Athlon or 
higher, 2 GB memory, 2 GB disk space, OpenGL 
supported card.

Ratings (on10) 
Features: 9 
Performance: 7 
Ease of Use: 6 
Value for money: 5 
Overall: 7 

Contact: Autodesk 
Phone: 919321522330 (Bhupesh Chheda) 
E-mail: bhupesh_chheda@adityagroup.com 
Web site: www.autodesk.com 
Price: Rs. 1,07,200 (Autodesk Maya Complete 
2009 Commercial New SLM) / Rs. 2,42,450 
(Autodesk Maya Unlimited 2009 Commercial 
New SLM)



DIGIT MARCH 200972

Bazaar

T
R

IE
D

 &
 T

ES
T

ED
Launched
Sony launches AD-7220-ID,
 a dust proof optical drive only for 
the Indian market. 

Logitech G25 
Amazing but too expensive as a must-have recommendation

Microworld’s eScan Internet Security 
Suite is a solution developed for 
home users who want protection 

from all kinds of attacks. 
The control center for the suite is 

something called the eScan Protection 
Center. The interface is simple to use but 
isn’t designed to look attractive. The virus 
scanner is the heart of security suites like 
this. The antivirus component is simple 
to use and has nothing special over other 
competitors. 

A feature called Endpoint Security 
prevents infections to your system from USB 
flash drives and suspicious applications on 
it. The Web Protection feature is basically 
a parental control which has presets for 
different age groups. Each one can be modi-
fied and tweaked by the user. Time restric-
tions can also be enforced. The popup filter 
settings can be changed from here. 

The firewall works well with the 
preset of filters that come with it. It can 
be also switched to an Interactive Filter 
mode which then learns your applications 
and ports over time. A network connec-
tions monitor is also part of the firewall. 
Processes and connections can be discon-
nected as per your wish. Spam filtering is 
also part of the suite. 

Alerts are displayed when there are 
suspicious connections or applications 
started. A window appears which requires 
you to enter your Windows account to 

proceed. The application does it pretty 
often the first time you run a few known 
applications. This can get a little annoy-
ing. You can choose to add the item to the 
Blacklist or Whitelist. The popup blocker 
works in the same manner and effectively. 

A privacy safeguarding and system 
cleanup feature allows you to clear your 
browser and application cache folders. This 
can be automated to happen on every 
reboot if you want it to. 

The application isn’t heavy while 
using it or while scanning but it still 
consumes around 90 MB of memory in 
the background. If you have anything 
less than 512 MB of memory, then only 
should this be a concern. 

eScan Internet Security Suite 10 is 
good for what it is – a simple, no-nonsense 
security suite. It has a few interesting 
features as well. Still at $46, its a little 
more expensive than what was expected 
for a single user license with only a year’s 
subscription.

Requirements: 
Windows platform, 128 MB RAM (256MB rec-
ommended), 150 MB disk space. 

Ratings (on10) 
Features: 7 
Performance: 6.5 
Ease of Use: 7 
Value for money: 6.5 
Overall: 7 

Contact: MicroWorld Software Services Pvt. 
Ltd. 
Phone: 022-28265701 
E-mail: sales@msspl.co.in 
Web site: www.mwti.net 
Price: Rs 2,300 ($46 for single user one year) 

Microworld eScan Internet Security Suite 10 
A single complete straight-forward security solution

The Logitech G25 is a 900-degree wheel 
that comes with a pedal set and a 
separate gear shift console. 

The pedals, unlike other wheels you 
come across, are made of metal. There are 
three pedals resembling those in a real car 
with each with its own level of resistance. 
The brake pedal is very hard though. The 
gear shift console has an H-style gear shift. 
The gear setup can also be switched to a 
standard sequential style with the 
turn of a knob. 

We used the 
wheel on 

Richard Burns Rally, GTR2 and Live For Speed. 
The force feedback works really well and 
it is noticeably better than the other well 
known Logitech wheel – the Momo. It’s 
easy to make out when your car loses trac-
tions while going sideways or when you’re 
going through bumps and grooves in the 
soft soil in RBR. 

Unfortunately, not many games use the 
900-degree steering capabili-

ties of the G25; therefore, 
you are forced to turn 

down the settings. The 
H-shift takes a while 

to get used to so 
till then, you’ll be 
slower than other 

sequential gear shift 
users if you’re very competi-

tive in online simulations. In 
every single way, the G25 is better 

than the Momo. The price is the only 
problem we see. It’s set at Rs 24,995, 

which is more than four times more than 

the Logitech Momo. If you’re going to use 
the G25 with a sequential shift, you might 
as well stick to the Momo. For those who 
simply want the best, the G25 is the best 
you’ll find in the market. 

Specifications: 
900-degree wheel, H-shaped gear shift, 
sequential gear shift, clutch, brake, accelera-
tor pedals. 

Ratings (on 10) 
Features: 8.5 
Performance: 8.5 
Build quality: 7.5 
Value for money: 2.5 
Overall: 7 

Contact: Logitech 
Phone: +91-22-2657 1160 
email: Kavita_nath@logitech.com 
web site: www.logitech.com 
Price: Rs 24,995
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TRIED & TESTEDLaunched
Asus launches M4 series of
motherboards that support the 
new AM3 socket from AMD 

HostedFTP.com 
Fast, simple to use, effective online space provider

HostedFTP.com is an online file stor-
age provider in a space now filled 
with many sites. HostedFTP.com 

brings a little more to this space. What 
makes the service great is the interface. 
All the features are organised into separate 
tabs. Registration is simple and it doesn’t 
take time to get used to the features as 
well. A welcome page greets you when you 
log into the service. It works well with all 
the usual browsers without any glitches. 

When you create an account, you not 
only get to upload files but you have the 
option to add other users or even allow 
public access to files. Groups can be created 
out of your user lists as well. Files can be 
uploaded using the web interface and Java 
applet that is embedded on the site. FTP 
access is available for you as well. 

Invites can be sent to users to download 
separate files or packages which are simply 
group of files. You are notified by mail 
when download made using the invites. 
Quotas can be sent as well. With user lists 
created, a particular file or package can be 
set easily to a particular group. 

File handling is simple with the web 
interface. Files can be moved, renamed and 
downloaded. A public folder is available 
and you have the option to have public files 
deleted after a set period of time. You can 
also have users enter information before 
downloading a file from the public space. 

There is some amount of customiza-
tion as well. You can put your web site 
name, a banner and a splash image for 

your account and your users will be shown 
the same. Most of the actions on HostedFTP.
com are wizard-based, so it’s simple to 
operate and use. Help is provided for every 
feature of the site. 

There are schemes you can choose 
from and they have storage constraints 
— 2 GB, 4 GB and 16 GB depending on your 
needs. There are some download limita-
tions and very minimal charges if you cross 
it. The service is excellent for personal use 
and even better for small groups of compa-
nies in multiple locations and you need 
a easy, secure and quick way to exchange 
large files. 

Ratings (on 10) 
Features: 8 
Performance: 8 
Ease of Use: 8 
Value for money: 7 
Overall: 8 

Contact: HostedFTP.com 
Web site: www.hostedftp.com 
Price: Personal Edition 2 GB ($10),
Group Edition 8 GB ($ 40),
Enterprise Edition 16 GB ($80) 

Seagate Barracuda 7200.11 1.5 TB
The Barracuda just got bigger

Seagate has always been a brand talked 
about when deciding which hard drive 
to purchase. Seagate took its own time 

to release its 1 TB drive, but seems to have 
pulled up with a 1.5-TB drive under the 
7200.11 series. 

The drive is silent. It doesn’t heat up 
as expected and stays at a stable warm 
temperature too. We tested the perfor-
mance of this hard drive through a 
series of test including HD Tach, SiSoft 
Sandra and even ran file transfer 
tests. In HD Tach, we got really 
great read and write speeds 
better than what you would 
expect from a 1.5-TB drive. 
SiSoft Sandra gave us 
slightly lower scores 
in comparison to HD 
Tach. The random 
access time matched 
in both the tests. We also 
performed some 4 GB sequen-
tial and assorted file transfer tests to 

find out good it performed. In the sequen-
tial transfer tests, we got a read time of 68.4 
seconds, a write time of 72 seconds and an 
internal copy time of the sequential file 
took 114 seconds. With the assorted file 
tests, we    got a read time of 83.7 seconds,    a 
write time of 80.5 seconds and an internal 
copy time of 102.7 seconds. 

As you can see, it does have some 
great read and write times shown 

in the file transfer test, 
and therefore, 

is an 

ideal drive to purchase if you’re looking to 
expand. Anyway, this is perfect as it will be 
pretty future-proof when building a new 
rig and definitely recommend it. 

Specifications:
Dimensions: 26.1 x 101.6 x 146.99 mm (H x W 
x L), Interface: SATA 3.0 Gbps, Cache: 32 MB, 
Capacity: 1.5 TB 

Ratings (on10)
Features: 7
Performance: 8
Build quality: 8
Value for money: 7
Overall: 7.5

Contact: Fortune Marketing Pvt Ltd (Seagate 
Distributor)
Phone: +91-11-2641 4468, +91-11-2647 2491
Email: sales@fortune-it.com
Web site: www.seagate.com
Price: Rs. 8,250 + VAT
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reader tutorials and workshops

Open Source

Nimish Chandiramani

 Y
ou’ve probably heard of the concept of the paperless 
office. Or the paperless school. Or the paperless univer-
sity. And, of course, Rich Media. All desirable buzzwords, 
but they all come at a price — Acrobat, or in extreme 

cases, Flash. 
Naturally, there’s an open source alternative. It’s called 

Sophie, and it’s been developed for the Institute for the Future 
of the Book (which really exists), so you can probably guess at its 
purpose. It lets you create “books”, complete with images and 
videos. And because it supports comments and sticky notes, it’s 
great for group presentations.

You can download it from http://www.sophieproject.org, and it 
comes for Windows, Linux and Mac OS X. 

Getting Around
Like so many open 
source projects, 
Sophie’s interface isn’t 
particularly intuitive. 
The screen is divided 
into a central area for 
your documents, and 
“flaps” on the left and 
right. Each flap has 
tabs on the side, which 
give you access to the 
program’s features. 

Starting Your First Book
This is really as simple as File > New Book, but if you’re going 
to create a book with a lot of text, we recommend using one 
of the templates. Select the Components tab on the right, and 
under Book Templates, double-click on Book with flow frame. 
This lets you create a new page every time  text goes beyond the 
limits of the text box on your first page.

Now that you’ve got your first page ready, you can double-
click inside the grey frame (the flow frame we just mentioned) 
to start typing in it. You can also import text into Sophie, though 

in true I’m-open-source-so-I-don’t-go-near-Microsoft-technologies 
fashion, you can’t import .doc files – the files in question must 
be in the RTF or TXT format. You can, of course, copy and paste 
text from anywhere. 

If your cursor is in a text box long enough, you’ll notice 
two grey buttons hovering near the box. These are halos – click 
on them, and you’ll see HUDs (Heads-Up Displays), which let 
you choose fonts and paragraph styles for your text. In general, 
whenever you select an item in Sophie, you’ll see a set of halos 
that open HUDs, which in turn let you change settings for that 
item. It’s a handy feature, and prevents you from having to muck 
about with a bunch of palettes or dialogue boxes. 

Finally, when you want to resize the frame or move it around, 
click on the grey border of the frame, and you’ll see a “halo” 
– an orange dotted line around the frame (this part can be a bit 
frustrating, because you have to click in just the right place). 
Use the corners to resize the frame, and the “+” in the centre to 
move it around. You’ll also see a new set of halos for the frame 
— change the background colour, margins, and actions, which we 
will come to in a bit.

And now, on to more complex matters. 

Enriching Your Book
Now that you can make your way around the interface, you can 
start adding media to your book. Sophie supports nearly all 
popular image, audio and video formats, so you don’t need to 
worry about this, at least. Like any other such tool, you first need 
to import your media files into the program before using them 
in your book. Choose File > Import File to start importing 
media files. If you want to import a bunch of files, however, a 
better idea would be to put all these files into a folder and import 
them: select the Resources tab on the right, and drag your folder 
on to it. In just a bit, you’ll see all your files getting added to the 
resources for the book. 

To add an image to your book, just drag it on to the page. 
You’ll be able to use the HUDs to change the size of the image, 
add a background colour, and choose how text wraps around it. 
If you don’t have media to import, fret not. Select the Internet 
Archive tab on the right, and you’ll be able to search for royalty-
free images, music or video to add to your book. 

Once you get used to the interface, using Sophie 
is like using PowerPoint

Author Me Good
Fun with Sophie — the poor man’s answer to Adobe Acrobat, and a little more

Flow frames let you deal with “overflowing” text

Every object has its halo, and its own special set of HUDs

Workshop
Learn how to stream your 

own videos  76
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One neat feature you have at your disposal here is the 
Anchor halo, which lets you attach your image to a text frame, 
paragraph, line or even character. To illustrate, let’s say that the 
image you just added to your book needs to be associated with 
the third paragraph. You’ve taken the time to position it well, 
and you’re happy with the way the text and image complement 
each other. But now, you must add text before the paragraph, 
which means that you must now reposition the image once 
again. With Sophie, however, you can position the image the way 
you want it, and then anchor it to the paragraph. Here’s how: 
once you’ve positioned the image, click and drag the Anchor halo 
to the paragraph to which you want to attach it. Now, click on the 
halo (don’t drag), and in the HUD, choose Paragraph. Now every 
time this paragraph moves, the picture will move with it. 

Anchoring is especially handy when you need to attach small 

images to words – for example, the image of a toolbar button 
next to its name. 

Getting Interactive
You can’t get far with any rich media authoring tool if you don’t 
have some interactive goodness thrown in, and Sophie lets you 
do plenty on that front. To make anything interactive, select 
it and click on the Links halo (the one that looks like a chain). 
First, you need to choose an event that will trigger the action 
you want – the mouseUp event, for example, means that your 
action will start when you click and then release the mouse 
button over the link. Once you’ve chosen your event, you’ve got 
several options ahead of you – you can make the link open a 
URL, turn to a page of the book, and, our favourite, turn a text 
frame off and on. Here’s how you do it: first, choose mouseUp 
as your event. In the menu below, choose Toggle Frame. Finally, 

drag the flag next to the last text box, and drop it over the frame 
you want toggled every time you click on the link. If you want 
a transparent “beam” to point from the link to the frame, check 
Show Annobeam.

You can also add more actions to the link by clicking on the 
“+” at the bottom-left of the HUD. To preview the results of your 
tinkering, select Test Mode at the bottom right of your book. To 
get back to editing, un-check Test Mode.

Share!
Finally, when you’ve had your fun with the program and finished 
your book, you can send it to your friends (or group members) for 
them to comment on. There are two ways for you to let people 
comment on your work: the first is to ask them to comment 
on specific areas. To do this, switch to the Components tab on 
the right, and from under Text Frames, drag a Comment into 
your text. Adjust the size of the comment frame, and you’re 
ready to publish your book: choose File > Publish Book to 
create a .sophie file that your team can read and comment on. 
Once you’ve published your book, readers will be able to add 
comments by clicking on the addComment links. They’ll also be 
able to reply to previous comments and start conversations.

The bad news with comment frames, however, is that they 
may bump your text around, which isn’t desirable at all. Which 
is why you have stickies. Under the Annotations tab on the left, 
you’ll find options to create sticky notes, highlights, and even 
audio annotations. 

Right now, anyone you collaborate with will need their own 
copy of Sophie or Sophie Reader installed, but the next version 
of Sophie promises to bring these features to an online version 
of the Sophie Reader.

Footnote
Sophie’s interface has a frustrating lack of any right-click menus 
or keyboard shortcuts, so it’s likely you’ll be frustrated with it 
for a while. Once you get used to it, however, its benefits far 
outweigh its shortcomings, and it’s one of the best tools we’ve 
seen this side of Acrobat. 

readersletters@thinkdigit.com

You’ll have a bunch of HUDs to fiddle with for images, too

Caption: Anchoring an image to a paragraph is a two-click job

Toggling images can be fun

You can start conversations with a comment text frame

Feature
Home cinema A/V 

systems  78

Tips and Tricks
All your questions 

answered  81

DIY
Make your own HTPC 

at home  92



DIGIT MARCH 200976

T
O

O
LB

O
X

Workshop

Kumar Jhuremalani

M
edia streaming refers to the broadcasting of multi-
media (video / audio) content from a computer, 
to be accessed by users located elsewhere without 
having to save any data. In other words, person A 

can stream a movie from one location and person B can be 
watching the same movie without having to save a copy of the 
movie on their computers. 

A video used for streaming is usually sent from a pre-
recorded video file, but with the advancement in technology, 
can now also be distributed as a live broadcast feed. In a live 
broadcast, the video signal is converted into a compressed 
digital signal and is then transmitted from a web server that 
is able to use the multicast protocol, where the same file is 
sent to multiple users at the same time. You don’t necessarily 
have to be streaming across the internet; media can also be 
transmitted locally over a network. Of course the person who 
wants to access this streaming media will also have to be on 
the same network. Although it is possible to access streaming 
media over the internet, it requires greater bandwidth.

Benefits of media streaming
 Media streaming does away with juggling CDs, DVDs or othe 

storage devices between machines.
 With streaming, you don’t need to download and re-download 

media files.
 No additional hardware is needed.
 Live broadcast from the internet is only possible through 

streaming.

Stream videos using VLC
VLC (Video LAN Client) media player is a well-known media 
player. This player can play almost any audio or video format 
you throw at it and is also extremely light on system resources. 
Another plus for VLC is that it works on Windows, Mac and Linux. 
Now, let’s get to actually streaming videos with VLC.

First, you need to get VLC for your OS. You can easily down-
load it from www.videolan.org. 

Once you have installed VLC on your system, click Media > 
Streaming. You need to set options to let you stream.

Select the videos you want to stream. Click and drag to select 
multiple files. Next click on Stream. 

Once you click on Stream, the next window that opens allows 
you to set the Stream Output options. Here, select Play locally and 
HTTP. Leave the port at 8080. Under Encapsulation, select MPEG-
TS and click on Stream.

The video will now play, indicating that it is being streamed. 
With HTTP as an output mode, anybody in your network 

can access your stream. If you want to avoid this, in the Stream 
Output options window, select RTP and then prefer UDP over RTP. 

You can add the IP addresses of the PCs you want to stream to. 
Leave the port default at 1234. 

Receiving a video stream 
VLC can be used on various platforms and for receiving the video 
stream we are going to use it on Linux. To install VLC, follow the 
same procedure as you did earlier.

First go to Media > Open Network. In the Network Protocol 
options, change the protocol to HTTP leaving the address bar 
empty. Check Show More Options at the bottom and type in the 
IP address of the PC that is streaming the media with the port 

being 8080. Once 
done, click Play and 
the media will start 
playing.

If you have used 
UDP instead of HTTP, 
all you have to do 
is click on Media 
> Open Network. 
Select UDP and click 
on Play. 

You can also 
stream HD videos 
using VLC, but make 
sure the computer 
you are receiving to 
can actually play HD 
smoothly. Well that’s 
all you need to do to 
stream your media 
using VLC. So go 
ahead, set a playlist 
that can be streamed, 
grab some popcorn, 
and sit back and 

The easy-to-use interface of VLC Player

Live News on the web
Major news channels like CNN have 
now moved to streaming content over 
the web

Workshop on 
Media Streaming

Selecting your videos to stream

Setting up the Stream Output Options via HTTP
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enjoy the show.

Stream videos using Orb 2.0 
Orb 2.0 is a program that lets you stream media from a PC which 
can be remotely accessed from any computer having an internet 
connection. Unlike VLC, you need to be online in Orb to receive 
the stream. Also, you need Windows. Orb let’s you stream videos, 
pictures, music and even webcam feeds.

To use Orb, download a small server applet onto your home PC 
which will catalogue and stream your media files including video, 

audio and photos. All 
these files are available 
at a single web page 
which can be accessed 
from anywhere. 

To start off, you 
need to download the 
Orb applet from www.
orb.com and follow the 
instructions. During 
the installation 
process, you also get to 
create your account.

Once you complete 
the installation, head over to 
mycast.orb.com and login.

Once you login and are at 
the homepage, click on Open 
Application > Video.

Orb creates a virtual 
database of the files on 
your system. To change this, 
right-click on the Orb applet 
running on your system tray 
and open Configuration.

To add a video to your 
streaming list, simply drag 

and drop the video on the right-hand side. Click on Share and 
select the option you wish to use. You have choices ranging from 
Public share, blogs and even sending the link via an email. 

Once you have shared the video, visit the given link and view 
the video from there.

With everything done online, Orb is a great way to remotely 

access media. It even works with game consoles such as the Xbox 
360, PS3 and Symbian-based handsets. If you’re looking to access 
your digital media anytime, just get to a PC and access Orb.

You may also find other software for streaming your media, 
but in our opinion these are the best available for media streaming. 
Media streaming is truly a great and efficient way with hardly any 
hassle to transfer or even transmit your media for others to view. If 
you have an HTPC, it is an added bonus to stream straight to your 
HTPC, where you can enjoy great quality videos. 

kumar.j@thinkdigit.com

Setting up the Stream Output Options via UDP

Receiving Stream through HTTP Receiving Stream though UDP

Setting up the Orb applet on your PC

Simple Account creation screen

Logging into the Orb service Select the option you wish to stream 

Setting folder options for OrbStart sharing your videos online

More  workshops online at
www.thinkdigit.com

Streaming is in
On Nov 22, 2008, YouTube’s fi rst 
ever Live Streamed event took 
place over the internet
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Terry Relph-Knight

These days there are more possibilities for ‘the TV’ than just 
being a box in the corner of the room. It makes sense to install 
an integrated system, where the screen is at the hub of work 
and entertainment activities. Although this concept was first 
proposed several years ago it is only now gradually becom-
ing economically and technically possible. Of course this does 
require more commitment, work and knowledge to set up than a 
simple TV. One thing definitely to bear in mind is that standards 
and features for digital audio and video are still changing so fast 
that it is difficult to make equipment choices that provide future-
proofing. In this article we will take a look at component choices 
and how to best hook them together. 

Choosing components
A home Audio/Visual system can be quite complex so it’s best 
to plan in advance before purchasing any components. You will 
need to decide on what you require your home system to do and 
on how the available space and budget may restrict your choices. 
It may seem attractive to integrate equipment you already own, 
but because of the new features required by digital audio, digital 
video and HD video this may not be practical.

A system may be composed of the following components: a 
display, a media player and/or a gaming console, a set top box, an 
audio amplifier, loudspeakers (from two to eight), a hard disk or 
DVD recorder, a PC and remote controls, plus possibly an aerial, 
cable feed or satellite dish. You might also want to include a 
tuner for radio reception.

The display
For displays there is a choice to be made between a computer 
monitor, a television or a projector. Computer LCD monitors are 
available with up to a 50-inch diagonal screen size although these 
are expensive at nearly Rs. 3 lakh. However, you can, for example, 
get a ViewSonic 22-inch with an HDMI connector and HDCP 
support for around Rs. 15,000. The advantages of computer moni-
tors are that in the smaller sizes they are relatively cheap and 
provide high resolutions. They are best suited to their primary 
purpose as computer displays with a secondary use as entertain-
ment displays. However, for use in a home A/V centre it is impor-
tant to buy a monitor with an HDMI input and HDCP support. 
There are still many new computer monitors for sale that do not 
have these features. 

TVs have the advantage that they can be used stand-alone, are 
available with up to a 52-inch diagonal display and the current 
flat panel TVs usually have quite a range of input and output 
connectors. Again an HDMI input and HDCP support is essential; 
many of the earlier high resolution flat panel TVs do not have 
these features.

The big advantages of projectors are that they can be 
installed unobtrusively, they don’t take up much space and they 
can provide large displays. Unfortunately, there are quite a few 
disadvantages: projectors are relatively expensive, particularly 
for higher resolutions and the running costs due to power 
consumption (350W for a 1200 lumen projector) and the cost of 
replacement lamps, are high. You can expect to pay between Rs. 
60,000 to Rs. 130,000 for a 1920x1080 resolution. Replacement 
lamps can cost Rs. 18,000 to Rs. 25,000 and you should budget for 

at least one lamp change during the life of a projector. Ceiling 
mounting a projector can also be something of a chore.

The Audio Amplifier
Let’s avoid all the audiophile arguments about audio quality 
– frequency response, distortion and so on – and assume that an 
amplifier bought from a well known brand name manufacturer 
is going to be of a good enough quality and we’ll concentrate on 
the required features.

The first thing to decide on is whether you might be satisfied 
with two channel stereo sound, or want to go for a surround 
set-up (with 5.1 or even 7.1).  Most surround sound capable ampli-
fiers have built-in decoding for both Dolby and DTS systems; best 
to avoid any that don’t.

Modern loudspeakers are usually quite inefficient (efficiency 
is sacrificed in favour of flat frequency response). Many multi-
channel amplifiers claim 100 or 200 W per channel although 
they don’t specify exactly what is meant by this. 50 W r.m.s per 
channel will be more than enough in most domestic settings. 

Remote control of volume and input selection are desirable 
features, but it’s unlikely you will find a mainstream audio 
amplifier that doesn’t have these.

Choose an amplifier with at least two HDMI inputs and two 
HDMI outputs; most amplifiers with these will also have a selec-
tion of phono connectors for other audio inputs and may also 
have digital optical inputs and outputs.

Loudspeakers – 5.1 and beyond
Although you can use the amplifiers and loudspeakers built in 
to a computer display or a television, these are normally limited 
to left and right stereo, are usually small and of limited qual-
ity. An external amplifier can drive multiple loudspeakers for a 
surround sound setup. 

With stereo sound where two loudspeakers are placed one to 
the left and one to the right in front of the listener, the illusion 
of a sound coming from any point between the two loudspeakers 
can be generated by driving both loudspeakers with the same 
signal, but at different volumes. When the volumes are equal 
the sound source appears to be in the centre, if the left portion 
of the signal is louder the sound source appears to move to the 
left, if the right signal is louder the source appears to move to 
the right. In surround sound this principle is extended by adding 
more loudspeakers placed around the listening position and the 
greater the number of loudspeakers used the more accurate is 
the illusion. Movie theatre installations have used as many as 24 
loudspeakers.

Home installations normally use five small ‘satellite’ loud-
speakers plus one bass-reflex sub-woofer and are referred to as 
5.1 (five smaller loudspeakers plus the single bass woofer). This 
arrangement is based on the principle that the sense of direction 
of a sound diminishes as frequency falls, so the bass frequencies 
can be provided by a single loudspeaker (note the difference 
between this and the movie theatre use of the sub-woofer only 
for extreme low frequency effects). Conveniently, it’s the bass 
frequencies that require the largest, most powerful loudspeaker, 
while the middle to upper frequencies require less power and 
can be generated by much smaller loudspeakers. The two front 
loudspeakers provide the left and right sound stage for sounds 
in front of the head, while the two rear loudspeakers expand the 

Home cinema 
     A/V systems

Oscar Winners in HD
Oscar winners Wall-E, The Dark Knight, 
Milk, Man on Wire, and Slumdog
Millionaire are available on Blu-discs
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sound stage behind the head and in combination with the front 
loudspeakers, to the sides. A central loudspeaker located behind 
or just above the middle of the screen is used to reinforce the 
centre of the sound image for dialogue of characters in close- up. 
A 7.1 system extends the 5.1 layout by adding two further loud-
speakers – back left and back right. In 6.1 there is only a single 
centre back loudspeaker.

However, in most domestic situations setting up even a 5.1 
system can be tricky. Placing the two rear speakers presents the 
greatest difficulty because the ideal position for these is just a 
little behind and above the listener, effectively placing them on 
stands in the middle of the room. 

For a stable and accurate surround image it is important 
that the loudspeakers in a surround sound system are all from a 
matched set. It is inadvisable to try to build up a surround system 
by adding loudspeakers to an existing left/right stereo pair unless 
they are identical models. 

A 5.1 system requires quite a lot of space, very symmetrical 
rooms should be avoided and hard reflective surfaces – the ceil-
ing above and the floor in front of the listening position – should 
be damped. Floor reflections can be controlled using carpets 
while ceilings can be fitted with acoustic panels. It may also be 
desirable to fit acoustic damping to the wall behind the listening 
position. 

While the single bass loudspeaker can be placed almost 
anywhere in the room, some positions will sound better than 
others and finding the right position is a matter of trial and 
error. Perhaps the ideal position is mid-way between the two 
front loudspeakers just below the screen. It is important to 

balance the relative levels between the small satellite loudspeak-
ers and the sub-woofer and 5.1 systems usually have a separate 
gain control for the sub-woofer. Placing loudspeakers at junc-
tions between walls and floor or ceiling will boost bass, although 
this may not be an issue with small satellite speakers. Putting the 
sub-woofer in a corner may seem convenient, but it will result in 
a large bass boost and it may not be possible to balance the bass 
content using the bass gain control.

Active loudspeakers
Smaller 5.1 systems, particularly those designed for computer 
gaming, may have a five channel amplifier incorporated into 
the bass sub-woofer cabinet, eliminating the need for a separate 
amplifier. These can be reasonably effective in smaller rooms. At 
the other end of the scale, very high-end systems may also use 
wide frequency range active loudspeakers with larger cabinets. 
Sub-woofers may not be needed with such systems. 

Program sources – aerial, cable or satellite?
Standard definition analogue television broadcasts are gradually 
giving way to DVB-T (Digital Video Broadcasts – Terrestrial) and 
existing televisions can be converted for digital reception with the 
addition of a digital tuner, often in a set top box. Even in major 
population centres reception of the digital terrestrial broadcast 
signals can be poor, the digital broadcasts do need a different 
aerial to that used for the analogue signals and you may need 
a high gain, very directional ‘digital’ aerial, possibly even fitted 
with a signal boosting amplifier. Using an aerial allows access 
to the ‘free’ broadcast digital channels. However it may be more 

convenient to subscribe 
to a satellite or cable 
service using a set top box, 
which should guarantee a 
strong signal. Even with 
a satellite or cable service 
it’s not guaranteed that 
program reception won’t 
be interrupted from time 
to time. Satellite reception 
is perhaps slightly more 
likely to drop the signal 
than a cable hook up, 
depending on the weather, 
the condition of the satel-
lite network and sunspot 
activity.

HDTV is just starting to 
become available in India 
this year. Many program 
makers are changing to 
HD and Direct to Home 
(DTH) satellite packages 
are available from Dish TV, 
Reliance Communications 
BIG TV, Tata Sky, Sundirect 
DTH, Airtel Digital TV and 
the public sector DD Direct 
(Doordarshan). HD set top 
boxes from Dish TV cost 
between Rs. 3,300 and Rs. 
4,000, around twice the 
price of standard defini-
tion. Cable services are 
also extremely popular in 
India and since a furore in 
2001 over large price hikes, 
have been provided on a 
Conditional Access System 
(CAS). CAS allows consum-
ers to choose and only pay 
for those channels they 

want to watch.
Diagram of a 5.1 audio setup in a typical room showing the possible inconvenience caused by placing the loudspeakers in 
the optimum positions

Pioneer calls it a day
Pioneer will phase out all its 
TV-related business activities by 
the year 2010. It will however 
remain in the audio business. 
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Apparently the government’s decision that the 2010 
Commonwealth Games will be broadcast only in high-defini-
tion has galvanised the push toward HDTV in India. As a result, 
the state-owned broadcaster Doordarshan, which is expected to 
launch HD-TV on an experimental basis soon, has stated it will 
produce content for the Commonwealth Games in this format.

Cabling – HDMI
Although most flat panel TVs and media players and audio ampli-
fiers still sport an array of different connectors for interfacing 
with other equipment, the High-Definition Multimedia Interface 
(HDMI) which started appearing on products in 2003, has become 
the default for hooking together digital audio and video equip-
ment. One of its design aims was to minimise the tangle of wires 
connecting the various units of an AV system together by combin-
ing video, audio and control cables into a single cable with just 
one connector on either end. In this way cable clutter is mini-
mised and the various units in a system can be chained together 
with just a single cable running between each one.

The high end audio market is notorious for taking things to 
extremes in the supposed pursuit of ever better sound reproduc-
tion. Exotic materials, specialist construction techniques and 
bizarre theories are regularly extolled as providing better sound, 
much of the time merely as an excuse for charging huge sums of 
money. Audio cables are a particular subject of controversy in this 
respect, even though these are only required to carry relatively 
low frequencies up to 20 Khz or so and it should not be particu-
larly challenging to engineer a cable to carry these low frequen-
cies over short distances.

HDMI is based on and is backwards compatible with, DVI-D 
and DVI-I and HDMI cables and signals can be connected to DVI 
devices using an adaptor. However not all of the HDMI functional-
ity will be supported. 

The HDMI specification is currently up to version 1.3 which 
adds support to the preceding 1.2 specification. Unfortunately, a 
number of current Blu-ray players, amplifiers and so on only have 
support for 1.2. To confuse things further, some features of the 
different specification revisions are optional features. For exam-
ple, 1.3 adds optional support for output of Dolby TrueHD and 
DTS-HD Master Audio streams for external decoding. TrueHD and 
DTS-HD are lossless audio codec formats used on Blu-ray Discs.

HDTV image formats and re-scaling
There are two main HDTV image formats in common use: 1080i 
and 720p. These numbers refer to vertical resolution; the number 
of lines in the image from top to bottom. For an image with a 16:9 
aspect ratio this means a 1080i image is 1920 by 1080 pixels and 
a 720p image is 1280 by 720. So the 1080i format would seem to 
have higher resolution.

Obviously for a display to be able to present 1080i or 720p 
signals its physical resolution must at a minimum match that of 
these signals. Looking at the specifications for HD Ready TVs can 
be a little confusing; for example, you can buy a 19-inch HD ready 
TV with a screen resolution of 1440 by 900.

HD Ready TVs use powerful image scaling algorithms and 
hardware to obtain the best fit for the variety of signal formats 
they must display. Because it was too expensive to design the 
early analogue TVs with a stable picture size that exactly filled 
the screen, the old TV signal standards allow for overscan; a 
border around the edge of the image that does not contain any 
important scene elements,  such as title text. Analogue TVs are 
set up so that most of this overscan area overlaps past the edges 
of the physical display area. Digital TVs do not need to overscan 
since they can map images precisely to all the available pixels, 
but nevertheless they may allow some overscan in an attempt to 
provide the best display for signals using the earlier formats.

Video compression – MPEG-2, H.264 
Raw video recording requires huge amounts of storage capacity. 
Because of this, all digital video is heavily compressed. Depending 
on the application, different compression schemes are used. For 
example, movies encoded to DVD use MPEG-2 (Motion Picture 

Experts Group 2) while HDTV uses H.264. H.264 is equivalent 
to MPEG-4 AVC (Advanced Video Coding). If you want to display 
HDTV on your computer you will need a graphics card that 
includes H.264 decoding. Nvidia include this capability in a suite 
of features it calls PureVideo, so any of its graphics card products 
that support PureVideo are suitable for HDTV display. ATI has a 
similar suite of HD features it calls Avivo.

Although these sophisticated compression algorithms solve 
the huge size and bandwidth problems of raw high resolution 
digital video, they do at times introduce visible artefacts, most 
often seen as blocky patches in the image.

High-bandwidth Digital Content Protection (HDCP)
When the specifications for high definition video and Blu-ray 
were being drafted the major content providers such as Time 
Warner and Sony, concerned about the degree of piracy with the 
old analogue formats, insisted that all high definition video hard-
ware should incorporate some form of content protection. HDCP 
uses a public key, private key encryption system to exchange 
handshakes between every device in the reproduction chain. If 
the handshake fails then the encrypted signal is not passed across 
the link. Public keys may be placed on a revocation list that is 
included on new media. If during the handshake, a public key is 
exchanged that is found to be on the revocation list, the device 
supplying the key is no longer recognised. 

Some critics of HDCP have said that reverse pressures from 
the hardware manufacturers, concerned that implementing 
HDCP encryption would add too much to the manufacturing 
costs, have resulted in a weak encryption system that is relatively 
easy to break.

It is possible to buy HDCP dongles or strippers on the ‘grey 
market’ that can be inserted in the signal path to, for example, 
convert a non-HDCP compliant monitor. However,   because these 
devices break the integrity of the encrypted signal chain, they are 
subject to key revocation.  

Viewing Distance and Screen Size
Our eyes have sharp focus in the centre of the field of view 
surrounded by our peripheral vision. This means that there is 
a cone of vision or field of view where objects will be seen most 
clearly. As a result, for a given screen size there is an optimum 
viewing distance. Since vision varies somewhat, the viewing angle 
used by different organisations to calculate the optimum view-
ing distance also varies. SMPTE (Society of Motion Picture and 
Television Engineers) recommends a 30 degree viewing angle, 
THX (Tomlinson Holman’s eXperiment – see boxout) 36 degrees 
(preferred) to 26 degrees.

The simplest way to work out the ideal viewing distance is 
to consider that given the SMPTE recommended viewing angle 
the distance to the screen should be 1.9 times the screen width 
(taking the THX recommendations the distance to the screen 
should be between 2.2 and 1.54 the screen width). Given the Dolby 
recommendations for a 5.1 speaker set-up radius of between 2 and 
4 metres, this means that a 40-inch (roughly 1m) screen is not too 
large even at a 2m viewing distance. At 4 meters a 2m plus screen 
can be accommodated. HD images will of course tolerate closer 
viewing before the individual image elements become visible 
than will standard definition images. 

Making your own HD video
There are now a number of video cameras on the market that 
shoot in HD formats. These record to MiniDV tape, or even to SD 
memory. None of these have HDMI connectors but use Firewire 
for their digital connection. For the ‘prosumer’ there is the Canon 
XHA1 or the Sony HDR-FX1 recording to MiniDV. 

For un-edited playback you can plug these cameras directly 
into your display, normally using composite or RGB outputs and 
inputs, and using the camera itself as the playback device. Editing 
of HD can be done by capturing the video onto hard disk and 
using editing software such as Adobe Premiere on a Windows 
PC or Final Cut Pro on an Apple. The latest versions of these 
programs support HD editing. 

readersletters@thinkdigit.com

Panosonic 150-inch
Panosonic launched a 150-inch 
fl at screen TV. With the current 
market situation, we know you 
are not even interested
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GMAIL
Gmail has by now grown to be ubiquitous. 
Almost all of us have a Gmail account and in 
most cases, it's our primary email address. 
The main reason why we've come to prefer 
Gmail so much is innovation. This innova-
tion comes by way of experiments that 
Gmail conducts in its Google Labs. Gmail 
deploys and tests most of its ideas in its labs, 
before a proper mainstream release. Many 
of these ideas come as suggestions from 
Gmail users, and many come from people 
at Google. They're aimed at improving func-
tionality and overall user experience and 
some of them are certainly worth checking 
out. To enable any labs feature, click on 
Settings and go to the Labs tab. Gmail labs 
currently lists some 30-odd lab features, 
from which we have here selected the ones 
we like the most. To activate any of them, 
click the 'enable' radio button for a par-
ticular feature and click 'save changes'. Labs 
works best with keyboard shortcuts, so we 
recommend you switch 
these on. To switch on 
keyboard shortcuts go 
to the General settings 
tab and activate this 
feature.

Create a Gmail 
back up (Offline)
Gmail lists this fea-
ture in its labs as 
the 'Offline' mode. 
According to the com-
pany, it will allow you 
to work in the familiar 
browser-based Gmail 
environment, even 
when you are offline. 
It’s an attempt by 
Google to come as close 
to Microsoft Outlook as 

possible. Nevertheless, email requires you to 
be connected at least at some point. So what 
use is the feature then? Although it may 
come in handy to compose a few drafts in 
those rare instances of internet failure, we 
found an alternate use. The feature can be 
used to back up your entire Gmail account! 
So if for some reason you loose access to 
your account, or if one day Gmail decides 
it’s not going to be so generous with storage 
space and is going to delete your older 
mails, you already have a backup ready. 
Also, this backup lies in the safety of your 
personal hardrive. 

To back up your account, enable the 
feature from Labs. Once enabled, an "Offline 
0.1" link will appear at the top-right corner 
of your Gmail interface. Click on it and 
your browser will prompt you to install the 
Google Gears add-on (currently not sup-
ported in Opera). If you are using Chrome as 
your browser, Gears is installed by default. 
Click install and let Gears install on your 
computer. You will need to restart your 
browser once Gears has finished the down-
load and installation. On restarting your 
browser, a Gears security warning will seek 

your permission to store 
information on your com-
puter. Check the box and 
click to allow this. It will 
now create shortcuts on 
the desktop or start menu 
as per your preference 
and begin downloading 
all your mail onto your 
system. This could take 
a while, since most of us 
have accumulated thou-
sands of emails over the 
years. However, based 
on your email volume, 
Offline Gmail will not 
download mail that's 
older than two years, and 
obviously Spam and Trash 
will also be avoided. Who 
wants that anyway? There 
is also the new Flaky 
Connection Mode which 

is a nice feature when you're on an unreli-
able or slow connection. It is somewhere 
in between using your local cache of down-
loaded information and a fully fledged 
network connection. It uses the local cache 
as if you were disconnected, but still syn-
chronises your mail with the server in the 
background. To go into, or leave, Flaky 
Mode, simply click on the offline icon in 
the top-right corner. We encountered sev-
eral glitches where Gmail restricted access 
to some functions even when Flaky mode 
was off. Repeatedly clicking "Leave Flaky 
Mode" didn't seem to help either. 

Quote only selected text
One of the most irritating things while 
sending a reply is having to quote the 
sender's entire text. Many times, we send a 
reply only in the context of a few sentences 
of a particular mail. Well, now with Gmail’s 
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“Quote selected text” Lab feature, you can 
do precisely that. After enabling it from 
Labs, all you have to do is select the text 
you wish to quote and then click Reply. Now 
only the text that you highlighted will form 
part of your reply. The feature is interesting, 
because now you can put much greater con-
textual emphasis in your replies.

Create a To-Do list (Tasks)
The Tasks feature adds a to-do list to Gmail. 
Tasks is perhaps the most intuitive and 
user friendly to-do list application avail-
able online. As is the case with everything 
Google, its charm is its simplicity. Once 
enabled, a new tasks link will appear in 
the left panel above the chat box. Clicking 
on the link will bring up the task list in 
the bottom-right corner. Click anywhere 
on the list and start typing to add tasks. 
Alternatively, you can also click on the '+' 
button to add a task. Navigating through 
the list with arrow keys and using [Enter] 
and [Backspace] to add or delete a task 
works fine. [Ctrl]+Up moves a task up the 
list. Use [Ctrl]+Down to move it down. 
You can also reorder tasks by dragging and 
dropping them using the drag handle on 
the left of each task. Apart from assigning a 
due date, tasks can even have extra informa-
tion such as a note associated with them. 
Click on the ' >' symbol to the right of the 
task, or hit [Shift]+[Enter] when in a 
task to bring up its details. 

The application even lets you have mul-
tiple lists. To add or delete new lists, click on 
the 'switch list' button in the bottom right 
corner. For a list of keyboard short-cuts, 
click on the Actions button. You can also 
create a task from an email from the More 
Actions menu. Choose 'Add to Tasks' when 
viewing an email, or press [Shift]+[T] if 
you have keyboard shortcuts enabled. What 
makes the feature so useful is that it sits 
in your mailbox screen unobtrusively, all 
the time. Since most of us have our Inbox 
constantly open, it also acts as a continuous 
reminder. 

Quick Links
Most of us who are not so fanatically organ-
ised, have hundreds of unread emails spread 
out through multiple pages in our Inbox. 
Wouldn't it be nice to bring them all together 
to be able to deal with them? Sure you 
could run a custom filter — is: unread 

in: Inbox — in the search bar. However, 
repeatedly searching mails from particular 
people can get quite cumbersome. Enabling 
Quicklinks will add a box to the left column 
that gives you single-click access to any book-
markable URL within Gmail. You can use it 
for saving frequent searches, important indi-
vidual messages, and more. To add a quick 
link, click on the 'Add Quick Link' button 
in the quick link box. It will automatically 
list the path of the current page you are on. 
For example, to search for all music in your 
Inbox, key in the command in:Inbox mp3 
has:attachment in the search box. Once 
the page is displayed, click on "Add Quick 
Link". Enter the title for current view "Music 
in Inbox" and click OK. A new quick link will 
be added that will show you all the music in 
your Inbox. 

Multiple ways to mark mails 
(Superstars) 
Gmail allows you to sort mails by applying 
labels and marking mails with stars. Out 
of the two options, starring mails is much 
easier as it is a single-click operation. 
Unfortunately, there is just one type of star 
available — the boring yellow one. Now with 
Superstars you can get your hands on a 
whole bunch of stars. In effect, they let you 
add another layer of sorting to satisfy all 
your organising needs. After enabling this 
feature, go to the General Settings page to 
choose which superstars you wish to use. To 
know the name of a superstar, hover over 
its image. Drag and drop the ones you wish 
to use. We recommend the purple-question 
and the red and green stars. Once in the 
Inbox, a new pointer will appear (>). Use the 
[J] and [K] keys to move the pointer and [S] 
to rotate through your selected superstars. 
Use the search operator has: to find all 
messages with your superstar, for example, 
has:red-star. 

Create custom keyboard 
shortcuts 
Not happy using the default Gmail short-
cuts? By activating this Labs feature, you can 
change keyboard shortcuts to your liking. It 
will add a new tab in Settings from where 
you can remap keys to various actions. Be 
careful about repeating keys though. If 
you do so, it will prompt you while saving 
changes. There is also a restore to defaults 
button if you change your mind about any 
of the binds.  

Mouse gestures
This feature is a step ahead of using 
keyboard shortcuts. Enabling mouse ges-
tures will allow you to use your mouse 
to navigate with gestures. With the right 
button of the mouse pressed, drag the 
mouse to the left to go to a previous 
conversation. Similarly, drag to the right 
to go to the next conversation. Move up 
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You can add custom search terms as Quick Links

Gmail: Use the Move 
to: button to label and 
archive

Use mouse gestures to navigate Gmail
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panes crowd the available screen space. 
Examples of search operators for panes 
are: is: sent, label: external 
mail”, etc.

Changing the appearance 
(Themes and add-ons) 
Gmail may be great, but you'd agree that 
there really isn't much to look at. Although 
we're all for simplicity and functionality, a 
little bit of style is always welcome. So, the 
guys at Gmail decided to give us themes. 
To apply any theme, go to the Themes tab 
in Settings. Some of the themes require 
you to enter your loca-
tion. According to 
Google, these themes 
will change according 
to your local time of 
day. While the themes 
offered by Gmail are 
about average, there 
are other ways to cus-
tomise your look. Head 
over to http://globexde-
signs.com/gr/ to install 
Google Redesigned, a 
Mozilla Firefox exten-
sion designed by Globex 
Designs that aims to 
fully redesign the look 
and feel of popular 
Google services. Once 
you have installed the 
extension, restart your 
browser and click on 
the GR icon in the 
bottom-right corner of your browser and 
select "Check For Style Updates". This will 
automatically download and install all the 
latest styles that are currently available. 
Alternatively, you can also get the "Stylish" 
plug-in from http://userstyles.org/stylish/. 
Stylish is to CSS what Greasemonkey is to 
JavaScript. Just follow the link to Mozilla's 
add-on page (addons.mozilla.org) and install 
the plug-in. Once installed, click on the 
stylish icon in the bottom-right corner of 
your browser. Click on 'Find styles for this 

page' when in Gmail. You will find tons of 
new styles to choose from. However, run 
only one of these plug-ins at a time. 

Disaster mode 
Remember, Gmail Labs is an experimental 
area. Most features are deployed without 
much testing. Some of the Labs features 
can and will occasionally break. Therefore, 
Gmail has provided you with an escape 
hatch. If you're having trouble accessing 
your account, you can temporarily disable 
labs for your session by logging in from 
this URL — http://mail.google.com/mail/
?labs=0. 

WINDOWS 7
Windows 7 beta is the latest iteration of the 
Microsoft Windows operating system. We 
spent a few days with it. Going back to XP 
or Vista after a few days on Windows 7 can 
be very difficult. The user-friendly response 
can be very addictive. The public beta of 
the operating system is out, and here is 
a primer to start you off if you have your 
hands on it.

Change the Theme
Right-click on the desktop, click on cus-
tomise. Then, select one of the default 
themes available to you. You can change 
the system sounds, and the way the menus 

and the bars look. The new feature in 
Windows 7 is that a theme can have a set 
of images that cycle automatically after 
a particular amount of time. The second 
ease of access theme is a throwback to 
good old Windows 95.

Windows Media Player
The first time you use Windows Media 
Player, instead of the default settings, 
go to the custom settings. Here, disallow 

to go to the Inbox. Once you get the hang 
of it, you'll soon be zooming your way 
effortlessly though Gmail. Unfortunately, 
this lab feature is designed to work best 
with Windows.

Optimise your 
signature 
(Signature tweaks) 
This is a very simple lab 
feature, which serves 
two purposes. It places 
your signature before 
the quoted text in a 
reply, and removes the 
"--" line that appears 
before signatures. This 
way, your signature no 
longer looks like it's 
auto appended, but 
something you took 
the trouble to person-
ally write. To activate, 
just enable and save 
changes in Labs.

Save screen space (Muzzle) 
Some of you popular people out there 
might have hundreds of people on your 
chat list. If each has their "unique" status 
message this might end up making your 
list a mile long. Activate this feature to 
hide your friends' status messages. This 
way you will know who is online, you save 
space, and you're not subjected to infuri-
ating status messages such as "xxx is really 
happy to see a unicorn".

Forgotten Attachment detector 
Surely, there might have been more than 
one occasion where you have sent out an 
email, and then sent out a rectification 
mail saying "sorry forgot attachment". 
Save yourself that little embarrassment 
by activating this feature. It prevents 
you from accidentally sending messages 
without the relevant attachments. It 
automatically scans your body text and 
prompts you if you mention attaching a 
file, but forgot to do so.

Add another pane (Multiple 
Inboxes)
This application lets you add boxes next 
to your Inbox, where you can view more 
mails. You can customise which mails you 
wish to see in these additional panes. The 
new lists of threads can be labels, your 
starred messages, drafts or any search you 
want. So if you pull emails from another 
mailbox via POP3, you can auto apply 
a label to them and have those mails 
displayed alongside your main Inbox. 
It’s like having two or more Inboxes in 
one mail. To configure this feature, go to 
Settings and click the Multiple Inbox tab. 
Here you can define the criteria for up 
to four panes. However, more than three 
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Changing the settings for your Windows 7 desktop

Only Vista SP1
can be upgraded
to Windows 7

Visit www.thinkdigit.com to know more 
about Windows 7

Spice up your Inbox using plugins
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Windows Media Player from updating the 
information on a file from the internet. This 
is because an unpatched Windows Media 
Player provided with Windows 7 changes 
the file when it retrieves this information 
from the internet. For example, the audio 
information from the first few seconds of an 
mp3 file may be lost. 

Use the search bar as a run bar
There is no run bar by default. However, 
when you click on start, the search field can 
be used for running programs. This process 
is made much faster in Windows 7, because 
you don’t even have to type in the complete 
name of a file or program to open or run it. 

Using program history
Windows 7 saves recently worked on docu-
ments in the start bar itself. These are 
not general documents in the ‘documents’ 
menu, but program specefic documents. 
For example, the recently visited sites on 
Opera will show up in the sub menu for the 
Opera program, and can be launched from 
the start bar itself. Similiarly, image editors, 
multimedia players, and practically every 
program will show up a sub menu with 
recently worked on items. 

Using applications on
the taskbar
Windows 7 replaces the space consuming 
application bars on the taskbar with icons. 
Hovering over the icon for an application 
shows a preview of the window. If there are 
multiple tabs in the application, then the 
preview will show all the tabs as separate 
windows. Hover over this preview to get 
the preview options. You can close tabs or 
windows from there. If you just hover over 
the preview and do nothing, all other win-
dows will go transparent, letting you see 
the application in full screen. So, if you are 
writing an email, but a phone number is on 
a Notepad file in the background, you don't 
need to go through a series of minimise 
and maximise actions to have 
a peek at the notepad file. This 
is faster than [Alt]+[Tab] 
too. When an application opens 
up in the taskbar, right-click on 
it and click on pin this applica-
tion to the taskbar. Like a dock 
in OS X, this application will 
remain here permanently. You 
can choose to unpin a program 
at any point of time. This fea-
ture takes away the need to go 
to the start menu for common 
applications. 

Using window actions 
for managing windows
Click and drag the title-bar of 
any window to the top of the 
screen to maximise it. Click and 

drag the top bar away from the top edge to 
restore the window. Click and drag the title-
bar of any window to either side of the screen 
to make that window fit half the screen on 
the side to which you drag it. You can also 
use the [Windows] and the arrow keys to 
arrange the window. [Windows]+[Left] 
or [Windows]+[Right] will place the 
window on either side, [Windows]+Up 
will maximise and [Windows]+Down will 
minimise the window. 

Cutting down the size of the 
taskbar
A significant difference is made by the 
size of the icons in the taskbar. By the 
standards of XP or Vista, they are huge. To 
change this, right-click on the taskbar, go 
to Properties > 
Taskbar and 
check use small 
icons. 

Use 
VirtualBox to 
experience 
Windows 7
You do not need to 
partition your hard 
drive or use a spare 
computer to check 
out Windows 7. 
Just use a program 
called VirtualBox 
that emulates a 
virtual machine on 
your computer screen to install the oper-
ating system. Click New and enter a name 
for the machine. In the OS Type dialogue, 
choose Microsoft Windows as the operating 
system, and Other Windows as the version. 
Choose to make a hard drive of around 20 
GB, but even 10 will suffice. In the Details 
window, mount the DVD image either by 
selecting an ISO, or the drive in which the 
DVD is in. Without this step, VirtualBox will 
not start the Windows 7 installation when 
the virtual machine starts up. 

Change network settings
The age old two computer icon for net-
work connections has been replaced with 
a monitor and a cable icon. This will be 
one of the few icons on the system tray by 
default. Click on this icon, then click on 
Open network and Sharing center. This view 
will seem a little complicated. To get direct 
access to your connections for changing 
IP settings and the like, click on Change 
Adapter settings. 

Use Sticky Notes
A great new feature in Windows 7 is the 
Sticky Notes. Start > Sticky Notes, 
and a small square appears on the screen 
exactly like a post it. Click on the plus sign 
to add a note, and drag the bottom right 

corner to resize the note. Click on the cross 
to close and delete the note. Note that the 
text stored in the sticky notes cannot be 
saved, but the notes will survive restarts as 
long as you do not close them. 

Use libraries
Libraries are a great way to navigate files on 
your computer. Say you have music stored 
across different hard drive partitions, and 
an external hard drive that is not always 

connected to the 
computer. Placing 
all the folders with 
music in them in 
the music library, 
will let you access 
the music files 
from essentially 
one folder. The 
files are not stored 
in the library, but 
the directory struc-
ture indexes the 
files and makes it 
accessible in this 
manner. You can 
also store the same 
files in different 
libraries using 
different library 
structures. 

Adding a Sticky Note to the desktop

Use VirtualBox to install Windows 7 on earlier versions

Windows 7 Beta
expires on August 1. 
So backup your data
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Changing the lid settings on a 
laptop
Many laptop users like to use the "do 
nothing" option every time the lid of the 
laptop is closed. Go to Start > Control 
Panel > All Control Panel 
Items > Power options. Change 
the default plan by going to change plan 
settings. This will open the Edit plan set-
tings window. Click on Change Advanced 
power settings. Under Power Buttons and 
Lid, there will be an option to change the 
action on closing the lid. 

Boosting the performance
If you prefer speed over bells and whistles, 
go to Start > Control Panel > 
All Control Panel items > 
Performance Information and 
Tools. Click on Adjust Visual effects, and 
select the Adjust for best performance 
radio button. You can tweak the minute 
details of the Windows 7 interface here, 
and go for some features that you like, 
discarding features that you don't. 

Fine tune the font display
Go to Start > Control Panel > All 
Control Panel Items > ClearType 
Text Tuner. The text tuner will show a 
bunch of different text display options, all 
of which are slightly different. While you 
are not allowed to manually tweak these 
options, the approach of choosing one from 
different versions works as well.

Using the Snipping Tool 
The Sniping tool can be used to capture 
any part of the screen, or just a particular 
window. Go to Start > Snipping 
Tool. In New, select the kind of snipe 
you want. A rectangular snipe lets you 
select a rectangular portion of the 
window. A freeform snipe gives you a 
pencil like select tool. The windows snip 
lets you save an entire window as an 
image file. As soon as a portion of the 
screen is snipped, Windows 7 lets you 
save the sniped portion as an image file. 
The snipped portion will also be copied 
to the clip board. 

Calibrate the Monitor
Windows 7 has a monitor calibration walk-
through that lets you accurately set the 
display settings. Go to Control Panel 
> All Control Panel Items > 
Color Management > Advanced 
> Calibrate Display. A detailed 
explanation along with pictures to guide 
you will let you calibrate the display. At the 
end of the process, you can revert to your 
earlier settings. 

ADOBE LIGHTROOM 2.2
Adobe Photoshop Lightroom 2.2 is bun-

dled along with Adobe 
Photoshop CS4, and is a 
complete photo manage-
ment utility. This soft-
ware is meant for pro-
fessional and enthusiast 
photographers, who 
have to handle a large 
photo collection. There 
are features available 
for filing, tagging and 
filtering photos. Some 
basic image editing 
can also be performed 
through the software, 
and the photos can be 
exported directly to 
Photoshop for further 
processing. 

Add images to Lightroom
Go to File > Import Photos 
from Disk or use the shortcut keys 
[Ctrl]+[Shift]+[I] to import photos 
stored on the hard drive. To import images 
directly from a digital camera or a USB 
drive, go to File > Import Photos 
from Device. Once imported, only the 
last imported photo will be seen in the cata-
logue. Click on the All photographs option 
in the Catalogue window to view all the 
imported images. 

View a quick slideshow
To instantly view a slideshow of all imported 
images or a selected catalogue, go to 
Window > Impromptu Slideshow or 
click [Ctrl]+[Enter]. 

Batch process images
Go to File > Export, or use the 
shortcut keys [Ctrl]+[Shift]+[E]. You 
can set your own presets, use custom set-
tings without presets or use Adobe's presets. 
For uploading to the web, the email preset 
is available, which resizes the images to 
a width of 640 pixels, 50 per cent quality 
and 72 dpi. To process images for an image 
hosting service, you can use better quality 
images. Create a new user preset by clicking 
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The Snipping tool in Windows 7

Fine Tuning how Windows 7 displays fonts

The new Flash Lite 
runtime released by 
Adobe allows mobile 
phones to display 
fl ash based content
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on User Presets then clicking on the Add 
button. Change the location, format, size 
and quality settings. To use a different 
colour space from the default RGB, click on 

Color Space, select Other in the drop down 
box, and check Include Display Profiles to 
view a list of available profiles. Click on 
Export.
 

Basic image editing
The Develop window has controls for basic 
image editing. By default, you will be in the 
Library window. You can correct exposure, 
brightness / contrast, fill light, and tweak 
the colour balance. 
The other options 
available in the 
Develop window 
include tone map-
ping, split toning 
and camera calibra-
tion.

 
Correct 

White  
Balance
In the Develop dia-
logue, click on the 
White Balance drop 
down box. To use 
a custom white 
balance setting, click on custom. To trust 

Lightroom, and use an automatic white 
balance setting, click on Auto. At any point, 
to go back to the original image, click 
on As Shot. Alternatively, go to Photo 

> Develop 
Settings > 
Auto White 
Balance. You 
can also use 
the shortcut 
keys [Ctrl] 
+ [Shift] 
+ [U] for 
auto white bal-
ance correc-
tion. To revert 
to the original 
image, go to 
Photo > 
D e v e l o p 
Settings > 
Reset. Note 
that this will 
also reverse 

other changes made to the image. 

Compare two photos side-by-side
The compare option lets you take a close 
look at two photos, or two variations of the 
same photo. If you zoom in to one photo, 
and move the photo about, the equivalent 
pixels in the second photo will also move in 
the same way, and be zoomed in to the same 
extent. First select the two photos you want 

to compare. If more than two are selected, 
only the first two 
in the filmstrip will 
be compared. Go to 
View > Compare, 
or just hit the [C] 
key. 

Export a 
slideshow to the 
web
Go to Window 
> Web. The gal-
lery option will be 
selected by default. 
On the Templates 
panel, which will 

be on the left-hand side of the window, 
there will be a number of templates avail-
able. Choose one of these templates. If an f 
icon appears, it’s a Flash template, and if 
the HTML icon appears, then it’s an HTML 
template. You can preview the complete 
gallery in the main window. Once you 
come across a gallery you want to use, 
select other details such as the name of the 
web site and gallery name. Once you are 
done, you can upload directly to your FTP 
server. Scroll down in the Web window till 
you see FTP upload options, at the bottom. 
Click on Upload.  

Make Lightroom run faster
Optimising the catalogue will make 
Lightroom run visibly faster. Go to Edit 
> Catalogue Settings > General 
and click on the Relaunch and Optimise 
button. Lightroom will restart at this point 
of time, and the catalogues will be opti-
mised for performance. 

Save catalogues
Once you have added photos to the cata-
logue, you can save the catalogues in an 
internal format of Lightroom. Go to File 
> Save Quick Collection. Enter 
a file name, and save the catalogue. You 
can choose which catalogue to load every 
time you start Lightroom. Go to Edit > 
Preferences > General > Default 
Catalogue. When starting up, use this 
catalogue drop down box, and select the 
catalogue you want to load every time 
Lightroom starts. 

THE GIMP
The Gimp is a platform-independent 
graphics editing tool comparable to 
Photoshop. While not as user-friendly as 
Photoshop, the program has most of the 
features of Photoshop, and some more. 
The Gimp is mostly used by Linux users 
for graphic editing and retouching pho-
tographs. 

Using the brushes and the 
eraser tool
The brush tool is accessed with a paintbrush 
icon. The eraser tool is a flattened red cube in 
the toolbox. It is to the right of the brush tool 
in the toolbox. Once a tool is chosen, choose 
a brush next. The options for this will appear 
in the context menu, which is located below 
the toolbox. Use the brush drop-down box to 
change the brush. Next increase the brush 
size, by using the slider or entering values 
in the brush size field. The maximum size is 
10, which is pretty small in relation to most 
images. There are advanced brush dynamics 
available, including jitters, fade out and gra-
dient paint. Use the Brush Dynamics drop 
down menu for more advanced options. You 
can tweak pressure, velocity, size, colour and 
hardness. 

The basic editing window in Lightroom

Compare two versions of an image side by side

Exporting a gallery in a format that can be put on the web

QnA
Get your tech niggles 

sorted out on page 89
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Create a logo
To create a logo, or a text with effects such 
as word art, go to File > Create > 
Logos and choose one of the options from 
the list. Enter the text for the logo in the 
Text: field. Change the font and background 
colour, and increase the font size as neces-
sary. Click on Ok. The logo created will 
typically be a composite of a few layers. 
Select the topmost layer and go to Layer > 
Merge Down to merge the layer with the 
layers below it. Merge all but the last layer to 
create a logo with transparency. 

Change layer composition
The blending options for layers is located 
in the Mode drop down box of the layer 
toolbox. The regular options available up 
to Photoshop CS3 are available. To fade 
changes to a degree with blending options, 
once changes are made, go to Edit > 
Fade, then use the transparency slider and 
blending options.

Working with layers
There is no pointer available in the toolbox, 

which is strange. While it is possible to 
drag and drop images to open them in 
Gimp, it is not possible to drag and drop 
images onto a layer. Select all, copy then 
paste into the file to create a layer. Use 
the scale tool to resize an image once it 
is dragged into a layer. Once you have res-
caled an image, click on Scale to finalise 
the scaling. Alternatively, you can go to 
Layer > Scale Layer. You also 
cannot drag a layer to re-arrange the 
layer order. Go to Layer > Stack > 
Raise Layer or Layer > Stack > 
Lower Layer for rearranging layers. 
An interesting option not available in 
Photoshop is to reverse the order of layers. 
Go to Layer > Stack > Reverse 
Layer Order. The visible order of the 
layers remain the same, but the top to 
bottom or bottom to top interpretation 
of the layer order switches every time you 
reverse the layer order. 

Selection
Apart from making sure that a layer is 
selected, you always have to have the 
entire image selected to work on it. If the 
whole image or a part of it is not selected, 

you cannot perform any photo editing oper-
ations at all. The best tools to select a part 
of the image is the Fuzzy Select tool, which 
is similar to the Magic Want in Photoshop, 
and the Lasso select tool. The lasso tool 
offers bigger circular nodes, which is an 
advantage over Photoshop. 

Using the clone tool
The clone tool can be used to hide unwanted 
artefacts or cover up unwanted features. 
What the clone tool does, is lift a portion 
of an image, and impose it over another 
portion of the image. To select the reference 
portion of the image, hold [Ctrl] and 
click on the part of the image you want to 
use as the reference. Then, use the clone tool 
over the area of the image you want to cover 
up. For elements such as fences or walls, you 
can use the perspective clone tool. 

Use a smaller menu
By default, the menu and toolboxes of Gimp 
are pretty large. You can reduce the size by 
going to Edit > Preferences > Theme 
> Small. This step will also free up more 
space for the image window. Go to Edit > 
Preferences > Interface > User 
Interface. Change the Default layer and 
channel size to "Small" and Navigation pre-
view size to "Small".

Correcting the white balance
If you have taken images with the wrong 
white balance, you can fix them automati-
cally in Gimp. Go to Colors > Auto > 
White Balance, and Gimp should take 
care of the rest. 

Changing the composition of layers

Build your 
own HTPC
DIY on Page 92

Instantly create a logo on Gimp

Visit www.thinkdigit.com to know the 
latest on software
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Compress images while saving
While saving the file, just add *.gz or 
*.bz2 to the filename, and the file will be 
saved as a compressed file directly from the 
program. For example, using image.jpg.gz 
will save the file as JPG and then compress it. 
This feature is useful for emailing pictures. 

Reduce filesize of JPG files
This process is analogous to the 'Save As for Web' 
feature in Photoshop. Go to File > Save As 
> JPEG then click on save. Reduce the quality 
slider from the default 90 to a suitable compro-
mise, say 60 or 75. A file size will be displayed 
below the slider. Then click on Save.

Make brushes for Gimp
Create a new image, edit it, and then save 
it as a brush file. Go to File > Save 
As, and in the file type drop down menu, 
select Gimp Brush (*.gbr). Save the 

file in home\.gimp-1.2\brushes, then 
refresh the brushes to see your brush. To create 
a simple brush, right-click on the brushes 
window, select New Brush, edit the parameters 
and click on Save. Brushes created in this way 
appear instantly. You can also right-click on a 
brush, and click on Open Brush as an Image, 
then edit the image file and save it as a brush. 

Adjusting the image
Gimp gives a number of image adjustment 
options. These are available in the Colors menu. 
Some of the options here are more advanced 
than Photoshop. For example, Colors > 
Threshold gives you two sliders to play around 
with instead of just one. The Color Balance menu 
has a 'Preserve luminosity' toggle that conserves 
the brightness of the image despite changes. 
While applying a filter or adjustment, you can 

use another adjustment 
to simultaneously manip-
ulate two aspects of the 
image. 

Using Paths
The path tool is the 
pen nib icon. Select it 
to draw a path. You can 
edit the path later, the 
nodes are larger than the 
nodes of the path tool in 
Photoshop, which makes 
this process easier. Click 
to add a node, click and 
drag to add a curve to 
the path between the 
nodes. Double-click 
once the entire path 
is finished. Look at the 
paths window below the 
toolbox for advanced options. Click on edit 

to move around nodes or manage the curves. 
Select move to move the 
entire path. Select Design 
again to add nodes. Now 
click on Select from Path 
to select the area the path 
covers, or click on Stroke 
Path to fill the path with a 
line. Advanced options are 
available at this point in the 
window that pops up.

GEGL Filters
GEGL stands for Generic 
Graphics Library. The later 
versions of Gimp use this 
for processing images better. 
By default, GEGL uses only 
8 bits of colour memory. 

GEGL allows Gimp to work on more space. 
Go to Tools > GEGL Operations to 
access GEGL filters. These vary from blurring 
to unsharp masks. There are 24 GEGL filters 
in Gimp 2.6. 

Instant protractor
Getting the angles just right can be impor-
tant for a lot of image editing purposes. This 
is particularly useful for landscape photos 
to check if the horizon is perfectly vertical. 
There is a protractor tool in the Gimp. Go to 
Tools>Measure. Click on any one point, then 
click on any other point in the photo. The 
angle between the two points will be displayed 
along the bottom of the window. 

Using pattern fill
The Gimp has an interesting feature, where 
you can fill a part of an image with a pat-
tern. This can be done by either using the 
select too and increasing the threshold 
to 100, or selecting a colour and using a 
threshold. Select the bucket fill tool (next to 
the font tool, or by using [Shift]+[B]). Select 
the Fill Type as Pattern. Select a pattern, and 
click anywhere in the image. 

Making brushes in Gimp

Filling a selected area with a pattern

Using paths in Gimp

Multimedia Authoring 
with Sophie
Page  76
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Monitor doesn’t display anything 
I read the QnA and Agent001 section in Digit regularly, and so 

I’m writing to you with my problem. My system is an Intel Core 2 Duo 
E4500, 250-GB HDD, GeForce 8600GT 512 MB and 4 GB 800-MHz 
RAM. I use an HCL 700SFl monitor. I installed Left 4 Dead without any 
hassles, and it runs properly. However, my monitor doesn’t show me 
any display. Instead, it gives a message with a blank screen - HF 70 Hz 
and management in 15 sec. Please give me a solution to this problem. 

Harsimranjit Singh Rangi 

 The problem is with your monitor and your game settings. 
The game loads with a resolution or a frequency that isn’t 

supported by your monitor. To fix this, right-click on the game 
in your Steam list of games and then on Properties. Click on 
Set Launch Options. Enter the value as -w 800. This will force 
the game to load with a resolution of 800 x 600. You can also 
try setting your monitor refresh rate for Windows to some-
thing a bit lower.

Query for a TA790GX3-A2 motherboard
I recently got a computer assembled by a local computer vendor in 

Baroda, Gujarat. The specification of my PC is as follows: 
AMD Phenom Quad Core 9950+ with a Biostar TA790GX3 mother-
board2 x 2 GB Transcend 800 MHz FSB DDR2 RAM

The rest of the system has regular components. I have a few 
queries regarding the products. Why can't I run both the modules in 
dual-channel mode even if they are both of the same frequency? I have 
lost my installation CD. Can you help me to source a new one?

Pankaj 

 The problems with dual-channel mode could be a compatibil-
ity problem between your memory and the motherboard. It 

could be that the RAM modules are plugged into the wrong slots. 
The drivers for your motherboard can be found at Biostar’s site - 
http://www.biostar.com.tw/app/en-us/t-series/driver.php?S_ID=376.

A few problems
1. Can I customise the right-click menu? I know how to do this from 

the Registry Editor. How can we add a folder name in the list of the 
right-click menu?
2. I have a computer running Windows XP with 512 MB of RAM. It was 
recently formatted because of some virus. Before formatting, GTA Vice 
City ran smoothly, but now it shows the error “Cannot find video mem-

All your computer 
niggles and nags are 
dealt  with here!

Your Questions, 
Our Answers

ory”. I had manually increased the video memory from the Windows 
Control Panel, but the game still does not start. What should I do?
3. Tell me how I can merge two Window partitions or remove the parti-
tions?
4. Also, tell me how you get 8 GB in a DVD of capacity 4.7 GB?

Akshay Soam 

 Although you can use the Registry Editor to add the specified 
entry, it might be easier to use software to do this — http://

www.freeware365.com/desktop/folderguide.htm.� 
If you run a computer with an onboard graphics card, 

then that is the cause of your problem. Try increasing the 
allotted�memory to your onboard graphics solution from the 
BIOS.�Upgrading your system or installing a graphics card is 
highly recommended. 

You can remove Windows partitions from the Computer Man-
agement utility under Administrative Tools in the Control Panel. 
Go to Disk Management and right-click on the partitions you want 
to delete. The partition you are currently working on cannot be 
deleted though. Merging can be done by first moving all data from 
one partition to the other, and then expanding that partition. You 
can also look for commercial partitioning utilities such as Parti-
tion Magic and EASEUS Partition Manager. 

8 GB can only be burnt on dual-layer DVDs. These are different 
from single-layer DVDs that we find everywhere. 8 GB dual-layer 
DVDs are expensive and usually cost around Rs. 100 per disc. 

Windows installation won’t detect my hard drive
My one-year old PC with an Intel DG33BU board, an Intel Core 

2 Duo E4500 processor, a 160 GB Seagate SATA hard drive, a Lite-
On DVD Writer and 3 GB DDR2 RAM (512+512, 1+1 GB, dual chan-
nel), does not run with SATA hard disk. Windows fails to detect 
the hard disk during its installation. When I set the ‘ATA/IDE 
mode’ to ‘Native’ and ‘SATA Configuration’ to either ‘IDE’ or ‘AHCI’ 
in BIOS, I am forced to set the ‘ATA/IDE mode’ to ‘Legacy’. As a 
result, the ‘SATA Configuration’ option in BIOS is disabled. Only 
then am I able to install Windows. Although it has been running 
fine since then with the setting, I think I may not be getting the 
optimum speed of SATA drives. I have seen my friend’s PC with a 
965 chipset-based motherboard running fine with ‘Native’ SATA 
support. Suggest what to do. 

Anupom Bora 

Folder Guide lets you easily add folders to the right-click menu

Partition Magic is a well known commercial partitioning utility

Q&A
SATA
A serial interconnect 
system between mother-
boards and peripherals

of netbook 
buyers con-
sider them
secondary PCs

80%Bazaar
Read the Black-
Berry Storm review 
in Bazaar 68
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 The Windows installation is unable to detect the hard drive 
mainly because it doesn’t come with the drivers for the SATA 

controller. Create a slipstream Windows installer. Download and 
copy the drivers for your motherboard’s SATA controller and 
create the disk using nLite (www.nliteos.com).

Appalling performance in games 
My PC configuration is as follows: 

CPU: Intel Pentium 4 HT 2.8 GHz
Motherboard: Intel 865 GBF with AGP 8x slot
RAM: 2-GB DDR (1 GB x 1 333 MHz, 512 MB x 1 266 MHz, 512 MB x 1400 
MHz)
HDD: Seagate 160 GB and 80 GB IDE 7200 rpm
Sound: SoundMax onboard with latest drivers installed
OS: Triple boot between Windows XP SP3, Vista Home Basic, Windows 
2003 Server
Graphics card: Sapphire Radeon AGP x1650(500 MHz) 512-MB DDR2 
800 MHz with 8.12 Catalyst drivers installed.

When I play Far Cry 2, Crysis, Call of Duty: World at War, they give 
me a very low frame rates — somewhere between 8 to 15 frames per 
second even with the minimum settings. Isn’t this card enough to play 
these games even on minimum settings? Even Need For Speed: Carbon 
gives 12 to 18 fps at a resolution of 1024 x 768. I have seen people 

maxing out this game on this card. 
Some games like Dead Space give decent frames, but there are 

some audio problems. The only games which I could play properly 
were Bioshock and FEAR. I play games only in XP. In Vista, these 
games are not at all playable. I tried reinstalling drivers for my graph-
ics card, sound and I even installed the SP3 update for Windows XP, 
but there was no improvement. 

What could be the problem? My processor fan makes a lot of 
noise and the temperature of the CPU reaches 60 to 65 degrees 
after playing a few games. Should I buy a new heatsink and fan or 
should I upgrade to a Radeon HD3850 AGP to get better perfor-
mance at medium / high resolutions? I do not have the budget to 
buy a new CPU.

Pranav Rao 

 Your system is highly outdated in comparison to the 
hardware available today. In its time, the Radeon x1650 was 

a mid-ranged graphics card meant to run games at medium 
resolutions. The processor is probably what’s bringing the 
performance down even more. Upgrading to a Radeon HD3850 is 
not recommended with your current processor. Your processor 
would then become a bottleneck. 

The temperatures for the processor are slightly high too. Try 
running the games with the cabinet open and see if the tempera-
tures drop a bit. A better heatsink might help, but if you haven’t 

Computer running really slow
Hi, my system configuration is as follows: 

Operating System: Windows XP Professional (5.1, 
Build 2600) Service Pack 2 
Motherboard: Intel DG33FB 
Processor: Intel Core 2 Quad CPU Q6600 @ 2.40 
GHz  
Memory: 2020 MB RAM 
My problem is that my computer is dead slow. It 
takes about four minutes to boot up. Please give 
me a solution for this problem.  

My drive configuration is as follows 
Disk & DVD/CD-ROM Drives 
Drive: C: 
Free Space: 0.7 GB 
Total Space: 12.5 GB 

Drive: D: 
Free Space: 3.3 GB 
Total Space: 30.0 GB 

Drive: E: 
Free Space: 42.0 GB 
Total Space: 110.1 GB 
Should I reinstall my Windows and format my 
drive? I have my mails in Outlook Express. How 
do I transfer them back to my laptop and back 
again after I reinstall? Please help! Thanks in 
advance. 

 Your C partition is low on space. This is 
the main reason for the slowdown of your 

system. For optimising your space, change 
your My Documents path. Right-click on the 
My Documents folder to do this. Move your 
unnecessary files from the Desktop and C 
partition and copy to another partition or 
drive. Move your Outlook data from Outlook 
at Options in Maintenance. 

Jagdeep Virdi
 (Tech QnA Expert)
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Moving your My Documents folder to a 
new position moves the contents as well

Adding drivers to your installation disc using nLite

Adding drivers to your installation disc using nLite

Don't miss out 
the exciting game 
reviews in Esc 
towards the end
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cleaned the case from inside in a while, it’s time you do so. You 
might see some improvement. It could also be that your proces-
sor is throttling down due to overheating. If you enjoy the latest 
games, then a complete system upgrade is highly recommended. 

Blurred images on the internet 
I have a Toshiba Satellite L100 laptop with an Intel Core Solo 

1.86-GHz processor, 512 MB RAM, 60 GB SATA HDD and 128-MB 
shared graphics card. When I browse the internet, all images and 
photos show up blurred. I find that other images stored in my 
system are showing up fine. The problem is only with the images on 
the internet. I use Windows XP Home Edition. Please help me out. 

Regards. 
Rajesh Das 

 The problem is really odd. Try other browsers such as 
Opera, Firefox, Safari to see if you have the same problem.� 

Many problems... 
I have a system with the following configuration — i945 

GCM chipset motherboard with an Intel Core 2 Duo CPU E7300 
@ 2.66 GHz, 2 GB DDR of RAM with a 250-GB hard disk drive and 
a DVD writer. I run Windows XP Professional. I also have a BSNL 
Broadband router (Sterlite SmartAX MT882) and an HP 3-in-1 
F2100 series printer.

I have Vista Ultimate Edition which I want to install, but I am 
not able to install my modem/router with it as it does not load 
properly — maybe it isn’t compatible with Vista. I checked online for 
updates of the driver for the modem, but I couldn’t find any. What 
can be done?

My printer driver takes too long to install in Vista, and some-
times the system hangs, but the printer driver does not load 
properly.

When I install IE7, the installation is proper, but during reboot, 
the system hangs while IE 7 personalises the settings with uninstall 
stub written on it. To solve this problem, I have to reinstall Windows 
XP repeatedly, but I am not able to use IE7. Please advise!

I am using MS Office 2007. Whenever I use MS Word and close 
it after doing my work, a window appears stating “Microsoft Office 
Word has encountered a problem and needs to close” and tabs 
“Send Report Later” or “Don’t Send”. I tried repairing the MS Office 
with the CD, but the result is the same. How can this be solved?
I need advice on the following as well — what is a chipset mother-
board and is it fine to use these mother boards? What are original 
motherboards and how are they different from chipsets? How do I 
get SP3 for my Windows XP? Is it worth installing SP3? Can I get the 
updates for this? How do you rate my system configuration? I know 
the request is a bit too long. I hope to hear from you.

Sanjay 

 Your problems with the modem and the printer are mostly 
caused by the drivers. Look on the official sites for the 

drivers. To be on the safe side, install updates of drivers for all 
your components. 

The problem with IE7 could be due to a virus. Run an antivi-
rus scan to check it. MS Office 2007 might be crashing because 
of a corrupt installation. Try reinstalling the software to see if it 
fixes the issue. It could also be a faulty RAM chip. 

A chipset is the set of chips mainly and traditionally known 
as the Northbridge and Southbridge used on motherboards. 
They have their own roles to play in the operation of a computer. 
The motherboards are made by separate brands as ASUS, MSI, 
Gigabyte, etc. When Intel makes a reference board with its own 
brandname, then such a board is commonly called an original 
Intel motherboard. You have an Intel 945 board made by Intel, 
but you can find boards made by other brands as well.

Windows XP SP3 is available as a free download on Microsoft’s 
web site. You can also use Automatic Windows Updates to update to 
it. Windows XP SP3 brings additional stability and security fixes. 

Windows XP SP3 
I have installed Windows XP SP3. It works well but when I try 

updating my graphics card driver and restart, the system does not 
boot. It shows a blue screen with some text on it for a few seconds, 
then it automatically restarts. On the next reboot, I get the safe mode 
bootup prompt. If I select the last known configuration option, it works 
and the system boots up. When I check the display drive, it still has the 
old version. Could you tell me how to rectify this problem? 

Sreekanth A.S. 

 Make sure that your graphics card is still on the list of 
supported hardware. Sometimes, manufacturers no longer 

support extremely old hardware. In such cases, the drive 
should not install. However, if it does, there is a good chance it 
will crash. If your current drivers don’t give you any problem, 
use them. 

Weird errors in Windows 
My system is showing an unusual message. During start up, it 

says that c:\AutoProtect\DrvMonitor.exe is corrupted. I have a two-
year old Lenovo 
laptop with 512 
MB RAM and 
an 80 GB hard 
drive. It runs an 
Intel Celeron 1.73 
GHz processor. 
Is this due to a 
virus infection?  

Souvik Saha 

Yes, this is a vi-
rus infection. It 
is a Trojan and 
the best way to 
fix the problem 
is to install, up-
date and run a 
complete system 
scanner.� 

Disabled 
Windows 

Task Manager
My Task Manager 
is disabled. How 

do I re-enable it? Please Help. 

 First, open a run window. Type in gpedit.msc. Then, go to 
User Configuration > Administrative Tem-

plates > System > Ctrl+Alt+Del Options. Double-
click on Remove Task Manager. Select disable. Your problem should 
then be solved. 

Jagdeep Virdi 
(Tech QnA Expert) 

Flash drive showing wrong free space 
My 8 GB pendrive just shows 2 GB of space and 5.85 GB of the 

space shows up as unallocated. What should I do? 

 Right-click on My Computer and go to Computer Manage-
ment. Now go to Disk Management. First backup the data. 

Then, select the 2 GB partition and delete it. Now recreate a new 
partition that uses the entire space on the flash drive. Format it 
with the file system of your choice. 

Jagdeep Virdi 
(Tech QnA Expert) 

Enabling the Task Manager using the Group 
Policy Editor

The Tech Q&A section of thinkdigit.com is 
the place to get your PC problems solved
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Kumar Jhuremalani

E
ver felt cluttered with the tons of DVDs and VCDs lying 
around your home or on your TV? What about the inter-
face of your home theatre system, is it too slow or not that 
friendly? That’s where an HTPC comes into the picture. 

HTPC stands for home theatre personal computer or home 
theatre PC. Simply put, all this means, is building a PC for enter-
tainment purposes that combines the benefits of a computer 
and a television integrated into one system. It’s a good option, as 
it saves space with the capabilities of a computer. Another good 
thing about having your computer connected to your TV is being 
able to record shows on the TV directly onto your computer, 
especially when you are unable to watch the program while it’s 
being broadcast. With HTPC software, all this is possible for free. 
Having an HTPC allows you to make slideshows, presentations, 
surf the web, and any other general computer task, all from the 
comfort of your couch — if you plan to set it up in the living 
room, that is. Combine this with a wireless keyboard and mouse 
and you’re all set to enjoy an HTPC to the full.

Basic computers are normally set up for tasks such as 
checking mail, editing office documents, etc. An HTPC, 
however, does require specific hardware for home entertain-
ment. While planning an HTPC, its cabinet needs to be specifi-
cally selected, as it needs to match the environment of your 
TV and living room and not look out of place. Also, remember 
you need something small and compact. Choosing the correct 
motherboard is also important as space saving is quite essen-
tial and should also have sufficient expansion slots to connect 
the remaining hardware. Next, you need a TV tuner card in 
order to watch TV on your PC. A processor with adequate speed 
as well as enough system RAM is a must. The prices of hard 
drives have also dropped, and unless you have all your movies 
on DVDs, you're going to need all the storage space you can get. 
A graphics card and a sound card are optional. 

Noise is an important factor when building an HTPC. If you 
plan to keep the HTPC in your living room, you wouldn’t want 
it to be noisy, lest it interfere with your work, or play. You can 
easily counter noise by selecting the right cabinet, choosing the 
right components and managing fan placement. You should have 
one intake and one exhaust fan, preferably silent ones. Usually, 
processors that generate more heat have their fans running at full 
clip to keep them cool, thus, processor selection is also critical.

The parts we used for building our HTPC are as follows:
 The case: the HTPC case is important as this determines the 

ultimate look of the HTPC itself, and it will also have to fit the 
rest of the hardware. The case we selected is the Zebronics Tambi 
designed as a cube. We chose this particular case because it is 
compact, and has a 3.5-inch optical drive bay. The only limita-
tion that you might face when opting for such a small cabinet 
is having only a single hard drive bay. However, with 1.5 TB hard 
drives now more affordable, this shouldn’t stop you from choos-
ing such a cabinet. Further, it should also have front USB and 
audio connectors for attaching headphones, or to plug a flash 

drive for quick access. Some cabinets available in the market are 
very sleek and resemble DVD players. Nevertheless, be warned 
- such cabinets will not have much room for expansion cards or 
even a 3.5-inch optical drive bay. For these cabinets, you will also 
need to purchase a slim drive. The reason we did not opt for this 
is the absence of slim Blu-ray drives. 

 The motherboard: we’ve used a mini-ITX motherboard from 
Zotac. You can clearly make out the size differences between an 
ATX, mini-ATX and mini-ITX motherboards. 

The Zotac GeForce 8200 ITX-WiFi has been designed for the 
AMD platform and is really compact and well laid out. It has six 
USB ports, a VGA port and a DVI port. Zotac also supplies a DVI-
to-HDMI converter with the motherboard. Since space is limited 
due to its size, this board has four SATA ports and two DIMMs for 

LCD TVs
Get one for your 

HTPC 75

DIY: 

HTPC

Zotac GeForce 8200 ITX board with WiFi

The Zebronics Tambi mini-ITX cabinet

Build Your Own
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 The hard drive: for this HTPC, we used a Seagate Barracuda 
7200.11 1.5-TB hard drive. As the cabinet we have selected only 
has one hard drive bay, and we wanted to get the most out of it. 
Another plus point to having so much space is you can store huge 
amounts of data, be it music, movies, TV serials, etc. If you have 
properly utilised all the space on this drive, the media should last 
you for months.

 Optical drive: we have used an ASUS BC-1205PT Blu-ray drive for 
our HTPC. This drive comes with 5x BD-ROM, 12x DVD-R, 6x DVD-
RW, 4x DVD-R(DL) and 5x DVD-RAM. We used an all-in-one combo 
drive for our build. Alternatively, you could opt for a DVD writer 
if you do not wish to purchase Blu-ray discs. 

 TV tuner card: unfortunately, the motherboard we have used 
comes with only one PCIe X1 expansion slot. Therefore, we have 
opted for an external TV tuner card. We used the Leadtek WinFast 
PalmTop TV which is a USB external TV-tuner. This looks good 
and should blend well with the whole setup. If you have a PCI or 
PCIe TV tuner card with an expansion slot, then it all boils down 
to the cabinet — whether there is enough space or not.

RAM. It can hold up to 8 GB of DDR2-1066 RAM. A good addition 
for this board is a Wi-Fi kit that is really a bonus and helps you 
do away with the network cable. This motherboard also comes 
integrated with the NVIDIA 8200 graphics solution, which can 
easily play HD video.

 The processor: the CPU we used is the AMD 5600X2. We selected 
this processor to go along with the Zotac 8200 motherboard 
because of its capability to handle HD playback. Even a low-end 
processor such as the 5600X2 is sufficient for this purpose.

 RAM: since the motherboard has 2 DIMMs, we have used 2 GB of 
DDR2 - 800 MHz RAM. This is enough for running your operating 
system and efficiently supporting the processor.

Installing the AMD Athlon 5600 X2

The motherboard with only 2 DIMM Slots 

Securing the Hard Drive to the cage and then attaching it to the cabinet

3D TVs
The future of entertainment

is coming  26

Carefully installing the Asus Blu-ray drive
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 All said and done, you are set to enjoy your HTPC. The system 
we built is purely for entertainment and other essential func-
tions. Switching between the TV and PC is simple as the TV tuner 
card we opted for comes with a remote control. You can easily 
find a wireless keyboard and mouse combo from Logitech that 
will suit the multimedia needs uses of your HTPC. The finishing 
touches would consist in just hooking it up to a nice large LCD or 
Plasma TV, sitting back and enjoying your Blu-ray movie. 

kumar.j@thinkdigit.com

Bazaar
More peripheral options 

for your HTPC 68  

The parts we used

Parts Model Price (Rs.)

Motherboard Zotac GeForce 8200 ITX WiFi 5,900

CPU AMD 5600 X2 4,120

Cabinet Zebronics Tambi (with PSU) 2,250

HDD Seagate Barracuda 1.5TB 8,750

ODD Asus BC-1205PT BR Drive 5,990

RAM 2 GB Corsair value RAM 1,880

TV Tuner Card Leadtek Winfast Palm Top 3,750

Total 3,2640

Entry-level configuration

Parts Model Price (Rs.)

Motherboard Zotac GeForce 8200 ITX WiFi 5,900

CPU AMD 5600 X2 4,120

Cabinet Zebronics Tambi (with PSU) 2,250

HDD Seagate Barracuda 500 GB 3,220

ODD LG DVD RW 1,200

RAM 2 GB Corsair value RAM 1,880

TV Tuner Card Leadtek Winfast Palm Top 3,750

Total 22,320

Intel Solution

Parts Model Price (Rs.)

Motherboard Zotac GeForce 9300 ITX WiFi 6,999

CPU Intel Core 2 Duo E4600 5,887

Cabinet Zebronics Tambi (with PSU) 2,250

HDD Seagate Barracuda 500GB 3,220

ODD LG DVD RW 1,200

RAM 2 GB Corsair value RAM 1,880

TV Tuner Card Leadtek Winfast Palm Top 3,750

Total 25,186

High-end gaming solution

Parts Model Price (Rs.)

Motherboard Asus P5Q 9,610

CPU Intel Core 2 Quad 6600 9,150

Cabinet Antec P180 Lifestyle Cabinet 6,950

Graphics Card Palit HD 4870 Sonic 1GB 18,750

HDD Seagate Barracuda 1.5TB 8,750

ODD LG DVD RW 1,200

RAM 4 GB Corsair XMS2 5,493

TV Tuner Card Leadtek Winfast Palm Top 3,750

Total 63,653

Assembly of the entire HTPC 

The final outcome — you could also try modding the cabinet, but that's a 
completely different article...
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Agent 001

Agent001

J
ust as hard drives have become ever cheaper, the demand for 
unlimited broadband connections has also risen. Users now 
tend to maintain their movie collections on hard drives. 
After all, one 500-GB HDD costs less than Rs. 3,000 now, and 

will store the contents of some 667 DVDs and an even larger 
number of CDs. Moreover, HD content is becoming the norm and 
each movie can be as much as 22 GB in size. That’s about three 
dual-layer DVDs at a price of Rs. 100 each! I’m not saying 
the optical disk is dead. Blu-ray is one of its champi-
ons, and a worthy one at that. But for most people in 
India, Blu-ray is still a buzzword and purchasing Blu-ray 
movies is a costly affair. Additionally, there are those 
who wish to have the convenience of having their entire 
movie collection on a hard drive or two. And that’s just 
movies; I haven’t considered collectors of game ISO 
files. Before people cry pirate, let me assure you, I’m 
talking about legal content. When I purchase a DVD 
movie or a game, I always make sure to extract an 
ISO of the same and back it up on my local HDD 
— insurance against mishaps of any sort. I have 
lost a lot of movies that I legally bought over 
the years to damaged media and I can tell 
you its no laughing matter. It’s also easier 
(infinitely so) to just mount an ISO or play 
a movie from my local hard drive than 
having to rummage in any of my six 100-
disc CD pouches.

My quest for a large storage solu-
tion began courtesy of a friend, who 
asked me (as a favour) to find him 
a humongous external and internal 
solution for his new PC (he’s a movie 
buff too). He is also into a lot of 
downloading of movies and these 
are carted around with him where 
ever he goes. Unfortunately, moving 
around with a 100 GB collection of 
FLAC files doesn’t help either. I started 
doing a bit of Googling and called up a 
few of my favourite dealers at Lamington 
Road. My preliminary research taught 
me two things. First, internal hard drives 
are ridiculously cheap at the moment and 
anyone needing more storage should stop 
waiting and take the plunge. Second, external 
solutions have not really become cheaper over 
the past six months or so. However, larger solu-

tions have become available in the 2.5-inch HDD capacity due to 
increases in the areal density of platters. Earlier 250 GB notebook 
drives used to be the goliaths of the 2.5-inch HDD world. These 
days, 500-GB drives are available and besides double the storage 
over a 250-GB drive, they are also a bit faster. In fact, as hard 

drive platters get denser, the hard drive gets faster. Obviously, 
this is assuming that other things remain the same. This 

is because with the higher areal densities the read 
/ write head can access more data with minimal 

mechanics.
If you’re looking for an external solution via 

USB, a 2.5-inch form factor is the only way to go, in 
my opinion. Not only is this form factor much more 

compact, but also requires no external AC power connect, 
unlike 3.5-inch external solutions. For me, this is the 

main reason I avoid 3.5-inch hard drives. Since you’re 
likely to be carrying your hard drive with you in 

your bag or backpack, the smaller form factor is 
also a great help. Speed junkies, do not be fooled 

by the fact that 2.5-inch solutions are slower 
than your 3.5-inch solutions. When looking 

at an external solution, it’s the speed of 
the USB / FireWire interface, that is, by 
far, the main bottleneck. And there are 
7,200-rpm, 2.5-inch drives around as well. 
Therefore, you don’t have to be stuck 
with a slower performing 5,400-rpm 
solution. Obviously, people who copy 
100 GB of data a day would still prefer 
a 3.5-inch external solution, but there 
are very few people with such colossal 
storage requirements. While storage 
size is a criterion for portable solu-
tions, I personally don’t mind a smaller 
portable HDD, because I make it a point 
to back up data and copy everything to 
my larger hard drive on my home PC. For 
such (non-lazy) users, depending on their 

data requirements, anything between 80 
GB and 160 GB is enough. Data hogs with 

very huge amounts of data to back up 
should shop for a drive in the region of 320 

GB. Also, larger drives are available but these 
aren’t value for money, as their “cost-per-GB” is 

higher. However, prices are expected to fall over 
the next six months so watch out and monitor 

prices yourself too.

When  matters
Agent 001 goes shopping for the largest hard drive possible

Price watch
For the best prices fl ip 

over to...  103

SizeSize
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well. With a single 1-TB hard drive, I would get a cool 500 GB 
more than both my older 250-GB hard drives would give me. 
WD’s new Black Series are fast, but expensive. In fact, they are 
more expensive than Seagate’s options. The 750-GB WD Black 
Edition is priced at Rs. 6,400, while the 1-TB version costs 
around Rs. 8,200. I say not cheap, because in comparison, the 
new Seagate 1 TB 7200.11 series hard drive is priced at a lowly 
Rs. 6,500! For the price, this drive is an absolute steal — it’s fast, 
runs cool and is in no way inferior to WD’s Black Series offering. 
In fact, we recently tested this drive and found it to be quite a 
performer. Seagate has also launched a 1.5-TB hard drive and is 
retailing for as low as Rs. 8,300, which is nearly the same price 
as the 1-TB WD Black Edition. I find the thought of a 1.5-TB hard 
drive as a backup drive giving me shivers up my spine. What I 
do is keep a large internal hard drive as a spare. I connect this to 
my PC once a month and backup all my downloads, movies and 
games; for longevity purposes, I disconnect this hard drive and 
store it carefully. So at any one time, I have at least two backups 
of all my data. My external drive is used solely for copying data 
to and fro my office, home PC and my notebook. 

We also came across Seagate’s latest 7200.12 series hard 
drives which are very new in our markets. Sadly there’s no 1.5 TB 
offering yet and the maximum size is one terabyte. I really liked 
this drive as the acclaimed read speed was 160 MBps. This drive is 
priced at Rs. 6,800 and is still pretty affordable. I ended up buying 
one, and paid Rs. 6,750 for it and got a cool five year warranty. 
My friend wanted something bigger (gasp!) and we eventually 
settled on the massive 1.5 TB Seagate Barracuda 7200.11 for
Rs. 8,200. This hard drive is the largest in the world in terms of 
storage space as of now, and makes a very suitable purchase for 
someone looking at buying the largest capacity drive available. 
Obviously, when WD’s two terabyte offering releases this drive 
will relinquish its lofty perch. But that’s another story. It’s fast 
too and after testing it, I can tell you that it runs fairly cool. I can 
tell you the store owner was rubbing his hands in glee and he 
told us he had never sold so many gigabytes worth of hard drives 
to a single party. For those of you who cannot count, we made 
off with some 2.82 terabytes of total storage, or a little more than 
two thousand, eight hundred and twenty gigabytes. 

agent001@thinkdigit.com

Another dilemma faced by most buyers is whether to buy 
an external case and a hard drive and combine the two to make 
your own solution or simply buy a ready-made external drive 
solution. Both methods have their relative merits, but I tend to 
prefer the former. For me, a warranty of three to five years on 
a finished product is worth the premium any day. Also, many 
vendors sell very cheap drive enclosures, as they are called, and 
quite frankly, they aren’t very long lasting. A couple of users have 
reported damage to their hard drives by using these cheap cages 
and while I do not know how exactly the damage occured, there’s 
no point taking a risk, especially when loads of valuable data 
are involved. In my opinion, Western Digital is the most popular 
brand in the market as of now in terms of external 2.5-inch solu-
tions. Seagate has just entered the Indian market with some very 
interesting options. Of course they’ve been in the 3.5-inch HDD 
market far longer. These brands use their own hard drives in such 
enclosures. You can buy just the hard drive (meant for notebooks 
as they are 2.5-inch drives) and buy an enclosure. Transcend, 
Lacey and Zippy are the three brands that sell a lot of enclosures. 
Mind you, these brands do not manufacture hard drives so you 
will need to buy a hard drive from one of the above mentioned 
brands. There are also several manufacturers who sell external 
solutions. WD, Seagate, Iomega, Freecom and Transcend are the 
big players and you will find quite a few offerings from them in 
the market, with WD and Seagate being the biggest sellers and 
also the most popular. Iomega and Freecom are slightly costlier. 
The reason for this, I assume, is because they don’t manufacture 
HDDs of their own. Seagate and WD also have the best warranty 
policies and the highest number of service centres — something 
that should also be taken into account.

For those looking at sheer speed, Seagate offers its FreeAgent 
XTreme drives. Unfortunately, these are based on the bulkier 
3.5-inch desktop HDDs, but they offer the blazingly-fast SATA 
2.0 interface. At Rs. 9,500 for the 500-GB version, and Rs. 10,000 
for the 640-GB version, these are worth the speed, especially for 
those wanting really snappy transfers and are willing to shell out 
accordingly. Obviously the Serial-ATA interface also helps over-
come the bottlenecks associated with USB and even FireWire.

For the data hog, I recommend WD’s 320 GB Passport. At 
Rs. 6,300, this is one of the best options around. I own a 160 GB 
WD external solution and am happy to report it has given me 
trouble-free service for the past two years, in spite of the rough 
handling it has borne. For someone looking at a smaller capacity 
solution, I recommend 160-GB solutions from WD. 80-GB solu-
tions are barely 600 bucks cheaper and not worth it, according to 
me, unless you really cannot afford to spend more. WD Passport 
160 GB for Rs. 3,100 is sweet. If you really are a behemoth to back 
up and store data, look at Seagate’s Free Agent 500 GB or WD’s 
Passport Elite 500 GB. This is the largest 2.5-inch solution money 
can buy. Unfortunately, these solutions are highly priced – Rs. 
12,000 for Seagate and Rs. 14,100 for WD. I bought the 320-GB WD 
for Rs. 6,000 after bargaining for a bit. And in my opinion, this 
offers the best of both worlds — it performs well and has oodles 
of storage. Best of all, it doesn’t break the bank.

In the desktop internal HDD space, it seems that the prices 
of the 500 GB-and-above segment have fallen, and fallen drasti-
cally. Everybody is going for 500-GB hard drives these days and 
even 250-GB and 320-GB hard drives are being overlooked. I was 
looking at buying two very large capacity hard drives — one for 
my friend’s voracious appetite for movies and another for me 
to replace the two 250 GB drives in my PC. And this is another 
reason to upgrade. Two hard drives consume twice as much 
power as one, not to mention they take up twice the space as 

When  matters

Terabyte
One Terabyte is one
thousand billion bytes, or
1,099,511,627,776 bytes

Quick Fact
The world’s fi rst hard drive, 
IBM’s RMAC was introduced in 
1956 with a capacity of 5 MB

Market Share
Seagate - 30.5%
Western Digital - 17.6%

It’s a well-known fact that Fujitsu had been struggling for quite 
some time now. This financial year alone, it had forcasted its 
losses to be around $500 million. With such tremendous losses, 
it has decided to shelve off its hard drive division to Toshiba. On 
the other hand, Toshiba hopes to gain a strong position in the 
enterprise-class solid-state disk (SSD) drive market. It will also be 
able to leverage Fujitsu’s expertise in the 2.5-inch HDD space, in 
which it is currently the leader. The deal will also fasttrack Toshiba 
to enter the HDD market for enterprise servers and data storage 
system applications. It now expects this deal to raise its overall 
share in the HDD market to over 20 per cent in the coming years. 
The deal is to take place in two stages with Fujitsu retaining 20 
per cent of its stake for some time. However, this is not the first 
time someone had their eye on ailing Fujitsu. Western Digital had 
made an estimated offer of $950 million some time back, but the 
deal fell through because of cultural differences. The value of the 
current deal is not known. Fortunately, layoffs don’t seem to be on 
the card as a result of the buyout.

Toshiba acquires more space
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Agent QNA

My PC configuration is as follows: Intel Core 2 Duo E4400 
processor, Simmtronics 2 GB @667 MHz, Mercury 945G Express 

Chipset, Samsung 19-inch LCD TFT monitor. Please comment on the 
configuration and suggest a good / powerful DX10.0 graphics card 
below Rs. 10,000.

Harish Verma

Do away with the Simmtronics memory. Although it was good 
in the days of SD RAM, it is not any more. Besides, service will 
be an issue. Opt for 800 MHz DDR2 memory instead of 667 MHz 
memory; the price difference is negligible. For Rs. 10,000, I’d 
recommend either a GeForce 9800 GTX+ or a Radeon HD 4850-
based graphics card.

I’m planning to buy a laptop in the next six months with a budget 
of Rs. 60,000. I’m looking for something that’s suitable for audio, 

video, gaming and office use. Please suggest a good configuration with 
good build quality, battery, features, support and services.

Rupak Nirola

If you want a multimedia notebook for that price, I recommend the 
Dell XPS 1530. It’s a solid performer for its price and comes with a 
very good processor. Dell also allows customisation of the compo-
nents, so you can end up with exactly what you like. 

I want to buy a digital camera in the price range of Rs. 7,000 to 
10,000. I want it primarily for capturing photos indoors (with less 

bright light than sunlight).
I have decided on a Samsung i8. Have I made the right choice? 

Please tell me about the best cameras in the range. 

Amit Singh

Indoor shooting is indeed a problem for most point-and-shoot 
cameras. Instead of the Samsung i8, I’d look at either the Canon 
SX100 IS or the A720 IS. Both these models feature 8-MP sensors 
and work well with higher ISO settings. 

My friend has the following configuration – an Abit IP35-E mother-
board, 2 GB of Corsair memory, an XFX GeForce 9400GT, WD 250 GB 

hard drive. He is in a dilemma as to which processor to buy. He also 
needs suggestions for the power supply. Please help.

Chirag S

Here, he needs to figure out his budget and also his 
usage patterns. Does he game or do video editing? 
On a budget of Rs. 10,000 or so, I’d recommend 
the Core 2 Duo E8500 (3.16 GHz) for gaming. For 
a budget of Rs. 8,000, I recommend the E8400 (3.0 
GHz). For multi-tasking and rendering, I recom-
mend a quad core. His options are the Core 2 Duo 
Q6600 (2.4 GHz) at Rs. 10,000. If he is willing to 
spend a little more, he can go for the Q9450 (2.66 
GHz) at Rs. 12,500, which is a superb all-round 
performer. For the power supply, look at Corsair’s 
VX 450 for Rs. 4,000. It’s a superb PSU.

I am a huge gaming fan, but I feel that my graph-
ics card is out-dated. I have a dual-core proces-

sor with 2GB of RAM. I’m currently using the NVIDIA 

GeForce 6200 LE. I’ve heard great things about the 9800 GTX+. I want 
a card dedicated to gaming only if it is powerful and allows me to play 
games like Crysis and Crysis Warhead at maximum settings and will 
also be future proof.

Vinayak Goyal

First, you have not mentioned the rest of your system configu-
ration and your exact CPU. Second, you have not mentioned a 
specific budget. The 9800GTX+ is indeed a good card and can be 
had for as little as Rs. 11,000 these days. But this card will only 
be future proof for the next six months or so, since games like 
Crysis will spawn better-looking, resource-heavy variants. I recom-
mend the GTX 260, which you can have for Rs. 19,000. Also, look 
for the ATI Radeon HD 4870 1 GB. At Rs. 18,500 or so, this card 
is great value for money. For NVIDIA GPUs, look at brands such 
as XFX, ASUS, ZOTAC, EVGA and Gigabyte. For ATI GPUs, look at 
Sapphire and Palit.

I want to buy an LCD TV and a 5.1 music system, both under
Rs. 1,00,000. I want at least a 32-inch screen size with good viewing 

angles and good contrast ratio for the TV. The speakers should be power-
ful and suitable for a large sized room.

Kshitij Rawat

For the television, I recommend Samsung’s Bordeaux 32-inch range 
of flat panels. LG’s Scarlet series is also good. Both should be priced 
at around the Rs. 45,000 mark. In fact, we’ve done a comparison test 
each for large screen panels and home theatre systems in this very 
issue, so check that out as well. 

I want to buy a laptop. The main requirements are that it should 
have at least a 14-inch screen, 15 inches is preferable and should 

be future proof. I plan to use it for moderate gaming and would prefer 
that it runs the latest games, but have no qualms about running the 
games at low settings. Therefore, I would prefer a dedicated GPU from 
ATI or NVIDIA. I don’t really care for things like fingerprint readers and 
web cams, but would love to have good-quality speakers, at least a 
250GB HDD and options like TV out and HDMI.

Amlan Mathur

There is a difference between 14.1-inch and 15.4-inch note-
books in terms of portability and pricing. From your query, I 
gather you do not want something compact. You have also not 
mentioned a budget for the same. For gaming, you will need a 

discrete graphics solution. Dell’s Studio XPS 16 is a 
good option for you. It is available with a GeForce 
9500 LE graphics solution and priced at Rs. 68,000 
makes a sensible buy for the discerning gamer. It 
also has TV-out and HDMI connects. If you really 
want to go crazy and get a really powerful solu-
tion, opt for the new Macbook Pro. At 15.4-inches 
and with the option of a mighty GeForce 9600 GT 
video solution, this notebook is definitely for the 
hardcore gamer. You can install Windows XP using 
Bootcamp and have it co-exist peacefully with 
Mac OS-X. This notebook is a beauty, but is priced 
accordingly too! Expect to pay Rs. 1,30,000 for the 
upgraded version, which has 4 GB of DDR3 memory, 
2.53 GHz processor and GeForce 9600GT graphics 
solution with a 250 GB hard drive.

Want a tech product, but 
don’t know how to go about 
buying it? Email
agent001@thinkdigit.com
with your complete 
contact details, and he might 
answer them here! Please 
note that Agent001 only 
answers purchase-related 
questions in this space.

Ask Away
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CONSUMER 
PROTECTION

helplines will have been established and will be integrated with 
the national system; they will be able to share data and interact 
with each other. In the meantime, they will have to act as stand-
alone operations.

Here at Digit, we would like to know of your experiences in 
using the Helpline if you have had cause to do so. Please let us 
know (at servicewatch@thinkdigit.com) how prompt was the response 
and if your complaint was satisfactorily dealt with. All construc-
tive feedback will be shared with the Department of Consumer 
Affairs. 

Edward Henning

I
n the last issue we described the efforts being made by the 
Indian government to improve consumer service in this 
country, and, in particular the availability of the National 
Consumer Helpline (1800-11-4000). This helpline is run out 
of Delhi, and is intended to give help and advice to consum-

ers who feel they have been let down after purchasing some 
product or service. The most interesting point about this helpline 
is the growing list of companies that have signed up agreeing to 
give fast responses to any complaints coming into the helpline, 
typically within 24 hours.

Despite the significant promotional campaign that has been 
run by the Department of Consumer Affairs, it appears that 
not everybody has understood the message. By coincidence, a 
colleague here in our publishing company had an apparently 
genuine complaint with a company that we knew to be on the 
Helpline list. So, he was informed of this, and it was suggested 
that he call the Helpline. But, he clearly did not believe it and 
seemed to think we were simply palming him off instead of genu-
inely trying to help! It needs to be pointed out that the Helpline 
is not a black hole into which any complaint will disappear never 
to be seen again. Much attention has been paid to trying to give 
a prompt response, particularly when it concerns the companies 
on the list mentioned before.

This service is in the process of being extended. Digit spoke 
recently to Mr. Sanjay Singh, Joint Secretary for the Department 
of Consumer Affairs. He informed us that having established the 
national Helpline, the next steps are to set up regional helplines. 
There are several reasons for this. One is to help cater to people 
speaking the large number of regional languages in India. Also, 
the problems people encounter will often vary considerably from 
region to region, and a local service will be better able to address 
issues raised by consumers. Local helplines will also be better 
able to help consumers in rural areas; reaching and helping the 
people in those areas is considered a critical priority.

Funding for these regional lines has been arranged, and 
some are already operating — Gujarat was mentioned, for exam-
ple. Later on, perhaps in a couple of years time, all these regional 

Wake up
Know your rights as a consumer

We received a complaint from a reader, Abhijit Banik, with a 
sorry tale regarding an MSP 345 Champion XL printer from TVS 

Electronics. This came with a two year onsite warranty. After about a 
year, problems started, which led to the device “basically not printing”. 
TVS made five service visits to the printer and each time the same 
problems would occur again after just a few days. Crucially, with his 
later complaints going unanswered, this dragged on beyond the point 
when the warranty had expired. In frustration, he contacted Digit.

We wrote to TVS, and to the company’s credit Mr. Banik’s printer 
was promptly replaced. He tells us “the new printer seems to be work-
ing fine and I have their people calling on me personally and over the 
phone to find out if I am happy and if everything is fine very often.” 

Clearly the original service engineer did not properly diagnose 
the problem — it should not take five service visits before an engineer 
realises that a fault is so serious that a device needs replacement 
rather than repair.

TVS contacted Digit with the shortest of replies: “customer did 
have a problem with the printer and we replaced the printer with a new 
one”. No explanation was forthcoming for this unfortunate episode. 

The lesson from this story is certainly to be more proactive in 
demanding proper attention well before the warranty runs out on a 

product. If a problem starts to drag on in this way, escalate up to the 
senior management in the relevant company. Don’t be shy; go to the 
top and demand attention. Other readers have told us of problems 
dragging on in this way — perhaps deliberately, perhaps not — beyond 
the expiry of the warranty. It then becomes much more difficult to 
find redress.

For example, reader K. Jagdish had trouble with a PC purchased 
from Rex Infosys (P) Ltd., Pala, which included an ASUS K8X-MX-UAYKZ 
series mother board and AMD Athlon 64 1.80 MHz. It started to break 
down very early and the motherboard was changed four times. Finally, 
the dealer stated that the processor was at fault, but that AMD refused 
to replace it as the warranty had expired.

After the reader contacted us, we got onto AMD. We were told that 
by the time that AMD was informed of this, the warranty had indeed 
expired. The company decided to make an exception in this case, and 
has replaced the faulty part, but was concerned that it had taken so 
long for the dealer to pass this onto AMD. With the motherboard being 
exchanged four times, this case is very similar to that of the faulty TVS 
printer. It seems most likely that a mis-diagnosis also occurred here, 
with the service people thinking repeatedly that the motherboard was 
at fault and not the processor.

Getting them to respond

Service Problems?
Write in to servicewatch@thinkdigit.com and 
we'll do our best to help to resolve them

Naming and Shaming

One tactic that is being used by the government in order to 
attempt to force companies to improve their level of customer 

service is to name and shame them on one of its web sites. The 
CORE Centre (Consumer Online Resource & Empowerment Centre, 
www.corecentre.co.in) carries a list of companies that it feels have not 
reponded properly to complaints that have been received. This list 
is given a pretty direct title: “Brands not Friendly and not Caring for 
Consumers”. It lists the names of the most offending brands, gives 
the number of complaints, and the responses. For example, the TV 
manufacturer Videocon is listed as having had 35 compliants made 
against, it has replied to none of the complaint communications 
passed to it by the CORE Centre, and has consequently resolved none 
of these complaints!

The CORE Centre states that it has taken this course of action in 
order to enable consumers to “Beware” of these organisations — in 
other words, perhaps you would be better off not buying from them. 
The more consumers who check this, and any other similar lists and 
do form their purchasing decision accordingly, the better the service 
will be that companies in general will provide. As one image on the 
CORE web site states: “Demand Your Rights!!” Informed by lists such 
as on the CORE web site, from reviews and so forth in magazines, also 
the experience of friends and colleagues — all of this is best put to 
use as consumer pressure. Letting the companies concerned know of 
your needs, and insisting on better quality of goods and services, not 
only helps all consumers, but the companies themselves. By forcing 
them to do a better job, makes you more likely to be a happily return-
ing customer. Is that not what they want?
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Best Buys + Killer Rigs

Doom invented rigs
The original driving force for 
gaming centric computers was 
Doom in the early '90s. 

Basic Setup
Components Our Choice Price

Processor Intel Core 2 Duo E5300 Rs. 4,200

Motherboard Zotac GeForce 9300 Rs. 7,500

RAM 2 GB DDR2 800 MHz (Kingston) Rs. 1,750

Hard Drive Seagate 500 GB 7200.11 Rs. 3,050

Monitor Acer 1916W Rs. 8,100

Sound Card None -

Cabinet Zebronics Antibiotic Rs. 2,400

Power Supply VIP 350 Watts Rs. 850

Keyboard Logitech Multimedia Rs. 350

Mouse Logitech 3 button scroll Rs. 350

Total Rs. 28,550

Multimedia Cum Gaming Rig
Components Our Choice Price

Processor Core 2 Duo E8400 Rs. 8,200

Motherboard MSI P45 Platinum Rs. 9,000

RAM 2 GB x 2 DDR2 800 MHz (Corsair) Rs. 3,600

Graphics Card Palit Radeon HD 4870 1 GB SONIC Rs. 18,100

Hard Drive Seagate 1 TB 7200.11 Rs. 6,500

Monitor Dell SP 2208 WFP Rs. 15,000

Sound Card ASUS Xonar DX Rs. 3,700

Cabinet CoolerMaster 690 Rs. 4,400

Power Supply Corsair TX 650 Rs. 6,500

Speakers Altec Lansing MX 5021 Rs. 6,500

Keyboard Logitech G15 Rs. 4,000

Mouse Logitech MX518 Rs. 1,300

Total Rs. 86,800

Ultra High-End PC / Gaming Rig
Components Our Choice Price

Processor Core i7 940 Rs. 26,000

Motherboard Intel DX58SO Rs. 16,000

RAM 2 GB x 3 DDR3 1600 MHz OCZ Rs. 18,000

Graphics Card ZOTAC GeForce GTX 295 Rs. 35,000

Hard Drive Western Digital Velociraptor 300 Rs. 11,000

Hard Drive 2 Seagate 1 TB 7200.11 Rs. 6,500

Monitor LG 246 Wp Rs. 23,000

Sound Card Creative X-Fi Titanium Rs. 12,000

Cabinet CoolerMaster STACKER RC 832 Rs. 14,500

Power Supply Corsair HX 1000 Rs. 13,500

Speakers Logitech Z5500 Rs. 14,000

Keyboard Logitech G15 Rs. 4,000

Mouse Razer DeathAdder Rs. 2,500

Total Rs. 1,96,000
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Price Watch

Moore's Law
The Moore's Law indicates that 
hardware costs reduce by 33% 
every year. 

Motherboards

Model Market Price Tested in Socket PCI-e x8/x16 slots SATA Ports No of rear USB Ports

Zotac 780i Supreme Rs. 14,500 AM2+ 3 6 6

ASUS P5Q Deluxe Rs. 12,600 June 2008 LGA775 2 6 6

ASUS P5Q-E Rs. 10,800 LGA775 2 6 8

ASUS P6T Deluxe Rs. 20,800 LGA1366 3 6 8

Gigabyte GA-EP45-DS3R Rs. 8,500 LGA775 2 6 8

Gigabyte GA-EX58-UD5 Rs. 17,000 LGA775 3 6 8

MSI X58 Eclipse Rs. 23,900 LGA775 3 10 8

ASUS M3N78-EH (Geforce 8200, AMD) Rs. 5,450 November 2008 AM2+ 1 6 4

ASUS M3A Rs. 4,950 AM2+ 1 4 4

Processors

Model Market Price Tested in Socket Speed FSB L2 Cache

AMD X2 6000+ Rs. 4,175 November 2008 AM2+ 3.1 GHz 2,000 MHz 
HyperTransport 2 MB

AMD Athlon X2 5600+ Rs. 3,700 November 2008 AM2+ 2.9 GHz 2,000 MHz 
HyperTransport 1 MB

AMD Athlon X2 5200+ Rs. 3,100 November 2008 AM2+ 2.7 GHz 2,000 MHz 
HyperTransport 1 MB

AMD Phenom X4 9550 Rs. 6,850 November 2008 AM2+ 2.2 GHz 3,600 MHz 
HyperTransport 2 MB

AMD Phenom X4 9650 Rs. 6,725 November 2008 AM2+ 2.3 GHz 3,600 MHz 
HyperTransport 2 MB

AMD Phenom X4 9850 Black Rs. 8,400 November 2008 AM2+ 2.5 GHz 4,000 MHz 
HyperTransport 2 MB

AMD Phenom 2 X4 920 Rs. 10,975 AM2+ 2.8 GHz 3,600 MHz 
HyperTransport 2 MB

Intel Core 2 Duo E8500 Rs. 9,600 March 2008 LGA775 3.16 GHz 1,333 MHz 6 MB

Intel Core 2 Duo E7300 Rs. 5,750 LGA775 2.66 GHz 1,066 MHz 3 MB

Intel Core 2 Duo E8400 Rs. 9,400 LGA775 3 GHz 1,333 MHz 6 MB

Intel Core 2 Duo Q8200 Rs. 9,100 November 2008 LGA775 2.33 GHz 1,333 MHz 4 MB

Intel Core 2 Duo Q9550 Rs. 14,975 LGA775 2.83 GHz 1,333 MHz 12 MB

Intel Core 2 Duo Q6600 Rs. 9,750 November 2007 LGA775 2.4 GHz 1,066 MHz 8 MB

Intel Core 2 Duo E5200 Rs. 3,525 November 2008 LGA775 2.5 GHz 800MHz 2 MB

Intel i7 920 Rs. 15,200 LGA1366 2.66 GHz 4.8GT/s QPI NA

Graphic Cards

Model Market Price Tested in Core Speed Type of memory Memory

Zotac 9800 GTX+ AMP! Edition Rs. 11,150 738 MHz GDDR3 512 MB

Zotac GTX 260 Rs. 20,200 650 MHz GDDR3 896 MB

EVGA 9800GT (Super Clocked) Rs. 9,600 650 MHz GDDR3 512 MB

EVGA 9600GT Knock-out Rs. 7,550 November 2008 700 MHz GDDR3 512 MB

ZOTAC GeForce GTX 285 Rs. 27,000 Febrauary 2009 648 MHz GDDR3 1024 MB

Palit Radeon HD 4870 1 GB SONIC Rs. 17,950 750 MHz GDDR5 1024 MB

Palit Radeon HD 4870 SONIC Rs. 15,650 October 2008 750 MHz GDDR5 512 MB

Palit Radeon HD 4850 SONIC Rs. 9,750 685 MHz GDDR5 512 MB

Palit GeForce 9400 GT Rs. 2,800 550 MHz GDDR2 512 MB

XFX GeForce 8600 GT Rs. 3,700 540 MHz GDDR2 256 MB

Stuff we would buy...Stuff we would buy...
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Hard Drives

Model Market Price Tested in Speed Cache Interface

Western Digital Caviar Blue 1 TB Rs. 5,350 7200 RPM 16 SATA 2

Western Digital Caviar Blue 750 GB Rs. 4,700 7200 RPM 16 SATA 2

Western Digital Caviar Blue 640 GB Rs. 3,700 7200 RPM 16 SATA 2

Seagate Barracuda 1 TB Rs. 5,500 7200 RPM 32 SATA 2

Seagate Barracuda 500 GB Rs. 3,075 7200 RPM 32 SATA 2

Seagate Barracuda 750 GB Rs. 4,900 7200 RPM 32 SATA 2

Monitors

Model Market Price Tested in Size Resolution Contrast Ratio Response time

Acer AL1916 Rs. 6,550 19-inch 1280 x 1024 700 : 1 8 ms

Acer AL2216 Rs. 9,800 22-inch 1680 x 1050 700 : 1 5 ms

Samsung 2033SW Rs. 7,850 20-inch 1600 x 900 15000 : 1 5 ms

Samsung 740NW Rs. 6,700 17-inch 1280 x 720 500 : 1 8 ms

Samsung 743NX Rs. 7,450 17-inch 1280 x 1024 500 : 1 5 ms

Samsung 943NWX Rs. 7,600 19-inch 1280 x 1024 1000 : 1 5 ms

Dell S1709W Rs. 6,750 17-inch 1440 x 900 600 : 1 8 ms

Dell 1909W Rs. 7,400 19-inch 1440 x 900 1000 : 1 5 ms

ViewSonic VX2255WMB Rs. 12,500 May 2008 22-inch 1680 x 1050 1000 : 1 5 ms

ViewSonic VX2835WM Rs. 28,000 28-inch 1920 x 1200 1000 : 1 3 ms

ViewSonic VA1918WM Rs. 6,750 19-inch 1440 x 900 1000 : 1 5 ms

LG W1942S Rs. 7,900 19-inch 1440 x 900 700 : 1 5 ms

LG W192W Rs. 7,550 19-inch 1440 x 900 700 : 1 5 ms

LG 177WSB Rs. 6,600 May 2008 17-inch 1440 x 900 700 : 1 8 ms

Cabinets

Model Market Price Tested in Dimensions Weight No of 5.25” bays Number of 
fans

Antec Nine Hundred Rs. 6,950 19.4 x 8.6 x 
18.6 “ 8.4 kg 3 4

Antec Twelve Hundred Rs. 11,650 22.9 x 8.4 x 
20.2 “ 14.5 kg 3 6

Antec NSK4400 Rs. 2,200 May 2008   16.6 x 7.8 x 
16.5 “ 8 kg 3 3

Antec P180 Rs. 6,450 21.3 x 8.1 x 
19.9 “ 14 kg 4 5

Antec P182 Rs. 8,075 21.3 x 8.1 x 
19.9 “ 14 kg 4 3

Cooler Master CM Stacker 832 Rs. 14,500 21.1 x 25.11 x 
9.84 “ 14.5 kg 9 2

Cooler Master CM 690 Rs. 4,200 20.64 x 8.38 x 
18.97 “ 9.8 kg 4 2

Cooler Master Cosmos-1000 Rs. 12,975 24.72 x 10.47 x 
23.54 “ 16.9 kg 5 3

Cooler Master Elite 330 Rs. 1,950 September 
2008

19.09 x 7.44 x 
16.73 “ 6 kg 4 1

NZXT GUARDIAN 921 Rs. 4,675 20.55 x 18.07 x 
8.11 “ 8.2 kg 3 3

Thermaltake Armor+ Rs. 12,500 23.6 x 9.6 x 
24.6 “ 10.2 kg 7 4

Thermaltake Xaser VI Rs. 13,700 January 2009 23.8 x 9.8 x 
26.0 “ 18.0 kg 7 4
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Smart SoHo

Siddharth Parwatay

I
nternet connec-
tivity is among 
the basic 
n e c e s s i -

ties today. 
You will 
s c a r c e l y 
find a 
b u s i -
ness in 
globalised 
India that 
does not depend 
on an internet 
connection in some 
way or the other. In fact, 
for most businesses, email, 
VoIP, and other web services 
are a lifeline. Ever since India 
became an off-shoring hub, many 
companies service clients abroad. 
Irrespective of usage, choosing the 
right internet connection is important 
– both from the functionality as well as 
cost saving viewpoint. Let’s look at some 
of the factors involved while zeroing in on a 
suitable connection.

The options available
In the earlier days, life was restricted to painfully 
slow dial-up connections. For corporates that 
could afford it, there was ISDN which was a bit 
faster and was considered state-of-the art for 
quite some time. However, today the internet 
is more accessible.

DSL / ADSL works through existing two-
wire copper telephone lines and is an always-
on connection. MTNL’s broadband service, 
based on ADSL 2+ technology, is known as Tri-
Band. Tri-band offers speeds of up to 2 Mbps 
with an assured minimum speed of 256 kbps 
to individual telephone subscribers.

A leased line is another option. Such a 
leased line connects two locations for a 
private voice and data telecommunication 
service. Rather than a dedicated cable, 
a leased line is a reserved open circuit 
between two points, used to connect 
to the internet. When you go in for a 
leased line, there are no data limits. 

Unlike normal dial-up connections, a leased line is 
always active, always on. The connection fee is a 
fixed monthly rate. The primary factors affecting the 
monthly fee are distance between end points and the 

speed of the circuit.
Wired cable connections 

are common in semi-urban 
office setups. Typically, local 
cable operators purchase 
bandwidth in bulk from 
large ISPs and channel them 

to individual subscribers. 
They have their own brand 

names for their service. There 
are also players like You Telecom 

that operates on last mile co-axial and 
fibre optic lines with cable modems. They 

have solutions for SMEs with unlimited plans 
such as the ‘Business Platinum’, 1 Mbps line for 

Rs. 9,500 per month.
Several players such as Airtel and Reliance 

Communications provide WiMax solutions for enter-
prises. WiMax stands for Worldwide Interoperability 
for Microwave Access, and is a standard wireless 

technology that allows broadband connections 
over long distances. However, the service is 

only available in certain major cities. 
A typical Broadband Wireless Access 

(BWA) system is composed of two 
key elements – base station and 
subscriber equipment. The base 
station connects to the subscriber 
equipment using an outdoor antenna 
to send and receive high-speed data 
to the subscriber equipment; thereby, 
eliminating the need of wire line 
infrastructure and provides a flexible 
and cost-effective last-mile solution. 
However, according to its web site, 

the bandwidth of the last mile 
wireless connectivity offered by 

Airtel is only up to 512 Kbps.
The choice now lies with 

what works best for you. The 
service provider plays a major 
role in this regard because 
inherently all transmission 
modes are almost equally 
susceptible to breakdowns. 
Your up-time will depend 
largely on the dedication of 

your ISP.

Internet Connectivity 
Solutions

Bazaar
Latest products tried and 

tested                      78

Shrikrishna Patkar
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The right plan and connection
The nature of your business will play a major 
role in deciding your ideal internet connec-
tion. If you are using the internet for 
simple tasks such as emailing with 
less browsing, you will require a 
different plan compared to a graph-
ics processing outfit working for an 
offshore client.

You should also look at the kind 
of traffic you are likely to produce. Does 
it consist more of uploads or downloads? If you 
find that your uploads are equal to downloads then 
you should go in for a 1:1 line. If your downloads are 
high and sending large files via FTP doesn’t form part 
of your daily function then go in for a line that offers, 
for example, upstream rates of 256 kbps while the down-
stream rate is 1 Mbps.

When considering the type of connection, whether to 
prefer cable, DSL or WiMax, depends largely on the data 
plans and rates. ISPs have several data plans designed for 
businesses, which essentially offer combinations between 
speed, download limits and price. Typically, ISPs might 
charge users a flat fee per month or apply charges based 
on usage. Usage may be calculated by time spent brows-
ing (per hour) or downloaded data. There are also plans 
where you find a combination of both. For example, the 
MTNL Tri-Band “Trib Business 7199” plan that offers 45 
GB downloads for Rs. 7,199 and an additional 70 paise per 
MB for downloads beyond the 45 GB limit. There may be 
other plans where usage during the day is calculated by 
hours spent online while during the night, it shifts to a 
per-MB basis.

Broadly, plans are categorised into limited usage and 
unlimited plans. If the volume of your internet usage is high, 
then an unlimited plan is a good idea. Limited plans usually have a 
fixed component of charges that cover a certain allowable download 
limit, say 500 MB. Beyond that limit, you will be charged a certain 
amount per MB or GB of downloaded data.

Whether limited or unlimited, the connection 
speed of a plan is defined by the bandwidth. 
Bandwidth is almost synonymous 
with data transfer rate, 
and therefore, synon-
ymous with speed. 
Choosing the band-
width depends on the 
criticality of speed 
to your business. 
If your internet usage 
is not part of your core 
business function, it doesn’t 
matter much if email takes a 
little longer to open. If you run a 
graphics solutions or media company, 
it’s likely you will need to send heavy files and browse rich 
content, so speed is important.

So how do you calculate your bandwidth requirement? 
Say your company is into wholesale exports, and much of your 
employees’ time is spent sending mails and viewing prices of 
commodities. High speed is not very critical, and you have about 
30 machines that need access to the internet. To be able to browse 
at decent speed, you need to have an effective speed of 15 kBps for 
each computer. So, at any given point of time, your connection’s 
bandwidth should be able to support 450 kBps (450 x 8 = 3,600 
kbps). Also, this does not mean that a constant stream of 450 

kBps will be consumed at all times, considering 
the idle time and intermittent requests on 

the connection. Therefore, a bandwidth 
of 2 Mbps should suffice for this 
scenario.

You may also be able to find 
online resources such as You 
Telecom’s plan calculator. It gener-

ates an estimate of your bandwidth 
and data transfer requirement. This 

is done by entering estimates of usage 
such as number of hours spent online, 

number of programs downloaded, and 
number of emails likely to be sent.

Factors while choosing an ISP
You have several players such as Bharti Airtel, MTNL, BSNL, 
Reliance Communications, Tata Indicom and even local cable 
operators that offer internet services. Where there is a level play-
ing field and all tariffs / plan details are the same, look at the 
fine print. Most ISPs try to hide complicated clauses within their 

service agreements which basically help them go back on 
their promised services. 

Look at things such as sharing ratio. Sharing 
ratio signifies how many users are going to 
be serviced by the same line to which you are 
subscribing. A sharing ratio of 1:1 means that 
you are the only subscriber on that line. Up 
time is also another important factor while 

choosing an ISP and is a measure of reliability 
that is indicative of the total time the service is func-

tional. Scalability is also something to look at. If you’re likely 
to expand operations, your current ISP should support scal-
ability. 

Customer service is another factor to consider. Is the ISP 
quick to respond to complaints? Most of this information can 
be gathered by consulting your friends and other users around. 
Since quality of service is also different in different geographies, 
it’s advisable to find out through other offices in your area, about 
their subscribed ISP.

Value added services can also be a differentiator. Most ISPs 
bundle benefits such as SMTP servers, web space, and email 
ids. It’s important to figure out if any of these services are 
relevant to your organisation and whether to choose a particu-
lar ISP for them. 

siddharth.parwatay@thinkdigit.com

Search engines
Get to know how search 

engines work         41
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solved                        81

DIY
Learn to make your own 

games                      92
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Nimish Chandiramani

D
isclaimer: This tutorial covers the very basics of Python 
programming. You’ll need some basic programming knowl-
edge for this. If you’re already familiar with the language, 
you could consider soaking in the other wonderful articles in 

this issue.
If you’re a programmer, or want to learn programming, 

you’re going to love Python. It’s one of the easiest languages 
you’ll ever learn, it’s powerful, and best of all, you can use it to 
build cross-platform applications.

Get Python
If you’re a Linux or Mac user, you’ve already got Python installed. 
However, you should still download the latest version — we’re 
using Python 3, which has made a few changes to the syntax. You 
can get Python for your platform from www.python.org. The instal-
lation process is pretty straightforward. 

The First Time
There are two ways you can work with Python — you could either 
write your programs in a regular text editor and run them in 
the Python environment, or type your commands directly into 
the interpreter. If you’re old enough to remember BASIC, you’re 
already familiar with this. For now, let’s work with the inter-
preter. You have two options: if you want to see your code in 
pretty colours, start IDLE — the integrated development environment 
(IDE) that installs with Python; or if you prefer the geeky good-
ness of the command line, fire up your terminal (Start > Run > 
type “cmd” in Windows) and type “python”.

Both environments are rather uneventful-looking, and all 
you’ll see is is a prompt that looks like this: “>>>”.

And now, you’re ready to start with the world’s simplest 
program. In the prompt, type “print(‘Hello, world!’)” (you can 
use single or double quotes — the interpreter isn’t fussy). And 
that’s it! Your first program: no messy surrounding code — just a 
command. You’ll notice that Python is consistently like this — it’s 
practically like having a conversation with your PC.

***code****
>>> print(‘Hello, world!’)
Hello, world!
***code****
Caption: Your first Python command in action

Know the rules
Before you move to the more complex world of two-line programs, 
you must first familiarise yourself with Python’s basic syntax. 
If you’ve had some experience with any other programming 
language, this can be a little disconcerting. Firstly, there’s no end-
of-line character. If you hit enter, you’ve ended a line — simple. 
Second, there are no beginning-and-end braces, brackets or 
anything — a program’s blocks are denoted only by indentation.

Other programming languages want you to declare variables 
before you use them in your program. Python is very forgiving 
in this matter. To start using a new variable in your program, 
all you need to do is give it a value — the Python interpreter 
will automatically decide what type of variable it is, and give 
it its own special place in your system’s memory. Let’s look at a 
program that calculates the area of a circle, and how you’ll see it 
in the interpreter:

***code****
>>>pi=3.14159           # <- this hash means 

you’re starting a comment
>>>r=4                  # the radius of the 

circle
>>>area=pi*(r**2)       # remember that even 

Python follows the BODMAS rule — brackets are always 
solved first

>>>print(area)
50.25644
***code**

Getting Modular
Once you’re ready to start writing multiple-line programs, you’re 
better off doing so in a Python file — called a module. Once you’ve 
written a module, you can execute it from the command line 
whenever you feel like it. There’s also a more significant use for 
modules, but we’ll come to that in just a bit. 

You can create modules in any text editor (see Kit Bag for our 
favourites). If you’re using IDLE, all you need to do is hit [Ctrl] + [N] 
to open a new window. When you’re ready, start typing. Let’s use 
the same example — calculating the area of a circle:

 ***code****
# Calculate the area of the circle
pi = 3.14159
r = 4
area = pi*(r**2)        # ‘**’ is the python 

equivalent of ‘to the power of’
print(‘The area is ‘,area)
***code****
Save this file as a .py file on your hard disk. If you’re using 

IDLE, you just need to hit [F5] to run the module. If you’ve used a 
text editor, open your terminal (command prompt in Windows), 
navigate to where you stored your file, and type “python file-
name.py”. 

But a program that calculates the area of just one circle isn’t 
really fun, is it?

Getting Interactive
To make this program slightly more useful, let’s have it ask the 
user for a radius. We do this by using the input() function, which 
will (as the name suggests), accept an input from the user. 

***code****
# Calculating the area of a circle, v2

pi = 3.14159
r = input(‘What is the radius? ‘)       # the 

question is optional
area = pi*(r**2)
print(‘The area is ‘,area)
***code****

When you run this file, you’ll see this:

***code****
$ python area.py
What is the radius? 5
The area is 78.53975
***code****

Now we’re getting somewhere. This would be a good time to 
fiddle with some conditional statements.  

***code****

First Hiss
Your first quick-and-dirty crash course in Python

Developer Corner
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Python was voted the Language of 
the year in 2008 by linuxquestions.org 
— for the second year in a row. 
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# Calculating the area of a circle, v3

pi = 3.14159
r = input(‘What is the radius? ‘)       # the 

question is optional
area = pi*(r**2)

if area > 100:                               
                  # a simple condition. 

Remember the colon at the end of the statement
    print(“That’s one big circle! Its area is:”,area)          # notice 

that we use double quotes here, because we’ve got a single quote 
in the sentence — don’t want to trip up the interpreter!

else:
    print(“Bah. That’s tiny. Just”,area)
***code****

Row, if you enter a radius that’s 6 or more, you’ll be compli-
mented on your choice. As you can see, Python’s “if..” statement is 
pretty simple. Every statement that you indent after the “if” will 
be executed if the condition you specify is true. The same goes for 
“else” — every indented statement after it will be executed if the 
condition is false. 

When you’re done mucking about with conditional state-
ments, you can take a ride on one of Python’s loops. 

 Round And Round
Writing loops in Python is as easy as conditional statements. 
One function that’s going to come to your aid here is “range”, 
which lets you specify a starting number, an end, and a step 
that’s added to every number. For example, range(1,100,2) 
starts at 1, and goes up to 100 in steps of 2. Let’s look at a 
simple loop:

***code****
# Counting to 50 in steps of 4
for i in range(0,50,4):         #again, remember 

the colon
    print(i)
***code****

That’s really all there is to it — pretty straightforward, yes? 
Python even has a “while” loop that’s just as easy:

***code****
# Counting with a while loop
i=0             # you have to assign variables 

first
while i<=50:
    print(i)
    i=i+4       # or i+=4, if you prefer
***code****
Unlike other languages, Python doesn’t have a “do-while” 

loop, so if you want your block of code to run at least once, you’ll 
have to figure out a smart way to do a while loop.

All right, enough with the trivial stuff.

Getting Functional
When you’re programming in the real world, you’re not going to 
write new programs every time you need to calculate the area of 
a circle, or want to count to 100 — you’re going to write functions, 
which are like little bottles of code that you can keep handy, and 
use them when you need to. Here’s how you define a function 
in Python:

***code****
# A function to calculate the area of a rect-

angle
def area_rect(length,breadth):       # accepting 

~arguments~ from your main code
    a = length*breadth
    return a                         # sending 

back the result of the calculation

# Now, you can use this function anywhere in the 
main code

l = input(‘What is the length? ‘)
b = input(‘What is the breadth? ‘)
area = area_rect(l,b)
print(‘The area is’, area)
***code****
Here’s where Python’s modular nature comes through. If 

you want to write a bunch of functions that you can use in any 
program that you write, you just need to write one module, and 
import it into the other modules you write. First, let’s write a 
module that defines the area functions we need:

***code****
# module with functions for area

def area_rect(l,b):
    a=l*b
    return a

def area_circ(r):
    pi=3.14159
    a=pi*(r**2)
***code****
Save this as areas.py. Now, start a new module, 

in which we’ll calculate the area of a circle:

***code****
# calculate the area of a circle

import areas                    # gives this 
module access to the functions in areas.py

radius = input(‘Enter a radius: ‘)
area = areas.area_circ(r)       # to access func-

tions, you need to type modulename.function
print(area)
***code****
Save this file — call it circle.py — in the same directory as 

areas.py. Now, when you run circles.py, Python will first compile 
areas.py into Python bytecode (you’ll see a new file called areas.
pyc), and then run the code in circles.py. 

If you’re going to use just a few functions of a module, 
however, it doesn’t make sense to import the whole module. 
In the example above, we aren’t using the area_rect func-
tion at all, so why import it? In this particular case, we have 
nothing to lose — but for more complex modules, you don’t 
want a bunch of unnecessary code taking up your system 
memory. Thankfully, Python lets you import specific items 
from modules. Instead of the “import” statement, you just 
need to use “from ... import ...”:

***code****
from areas import area_circ     # import just 

this function
area = area_circ(5)             # you don’t need 

to use module.function() here
***code****

Welcome To The Jungle
Now that you’ve had a dose of the basics, you can move on to 
more advanced stuff, like object-oriented programming (OOP). 
If you haven’t OOP-ed before, check out our Fast Track to C++ 
for an introduction. You can also use Python in combination 
with a GUI framework — wxWidgets, Qt and the like — to build 
graphical applications that will run on Windows, Mac and 
Linux. If you want a change from PHP, you can even use Python 
to power your web site as well. If you use Blender for 3D graph-
ics, you can have all sorts of fun with it using Python scripts. 
To cut a long story short, if you want to do it, chances are that 
you can do it with Python. 

readersletters@thinkdigit.com

PyCon 2009
The world's largest Python community 
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March to 2nd April in Chicago, USA.  



ESC

DIGIT MARCH 2009108

ES
C

Feature

Aditya Madanapalle 

W
ith the invention of the telephone, the way people 
interacted and behaved with each other changed 
forever. The radio has also been one such invention 
that has changed our lives as humans. It became an 

addictive evening time activity, similar to the family spending 
their nights in front of the television in the ‘90s. 

Entertainment grew to progressively invade more and more 
sensations, but gaming was when entertainment truly arrived. 
Audio-visual interaction is too good to resist. Games are the most 
immersive entertainment available to people today. Even a casual 
gamer can end up spending a significant amount of time playing 
the same game rather than watching the same TV channel or 
listening to the same radio station, or reading a book. 

Every time there is some technological progress, there is a 
flurry of discussion and debates over the social effects of these 
technologies. As technologies mature, a deeper understanding of 
their potential harm emerges. There’s no doubt many spend a lot 
of time gaming, and this has raised one question from doctors, 
psychologists, concerned parents and educationalists – are games 
good or bad for you? We spoke to psychologists, surveyed chil-
dren who are into gaming, interacted with the parents of these 
children, and looked at some international studies, to demystify 
what is generally a misunderstood activity. 

Wake up, Mr Freeman...
Interestingly, several gamers are in a dilemma of sorts themselves. 
Most gamers are well aware of the problems that gaming can pose. 
In fact, serious gamers take adequate steps to shield themselves 
from harm. Even within a game, the older and more experienced 
players groom the newer players into playing responsibly.

Most parents are not aware of the game contents, or even 
understand what their children are up to. There are several ques-
tions that concern parents. How many hours a day of gaming is 
normal? Where should they draw the limit? Is it OK to play late 
night? How adversely does gaming affect children? To what will 
the child be exposed?

These are all valid questions, but the concerns are based on 
myths. Since games are a fairly recent phenomenon here in India 
it is natural that such questions should arise. Some clearing of 
the air is required. On one side of the coin, games, like any other 
repeated activity, make you really good at some things. Think of 
it as mental exercise. Games do not ruin eyesight, neither does 
watching television for a long time, or reading a book in the dark. 

In fact, gaming is said to improve visual perception. For 
example, those who play first person shooters resolve closely 
packed objects better and learn to process information very 
quickly. Games train players to understand threatening situations 
and respond to them by dealing with panic. If a child is nervous 
or restless, then it is recommended to let the child play games to 
build focus. In fact, gaming is used as a therapy in some western 
countries for children with attention deficit disorders. Gaming 
also improves reflex and boosts hand-to-eye coordination. 

Another myth is that exposure to games make children more 
violent. Children don’t play games to be violent, they play it for 

accomplishment – completing a task or a mission. They play a 
game to beat the game, not the fictitious beings in the game. A 
good example of this is the defrag mod for the popular combat 
shooter game Quake3. When several parents were complaining 
how violent the game was, where the objective was to shoot play-
ers with an arsenal of weapons, a group of people began to use 
the same weapons for performing stunts within the game. Videos 
were shared over the internet, and the community became a 
movement, a violent game was turned into an activity of skill 
and precision. 

Games are typically very short, and single player games 
hardly ever last for more than eight hours at the highest level 
of difficulty. It’s also very easy to get bored with games, so the 
resourceful gaming community comes up with innovative ways 
to play the game. An illustration of this is the speed-running 
community where gamers play to cross the game as quickly as 
possible, often using alternate routes and exploiting bugs in the 
game. There are plenty of secondary skills that are enhanced by 
gaming, including logical reasoning and memory retention.  

Somebody set up us the bomb
On the other side, there’s a lot that can go wrong. There have 
been instances of children going into coma, or even dying 
after prolonged gaming sessions. These intense sessions could 
last more than two days at a stretch, and are referred to as 
bingeing. There are cases where parents with young children 
were so addicted to games that their children were made to 
starve. An intense obsession for a game, or gaming in general, 
can develop to a point where playing a game is not a matter 
of choice, but a matter of compulsion. These, however, are 
isolated cases, and the majority of the gamers around the 
world are well-balanced people whose lives are not adversely 
affected by gaming. 

Most of these problems cannot be blamed on the game 
itself. It’s a result of faulty lifestyle choices, and an indicator 
of unhealthy behaviour. These include parents not spending 
enough time with their children, children not being encouraged 
to play outdoors and developing a psychological distance from 
reality. If the game were not the focus of the problem, something 
else almost certainly would be.

According to Shekhar Kunte, psychology trainer, “indulging 
in games makes the child mentally cut off from the real world. 
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It’s not just games that affect children in this manner though, 
chatting and text messaging cause the same problems”. Any 
system that a child interacts with can be confusing and mislead-
ing, as real-life skills are left out. Such a delusion can be very 
strong, with total mental dedication to something that is not 
true at all.  

The problem arises when children confuse the real with the 
virtual, as Brazelina Almeida, Vice Principal of Christ Church 
School points out, “As was the case with WWF a while ago, chil-
dren trying to emulate the fantasy world into reality can have 
disastrous effects. Rather they should read or go out and play”. 
This is a problem even for adults. The sense of reward after play-
ing a game can be so fulfilling that gamers can be misled into 
preferring the virtual world to the real. 

Meetah Shah, another clinical psychologist and a counsel-
lor, suggests a slightly more liberal approach. She believes 
that in moderation a dose of gaming can be healthy on some 
terms (she cites the example of hand-to-eye co-ordination), 
but concentrating on physical activities is equally important. 
She suggests a timetable that allows for liberal gaming and 
physical activities that a parent can make a child follow. This 
includes not just gaming, but all kinds of entertainment-
related activities such as watching movies, listening to music 
or spending time with friends. 

We spoke to a few parents of children who were really into 
gaming. Two things we noticed were parents scheduled timings 
for studies, gaming and physical activities. Academic perfor-
mance of their children was not affected because of gaming. 
Moreover, the children themselves preferred to engage in physi-
cal activities. The console of choice for the children was the Wii, 
which involves more body movement than playing with just a 
joystick, keyboard or gamepad. 

Clearly, gaming itself is not the problem. Rather, it is the 
overall approach to development that needs to be highlighted. 
As with most gamers globally, children in India need to balance 
their real world activities with virtual feats. 

Almeida is of the opinion that the kind of games, their 
content, and the time spent on them must be regulated by the 
parents. “I’m most concerned about latch-key kids who are left 
unsupervised for long periods of time. Since games are obviously 
entertaining, self regulation by children themselves is unlikely.” 
Children these days are exposed to a lot of things, and there are 
undesirable messages everywhere. 

When asked specifically about how violence in gaming 
affects children, Shah pointed out, “violence is everywhere, 
including Tom and Jerry cartoons. What is of importance is the 

parents’ attitude towards their children, and how well they are 
able to guide their children through the formative years”. 

Experts agree that boys are exposed to more harm from 
gaming than girls. This is for several reasons. Most games are 
designed to be played by boys. Gaming consoles are more likely 
to be purchased for boys rather than girls. Boys also receive more 
encouragement and support for using and abusing technol-
ogy than girls. Most importantly, peer pressure from boys over 
gaming, or a particular game is much more than the necessity to 
be good at gaming than in girls. 

But our princess is in another castle!
Since the dawn of the century, games have taken a new path. Most 
games released in the last five years have been centred around 
multiplayer gaming online. Counter Strike, one such phenom-
enon in India, is played across the country in schools, colleges 
and even offices. The dedication to developing the skills necessary 
to play at par with other players in the circle can be demanding 
and leech resources, energy and time away from other activities. 
Mythology, fantasy and technology have combined erratically to 
form massive multiplayer online role-playing games (MMORPG). 
These are highly intensive games, requiring endless hours of game-
play, where a virtual character develops over time depending on 
the choices and activities of the person who is playing. One of the 
most popular role playing games in India is Ragnarok. 

Internationally, games such as World of Warcraft have many 
dedicated players. Children are more susceptible to MMORPGs 
because of the number of hours of gameplay required. Also, 
the danger of confusing the real world for the virtual world is 
increased because of the role playing nature of the game. These 
games are gender-neutral, and allow either gender to play with 
characters of any gender. Adults and children alike are exposed 
to problems with such games.  

Experts, psychologists and educators agree that these games 
are not good for children. Left unsupervised, they can cause 
considerable harm to children. Specifically, the harm that is asso-
ciated with gaming is a confusion of reality, exposure to violence 
and lethargy. 

Such accusations are not new to entertainment, and have 
been around for a long time. All forms of entertainment have the 
same side effects. Movies, music and even books have all been 
accused with the same negative repercussions during their time. 
Experts agree that the key is to ensure a balance between time 
spent in entertainment vis-à-vis studying or development. It’s 
always healthy to be passionate, but how far is far enough? In 
India, massive online multiplayer games have not spread as well 
as they have in other countries. Therefore, we don’t experience 
heavy fallout from it. 

The truth is that most of today’s debates about gaming being 
good or bad for you are centred around massive online multiplayer 
games, the community, and how obsessed they are with play-
ing. Is there anything wrong with a child who plays six hours 
at a stretch during vacations? Although we have no answer 
to that question, many feel that’s way too far. Communities 
develop their own codes, in-jokes, temperaments and attitudes. 
Nevertheless, as it is said, anything in excess is bad.

Many gamers cannot distinguish between the real and virtual 
world, and often events in each affect the other. Fortunately, 
India is not facing such problems yet, but it’s happening all over 
the globe. Divorces in real life due to affairs in virtual worlds or 
large amounts of money being paid in the real world for hard-to-
find gadgets in a virtual world are almost everyday occurrences. 
With a picture of a virtual funeral in World of Warcraft for a 
girl who died playing it in the real world, we leave you to decide 
– whether there is anything horribly wrong here. (with inputs from 
Kumar Jhuremalani and Siddharth Parwatay) 
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H
ere, we discuss methods to create your own simple 
game. Before you start, you need to invest a lot of time 
and effort. Even a simple game has to be tweaked many 
times over to gain perfection. You don’t necessarily 

need have any prior knowledge of programming. This is a guide 
to get started, your imagination can take you much further. 

Part I: Make a game using FPS Creator
FPS Creator is a simple and fun game creator with a quick 
approach. You can download it at www.fpscreator.com. The web 
site also sells model packs that can be used with the creator, 
and they have a range of interesting items, backgrounds and 
characters. FPS creator allows you to create an environment for 
playing, set points for picking up health and ammunition, and 
locate enemies around the map. You can also waypoint enemies 
to give them movement, which is a very basic form of artificial 
intelligence. 

The opening screen of FPS Creator has a library toolbar to 
the right and a grid in the main window. We will be “painting” 
objects, entities, and segments of the map on this grid. To move 

around the grid, use the arrow keys. To go up or down a layer, or 
level, use the plus [+] and minus [-] keys. You can use this method 
to create multiple levels in the same map. To zoom in or out, use 
the mouse wheel. Zooming and changing the levels is not the 
same operation. You start at a neutral level, and can either dig 
deeper, or build up. 

By default, the ‘prefrab’ tab is selected. This is a library 
of pre-fabricated structures that can be added directly to the 
map. To create your own structures from scratch, go to the 
segments tab, and click on ‘add new segment’. There are two 
sets of segments, one with a sci-fi theme, the other with a 
WWII theme. A typical brush will paint a floor, the walls, and 
the ceiling. Adjoining blocks will be automatically joined. There 
are also floor only, and ceiling-only brushes available. Ignore 
the ramps, steps and platform brushes for now. Choose a room 
brush, and start painting. 

This creates a simple room. To create some kind of an exit 
from the room, go to Segments > Sci-fi > Scenery and 
select one of the doors. The ‘automatic’ doors will open when 
the character approaches. The ‘use’ doors will open when the 

user presses the action key for opening the door. The fake doors 
will not open, and as such don’t lead to anything. First, select 
the door; to rotate the door while placing it, use the [R] key. We 
will create a corridor leading out from the door. Go to Segment 
> Sci-Fi > corridors. Select a corridor and paint them, 
along with a turn segment or two if you want. Lead the corridor 
into another room, and place doors on that room too. 

Moving to advanced game building; after selecting a room 
brush, go to the Segments menu and select one of the options. 
For example, Segments > Paint Only Walls adds walls 
without the floor or ceiling. This allows you to create openings 
into upper levels, or create rooms that have high ceilings. Go to 
Segments > Sci-Fi > Platforms for selecting staircases 
that lead to the upper levels. Use all the imagination you have got 
at this stage. 

Opening screen

Make your own games

Simple room

Corridors and faked rooms

Complicated levels

Longest time in 
development
Duke Nukem Forever has 
been in development 
since 1997. 
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From our levels, notice that there are rooms and corridors 
on different levels. The laws of physics don’t apply, so you don’t 
have to consider objects such as pillars. Just make sure nothing 
is disconnected from the rest of the segments. While you’re 
creating the map itself, make plenty of nooks and corners to 
hide enemies, areas where you can pick up ammo and health. 

Now it’s time to decorate the map and add touches. There 
are lights available, switches for lights, windows, furniture and 
and other items. There are a range of these like pipes, corpses 
and crates, so strew them liberally around the map. This adds 
colour and character to the game.

It is a good idea to zoom in while placing things around 
the map. Some of these objects are really small, and placing 
them correctly takes a lot of time. Skip this if you don’t have 
the time. Create the environments, which makes the experience 
much better when you actually play the game. 

Next, go to Entities > Sci-Fi > characters, and 
select enemies. Place them around the map too. Use armed 
environments for better results. Place them around corners or 
behind doors to make the game interesting. 

Once you have placed an enemy, you can waypoint it so that 
it patrols an area. By default, the waypoint mode is enabled. 
Press [W] and click Near the enemy. A star would now appear. 
All enemies will catch on to and follow the nearest waypoint. 
So you can make a particular enemy follow complicated routes 
through the map, and even across levels if you want. Hold 
[Shift] and click on the star again, and you should get a 
stretchable bar that you can drag around. Place the second 
star at a point where you want the enemy to go to. Repeat the 
process till you have set paths for your enemies. 

Now, go to Entities > Sci-Fi > Items and select 
Weapons and ammunition. Liberally scatter these around the 
map. Markers are a way of telling the software what you want 
the game to do at particular points and at particular times. You 
can create “hurt” and “heal” zones, set the start and end points 
of the game, as well as program complex triggers that take 
particular actions when the player comes there. For now, just 

create a simple starting point for the character. Go to Marker 
> Player Start, and place the start marker at a point on 
the map where you want the player to start. 

That is it, the game is now ready. Click on the test level 
button to run the game. You can alternatively build the game. 
There several advanced options available. The more time you 
spend with a game, the better it gets. Once you test the level, 
you are bound to run into some bugs. 

This is a dead end that was not intended to be there. There 
will also be gaps in walls, staircases that don’t go anywhere, a 
mismatch in the levels, and a number of other problems. The 

real part in making the game comes now, where you have to 
make the gameplay and level designs better over repeated tests. 
The positioning of the ammunition, whether the items supplied 
are enough, are the waypoints laid out well. These are just some 
of the considerations. If you upgrade to the full version, you can 
build stand alone games, and even sell them. 

Part II: Using Game Maker 7
Game Maker 7 is the game creator of choice for many hobby-
ists. You can make old school games similiar to Pacman, 
Mario or Galacta. The software is very versatile, and can 
easily handle platformers and top-down shooters. The latest 
version also allows you to create simple 3D games such as 
Doom. While the games made in Game Maker don’t look all 
that great, it’s a great starting point for serious enthusiasts 
or those who want to get into the profession. This is because 
the logic of games, and the gameplay itself is focused on 
more than the look and feel. 

It is possible to create pretty versatile games in Game 
Maker, even a game that switches from being a platformer to 

Placing stuff

Way point

Dead end

Kill people

3 years
The average development 
cycle of a game

Profi ts?
Only the top 5% leading games 
manage to rake in money
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a racer in different levels. Game Maker uses two basic compo-
nents for making games. The first type is static, and the second 
type is dynamic. Static components are sprites, sounds and 
backgrounds. A sprite can be any element in the game, the 
ground, the trees, the enemies and the player are all defined 
using sprites. Dynamic components include objects and rooms. 
Objects are sprites with attributes and behaviour. 

An orange orb used as a bullet is a sprite, but an orange orb 
programmed to come into existence when the [Space] key 
is pressed, produces a sound for that action and kills enemies, 
is an object. A room is the game environment using the back-
ground and any object that the user puts in. 

Discussed below is a method to create a simple top-down 
shooter. The logic and approach to handling Game Maker can 
be used for creating any type of game. 

The first step is to create and load all the static objects. 
This means creating sprites, backgrounds and sounds. Sprites 
can be created in paint or any image creation program of your 
choice. Use very small images, and zoom in and work. Simple 
lines are enough to create sprites. We used paint to create this 
space ship.

Think of all the elements you’ll need in the game. We 
created enemy ships, and bullets. We also used a stock explo-

sion animation. 
Animated GIF files 
can be used in Game 
Maker, and they will 
be animated in-game 
as well. We also used 
sounds downloaded 
from the internet, 
and a space wallpaper 
for the background. 
Reduce the quality of 
large backgrounds. 
There are a wealth of 
sprites, sounds and 
backgrounds avail-
able for free, for any 
kind of game that 
you may want to 
create. Sprites are 

often drawn with different views in the same file, so you will 
have to break them down into individual images if you are not 
using your own.  

Fire up Game Maker 7 now. You will see a number of folders 
on the left hand side. We start by loading our sprites. Right-
click on Sprite, and then click on Create Sprite. A window 
should appear. Click on load, navigate to the image file of your 
sprite and click on Open. This window also has the sprite editor, 
which lets you change colours, and resize the sprite. Typically, 
make a sprite smaller than 100 pixels. 

Your sprites will 
be named sprite, 
sprite1, sprite2, and 
so on. Change these 
to more recogni-
sable names that are 
simpler to handle 
if you have a lot of 
sprites. Load all the 
sounds you want 
to use too. You can 
have sounds for every 
bullet fired, explo-
sions, and also have 
a background score 
too. You can also have 
sounds for the move-
ment of your space-

ship towards the left or right. All this will be programmed later on. 
Next, load the background.

The right programming makes all the difference in the 
game. Game Maker can ascribe behaviour to the object based 
on the actions of the user. To create a new object, right-
click on the Objects folder. Then, load a sprite in the Sprite 
window by clicking on an option from the drop-down box. 
Once you have made an object, changes to the sprite will 
change the object automatically. Now create a new event. 

On the right-hand side pane, in a tabbed view are a number 
of options. Drag and drop these actions as per your require-
ments. You can play a sound, make the object move, jump to a 
particular position, change into another image and even make 
actions based on probability. Explore these actions - you don’t 
need all of them. Add events for all the movement keys, and 
move the object to the appropriate directions. Now you will 
have to program the fire key. For this, you will have to create 
another object, which is the firing object. Make the object move 
towards the top of the screen on creation. Go back to the plane 
object, and add an event for the [Space] or the [Ctrl] key. 
In the main tab is a create instance button (a lightbulb). Click 
on this and select the instance of the fire object. Now, every 
time you press [Space], your space ship will spew fire. 

Create enemy objects, and configure them to vanish 
when they get hit by the bullets that are fired. You also 
have to make sure that your own plane gets destroyed when 
it is hit. 

Now create a new room. Load the background for the 
room in the backgrounds tab. The drop down box will show 
all the loaded backgrounds. Check the horizontal and verti-
cal tile options. Click on Views, and check Enable view. Now, 
select the dimensions of the game. This can be 400 x 300. You 
can make exotic scrollers here, such as a 200 x 200 square 
scroller. In the View in Room box, set the Y value to a large 

number (more than 
2000). This lets you 
place enemies to 
appear when play-
ing the game. Place 
a few enemies, and 
you’re good to start 
playing. However, 
you need a lot of 
tweaking before 
you can perfect 
a game. The real 
building starts 
from here. 

Be dedicated, and 
have fun for fruitful results. Game Maker has some scripting 
capabilities too. Once you’ve understood the basics of how 
gameplay works, you can move on to better things. 3DRad, is 
another software that lets you create 3D games in the same 
spirit as Game Maker.

aditya.madanapalle@thinkdigit.com 

Creating a sprite

Create instances

Edit sprites

Finally the game

$15 million
The development cost 
of an average game
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B
eing a military shooter, you wouldn’t expect much 
of a story from Killzone 2, and there really isn’t one 
to speak of. It’s only in the latter stages that some 
semblance of a story comes together to make things 

more interesting. The single-player campaign does seem on 
the short side though, and on normal (trooper) difficulty, 
completing it in under 10 hours shouldn’t be much of a 
problem.

Visually, Killzone 2 is stunning and the attention to 
detail is quite baffling. Everything from the weapon model-
ling and explosions to the texture detail and shadows will 
make you sit back in awe. A limited colour palette and a few 
instances of unimaginative level design are the only down-
ers in what is otherwise a visually top-notch game and one 
that PS3 fans and Sony will use as a poster child for what 
can be achieved with the power of the PS3.

Although the game is set on an alien planet, lending it 
a bit of a sci-fi feel, everything from the movement physics 
to the weapon selection is very realistic. The levels and envi-
ronments too, vary quite a bit. What starts out in the streets 
of a Helghan city, later moves through stone structures, vast 
open barren lands, and industrial complexes, to name a few. 
But while overall the levels are varied enough not to feel 
monotonous, you can’t help but feel that Killzone 2 doesn’t 
deviate enough from the industrial wasteland-look that has 
been done so many times before in first-person shooters. 

While few console games can compete with Killzone 2 
in the graphics department, it is the enthralling gameplay 
that is the most enjoyable aspect of the game. The thrill-
ing gun battles, an intuitive cover system, clever enemy AI, 
and explosive set pieces all combine to deliver an intense 
gameplay experience that you won’t soon forget. The clever 
enemy AI will make the use of cover all the more necessary. 
The enemies, who are spread out across various classes, 
will use different tactics to get to you. Many levels offer you 

multiple routes to the next checkpoint, but the enemy will 
also use these multiple routes to flank you every chance 
they get. Every now and then, you will also be faced with 
bossfights that provide a great way to mix up the gameplay.

One key gameplay aspect that some may appreciate 
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while others may dislike is that you can only carry one of 
the above weapons with you at any given time, while you 
have a secondary firearm — a pistol with unlimited ammo, 
and a knife with you at all times. What this means is you 
will play most of the game with your preferred weapon, 
usually an assault rifle, while the other powerful weapons 
are used when needed, then discarded in favour of the rifle.

Once the credits roll on the single player campaign, 
you can jump right into the highly praised class-based 
multiplayer mode. You start out as a regular soldier and 
as you pick up points, you level up, which unlocks more 
weapons and soldier classes. You can also mix and match 
abilities from various classes, ensuring that your multi-
player experience never gets stale. 

The main Warzone multi-player mode is a mix of vari-
ous match types, including variations of assassination, 
search-and-destroy, team deathmatch, and capture the 
f lag. You can also try the off line Skirmish mode, where 
you can take to one of the multiplayer maps along with 15 
bots. Bots can also be used online in case you don’t have 
sufficient players. One of the biggest complaints in the 
lead up to the game’s release has been the lack of a co-op 
mode. But both the campaign and the multi-player mode 
more than make up for the lack of co-op.

Killzone 2 is a thoroughly enjoyable game not only for shoot-
ing fans, but for gamers in general. You will be hard pressed to 
find a console game that looks better than this, but Guerrilla 
didn’t stop there. It gave us one of the most thrilling gun 
combat experiences that also transfers into the game’s highly 
addictive multi-player mode. As hard as it may have seemed 
considering all the pre-release hype, Killzone 2 has delivered the 
goods. If you buy it, you won’t be disappointed. 

Genre: First person shooter
Platforms: PlayStation 3
Studio: Guerrilla Games
Publisher: Sony Computer Entertainment
Number of players: 1 offline, 32 online
 Score: 8/10
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Agent001

R
esident Evil 5 is an embarrassment to the survival 
horror genre. First of all, the environments are not 
cramped, secondly, a majority of the game takes 
place during the day and finally it doesn’t try to 

force you to memorise a brand new control scheme to (arti-
ficially) heighten the tension. If this is what survival horror 
meant to you, kindly stop reading this review but if you’re 
willing to accept change you’d realise that Capcom’s bold 
decisions have led to a game that is bound to please the 
survival horror enthusiast and the newbie alike.

Earlier Resident Evil games were criticised for their 
clunky control scheme, unforgiving save system (which 
required you to hunt down typewriters in in-game loca-
tions) and steep learning curve. It seems that Capcom have 
taken their community feedback to heart this time around. 
While last generation’s Resident Evil 4 was a step up from the 
series’ usual offering, Resident Evil 5 builds upon its over the 
shoulder action, quick time events and visceral bloody boss 

battles to deliver a game that is a revolu-
tion, if not evolution of the franchise.

This time around you’d be visiting 
the fictitious African country of Kijuju 
as Chris Redfield, the protagonist of 
the first game Resident Evil that liter-
ally invented the survival horror 
genre. Along the way you’d encounter 
foes and faces, familiar and new in 
addition to the usual convoluted to 
the point of nonsensical plot that 
usually accompanies each install-
ment in the series. And to share 
all this newness (and familiarity) 
with you is Sheva Alomar, your 
partner for the mission, who is 
playable in co-operative mode. 
While most team-based charac-
ters are a pain to manage when 
controlled by the AI, Sheva is 
different. She provides you cover 
fire, ammo and makes the single 
player experience quite enjoyable. 
A definite step up from team 
members of other titles such as 
Army of Two and Gears of War.

While we’re on the topic of 
Gears of War, if you’ve played 
the game, or any other third-
person shooter, you’d be right 
at home with the controls in 
Resident Evil 5. The control 
scheme marries the best of 
contemporary games with 
the longstanding Resident Evil 
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tradition of stopping and shooting compared to the usual 
run and gun mechanic, ensuring that you’d be blowing 
heads off zombies with laser-like precision. Carnage at its 
best.

And what carnage it is. Shoot an attacking dog and a 
zombie parasite splits it into half, giving you a new foe to 
get rid of. The game looks brutally gorgeous and packs a 
visceral punch with moments like these. 
Everything from lighting effects to 
zombie pixels have been painstak-
ingly rendered to make the most use 
of next-gen hardware. If this weren’t 
enough, the music is well paced, with 
tracks selected according to the state 
of panic your character is in, it mixes 
in some percussion and operatic beats 
along with the usual electronic fare to 
great effect. When it comes to produc-
tion values Resident Evil 5 is as high 
as they come making the improbable 
zombies in broad daylight situation a 
tense, heart stopping affair that’s multi-
plied several times over when you’ve got 
a friend playing along as well.

The cooperative mode is seam-
lessly built into the game. In fact there are 
sections where you’d feel that the game was made for coop 
and coop alone. However it’s an undertaking that’s best done 
via PSN or XBL as offline coop features screens that signifi-
cantly shrinked down (unless you fancy playing at 480p).

Other grouses include a cover system that’s quite useless 
and an inventory system that’s tougher to manage than a pair 
of Bollywood starlets.

These minor flaws aside, Resident Evil 5 is an epic game 
that is worth playing for anyone even remotely interested 
in the survival horror franchise. Even if you’re not, it’s still 
worth a try regardless. 

Developer: Capcom
Publisher: Capcom
Platforms: Xbox 360, PlayStation 3
 Score: 8/10

Devil May Cry
was initially planned to be a 
sequel for the Resident Evil 
series
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T
he widely-publicised Ghajini is supposed to be an Indian 3D 
game for the PC. Although there are a few titles that claim 
the same honour, we’ll give this one the benefit of doubt 
for what the developers have done. The game follows up 

on the popularity of the movie. The game has pretty high graphic 
requirements, and we received word from the developers about 
some toning down in the graphics department they had done, so 
that the game would run on more computers. The game puts you 
in the shoes of the protagonist in the film — Sanjay — and lets you 
play the game as his character. It is supposed to be a third-person 
adventure game, but it plays more like a puzzle game.

We were really impressed with the way the game begins. There 
are no cut scenes. Instead, you have a series of comic book-style 
panels that explain the background with a voice over by Aamir Khan 
himself, and a great background track. The game goes overboard with 
terms such as darkness and haunting which reads like juvenile poetry, 
but successfully lays down a dark and haunting aura for the game. 
The artwork used is amazing, and is done with style and panache. 
When the game loads, you are stunned by the level of detail. The envi-
ronments are richly created (although with very low quality textures), 
and the in-game character is a very good likeness of Aamir Khan.

The game starts going downhill from the second you start play-
ing. You get an objective in the first level — go to the lift. Sanjay, 
despite his amnesia (we’ve heard it’s retrograde, but it is more 
highly selective than anything else), tells you that it is out of the 
door to his right. However, he forgets that you need keys to open the 
door (keys, from the inside?) so you go around the apartment look-
ing for keys, a map of Mumbai, a camera and other oddities. You do 
this by opening every drawer in the map, and going over every inch 
of the house. You expect some action, some passion, which is why 
anybody would want to get in Sanjay’s shoes. What you get is an 
escape room puzzle with zero ingenuity. The game uses some pretty 
good devices, which would have worked in a better game. For exam-
ple, you have to hide from policemen by scanning their “cones of 
vision” which are shown like sweeping spotlights. Avoid the yellow 
areas, and they won’t see you. Sanjay walks, never runs, and is even 
slower when crouching, which he has to do, all too often. The pace 
of the game is an anti-climax following the intros at every level.

The combat does not kick in until the third level of the game. 
You have to beat up a construction site full of illegal drug labs. You 
also have to blow up the labs. The fourth level has you beating up 
some people in the streets of the city. Some of them have guns, 
but the rest use cricket bats, hockey sticks and baseball bats. Why 
baseball bats we wonder? There are sufficient Indian weapons 
around to use, a good weapon would have been the pipe with a 
tap still attached to it, as shown in a gory panel during the open-
ing of the level. Navigating around the game can be a tedious and 
difficult process. Jumps that look impossible do no damage. Falling 

from a pipe just because the control of the character is difficult 
kills you. Getting into doors, ramps, ledges — all of which happen 
pretty frequently — is made difficult by a lack of smooth program-
ming. You are not given enough control in the game to meet the 
demands of the game, which is not a lack of skill on the gamer’s 
part, but a lack of skill on the part of the devlopers. 

The AI for the combat gets horribly boring very quickly. All the 
people around behave in the exact same way. There are a whole 
gamut of moves possible, by using a combination of the [Q] and [E] 
keys on the keyboard. These let you throw spectacular punches and 
kicks, and hardly receive any damage in the process. What is impos-
sible to counter are the petrol bombs thrown at you every now and 
then. You just have to find a way to avoid them. Most of the game 
forces you to think of a counter-intuitive approach to a problem. If a 
man with a gun is shooting at you, you don’t run directly at him, but 
approach using alternative methods out of his line of fire, so that he 
runs away. There are some hilarious times when you get to fight two 
people at a time, and they are reacting in the same way together. It 
feels like fighting Siamese twins who share a common brain.

There are a few moments when the meticulous attention-
to-detail shines through. It is really great to see some (although 
boxy) autorickshaws in a game. There are a whole bunch of 
bugs and glitches  such as disappearing floors, your head going 
into the surroundings, unclear areas where you cannot navi-
gate to — all of these are forgivable. What is not forgivable, is 
the way the character gets stuck for no fault of yours. Jump 
on a tinned roof in the wrong angle, your legs disappear into 
the floor, and you cannot move. Try climbing a pipe when you 
are too close to it, you are made immobile because your body 
becomes embedded into the pipe. These things can happen at 
unpredictable points in the game, and your only option is to 
restart. The sound is excellent, we have no complaints about it. 
It gives a sense of pace to what would have otherwise been a 
long and boring game. The graphics are better than you would 
have expected, and we would have accepted a lot less. The game 
hardly manages to tax the machine, and we have no idea why 
the requirements are so high. The characters look much better 
than the surroundings, some of which look positively alien. 

What absolutely cannot be overlooked, is how unplayable 
the game is. This is not a game you can enjoy playing. This is 
not a game where your actions give you any sense of achieve-
ment. The character moves too slowly, the action is at a snail’s 
pace, you are not allowed to run, and all of this makes the game 
very difficult. The game defeats you, but through no shortcom-
ings of your own. The gameplay is simply not mature enough by 
international standards — prevalent a decade and a half ago. All 
in all, this is a very forgettable game. 

Publisher: FXLabs 
Distributer: Eros Multimedia Pvt Ltd 
Price: Rs. 199 
 Score: 3/10

Ghajini

Feels like bullet time, but isn’t

Basic Instinct II rubbing shold-

ers with DON and Bheja Fry

Help me officer, my head is stuck in a wall



DIGIT MARCH 2009120

The Last Word

“I am mainly 
thinking of the 
internet as an 
information 
resource. A demo-
cratic internet 
implies that 
anybody can put 
up anything they 
like, regardless of 
accuracy”

Many years ago I was often accused of in 
some sense opposing the internet. Clearly, 
I had not done a good job in expressing 
myself, and so I had better be more care-
ful now.

My objections had always been directed 
at the nonsense that would come from so 
many of the self-styled internet evange-
lists; one of the funniest that caught my 
attention a few years ago was a prediction 
by no less a person than MIT’s Nicholas 
Negraponte that within a couple of years 
there would be more Barbie dolls attached 
to the internet than Americans. I have no 
idea what they put in the water at MIT, but 
if criticising such nonsense makes me an 
internet opponent, then so be it.

A century and a half ago, people made 
similarly exaggerated claims for the tele-
graph. (Yes, I mean the morse code electric 
telegraph.) According to one author on the 
subject, because the invention of the tele-
graph had such a profound effect, “experts” 
extrapolated and decided that the tele-
graph would “eliminate the drudgery of 
manual work and create a world of abun-
dance and peace.” The book from which I 
am quoting is “The Victorian Internet” by 
Tom Standage — I often suggest that people 
read this in order to help put into perspec-
tive some of the wild expectations about 
the internet.

The silliest notion is also one of the 
most attractive to many people, and that 
is the general idea of the democratic inter-
net. Now, the word “democratic” is a politi-
cal term, and there are many aspects of 
the internet — uses to which it can be out 
— where politics has no place at all. I am 
mainly thinking of the internet as an infor-
mation resource. A democratic internet 
implies that anybody can put up anything 
they like, regardless of accuracy.

One example: I travel to Kathmandu 
quite often, and know the city well. A few 
years ago I wanted to use Google Earth to 
explain to a friend how to find a rather 
obscure bookshop. Useless. Most of the 
landmarks — hotels, restaurants, shops, etc. 
— had been wrongly marked. In particular, 
one chap had marked dozens of places, all 
of them a few hundred metres away from 
their actual locations — he had clearly not 
set his GPS device properly. As an informa-
tion resource, this made it totally useless.

I have written before here of the unre-
liability of some of the information on 
Wikipedia, in particular controversial 
subjects where zealots have taken over 
and allow no opposing views to their own 
— these are clear examples of politics inter-

fering in information; the modern equiva-
lent of book burning.

Well, things are starting to change, 
but not far or fast enough, in my opinion. 
These changes have been prompted by 
malicious edits to Wiki pages that implied 
that US senators Robert Byrd and Edward 
Kennedy had died. The suggestion is that 
any changes to a page will be checked 
before actually being added to the site. 
However, in a recent interview, the founder 
of Wikipedia, Jimmy Wales, made it clear 
that this rule — already applied on the 
German site — would only apply to pages 
concerning living people.

How about the rest of the information 
that is up there? A golden rule in edito-
rial offices is that several pairs of eyes 
need to check every single item that is 
to be published. That rule is intended to 
eliminate factual errors, but it also helps 
prevent malicious mis-information of the 
sort that occurs on Wikipedia. 

In the interview, Wales stated that 
“what we are looking for right now is 
the exact parameters of how we would 
implement in a way that would get very 
strong support... instead of a complicated 
hierarchical system... somebody who has 
been around the community for a while 
will check it.”

He seemed very defensive — meeting 
much oppostion from “the community”, 
no doubt.

This is one very small step in the right 
direction, but it might end up giving more 
strength to the zealots — who by defini-
tion have dug themselves deeply into “the 
community” in order to press their own 
agendas forward. 

The information aspects of the internet 
such as Wikipedia and Google Earth need 
much stronger and more careful manage-
ment. It is a form of publishing, after all, 
and the editorial checks and balances that 
have been developed over many decades in 
the print industry have not become redun-
dant simply because of the addition of a 
new medium. The accessibility of this new 
medium actually makes them all the more 
important and necessary today.

Democracy or accuracy?

edward.henning@9dot9.in
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